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Record of Revisions

Reference numbers are shown at the bottom left corner on the back cover of each manual.

Printing Date Reference No. Revised Contents

May, 2008 1060NE0 First edition
• Additional functions for the version 5.1.0.0

June, 2008 1060NE0a English expressions reviewed

September, 2008 1060NE1 Second edition
• Additional functions for the version 5.2.0.0

November, 2008 1060NE2 Third edition
• Additional functions for the version 5.3.0.0

March, 2009 1060NE3 Fourth edition
• Additional functions for the version 5.4.1.0

December, 2009 1060NE4 Fifth edition
• Additional functions for the version 5.4.8.0

June, 2010 1060NE5 Sixth edition
• Additional functions for the version 5.4.11.0

October, 2010 1060NE6 Seventh edition
• Additional functions for the version 5.4.14.0

November, 2010 1060NE7 Eighth edition
• Additional functions for the version 5.4.15.0

February, 2011 1060NE8 Ninth edition
• Additional functions for the version 5.4.17.0

May, 2011 1060NE9 Tenth edition
• Additional functions for the version 5.4.18.0

November, 2011 1060NE10 Eleventh edition
• Additional functions for the version 5.4.21.0

February, 2012 1060NE11 Twelfth edition
• Additional functions for the version 5.4.22.0

May, 2012 1060NE12 Thirteenth edition
• Additional functions for the version 5.4.23.0

August, 2012 1060NE13 Fourteenth edition
• Front cover revised
• Additional functions for the version 5.4.24.0

November, 2012 1060NE14 Fifteenth edition
• Additional functions for the version 5.4.25.0

February, 2013 1060NE15 Sixteenth edition
• Additional functions for the version 5.4.27.0

April, 2013 1060NE16 Seventeenth edition
• Additional functions for the version 5.4.28.0



Record of Updates

V-SFT
Ver.

SYSTEM 
PROG. Ver. Additional Functions Date of Release

5.0.0.0 1.000 V8 series November, 2007

5.0.1.0 1.010 <Connectable models added>
• Multi-link
• Multi-link2
• OMRON: E5AR/E5ER
• RKC: SR-Mini (MODBUS RTU)
• RKC: CB series
• RKC: SRV (MODBUS RTU)
• Fuji Electric: FVR series

December, 2007

<Functions added>
• Emulation function

5.0.4.0 1.030 <Connectable models added>
• Hitachi Industrial Equipment Systems: HIDIC-H
• Hitachi Industrial Equipment Systems: HIDIC-H (Ethernet)
• Hitachi Industrial Equipment Systems: HIDIC-EHV
• Hitachi Industrial Equipment Systems: HIDIC-EHV (Ethernet)
• Hitachi: HIDIC-S10/2α, S10mini
• Hitachi: HIDIC-S10/2α, S10mini (Ethernet)
• Hitachi: HIDIC-S10V
• Hitachi: HIDIC-S10V (Ethernet)
• Fuji Electric: MICREX-SX (OPCN-1)
• Fuji Electric: MICREX-F
• Fuji Electric: FALDIC-α series
• Siemens: S7 PROFIBUS-DP
• SAIA: PCD
• KOYO ELECTRONICS: SU/SG (MODBUS RTU)
• KOYO ELECTRONICS: SU/SG (K-Sequence)
• KEYENCE: KV10/24 CPU
• Yamatake: SDC35/36
• Yamatake: DMC10
• Yamatake: DMC50 (COM)
• RKC: SR-Mini (Standard Protocol)
• IAI: PCON/ACON/SCON (MODBUS RTU)
• SHINKO TECHNOS: DCL-33A
• SHINKO TECHNOS: FC series
• V-Link
• Modbus slave (RTU)
• Modbus slave (TCP/IP)

January, 2008

<Models added for ladder transfer>
• MITSUBISHI ELECTRIC: A series CPU
• Yokogawa Electric: FA-M3/FA-M3R
• Fuji Electric: FLEX-PC

<Functions added>
• 128-color monitor

5.0.5.0 1.040 <Connectable models added>
• Allen-Bradley: Control Logix/Compact Logix
• Allen-Bradley: Control Logix (Ethernet)

February, 2008



5.0.7.0 1.060 <Connectable models added>
• Allen-Bradley: SLC500
• Allen-Bradley: MicroLogix
• Siemens: S7-300/400 (Ethernet)
• KEYENCE: KV-3000/5000
• KEYENCE: KV-3000/5000 (Ethernet TCP/IP)
• Automationdirect: Direct LOGIC (K-Sequence)
• Automationdirect: Direct LOGIC (MODBUS RTU)
• OMRON: E5AN/E5EN/E5CN/E5GN
• RKC: MA900/MA901 (MODBUS RTU)
• MITSUBISHI ELECTRIC: FR-*500
• TOSHIBA: VF-A7

March, 2008

<Models added for ladder monitor>
• MITSUBISHI ELECTRIC: QnH

5.0.9.0 1.080 <Connectable models added>
• Siemens: S7-200PPI
• Siemens: S7-300/400MPI
• SAMSUNG: SECNET
• LS: MASTER-KxxxS
• EATON Cuter-Hammer: ELC
• AB OEMax: N7/NX series
• SHINKO TECHNOS: C series

April, 2008

<Models added for ladder transfer>
• Allen-Bradley: SLC500

<Models added for ladder monitor>
• Fuji Electric: SPB (N mode) & FLEX-PC CPU
• Fuji Electric: Micrex-SX
• Yokogawa Electric: FA-M3/FA-M3R

5.1.0.0 1.100
1.110 

(V806)

<Edit models added>
• V806 series

May, 2008

<Connectable models added>
• Fuji Electric: HFR-C11K
• Fuji Electric: ALPHA5
• Fuji Electric: APR-N series (MODBUS RTU)
• LS: MASTER-KxxxS CNET
• FATEK AUTOMATION: FACON FB series
• UNITRONICS: M90/M91/Vision series (ASCII)
• OMRON: V600/V620
• SanRex: DC AUTO (HKD type)
• SUNX: LP-400

<New functions>
• Data display with entry function
• Languages for stroke fonts added
• 16 language selection types available
• Item show/hide function
• USB connection (barcode reader/keyboard/mouse)
• E-mail certification
• FTP server
• MES interface
• Two Ethernet ports
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5.1.1.0 1.120 <Edit models added>
• V810C/V808C series
• TELLUS3

June, 2008

<Connectable models added>
• Fuji Electric: HFR-C9K
• Fuji Electric: WE1MA series (MODBUS RTU)
• Yokogawa Electric: FA-M3/FA-M3R (Ethernet TCP/IP)
• IDEC: MICRO Smart
• SAIA: PCD S-BUS
• TECO: TP-03 (MODBUS RTU)
• DELTA TAU DATA SYSTEMS: PMAC
• SAMSUNG: N_Plus
• AB OEMax: NX7/NX Plus Series

5.1.2.0 1.130 <Connectable models added>
• Allen-Bradley: SLC500 (Ethernet)
• Allen-Bradley: MicroLogix (Ethernet)
• Yokogawa Electric: UT350/450
• TOSHIBA MACHINE: TC200
• LS: XGT/XGK series
• LS: XGT/XGK series CPU
• SHARP: JW series
• SHARP: JW20 COM port
• SHARP: JW100/70H COM port
• Fuji Electric: FRENIC-MEGA (MODBUS RTU)
• RKC: SRZ (MODBUS RTU)
• Matsushita Electric Works: FP-X series
• SHINKO ELECTRIC: SELMART
• DELTA TAU DATA SYSTEMS: PMAC (Ethernet)
• MITSUBISHI ELECTRIC: QnU CPU port

July, 2008

5.2.0.0 1.200 <Connectable models added>
• FANUC: Power Mate
• IDEC: MICRO3
• Yokogawa Electric: 

UT100/UT750/UT550/UT520/UT320/UT2400/UT2800
• MITSUBISHI ELECTRIC: MR-J3*A
• TOHO: TTM-00BT
• TOHO: TTM-200 (MODBUS RTU)

August, 2008

<New functions>
• Word lamp
• Slider switch
• Scroll bar (JPEG display)
• Operation log function
• Security function
• Differences transfer
• The number of screens increased
• Macro commands added (trigonometric functions, conditional 

branch macro)

5.2.3.0 1.210 <Connectable models added>
• Gammaflux: TTC2100
• MITSUBISHI ELECTRIC: QnH (Q) series (CC-LINK)

September, 
2008

<Models added for ladder transfer>
• MITSUBISHI ELECTRIC: QnU series CPU
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5.3.0.0 1.300 <Connectable models added>
• Yamatake: AHC2001, AHC2001+DCP31/32
• GE-FANUC: 90 series (SNP-X)
• BECKOFF: ADS protocol

<New functions>
• Additional alarm function
• Network camera of AXIS
• Ladder transfer function via USB

MITSUBISHI ELECTRIC: QnH series CPU
MITSUBISHI ELECTRIC: Q00J/00/01 CPU
MITSUBISHI ELECTRIC: QnH (Q) series CPU (multi CPU)
Fuji Electric: MICREX-SX SPH/SPB CPU

• Screen size selection available for Tellus
• I/O comment display of the ladder transfer function for the 

model of Yokogawa Electric
• Multi-link2 Ethernet

October, 2008

5.3.1.0 1.310 <Edit models added>
• V815X

<Connectable models added>
• Allen-Bradley: Control Logix (Ethernet) 1:n connection
• TOYO DENKI: μGPCsx series
• TOYO DENKI: μGPCsx CPU port
• TOYO DENKI: μGPCsx series (Ethernet)
• TOYO DENKI: μGPCsx (SX bus)
• TOYO DENKI: μGPCsx (OPCN-1)
• KEYENCE: KZ-A500 CPU
• TOSHIBA: VF-S7
• TOSHIBA: VF-S9
• TOSHIBA: VF-S11
• TOSHIBA: VF-AS1
• TOSHIBA: VF-P7
• TOSHIBA: VF-PS1
• TOSHIBA: VF-FS1
• TOSHIBA: VF-nC1
• MITSUBISHI ELECTRIC: FX series CPU
• MITSUBISHI ELECTRIC: FX1S series CPU
• MITSUBISHI ELECTRIC: FX-3G

<New functions>
• Ladder transfer via Ethernet 

MITSUBISHI ELECTRIC: QnH (Q) series CPU
MITSUBISHI ELECTRIC: Q00J/00/01 CPU
MITSUBISHI ELECTRIC: QnH (Q) series CPU (multi CPU)
MITSUBISHI ELECTRIC: QnU series CPU
Fuji Electric: MICREX-SX SPH/SPB CPU

• Ladder transfer via USB
MITSUBISHI ELECTRIC: QnU series CPU

• Selective transfer function
• V715X support for ladder monitor

November, 2008
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5.3.3.0 1.320 <Edit models added >
• V808CH (hand-held type)

<Connectable models added>
• MODBUS TCP/IP Sub Station
• Yamatake: SDC10
• Yamatake: SDC20
• Yamatake: SDC21
• Yamatake: SDC30/31
• Yamatake: SDC40A
• Yamatake: SDC40G
• Yamatake: DCP31/32

<New functions>
• V715X dimming method change macro SET_BZ

December, 2008

5.3.4.0 1.320 <Connectable models added>
• General-purpose PROFIBUS-DP

December, 2008

5.4.0.0 1.400 <Connectable models added>
• General-purpose FL-NET
• MOOG: J124-04x series
• YAMAHA: RCX142
• TOSHIBA: T series/V series (T compatible)
• Siemens: S7
• OMRON: E5CK
• OMRON: E5EK
• OMRON: E5AK
• OMRON: E5ZE
• OMRON: E5ZD
• MITSUBISHI ELECTRIC: FR-E700

<New functions>
• V806 portrait orientation
• Alarm acknowledge
• Operation log viewer
• Trend sampling graph show/hide function
• Ethernet network table number increase (up to No. 255)
• Macro command SMPL_CSV2, SMPL_CSVBAK2, 

HDCOPY3 file name designation
• Backspace switch enabled for numerical data entry
• Scroll bar-ready item added

February, 2009

5.4.1.0 1.410 <New functions>
• Remote desktop window display

February, 2009

5.4.3.0 1.430 <Connectable models added>
• MITSUBISHI ELECTRIC: QnH (Q) series (Ethernet ASCII)
• MITSUBISHI ELECTRIC: QnH (Q) series (multi CPU) 

(Ethernet ASCII)
• OMRON: SYSMAC CV series
• TOSHIBA: EX series
• RKC: REX-F400/F700/F900 (Standard Protocol)
• UNIPULSE: F340A
• UNIPULSE: F371
• Hitachi Industrial Equipment Systems: SJ300 series
• Hitachi Industrial Equipment Systems: SJ700 series
• Banner: PresencePLUS (Ethernet/IP (TCP/IP))

April, 2009

5.4.3.0 1.430 <New functions>
• EL-type-compatible display for V808C (128 colors only)
• SX simplified instrumentation function

April, 2009
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5.4.4.0 1.440 <Connectable models added>
• MITSUBISHI ELECTRIC: FX3U series (Ethernet)
• UNIPULSE: F720A
• UNIPULSE: F800
• EMERSON: EC10/EC20/EC20H (MODBUS RTU)

May, 2009

5.4.5.0 1.450 <Connectable models added>
• MITSUBISHI ELECTRIC: FX3U/3UC/3G series link (A 

protocol)
• MITSUBISHI ELECTRIC: A series (CC-Link)
• MITSUBISHI ELECTRIC: QnA series (CC-Link)
• GE Fanuc: 90 series (Ethernet TCP/IP)
• DELTA: DVP series

<New functions>
• Continuous buzzer for switch
• Page block batch setting
• Macro toolbar

July, 2009

5.4.7.0 1.460 <Connectable models added>
• Siemens: S7-300/400 (Ethernet ISOTCP)
• Siemens: S7-300/400 (Ethernet  TCP/IP PG protocol)
• LS: GLOFA GM series (Ethernet UDP/IP)
• MODICON: Modbus RTU
• Telemecanique: TSX Micro
• DELTA: DVP series
• MITSUBISHI ELECTRIC: MR-J3-*T
• SHINKO TECHNOS: JCx-300 Series
• Shimaden: Shimaden standard protocol

<New functions>
• Multi-link2 (Ethernet) available for 1:n connection using 

MODBUS RTU

August, 2009

5.4.8.0 1.480 <Connectable models added>
• IAI: ROBO CYLINDER (RCP2/ERC)
• IAI: ROBO CYLINDER (RCS/E-CON)
• L-CPU-B

<New functions>
• RGB touch switch available at 2 channels
• Tag editing
• MITSUBISHI ELECTRIC: Ladder monitor function extended
• Ladder transfer via USB or Ethernet

Yokogawa Electric: FA-M3
Yokogawa Electric: FA-M3R

October, 2009

5.4.9.0 1.500 <Connectable models added>
• IDEC: MICRO Smart pentra
• Automationdirect: Direct LOGIC (Ethernet UDP/IP)
• MODBUS RTU extended format
• TOSHIBA MACHINE: VELCONIC series

<New functions>
• Alarm display Date and time 8-point display
• Ladder monitor

MITSUBISHI ELECTRIC: QnU series CPU V7-compatible

November, 2009
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5.4.10.0 1.520 <Connectable models added>
• Yaskawa Electric: MP2000 series
• Yaskawa Electric: MP2000 series (UDP/IP)
• LS: GLOFA CNET
• LS: GLOFA GM series CPU
• Allen-Bradley: PLC-5
• MITSUBISHI ELECTRIC: MR-J2S-*A
• SHARP: DS-30D
• SHARP: DS-32D

<New functions>
• Switch multi-function
• Tag editing data import/export
• Trend graph superposition
• Macro command SET_BZ continuous buzzer sound
• 128-color by default for model change from GD-80/V609E to 

V8
• Line spacing maintained for text on switch/lamp
• Automatic change in number setting consistent with 

screen/overlap number change
• Screen library batch change
• Cross-reference function extended
• 16-bit map import
• [Device Connection Setting] PLC table import/export

January, 2010

5.4.11.0 1.530 <Connectable models added>
• MODBUS TCP/IP (Ethernet) extended format
• OMRON: KM20
• OMRON: KM100
• Fuji Electric: FVR-11S (MODBUS RTU)
• M-System: R1M series (MODBUS RTU)

<New functions>
• Microsoft Windows 7 supported
• V806 Japanese conversion function supported
• Macro editor function extended
• Macro commands

FORMAT_DATA (conversion from a string to numerical data) 
FORMAT_STR (conversion from numerical data to a string) 
READ_FILE (read universal file)
WRITE_FILE (write to universal file)
MOVE_FILE (file movement) 

• Additional network camera model: Panasonic
• MODBUS RTU extended format

Increase in the maximum number of tables registered per 
port number

• Ladder monitor function
OMRON: SYSMAC CS1/CJ1
OMRON: SYSMAC CS1/CJ1 (Ethernet)
OMRON: SYSMAC CS1/CJ1 (Ethernet Auto)
V810C/C808C/V808CH supported (CF card necessary)

• MITSUBISHI ELECTRIC Multi-link2 V7-compatible 

April, 2010
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5.4.14.0 1.570 <Connectable models added>
• MITSUBISHI ELECTRIC: QnU series (built-in Ethernet)
• MITSUBISHI ELECTRIC: L series link
• MITSUBISHI ELECTRIC: L series (built-in Ethernet)
• Hitachi: HIDIC-S10/4α
• WAGO: 750 series (MODBUS RTU)
• WAGO: 750 series (MODBUS Ethernet)
• UNITRONICS: Vision Series (ASCII Ethernet TCP/IP)

<New functions>
• Remote desktop PC screen auto-reduction display
• Operation log selection by switches
• Operation log viewer item-by-item display
• Macro commands

IF-ELSE-ENDIF comparison of data in BIT format
CLND_TO_GRE/GRE_TO_CLND (macro for conversion 
between calendar data and GMT-based UNIX time)

• Text comparison between files
• Use of real numbers for bar graph/pie graph/closed area 

graph/panel meter
• Ladder monitor function extended

MITSUBISHI ELECTRIC: folder name designation
MITSUBISHI ELECTRIC, OMRON:
Ladder monitor display area adjustment to the screen size

• Default parts change (2D parts) for item placement
• Multi-line text property batch change for switch/lamp
• Switch/lamp text centering maintained at the time of 

automatic resizing
• Increase in overlap library/screen library/page block numbers
• ON grid position designation
• Screen image file output (*.bmp, *.jpg)
• Macro editor function extended

Memory setting menu display position designation 
(upper/lower)
Error line comment out at the end of the macro editor

• Confirmation display at the time of transfer over Ethernet
• Options added to the [Transfer Item Selection] dialog: 

[Buffering Area], [Network Table (Ethernet)], and [Device 
Memory Map]

• Showing/hiding the message “Battery not set” on the Main 
Menu screen when SRAM is not in use

• MITSUBISHI ELECTRIC devices SS, SC, SN, and Z added

<Ladder transfer via USB or Ethernet>
• MITSUBISHI ELECTRIC: GX-Works2 available

July, 2010
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5.4.15.0 1.610 <Connectable models added>
• OMRON: SYSMAC CS1/CJ1 DNA
• OMRON: SYSMAC CS1/CJ1 DNA (Ethernet)
• Siemens: S7-1200 (Ethernet ISOTCP)
• CIMON: BP series
• CIMON: CP series
• Chino: LT230 (MODBUS RTU)
• Chino: LT300 (MODBUS RTU)
• Chino: LT830 (MODBUS RTU)
• Chino: DB1000B (MODBUS RTU)
• Chino: KR2000 (MODBUS RTU)
• Sanmei Electronics: Cuty Axis
• Bosch Rexroth: IndraDrive

<New functions>
• Numerical data entry function extended
• Trend graph dealing with real numbers
• Offset value designation memory (numerical data display and 

character display only) 
• Jump to the target screen by switch ([Function: Screen] only) 
• END memory and memory count settings added for memory 

batch change
• SRAM forced formatting

<Revision>
• STA_LIST data sheet consecutive print ($s1009 - $s1011)
• CVFD

October, 2010

5.4.17.0 1.650 <Connectable models added>
• Yamatake: NX (CPL)
• Yamatake: NX (Modbus RTU)
• Yamatake: NX (Modbus TCP/IP)
• RKC: FB100/FB400/FB900 (MODBUS RTU)
• Fuji Electric: FRENIC5000G11S/P11S
• Fuji Electric: PH series
• MOELLER: PS4
• Turck: BL Series Distributed I/O (MODBUS TCP/IP)
• Agilent: 4263 series

<New functions>
• Global overlap
• Panel meter function extended
• MES macro command “MES UPDATE” (database update)
• Operation log: CF card writing error detection
• Message/comment transfer
• Recipe file backup
• Allen-Bradley ControlLogix (Ethernet)

CPU slot No. setting available

<Revision>
• Update of recipe mode when SV/WR macro command is 

executed
• Specification added for the [Function: Return] switch
• Removal of limitation for the registerable number of 

characters on the switch/lamp (127 characters)
• Overlap operation sound off ($s75)

February, 2011
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5.4.18.0 1.670 <Connectable models added>
• SHARP: JW300 series
• SHARP: JW series (Ethernet)
• SHARP: JW311/312/321/322 (Ethernet)
• SHARP: JW331/332/341/342/352/362 (Ethernet)
• KOYO ELECTRONICS: SU/SG
• KOYO ELECTRONICS: SR-T (K protocol)
• Allen-Bradley: NET-ENI (SLC500 Ethernet TCP/IP)
• Allen-Bradley: NET-ENI (MicroLogix Ethernet TCP/IP)
• GE Fanuc: 90 series
• Jetter: JetControl Series2/3 (Ethernet UDP/IP)
• Fuji Electric: FALDIC-W series
• TOHO: TTM-000

<New functions>
• Microsoft Windows Vista/Windows 7 64-bit edition supported
• Data display item attribute designation
• Data sheet print function expanded
• MES setting dialog improved
• Tags

Siemens S7-200 format import
• Selection order batch change for entry targets 
• Ladder monitor

MITSUBISHI ELECTRIC: QnA series link
MITSUBISHI ELECTRIC: QnA series (Ethernet)

• V808CH brightness adjustment macro command “BRIGHT” 
supported

• GE Fanuc  90 series (SNP-X) multi-link2 V7-compatible
• Universal serial specification added

<Devices added>
• Yokogawa Electric: Device SW/SL/F, PLC_CTL command 

added
FA-M3 (without device F)
FA-M3R
FA-M3/FA-M3R (Ethernet UDP/IP)
FA-M3/FA-M3R (Ethernet TCP/IP)

• Fuji Electric: MICREX-SX  PLC_CTL command added 
(redundancy)
MICREX-SX SPH/SPB series
MICREX-SX SPH/SPB CPU
MICREX-SX (Ethernet)
MICREX-SX (SX bus)
MICREX-SX (T-link)

• Yamatake: DMC50 (COM) device C
• DELTA TAU DATA SYSTEMS: Device P_INT

PMAC
PMAC (Ethernet TCP/IP)

<Revision>
• Numerical data display’s alarm maximum and minimum 

values targeted for range change
• PLC_CLND macro wait function $s1395

April, 2011
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5.4.21.0 1.720 <Connectable models added>
• MITSUBISHI ELECTRIC: Q170MCPU (Multi CPU)
• MITSUBISHI ELECTRIC: Q170MCPU (Multi CPU) (Ethernet)
• Siemens: S7-200 (Ethernet ISOTCP)
• Fuji Electric: WSZ series

<New functions>
• Panel meter function extended to 128 colors/monochrome
• Extended point size range for Windows fonts
• E-mail port number setting added
• Search for macro commands

<Revision>
• Time display revised
• V7-compatible RGB display by signal input 

October, 2011

5.4.22.0 1.750 <Connectable models added>
• Yokogawa Electric: FA-M3/FA-M3R (Ethernet UDP/IP ASCII)
• Yokogawa Electric: FA-M3/FA-M3R (Ethernet TCP/IP ASCII)
• VIGOR: M series
• LS: XGT/XGI series
• LS: XGT/XGI series (Ethernet)
• OMRON: E5CN-HT

<Devices added>
• TOSHIBA MACHINE: TC200

Device U / M / Q / I (IW) / O (OW) / J (JW) / K (KW)
• Jetter: JetControl Series 2/3 (Ethernet UDP/IP)

Device ST added, device range for I, O, R and FT expanded

<New functions>
• V808C portrait orientation
• Changes for numerical data display part available with the 

extended panel meter function used
• Refined search filter for project list-view window

<Revision>
• List on the [Parts List] and [Change Part] dialog improved
• Function switch specifications changed
• Default value for communication parameters changed
• Company name changed from Panasonic Electric Works to 

Panasonic
• List file for Fuji Electric’s temperature controller, servo, and 

inverter added and modified

January, 2012
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5.4.23.0 1.790 <Connectable models added>
• MITSUBISHI ELECTRIC: A Link + Net10
• MITSUBISHI ELECTRIC: A series (OPCN-1)
• OMRON: SYSMAC C (OPCN-1)
• GE Fanuc: 90 series (SNP)
• GE Fanuc: RX3i (Ethernet TCP/IP)
• Siemens: S5 PG Port
• LS: GLOFA GM7 CNET
• LS: XGT/XGK series (Ethernet)
• LS: XGT/XGI series CPU
• FUFENG: APC series Controller
• Fuji Electric: FRENIC-MEGA SERVO (MODBUS RTU)
• Fuji Electric: ALPHA5 Smart (MODBUS RTU)
• SHINKO TECHNOS: GC series
• SHINKO TECHNOS: PC-900
• SHINKO TECHNOS: PCD-33A
• SHINKO TECHNOS: ACS-13A
• SHINKO TECHNOS: ACD/ACR series
• SHINKO TECHNOS: WCL-13A

<Connectable models added>
• OMRON: CJ2
• KEYENCE: KV-LE20V
• Fuji Electric: FePSU Breaker

<New functions>
• Text search and replacement
• Ladder transfer via USB or Ethernet

LadderComOp version 2: Compatibility with Windows 
Vista/Windows 7 

• Ladder monitor 
Compatibility with ladder monitor CJ2 (OMRON)
Device search expanded (Yokogawa Electric)
Number of blocks increased for function block change 
(Yokogawa Electric)

• Compatibility with KeepAlive
MITSUBISHI ELECTRIC, OMRON

<Revision>
• Display function compatible with EL-type MONITOUCH: 

All models in the V8 series (128 colors) 
• Japanese conversion function additional specifications
• TELLUS version 3  [Printer Setting]

April, 2012
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5.4.24.0 1.830 <Connectable models added>
• JTEKT: TOYOPUC (Ethernet PC10 Mode)
• Allen-Bradley: PLC-5 (Ethernet)
• Siemens: TI 500/505 
• Siemens: TI 500/505  V4 Compatible
• Yamatake: MX series
• RS: OEMax NX700 Series (Ethernet)
• Oriental motor: Highly-efficient AR series (MODBUS RTU)
• Oriental motor: CRK series (MODBUS RTU)

<Devices added>
• RS: OEMax  NX7/NX Plus series (70P/700P/CCU+) 

device TC/SV/PV/SR/D
• Panasonic: LP-400 PLC_CTL command added

<New functions>
• [GD-80E/V609E Compatible] setting for V810C added  
• Trend sampling/trend graph

Expansion of X-axis point setting (valid in TELLUS)
• Trend sampling

Expansion of sampling word count
• Additional network camera model: BANNER
• Tags

Siemens STEP7 tag import
• Ladder monitor function

MITSUBISHI ELECTRIC Expansion of program switching 
count

• Communication interrupt/restart memory ($P)
In MODBUS RTU expanded format only

• Compatibility with CC-Link version 2 
(communication unit “CU-02-2”)

• Compatibility with LED backlight
(V812(i)S, V810(i)S, V810(i)T, V810(i)C)

• Compatibility with KeepAlive function
JTEKT: TOYOPUC (Ethernet PC10 mode)

<Revision>
• Windows fonts position adjustment

July, 2012

V-SFT
Ver.

SYSTEM 
PROG. Ver. Additional Functions Date of Release



5.4.25.0 1.890 <Connectable models added>
• Universal DeviceNet
• OMRON: E5AK-T
• Fuji Electric: WE1MA (version B) (MODBUS RTU)
• Chino: LT400 series (MODBUS RTU)
• Panasonic:  MINAS A4 series

<New functions>
• Fuji Electric: Improvement of the memory conversion dialog 

for model change MICREX-F →  MICREX-SX
• Tags

MITSUBISHI ELECTRIC: Importing variable name files 
exported from GX Works2 

• Recipe mode: Display order change
• Compatibility with LED backlight

(V815iX, V808(i)S, V808(i)C, V806 series)
• Backlight information storage ($s1349)
• KEYENCE: KV-3000/5000  Multi-link2 V7-compatible

<Revision>
• Fuji Electric: WE1MA (version A) (MODBUS RTU) name 

change

October, 2012

V-SFT
Ver.

SYSTEM 
PROG. Ver. Additional Functions Date of Release



5.4.27.0 1.920 <Connectable models added>
• OMRON: E5CK-T
• Fuji Electric: FRENIC-HVAC/AQUA (MODBUS RTU)
• Panasonic:  KW Series
• Asahi Engineering: Stepping motor

<Connectable models added>
• MITSUBISHI ELECTRIC: QnU series CPU

Q10UDH/Q13UDH/Q20UDH/Q26UDH
• TOSHIBA MACHINE: TC200  compatible with RS-485 

(2-wire)
• Allen-Bradley: ControlLogix (Ethernet)

CompactLogix  L27ERM

<Devices added>
• FUFENG: APC Series Controller

TSW/TP/CSW/CP/KJS/KP/KJL/KJH/KI/KJC/KJR

<New functions>
• Switch language changeover
• Trend graph/sampling function extended

Zooming in/out, showing sampling times, cursor point values, 
and scales

• Tags
Siemens: DB filter, import

• Allen-Bradley: User tag (extension: *.L5K) import
• Compatibility with KeepAlive function

Yokogawa Electric
• Compatibility with Multi-link2 V7

OMRON: SYSMAC C
OMRON: SYSMAC CV
OMRON: SYSMAC CS1/CJ1

<Revision>
• Error/warning full text display on the Main Menu screen of 

V806
• Display of the power-off prohibition message during 

automatic uploading from CF card

January, 2013

V-SFT
Ver.

SYSTEM 
PROG. Ver. Additional Functions Date of Release



5.4.28.0 1.950 <Connectable models added>
• Yokogawa Electric: FA-M3V
• Yokogawa Electric: FA-M3V(Ethernet)
• Yokogawa Electric: FA-M3V(Ethernet ASCII)
• KEYENCE: KZ series link
• RS Automation: X8 Series
• RS Automation: X8 Series(Ethernet)
• MODBUS ASCII
• Koganei: IBFL-TC

<New functions>
• Microsoft Windows 8 (32-bit / 64-bit) supported
• Switch Switching to Main Menu
• Ladder transfer via USB or Ethernet

Siemens: S7-200 PPI
• Compatibility with KeepAlive function

JTEKT: TOYOPUC(Ethernet)
• Compatibility with TELLUS and V-Server Lite

<Revision>
• Default parts improved
• Auto-installation of the USB driver for screen data transfer
• Ladder transfer via USB or Ethernet

Compatibility with user authorization
• Default value for Buffering Area Setting changed

[ Start Bit] of [Sampling Method: Alarm Logging] 
• Windows fonts position adjustment (Multi Text)
• Default value for [Device Connection Setting] changed

Fuji Electric: PPMC(MODBUS RTU) [Signal Level]
WAGO: 750 series(MODBUS RTU) [Connection Mode]
SAMSUNG: N_plus [Send Delay Time]

April, 2013

V-SFT
Ver.

SYSTEM 
PROG. Ver. Additional Functions Date of Release





Preface

Congratulations on your purchase of the configuration software (V-SFT-5) for the MONITOUCH V series.
For clear understanding of the software and efficient configuration for the MONITOUCH, carefully read this manual 
and other manuals provided together with the MONITOUCH.

Notes:

1. Copyright of the software is possessed by Hakko Electronics Co., Ltd.
2. Reproduction of any contents of the software and this manual, in whole or in part, without permission 

of Hakko Electronics Co., Ltd. is prohibited.
3. Specifications of the software and the information in this manual are subject to change without prior 

notice.
4. If the specifications of the software do not correspond with the contents of this manual, the software 

specifications have priority.
5. No liability is assumed by Hakko Electronics Co., Ltd. with respect to any affects brought on by the 

use of the software or manual.
6. Use of this software is limited to a single central processing unit.

Regarding Trademarks:

• Windows, Word and Excel are registered trademarks of Microsoft Corporation in the United States 
and other countries.

• All other company names or product names are trademarks or registered trademarks of their 
respective holders.

• Programmable logic controllers (PLCs) are products of their respective manufacturers.





About Manuals

This manual describes the functions of the MONITOUCH V8 series in detail.
The following manuals are available for the MONITOUCH V8 series:

Manual Name Reference No. Contents

V8 Series Reference: Additional 
Functions (this manual)

1060NEx The functions that are added from the V-SFT 
version 5.1.0.0 to the MONITOUCH V8 series are 
explained in detail.

V8 Series Reference Manual 1055NEx The functions of the MONITOUCH V8 series are 
explained in detail.

V Series Macro Reference 1056NEx An overview of macros of the V-SFT version 5 as 
well as macro editor operations and macro 
command descriptions are explained in detail.

V8 Series Introductory Manual 1057NEx An overview of the MONITOUCH V8 series as well 
as basic operating procedures of the configuration 
software are explained in detail.

V8 Series Operation Manual 1058NEx The information related to the operations of the 
V-SFT version 5, such as software composition, 
editing procedure or limitations, is explained in 
detail.

V8 Series Hardware Specifications 2016NEx Hardware specifications and handling procedures 
of the MONITOUCH V8 series are explained.

V806 Series Hardware Specifications 2017NEx Hardware specifications and handling procedures 
of the MONITOUCH V806 series are explained.

V815 Hardware Specifications 2018NEx Hardware specifications and handling procedures 
of the MONITOUCH V815 are explained.

V808CH Hardware Specifications 2019NEx Hardware specifications and handling procedures 
of the MONITOUCH V808CH are explained.

V8 Series Connection Manual 2201NEx Connections with respective devices and wiring 
diagrams between the MONITOUCH V8 series are 
explained.

V Series DLL Function Specifications 1059NEx An overview and contents of DLL files used for 
Ethernet (HKEtn20.DLL) and CF card 
(VCFAcs.DLL) are explained in detail.





V Series Functions

The V8 series is equipped with the following functions.  Depending on the V series model, some functions may not 
be available.  Please note the availability of each function.  For more information, refer to the related chapter.

Functions Described in the V8 Series Reference Manual

V8 Series Reference Manual V8 Series

Chap. Contents V815iX

V812iS
V810iS
V810iT
V808iS

V812S
V810S
V810T
V808S

V810iC
V808iC

V810C
V808C V808iCH V808CH

V806iT
V806iC
V806iM

V806T
V806C
V806M

2 Overlap

Superimpose × × × × × ×

Video overlap × × × × × × ×

3 Switch

Coordinate output*1

Transparency 

Multi-output

Delay/
Message box

4 Lamp

Transparency 

5 Data display

6 Message display

Comment display

7 Entry mode

Automatic writing when 
the entry target has been 
moved

Switch
[Function: Cancel]

Switch
[Function: Max./Min. 
Value Entry]

Password: variable

Digital switch
(add/subtract switch)

Japanese conversion 
function

8 Graph

Scale: variable

9 Trend

XY parameters

X scale

10 Sampling

Acknowledge display:
(acknowledge) function

11 Graphic

12 Time display/calendar

13 Recipe mode



: Available  : Optionally available  ×: Not available

*1 For analog switch type only
*2 Not supported by V806iM and V806M.
*3 Only UDP/IP is supported.

14 Multimedia − − − − − − − − −

Animation × × × × × ×

Video/RGB display × × × × × × ×

JPEG display    *2    *2

Sound replay function × × × × × × ×

15 Others − − − − − − − − −

Data block area

Memory card mode

CF card

SRAM

CREC × ×

Memo pad*1

16 Print

Data sheet print Serial × ×

USB 

17 Barcode One-dimensional

Two-dimensional

18 CF card Built-in

USB × ×

2-drive connection × ×

19 Ethernet function ×

Screen data transfer ×

PLC connection     *3    *3 ×    *3

E-mail × × × ×

Web server × × × ×

20 Slider switch

A1 Buffering area

Store target: SRAM

Store target: CF card

A2 SRAM/clock setting

A3 Display language

Multi-language selection

Displayed character 
selection

Multi-language screen

− Windows fonts

V8 Series Reference Manual V8 Series

Chap. Contents V815iX

V812iS
V810iS
V810iT
V808iS

V812S
V810S
V810T
V808S

V810iC
V808iC

V810C
V808C V808iCH V808CH

V806iT
V806iC
V806iM

V806T
V806C
V806M



Functions Described in the V8 Series Reference: Additional Functions (this manual)

V8 Series
Reference: Additional Functions V8 Series

Chap. Contents V815iX

V812iS
V810iS
V810iT
V808iS

V812S
V810S
V810T
V808S

V810iC
V808iC

V810C
V808C V808iCH V808CH

V806iT
V806iC
V806iM

V806T
V806C
V806M

2 Global overlap

3 Switch
Multi-function

Language changeover

Switching to Main Menu

Continuous buzzer

4 Word lamp

5 Data display
Offset value designation 
memory

Attribute change

6 Data display with entry 
function

Slider switch*1

Numerical data entry 
(extended)

7 Graph (real values)

Panel meter function 
extended

Alarm 2

*2 *2  *2  *2

Indicator setting extended *3 *3 × × × × × ×

Scale setting extended *3 *3 *2 *3 *2 *3 *3 *3 *2 *3 *4 *2 *3 *4

Numerical data display *2 *2 *2 *2

8 Trend graph/sampling
Scale display

Expansion of word count

Real numbers

Trend sampling
Cursor point value display

Sampling time display

Zooming in/out

Graph show/hide function

9 Alarm function
Parameter addition 
function

Acknowledge

10 RGB display
(touch switch emulation)

× × × × × × ×

Enlarged display 
(full screen)

× × × × × × ×

Size adjustment × × × × × × ×

11 Scroll*1

12 Expanded data sheet



: Available  : Optionally available  ×: Not available

13 Stroke fonts *3 *3

Extended point size range 
for Windows fonts

16-language selection

14 CF card 
Screen added

Message storage

Addition of titles to CSV 
file (sampling data)

15 Item display function

16 FTP server × × × ×

17 E-mail certification × × × ×

Two Ethernet ports × × × × ×

18 Network camera *3 × *2 *3 × *3 × *2 *3 *4 ×

19 Remote desktop window 
display*1

*3 × *2 *3 × *3 × *3 *4 ×

20 MES interface ×

21 Operation log/Log viewer

22 Security

23 Macros

24 Tag editing

25 Jump to the target screen 

Refined search filter for 
project list-view window

Memory batch change

Selection order batch 
change

Cross-reference
Macro command search

Text search and 
replacement

Image file 3D part 
conversion

Text comparison

Selective transfer

Message/comment transfer

26 USB barcode reader × ×

USB keyboard × ×

USB mouse *2 *2 × × *2 *2

USB-FDD × × × × × ×

27 Ladder transfer USB

Ethernet × × × ×

V8 Series
Reference: Additional Functions V8 Series

Chap. Contents V815iX

V812iS
V810iS
V810iT
V808iS

V812S
V810S
V810T
V808S

V810iC
V808iC

V810C
V808C V808iCH V808CH

V806iT
V806iC
V806iM

V806T
V806C
V806M

*1 For analog switch type only
*2 Not available on the portrait-orientated V808C/V806

*3 The 128-color mode is not supported.
*4 The V806M is not supported.



Notes on Safe Usage of MONITOUCH

In this manual, you will find various notes categorized under the following levels with the signal words “DANGER”, 
and “CAUTION”.

Note that there is a possibility that the item listed with  may have serious ramifications.

DANGER Indicates an imminently hazardous situation which, if not avoided, will result in death or 
serious injury.

CAUTION Indicates a potentially hazardous situation which, if not avoided, may result in minor or 
moderate injury and could cause property damage.

• Never use the output function of MONITOUCH for operations that may threaten human life or damage the 
system, such as switches to be used in case of emergency.  Please design the system so that it can cope 
with the malfunction of a touch switch.  A malfunction of the touch switch will result in machine accident or 
damage.

• Turn off the power supply when you set up the unit, connect new cables, or perform maintenance or 
inspections.  Failure to do so could cause electric shock or damage to the unit.

• Never touch any terminals while the power is on.  Otherwise, electric shock may occur.
• You must put a cover on the terminals on the unit when you turn the power on and operate the unit.  Without 

the terminal cover in place, electric shock may occur.
• The liquid crystal in the LCD panel is a hazardous substance.  If the LCD panel is damaged, do not ingest 

the leaked liquid crystal.  If the liquid crystal spills on skin or clothing, use soap and wash off thoroughly.
• For MONITOUCH using a lithium battery, never disassemble, recharge, deform by pressure, short-circuit, 

reverse the polarity (+/−) of the battery, or dispose of the battery in fire.  Failure to follow these conditions will 
lead to explosion or fire.

• For MONITOUCH using a lithium battery, never use a battery that is deformed, leaks, or shows any other 
signs of abnormality.  Failure to follow these conditions will lead to explosion or fire.

• If the screen becomes dark due to a failure or service life of the backlight, the POWER lamp starts flashing.  
The switches on the screen remain active even in this condition.  However, if the screen is too dark to view 
the switches while the POWER lamp is flashing, do not touch the screen.  Doing so could cause unexpected 
activation, resulting in machine damage or accident.

CAUTION

DANGER



• Check the appearance of MONITOUCH when it is unpacked.  Do not use the unit if any damage or 
deformation is found.  Failure to do so may lead to fire, damage, or malfunction.

• For use in a facility or for a system related to nuclear energy, aerospace, medical, traffic equipment, or 
mobile installations, please consult your local distributor.

• Operate (or store) MONITOUCH under the conditions indicated in this manual and related manuals.  Failure 
to do so could cause fire, malfunction, physical damage or deterioration.

• Understand the following environmental limits for use and storage of MONITOUCH.  Otherwise, fire or 
damage to the unit may result.

- Avoid locations where there is a possibility that water, corrosive gas, flammable gas, solvents, grinding 
fluids or cutting oil can come into contact with the unit.

- Avoid high temperature, high humidity, and outside weather conditions, such as wind, rain or direct 
sunlight.

- Avoid locations where excessive dust, salt, and metallic particles are present.
- Avoid installing the unit in a location where vibration or physical shock may be transmitted.

• Equipment must be correctly mounted so that the main terminal of MONITOUCH can not be touched 
inadvertently.  Otherwise, an accident or electric shock may occur.

• Tighten the fixtures of MONITOUCH with a torque in the specified range.  Excessive tightening may distort 
the panel surface.  Loose tightening may cause MONITOUCH to come off, malfunction, or be short-circuited.

• Check periodically that terminal screws on the power supply terminal block and fixtures are firmly tightened.  
Loosened screws may result in fire or malfunction.

• Tighten terminal screws on the power supply terminal block equally to a torque of 0.5 N•m.  Improper 
tightening of screws may result in fire, malfunction, or other trouble.

• MONITOUCH has a glass screen.  Do not drop or give physical shock to the unit.  Otherwise, the screen 
may be damaged.

• Connect the cables correctly to the terminals of MONITOUCH in accordance with the specified voltage and 
wattage.  Over-voltage, over-wattage, or incorrect cable connection could cause fire, malfunction or damage 
to the unit.

• Be sure to establish a ground of MONITOUCH.  The FG terminal must be used exclusively for the unit with 
the level of grounding resistance less than 100 Ω.  Otherwise, electric shock or fire may occur.

• Prevent any conductive particles from entering the MONITOUCH.  Failure to do so may lead to fire, damage, 
or malfunction.

• After wiring is finished, remove the paper used as a dust cover before starting to operate MONITOUCH.  
Operation with the cover attached may result in accident, fire, malfunction, or other trouble.

• Do not attempt to repair MONITOUCH at your site.  Ask Hakko or the designated contractor for repair.
• Do not disassemble or modify MONITOUCH.  Otherwise, malfunctions may occur.
• Hakko Electronics Co., Ltd. is not responsible for any damages resulting from repair, overhaul or 

modification of MONITOUCH that was performed by an unauthorized person.
• Do not use a sharp-pointed tool when pressing a touch switch.  Doing so may damage the screen.
• Only experts are authorized to set up the unit, connect the cables, or perform maintenance and inspections.
• For MONITOUCH using a lithium battery, handle the battery with care.  The combustible materials such as 

lithium or organic solvent contained in the battery may generate heat, explode, or catch fire, resulting in 
personal injury or fire.  Read related manuals carefully and handle the lithium battery correctly as instructed.

• When using a MONITOUCH that has an analog switch resolution with resistance film, do not press two or 
more points on the screen at the same time.  If two or more positions are pressed at the same time, the 
switch located between the pressed positions will activate.

• Take safety precautions during such operations as setting change during running, forced output, start, and 
stop.  Any misoperation may cause unexpected machine motions, resulting in machine accident or damage.

• In facilities where a failure of MONITOUCH could lead to accident threatening human life or other serious 
damage, be sure that the facilities are equipped with adequate safeguards.

• At the time of disposal, MONITOUCH must be treated as industrial waste.
• Before touching MONITOUCH, discharge static electricity from your body by touching grounded metal.  

Excessive static electricity may cause malfunction or other trouble.
• During the CF card power supply, the LED inside the CF card cover illuminates in red.  If you remove the CF 

card or turn the MONITOUCH off while the LED is illuminating, data on the CF card may become corrupt.  
Before removing the CF card or turning MONITOUCH off, ensure that the LED is not illuminating.

CAUTION



[General Notes]
• Never bundle control cables and input/output cables with high-voltage and large-current carrying cables such 

as power supply cables.  Keep these cables at least 200 mm away from high-voltage and large-current 
carrying cables.  Otherwise, malfunction may occur due to noise.

• When using MONITOUCH in an environment where a source of high-frequency noise is present, it is 
recommended that the FG shielded cable (communication cable) be grounded at its ends.  However, the cable 
may be grounded only at one end if necessary due to unstable communication conditions, or for any other 
reason.

• Plug connectors or sockets of MONITOUCH in their correct orientation.  Otherwise, malfunctions may occur.
• When an LAN cable is wrongly connected to the MJ1/MJ2 connector, the counterpart device may be damaged.  

Double-check the connector to avoid improper insertion.
• Do not use thinners for cleaning because they may discolor the MONITOUCH surface.  Use an alcohol-based 

cleaner which is commercially available.
• If a “data receive error” occurs when MONITOUCH and the counterpart (PLC, temperature controller, etc.) are 

started at the same time, read the manual for the counterpart unit and handle the error correctly.
• Avoid discharging static electricity on the mounting panel of MONITOUCH.  Static charges can damage the 

unit and cause malfunctions.  Otherwise, malfunction may occur due to noise.
• Avoid prolonged display of any fixed pattern.  Due to the characteristics of the liquid crystal display, an 

afterimage may occur.  If a prolonged display of a fixed pattern is expected, use the auto OFF function of the 
backlight.

[Notes on LCD]
  Note that the following conditions may occur under normal circumstances:

• The response time, brightness and colors of MONITOUCH may be affected by ambient temperature.
• Tiny spots (dark or luminescent) may appear on the display due to liquid crystal characteristics.
• There are variations in brightness and colors on each unit.
• When LCDs incorporating CCFL (cold cathode fluorescent lamp) backlights are used, their optical properties 

(brightness, irregular colors, etc.) may change over time, especially at low temperatures.
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11 System Settings
1.1 Edit Model Selection

V806 Series

The “V806 series”, 5.7-inch QVGA type, has been added to the MONITOUCH V8 series.

* The screen data of the V806 series cannot be saved into an earlier version (for example, V7 or V6 
series).

V806 Series Specifications

The main specifications are shown below:

* For more information, refer to the V806 Series Hardware Specifications Manual.

Model Edit Model i Series Portrait Size Color Option Unit Touch Switch

V806iT
V806iC

V806T/C
Checked

Portrait

320 * 240

64K-Color w/o blinking
32K-Color
128-Color 
( Portrait not allowed)

None

CF+D-sub
Analog switch

V806T
V806C Unchecked

V806iM
V806M

Checked
None 16 gray scales

V806M Unchecked

Item V806iT V806T V806iC V806C V806iM V806M
Display device TFT color STN color STN monochrome
Display size 5.7-inch

Display colors 65,536 colors (w/o blinking), 32,768 colors (w/ blinking),
128 colors (w/ 16-color blinking) 16 gray scales (w/ blinking)

Resolution (W × H) 320 × 240 dots
FROM capacity 4.5 MB
SRAM capacity 512 kB 128 kB 512 kB 128 kB 512 kB 128 kB

Serial port 2 serial ports (MJ1, MJ2), 
1 D-sub 9-pin port (CN1) added when option unit “DU-10” is mounted

Ethernet port Built-in Communication 
unit “CU-03-3” Built-in Communication 

unit “CU-03-3” Built-in Communication 
unit “CU-03-3”

USB A/B ports Built-in
CF card interface CF card socket added when option unit “DU-10” is mounted
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Portrait Orientation

The V806 series can be installed in portrait orientation.

V-SFT

When the box for [ Portrait] is checked in the [Edit Model Selection] dialog, V-SFT editing that suits a 
portrait-orientated unit is possible.
For where the setting item is provided, refer to page 1-1.

Notes

• In a case where you attempt to convert landscape-orientated data in V-SFT to portrait-oriented 
data (by automatic resizing), the following dialog appears.
You cannot undo the conversion.

• Automatic resizing is executable in the following areas:
Screen, screen library, overlap library, graphic library, and data block

• Character properties will be adjusted to a maximum extent, according to resizing.
However, such an adjustment to character properties is not available with the following functions: 
bit order alarming, alarm sub-display, time order alarming, alarm logging, message mode, data 
sampling, alarm tracking, and memory card

• For any parts which are not ready for automatic resizing, resize them by manual operation.

• Unchecking the box for [ Place switches on switch grids] (in the V-SFT, [View] → [Grid] → [Grid 
Setting]) will help resize characters neatly.

• When specifying the coordinates (start X, start Y) of an overlap in dots, they are determined in 
increments of one dot on the X axis and four dots on the Y axis.  (For landscape orientation, 
coordinates are determined in increments of four dots on the X axis and one dot on the Y axis.)  
Therefore, when portrait orientation is adopted, a Y-axis coordinate will be rounded down to a 
multiple of 4.

Be sure that the power supply faces upward.  In this position, the function switches on the V806 are 
in a lower position.
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1V8C Series

The “V8C series” has been added to the MONITOUCH V8 series.

* The screen data of the V8 series cannot be saved into an earlier version (for example, V7 or V6 
series).

V8C Series Specifications

The main specifications are shown below.

* For more information, refer to the V8 Series Hardware Specifications Manual.

Model Edit Model i Series Portrait Size Color Memory 
Expansion

Touch Switch

V810iC
V810C

Checked
None

640 * 480

64K-Color w/o blinking
32K-Color
128-Color ( Portrait 
not allowed)

None

Analog switch / 
Matrix switchV810C Unchecked

V808iC
V808C

Checked
Portrait Analog switch

V808C Unchecked

Item V810iC V810C V808iC V808C
Display device TFT color
Display size 10.4-inch 8.4-inch
Display colors 65,536 colors (w/o blinking), 32,768 colors (w/ blinking), 128 colors (w/ 16-color blinking)
Resolution (W × H) 640 × 480 dots
FROM capacity 12.5 MB 4.5 MB 12.5 MB 4.5 MB
SRAM capacity 512 kB 128 kB 512 kB 128 kB
Serial port 3 serial ports: D-sub 9-pin (CN1), modular jacks (MJ1, MJ2)

Ethernet port Built-in Communication unit 
“CU-03-3” Built-in Communication unit 

“CU-03-3”
USB A/B ports Built-in
CF card interface Built-in
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Portrait

The V808C series can be installed in portrait orientation.

V-SFT

When the box for [ Portrait] is checked in the [Edit Model Selection] dialog, V-SFT editing that suits a 
portrait-orientated unit is possible.
For where the setting item is provided, refer to page 1-3.

Notes

• In a case where you attempt to convert landscape-orientated data in V-SFT to portrait-oriented 
data (by automatic resizing), the following dialog appears.
You cannot undo the conversion.

• Automatic resizing is executable in the following areas:
Screen, screen library, overlap library, graphic library, and data block

• Character properties will be adjusted to a maximum extent, according to resizing.
However, such an adjustment to character properties is not available with the following functions:
Bit order alarming, alarm sub-display, time order alarming, alarm logging, message mode, data 
sampling, alarm tracking, and memory card

• For any parts which are not ready for automatic resizing, resize them by manual operation.

• Unchecking the box for [ Place switches on switch grids] (in the V-SFT, [View] → [Grid] → [Grid 
Setting]) will help resize characters neatly.

• When specifying the coordinates (start X, start Y) of an overlap in dots, they are determined in 
increments of one dot on the X axis and four dots on the Y axis.  (For landscape orientation, 
coordinates are determined in increments of four dots on the X axis and one dot on the Y axis.)  
Therefore, when portrait orientation is adopted, a Y-axis coordinate will be rounded down to a 
multiple of 4.

Be sure that the power supply faces upward.  In this position, the function switches on the V808C 
series are in a upper position.
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1V815iX

The model V815X has been added to the MONITOUCH V8 series.

* The screen data of the V8 series cannot be saved into an earlier version (for example, V7 or V6 
series).

V815iX Specifications

The main specifications are shown below.

* For more information, refer to the V815 Hardware Specifications Manual.

Model Edit Model Size Color Memory 
Expansion Touch Switch

V815iX V815X 1024 * 768 64K-color w/o blinking
32K-color None Analog switch

Item V815iX
Display device TFT color
Display size 15-inch
Display colors 65,536 colors (w/o blinking), 32,768 colors (w/ blinking)
Resolution (W × H)  1,024 × 768 dots
FROM capacity 12.5 MB
SRAM capacity 512 kB
Serial port 3 serial ports: D-sub 9-pin (CN1), modular jacks (MJ1, MJ2)
Ethernet port Built-in
USB A/B ports Built-in
CF card interface Built-in
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V808CH

The model V808CH has been added to the MONITOUCH V8 series.

* The screen data of the V8 series cannot be saved into an earlier version (for example, V7 or V6 
series).

V808CH Specifications

The main specifications are shown below.

* For more information, refer to the V808CH Hardware Specifications Manual.

Model Edit Model i Series Size Color Memory 
Expansion Touch Switch

V808iCH
V808CH

Checked
640 * 480

64K-color w/o blinking
32K-color
128-color

None Analog switch
V808CH Unchecked

Item V808iCH V808CH
Display device TFT color
Display size 7.5-inch
Display colors 65,536 colors (w/o blinking), 32,768 colors (w/ blinking), 128 colors (w/ 16-color blinking)
Resolution (W × H) 640 ×  480 dots
FROM capacity 12.5 MB 4.5 MB
SRAM capacity 512 kB 128 kB
Terminal block RS-232C (TB2), RS-422/RS-485 (TB3)
Ethernet port Built-in -
USB-B port Built-in
CF card interface Built-in
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11.2 EL-type MONITOUCH (GD-80E/V609E) Display 
Compatibility Function
Overview

• If an EL-type MONITOUCH, such as GD-80E or V609E (production discontinued), needs to be 
replaced, models V808(i)C and V810(i)C are recommended as substitutions since EL types are no 
longer available.
However, V808(i)C and V810(i)C are higher in vertical resolution by 80 dots.  By using the 
compatibility function explained in this section with these models, screens can be automatically 
centered in the vertical direction.  Therefore, the substitution of EL types is made easy, with no 
need to change the layout of screen data.

• If an EL-type MONITOUCH is substituted with a model in the V8 series, batch color change is 
possible for converting the former screens into two-color display, using a color specified other than 
black.

Model substitution

*1 If any setting other than “128 colors” is specified, this function cannot be used.
*2 Only the model V808(i)C/V810(i)C supports the centering in the vertical direction (checking 

[ GD-80E/V609E Compatible]).
For more information on the centering, refer to page 1-9.

Before Substitution After Substitution Color *1

GD-80E All units in the V8 series*2

(V808(i)C/V810(i)C recommended) 128 colors
V609E

GD-80E/V609E (640 * 400 dots)

V808C (640 * 480 dots)

Example: Substitution of GD-80E or V609E by V808C

White specified for 
[Color Batch Change] 

* Centering in the vertical direction supported by V808(i)C/V810(i)C only
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Screen data conversion procedure (GD-80E/V609E → V808C)

This section describes the procedure to convert the screen data of the GD-80E into data for the 
V808C.

1. Click [File] → [Open].  The [Open] dialog is displayed.
2. Select “*.80” for [Files of type].  Then select the screen data of GD-80E and click [Open].

3. The [Edit Model Selection] dialog is displayed.  Select options as shown below and click [OK].
• [Edit Model] → “V808C”
• [Color] → “128-Color”

If any option other than “128-Color” is specified for [Color], the dialog shown in step 4 will not appear.
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14. The [Unit Setting] dialog is displayed.

To display this dialog after the setting is finished, click [System Setting] → [Unit Setting] → 
[GD-80E/V609E Compatible].

GD-80E/V609E 
Compatible
(V808(i)C/
V810(i)C only)

Checked:
The screen data is displayed in the center of the V8 screen with top and 
bottom margins of 40 dots, respectively.
(No part can be placed on these margins.)
Screen data of 640*400 dots is displayed on V-SFT.

Unchecked:
On the V8, screen data is displayed in the same position as specified on 
V-SFT.

Color Batch 
Change

Checked:
Converts any colors other than black into the color specified here to make 
the display color the same as the one used on GD-80E/V609E (2 colors).

* The color data cannot be restored after conversion.

Unchecked:
Screen data is displayed in the same colors as those before conversion.

Margins of 40 dots are 
kept at the top and 
bottom, respectively.
(Displayed in black on 
the V8.)

Display on V808C

V808C data displayed on computerGD-80E/V609E data displayed 
on computer
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* For pattern data, there are some colors that cannot be converted.
In such a case, the dialog shown below is displayed.

5. Click [OK] after setting.
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11.3 General Settings
Options Added to [General Settings] Tab Window

The options described below have been added.
For description of the other options, refer to the V8 Series Reference Manual.

Allow to use 
Insert/DELETE keys when 
entering values

For more information, refer to “6.3 Numerical Data Entry (Numeral 
Insertion/DELETE Keys Enabled)”.

Format the SRAM 
forcefully

This option determines the action to be taken in the event of error: 
161 (0: ), indicating an SRAM formatting error, no SRAM data 
immediately after shipment, or loss of SRAM data due to battery 
disconnection.

• Unchecked (default):
Formatting the SRAM is executed on the Main Menu screen while 
the battery is connected with the V8 unit.

• Checked:
A forced formatting is executed.
Whether an automatic formatting has been executed can be 
reviewed at $s1085.
(Upon execution, “1” is placed at $s1085.
The value at the address is cleared back to zero at the time of the 
reentry to the Main Menu screen.

Retain compatibility with 
negative value handling of 
CVFD macro command

This option determines the action to be taken for the conversion of 
negative values. 

• Unchecked (default):
An operation is performed according to the value at $s99.

• Checked:
A truncation is performed, irrespective of the value at $s99.

* For more information on the macro command CVFD, refer to 
the Macro Reference Manual.
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Backup the recipe file This option determines the action to take when an error occurs in 
writing to a CSV file in the recipe mode.

• Unchecked (default):
No backup file is created.

• Checked:
When recipe data has been written successfully, a backup file 
“XXX.BAK” is created together with the CSV file.
When it has failed, temporary files “xxx.000 - xxx.999” * are 
created.

* If temporary files “xxx.000” through “XXX.999” already exist, 
the oldest file is retrieved and is deleted.

Display the recipe mode 
after executing SV/WR 
macro commands

This option determines the action to take whether or not to update the 
recipe mode when the RECIPE folder in the CF card is read again by 
the following macro commands.
[Applicable commands]
SV_RECIPE, SV_RECIPE2, SV_RECIPESEL, SV_RECIPESEL2, 
WR_RECIPE_FILE, WR_RECIPE_LINE, WR_RECIPE_COLUMN

• Unchecked (default):
The recipe mode item is not updated.

• Checked:
The recipe mode item is updated.
The recipe mode item is reset to the default status.
If editing is disabled by the command memory, the current display 
status is kept.

Return switch prohibited 
when switching the screen 
by an external command

This option determines the action to take when the [Function: Return] 
switch is used.

• Unchecked (default):
It is possible to go back to the screen previously displayed when it 
is switched by an external command.

• Checked:
It is not possible to go back to the screen previously displayed 
when it is switched by an external command.

Cancel the restriction on 
the number of registerable 
characters for Switch and 
Lamp (127 characters)

This option determines the number of characters that can be 
displayed on the switch or lamp.

• Unchecked (default):
The number of registerable characters is limited according to the 
width of the item.

• Checked:
A maximum of 127 characters can be registered regardless of the 
width of the item.

* If [  Size Automatic Adjustment] is checked in the [Switch] 
or [Lamp] dialog ([Text] tab window), the setting for [  Size 
Automatic Adjustment] overrides the setting made here.
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1Scale the upper/lower limit 
of the alarm for num. 
display

This option determines the range of values associated with alarm 
issue for numerical data display.   

Example: 
Numerical data display to be colored blue for a value 101 or above

• Unchecked (default):
The maximum and minimum values for alarm are set in the range 
according to “After range change”. 

Alarm maximum value:  $u1000 = 100
• Checked:

The maximum and minimum values for alarm are set in the range 
according to “Before range change”. (With constant designated, 
the operation as the above “Unchecked” will take place.)

Alarm maximum value:  $u1000 = 1000

Change the display from 
“00:00 AM/PM” to “12:00 
AM/PM”

Time can be displayed in the format based on the 12-hour clock 
system.
[Target parts]
Alarm display, time display, CSV files output associated with sampling

• Unchecked:
At midnight → Displayed as “00:00 AM”
At noon → Displayed as “00:00 PM”

• Checked (default):
At midnight → Displayed as “12:00 AM”
At noon → Displayed as “12:00 PM”

Check signal changes 
while displaying RGB input

This option determines the RGB input signal (frequency) acquisition 
timing.

• Unchecked:
The screen is displayed under the control of the input signal at the 
time of initial connection.
(In the case of input signal discontinued, the image being 
displayed remains on the screen.)

• Checked (default)*:
The screen is always displayed under control of the newest input 
signal.  This mode is useful in a case where the frequency of the 
input signal is variable (example: resolution change from SVGA to 
VGA).  A screen display is produced based on the clip start 
position and the clip size as default. 
(In the case of input signal discontinued, the screen is cleared and 
goes black.)

* While multiple channels are set for screen displays, the 
display speed may decrease even at the time of signal input 
over only one channel.
With the optional unit “GU-01” connected, input signal 
acquisition takes place periodically.  During the acquisition 
process, communications (with PLCs) may become slow.

Numerical data 
display memory

: D100

Alarm maximum 
value memory

: $u1000, Alarm color: blue

Before range change : 0 - 1000

After range change : 0 - 100 (101 or above: Alarm color → blue)
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Adjust Windows Font with 
+1 dot in the Y direction

This option sets whether or not to adjust the positions of characters in 
Windows fonts.

• Unchecked (default):
Characters placed in the editor software are moved up by one dot 
on the Y axis when they are displayed on MONITOUCH.  

• Checked:
Characters are displayed in the same positions as set in the editor 
software.

Adjust position of Windows 
Font (Multi Text)

This option sets whether or not to adjust the positions of characters 
when the Windows fonts are used in the Multi Text.

• Unchecked:
The heights of characters are calculated at a fixed value.

• Checked (default):
The heights of characters are adjusted not to protrude from the 
multi-text area.
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2 Global Overlap
Overview

With the earlier version of V-SFT, the multi-overlap display must be set on multiple screens to made it 
appear on any screen when the screen display is changed over.  With the version of 5.4.17.0 or later, 
once the global overlap display is set, the overlap display remains displayed even when the screen is 
changed.
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[Global Overlap Setting] Dialog

Click [System Setting] → [Global Overlap Setting], and check [  Use Overlap]. 

The global overlap display works as overlap ID No. 3.

[Main] Tab Window

The global overlap ID 
number is fixed to “3”.
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Designate
(Internal, External)

Internal:
An overlap display can be shown or hidden by pressing a switch placed 
on the screen or using a macro command.

External:
An overlap display can be shown or hidden by specifying an overlap 
library number in memory.  In this case, the display position can also be 
specified by an external command.

Info Output Memory Specify the desired memory address.
The overlap library number currently shown on the screen is stored in the 
top memory address “n”.  When no overlap display is shown, “-1” is stored.
If [Internal] is selected for [Designate], one word of top memory address “n” 
is used.
If [External] is selected for [Designate], a maximum of four words from top 
memory address “n” is used.(n to n+3)

Overlap Library No. This is valid only when [External] is selected for [Designate].
A memory address of [Info Output Memory] “n + 1” is automatically 
allocated.
Specify the overlap library number to be displayed in advance.

Method Details See:

Switch Function: Multi-Overlap Display → Show
Function: Overlap Display (OFF) → Hide

page 
2-5

Macro SET_MOVLP → Show
OVLP_SHOW → Hide

page 
2-5

Method Details See:

Read area 
“n + 1”

Bits 3 of read area “n + 1”
(1: show, 0: hide)

page 
2-6

Command 
Memory

Command Memory  Bit 0
(1: show, 0: hide)

page 
2-6

Target library 
designation

Overlap Library No.
(= Info Output Memory “n + 1”)

Coordinate 
designation

This is valid only when [  
Coordinate Designation] is 
checked.
(= Info Output Memory “n + 2”, 
“n + 3”)

Target library 
designation

Overlap Library No.
(= Info Output Memory “n + 1”)

Coordinate 
designation

This is valid only when [  
Coordinate Designation] is 
checked.
(= Info Output Memory “n + 2”, 
“n + 3”)
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[Detail] Tab Window

* If you select [System Setting] → [Device Communication Setting] → [Read/Write Area] and 
check [  GD-80 Compatible Read/Write Area], the setting for [  Command Memory] 
becomes invalid.

Coordinate 
Designation

This is valid only when [External] is selected for [Designate].
A memory address of [Info Output Memory] “n + 2” or “n + 3” is 
automatically allocated.
Checked:

Specify the coordinate position where the overlap display is shown from 
the memory.
[Info Output Memory] “n + 2”: X coordinate
[Info Output Memory] “n + 3”: Y coordinate

Unchecked:
The overlap display is shown in the same position as it is placed for the 
overlap library.

Command 
Memory *

Checked:
Specify one word of memory as desired.
This is used for showing or hiding the overlap display according to the 
data in the specified memory address.
However, it is not possible to use bit 3 of read area “n + 1” for showing or 
hiding the overlap display.

Unchecked:
Bit 3 of read area “n + 1” is used at all times.

Item Select 
Memory

This is required when using “entry mode” on the overlap screen.
For more information, refer to the V8 Series Reference Manual.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

1: Show
0: Hide

Not used (Be sure to set “0”.)
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Showing/Hiding Global Overlap Display

Internal Command
Switch
The global overlap display can be shown or hidden by using a switch.

Macro commands
Use the macro command “SET_MOVLP” (show) or “OVLP_SHOW” (hide).
Be sure to set “3” for the overlap ID.

* For more information on macro commands, refer to the Macro Reference Manual.

Function Description

Multi-Overlap Display Select to show the global overlap display.

[Overlap ID]: 3 (cannot be changed)
[Overlap Library No.]: Specify the desired number.
[  Display Position]: 
Unchecked:

The overlap display is shown in the same position as it is placed 
for the overlap library.

Checked:
You can specify the display position as desired for respective 
switches.

Overlap Display Select to hide the global overlap display.

[Overlap ID]: 3 (cannot be changed)
[Action]: OFF

Show Hide
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External Command
Read area
The global overlap display can be shown or hidden by setting the read area.

1. Specify the overlap library number for [Overlap Library No.].
2. Set bit 3 of read area “n + 1” in the [Read/Write Area] tab window that is displayed by selecting 

[System Setting] → [Device Connection Setting] → [Read/Write Area]. 

* If it is desired for a memory address to show or hide the overlap display, use the command 
memory.

Command memory
The global overlap display can be shown or hidden by using the command memory.

1. Specify the overlap library number for [Overlap Library No.].

2. Check [  Command Memory] in the [Detail] tab window in the [Global Overlap Setting] dialog that 
is displayed by selecting [System Setting] → [Global Overlap Setting].  Specify the desired address 
for [Command Memory].  
The overlap display is shown or hidden according to the setting of bit 0 in the command memory.

Overlap ID 3

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

1: Show
0: Hide

MSB LSB

n + 1

1: Show
0: Hide

Not used (Be sure to set “0”.)

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB
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Function Related to Global Overlap Display (Entry 
Mode)

The global overlap setting is added to the command memory and information output memory in the 
entry mode.

Command Memory
[Input Item Select: Internal]

1. Entry area designation

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

1 0 0 0 0 0 0 0 0 0 0

MSB LSB

2. Entry area
0: Disabled
1: Enabled

3. Entry area
0: Manual
1: Auto

4. Write enabled/disabled
0: Write disabled
1: Write enabled

System reserved
(Be sure to set “0”.)

1. Entry area 
designation

This is valid when entry area (2.) is set to enabled [1].
Specify the area where the cursor can move.  The content is shown below:

2. Entry area Select the area where the cursor can move between the data fields to 
select an entry target.

0: Disabled
The cursor moves in the areas in the following order:
1) Base screen
2) Overlap ID 0
3) Overlap ID 1
4) Overlap ID 2
5) Global overlap ID 3

1: Enabled
The cursor moves in the specified area only.
For the procedure of area designation, refer to “1. Entry area 
designation”.

3. Cursor movement For more information, refer to the V8 Series Reference Manual.

4. Write 
enabled/disabled

Bit No. Type

02 01 00 Data Display Data Block

0 0 0 Base Data block area No. 0

0 0 1 Overlap ID 0 Data block area No. 1

0 1 0 Overlap ID 1 Data block area No. 2

0 1 1 Overlap ID 2 Data block area No. 3

1 0 0 Global overlap ID 3 -
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[Input Item Selection: External]

Info. Output Memory

1. Order INC 
designation

For more information, refer to the V8 Series Reference Manual.

2. Entry area 
designation

Specify the area the cursor can move.  The content is shown below:

3. Entry target data For more information, refer to the V8 Series Reference Manual.

4. Write 
enabled/disabled

1. Order INC For more information, refer to the V8 Series Reference Manual.

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0

MSB LSB

2. Entry area designation 1. Order INC designation (0 to 255)

4. Write enabled/disabled
0: Write disabled
1: Write enabled

3. Entry target data selection
0: Data display
1: Table data display

Bit No. Type

13 11 10 Data Display Data Block

0 0 0 Base Data block area No. 0

0 0 1 Overlap ID 0 Data block area No. 1

0 1 0 Overlap ID 1 Data block area No. 2

0 1 1 Overlap ID 2 Data block area No. 3

1 0 0 Global overlap ID 3 -

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

MSB LSB

[Info. Output Memory] n

2. Entry area 1. Order INC (0 to 255)

4. Entry motion
0: Disabled
1: Enabled

5. Write enabled/disabled
0: Write disabled
1: Write enabled

3. Entry target data selection
0: Data display
1: Table data display
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* For more information on the usage of the info. output memory, refer to the V8 Series 
Reference Manual.

System Memory

The following describes the system memory associated with the global overlap display.

2. Entry area The currently selected entry area number is written.  The content is shown 
below:

3. Entry target data 
selection

This bit is valid, provided that [ Line/Column Output] is checked.
For more information, refer to the V8 Series Reference Manual.

4. Entry motion For more information, refer to the V8 Series Reference Manual.

5. Write status

$s Description Remarks

1560 Registration/display status ← V

1561 Display position: X coordinate ← V

1562 Display position: Y coordinate ← V

1563 Overlap library number
No.: 0 to 9999
Not displayed:  -1

← V

Bit No. Type

12 11 10 Data Display Data Block

0 0 0 Base Data block area No. 0

0 0 1 Overlap ID 0 Data block area No. 1

0 1 0 Overlap ID 1 Data block area No. 2

0 1 1 Overlap ID 2 Data block area No. 3

1 0 0 Global overlap ID 3 -

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

MSB

Overlap registration
0: No
1: Yes

LSB

Display status
0: Hide
1: Show

Model Dot Column
(1 column = 8 dots)

V815X 0 to 1023 0 to 127

V812S/V810S/V808S 0 to 799 0 to 99

V810T/V810C/V808C/V808CH 0 to 639 0 to 79

V806T/V806C/V806M 0 to 319 0 to 39

Model Dot Line
(1 line = 20 dots)

V815X 0 to 767 0 to 37

V812S/V810S/V808S 0 to 599 0 to 29

V810T/V810C/V808C/V808CH 0 to 479 0 to 23

V806T/V806C/V806M 0 to 239 0 to 11
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Limitations

Size Limitations

There is a limit to the size of the overlap display that can be shown on one screen.
Set the size of overlap displays (normal, call-, multi-overlap display (of the maximum size when 
showing several multi-overlap displays) and global overlap display) so that the combined size does not 
exceed the maximum overlap size shown here.

* For the size of the overlap displays when the global overlap display is not used, refer to the 
V8 Series Reference Manual.

Overlap display size calculation method (unit: dots)
Overlap size = Overlap display width × Overlap display height

(Unit: dots)

Example: For V810T

Model Maximum Screen 
Size

Maximum Overlap 
Size

Maximum Overlap Size 
(for Video)

V815iX (1024 × 768) 786,432 3,145,728 1,572,864
(The total of widths of four 
overlap displays must not 

exceed 2,048 dots.)

V8xxxS (800 × 600) 480,000 1,920,000 960,000
(The total of widths of four 
overlap displays must not 

exceed 2,048 dots.)

V810xT (640 × 480) 307,200 1,228,800 614,400
(The total of widths of four 
overlap displays must not 

exceed 2,048 dots.)

V810xC (640 × 480) 307,200 921,600 -

V808xC (640 × 480)

V808CH (640 × 480)

V806xx (320 × 240) 76,800 230,400 -

640

480

448

400

640 x 480 = 307,200 (  1  )

448 x 400 = 179,200 (  2  )

448

400

448 x 400 = 179,200 (  3  )

300

200

300 x 200 = 60,000 (  4  )
=<

  1  ( = 307,200)    307,200
  1  +  2  +  3  +  4  ( = 725,600)    1,228,800

=<

Overlap ID 0

Overlap ID 1

Overlap ID 2

(Base screen) Global overlap ID 3

The total size falls within the range, and 
thus, there is no problem.
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Display Limitations

• When the global overlap display has been hidden by the internal command (switch or macro 
command) after it was brought up by the external command, bit 3 of the external command must 
be set (0 → 1) to display the global overlap display again.  It is recommended that you use the 
external command to hide the overlap display once it has been shown by the external command.

• Note that the overlap display with “superimpose” is placed over the global overlap display.
• When the global overlap display with “superimpose” is shown, the transparent color and the blend 

value become the same as those set for the screen on which the global overlap display first 
appeared.

• The global overlap display is not shown while the login screen registered on the [Security Setting] 
dialog is displayed.
After the screen display is switched to another, the global overlap display will be shown.

• The global overlap display will be shown again after any of the following functions is executed.
• The macro command CHG_LANG has been executed to change the language.
• The item placed on the global overlap display has been shown/hidden.
• The offset memory value of the item placed on the global overlap display has been changed.
• The overlap display of the same overlap library number has been displayed while the global 

overlap display is displayed.
• The data block area cannot be used on the global overlap display.  If used in this way, the contents 

in the data block area will not be displayed on MONITOUCH.
“Warning” is displayed on the [Error Check] window in the following cases:

• In the case where [Designate: Internal] is selected and the macro command “SET_MOVLP” is 
used or [Designate: External] is selected:
Do not specify the overlap library number of the data block area for the global overlap display.

• In the case of the [Function: Multi-Overlap Display] switch with [Designate: Internal] selected:
Change the overlap library number, or delete the data block area from the specified overlap 
library.

• When the global overlap display is used, “3” cannot be specified for [Order INC] in the [Detail] tab 
window in the [Data Block Area] dialog.  Specify a value from 0 to 2 for [Order INC].

• The global overlap display cannot be set for component parts.  It cannot be called up from 
component parts.



2    Global Overlap

2-12

Please use this page freely.



3    Switch

3-1

3

3 Switch
3.1 Multi-function

Overview

In regards to a switch placed on a screen, which is provided with the [Write] or [Word Operation] 
function, you may also enable the switch to work as a screen change switch.  To accomplish the 
screen change function of the switch in a conventional manner, the macro command SET_SCRN must 
be used as the switch ON (or OFF) macro.
However, in accordance with the multi-function switch setting discussed hereafter, a switch can easily 
be capable of two functions.

Targeted Switches

• Switches with the following setting: Under [Function] in the [Switch] dialog, [Entry] and [Write] or 
[Standard] and [Word Operation] are selected.

Location for Setting

Click the target switch.  Its [Switch] dialog is displayed.
When [Write] or [Word Operation] is selected under [Function], the [  Screen] field at the bottom of 
the dialog becomes active.

* When a switch that works for [Write] or [Word Operation] is provided with [  Screen] 
setting, pressing the switch implements the action of [Write] or [Word Operation] first and 
then a screen change.



3    Switch

3-2

3.2 Language Changeover
Overview

The interface language can be switched easily with a switch provided with the function [Language 
changeover].  
Each time a [Language changeover] switch is pressed, the interface language switches in the 
specified order beginning from [Initial Interface Language].  Meanwhile, a desired language can be 
displayed by specifying its number with an external command.

Location for Setting

Click the target switch to open its dialog.
Select [Language changeover] under [Function].

* To see the number of interface languages, go to [System Setting] → [Font Setting].

* If a nonexistent language number is specified for display, an error beep sounds and no 
action takes place.

Fixed The interface language is displayed according to the specified language 
number.*  

Language 1 - 16

Auto Change The interface language is switched in the specified order beginning from 
[Initial Interface Language] set in the [Font Setting] dialog.  Languages that 
are not selected in the dialog will not be displayed.

Memory Designation The interface language of the number placed at the specified memory 
address is displayed.*  

  0 : Language 1
  1 : Language 2
  2 : Language 3

15 : Language 16
:
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Redrawing Timing

When the interface language is switched, the screen is redrawn.  The following actions also take place 
at the same time.

• Open macro, close macro (screen, multi-overlap library)
• Cycle macro (screen)
• $T memory zero clear (screen)
• Screen interrupt command transfer (PLC type: universal serial) (screen)

If you do not want to execute these operations at the time of redrawing, check the boxes as required.
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3.3 Switching to [Main Menu] screen
Overview

The [Main Menu] screen can be switched easily with a switch provided with the function 
[Switching to Main Menu].  

Location for Setting

Click the target switch to open its dialog.
Select [Switching to Main Menu] under [Function].
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3.4 Buzzer
Overview

In a conventional manner, the setting for the buzzer sound of MONITOUCH, as well as for the switch 
buzzer sound, is comprehensively made in the [Unit Setting] dialog.
A new function is now available to set a buzzer sound on a switch-by-switch basis.
It is also possible to produce a continuous sound while a switch is held down.

Location for Setting

1. Click the target switch.  Its [Switch] dialog is displayed.

2. Open the [Detail] tab window.  Check [  Buzzer Sound] and select an option.

In the [Buzzer] tab window in the [Unit Setting] dialog ([System Setting] → [Unit Setting]), you can 
set a buzzer sound for the V8 unit including switches.
However, if [  Buzzer Sound] is checked in the [Switch] dialog for any switch, the option selected 
for [Buzzer Sound] takes priority.

(Default: [Standard])
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4 Lamp
Overview

• A maximum of 128 patterns (pattern 0 to 127) can be registered for one lamp part (including the 
one in the switch part).

• The lamp display can be changed by bit ON/OFF operation or pattern number designation.

Usage Example

Register 128 patterns for the lamp part in advance.

Word lamp
Lamp part: 1
Lamp memory: D100
Number of patterns: 128

* When a value outside the specified range is set on MONITOUCH, the lamp display is 
not changed.

(OFF) (ON) (P3) (P4) (P5) (P6)

(P128) (P127) (P8) (P7)

Pattern 0

Operation 
Stop

Pattern 1 Pattern 2 Pattern 3 Pattern 4 Pattern 5

Operation
Start Tank Error

Temperature
Rise

Temperature
Drop

Pressure
Drop

Pattern 6

Voltage
Drop

(  ): bit lamps

Ground
Fault Hazard

Pattern 126

Preparing

Pattern 127

Production
Stop

D100 3
D101

D100 0
D101

<Status Monitor Screen>

Operation
Stop

<Status Monitor Screen>

Temperature
Rise

Set “3” for D100 in the PLC memory.
Pattern 3 is displayed.

Set “3” for D100.

When “0” is set for D100 in the PLC 
memory, pattern 0 is displayed.
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Bit lamp
Lamp part: 1
Lamp memory: M0 (allocated consecutively from M0 for the number of patterns)
Number of patterns: 128

* When multiple bits are set to “ON”, the pattern of the most significant bit is displayed.

M000-015
M016-031

M112-127

M000-015
M016-031

M112-127

<Status Monitor Screen>

Operation
Stop

<Status Monitor Screen>

Pressure
Drop

Set “ON” for M4 in the PLC memory.
Pattern 5 (P6) is displayed.

M4 is set to “ON”.

When “OFF” is set for M0 to 126 in the 
PLC memory, pattern 0 (OFF) is displayed.

M000-015
M016-031

M112-127

<Status Monitor Screen>

Production
Stop

Pattern 127 (P128) is displayed.
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Setting Procedure

Applicable Items

• Lamp part or switch part

Setting Procedure

The procedure for setting a lamp part with word designation is explained.

Step 1 Click on the lamp part placed on the screen to display the item dialog.
Select [Word] for [Memory Designation], and [BCD] or [DEC] for [Input Type].

Step 2 In the [Style] tab window, specify the number of patterns for [No. of Patterns] (up to 128).
A maximum of 128 patterns of styles and text can be registered.
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* When bit designation is used for the lamp part, the dialog shown below is displayed.  For the 
setting procedure, refer to the procedure for word designation mentioned above.

In the [Text] tab window, register the text for each pattern.
* If you cannot select a tab window other than [0], select [REP] for [Draw Mode] in 

the [Style] tab window.

The necessary settings have been completed.
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5 Data Display
5.1 Offset Value Designation Memory

Overview

Once you have placed a numerical data display part on the screen, you can monitor the value at the 
PLC memory address assigned to the part and also write data to the memory address.
When using additional memory addresses, however, you need to add parts for the memory addresses 
or register them with another screen.
With the offset value designation memory, one numerical data display part becomes available with 
multiple memory addresses.  This feature reduces the number of screens or parts used and facilitates 
screen maintenance.

D100 3

1000

980

12
D103 (D100 + 3)
D113 (D110 + 3)
D123 (D120 + 3)

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

1000

999

5

1

D102 (D100+ 2)
D112 (D110 + 2)
D122 (D120 + 2)

1000

998

10

D100 2

D100

D102

0

1000

998

D103

D112
D113

D122
D123

1000

10

980

12

D101 1000

999D111

5D121

D101 (D100+ 1)
D111 (D110 + 1)
D121 (D120 + 1)

Example: Display of the scheduled production volume, non-defective count, and defective count for 
a machine selected from Nos. 1 to 3

“2” written to the 
offset value 
designation 
memory D100

Numerical data display

Machine number: D100 (memory)

Scheduled 
production volume:

D100 (base memory), D100 (offset value designation memory)

Non-defective count: D110 (base memory), D100 (offset value designation memory)

Defective count: D120 (base memory), D100 (offset value designation memory)

When D100 = 1, machine No. 1 data at 
D101, D111, and D121 are displayed.

“3” written to the offset 
value designation 
memory D100

Machine number
Scheduled production

volume

Non-defective count

Defective count

<One-day production result>

<One-day production result> <One-day production result>

When D100 = 2, machine No. 2 data at 
D102, D112, and D122 are displayed.

When D100 = 3, machine No. 3 data at D103, 
D113, and D123 are displayed.

Machine number
(Offset value 
designation memory)

Scheduled production 
volume

Non-defective count

Defective count

Machine number
Scheduled production

volume

Non-defective count

Defective count

Machine number

Scheduled production
volume

Non-defective count

Defective count
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Applicable Items

• Numerical data display: [Function: No Function/Entry Target/Digital Switch], [Alarm: Max./Min.]
• Character display: [Function: No Function/Entry Target/Password Input]

Setting Items

In the [Main] tab window in the [Num. Display] dialog, check [ Offset Value Designation Memory].  

1. Base Memory Specify a memory location as the base (= offset memory).

2. Offset Value Designation 
Memory

Specify a memory location to store the offset value for the base 
memory and either code DEC or BCD.  It is possible to use a 
constant.

Ranges
DEC: 0 - 65535
BCD: 0 - 9999
Constant: 0 - 65535

Example:  Numerical data display

* For other settings, refer to the 
V8 Series Reference Manual.

1.
2.

Memory Remarks

PLC1 - PLC8 memory

Internal memory

Tag Valid types:
Word address
Bit address
Double-word address

Memory table Component parts
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5

Update Timing

The offset value designation memory is read in every cycle, irrespective of the item processing cycle.
When to update the screen depends on the setting made at [Redraw the screen] ([ Screen Setting] 
→ [Screen Setting] → [Show/Hide Item]). 

• Checked:
The screen is updated when the value in the offset value designation memory changes. 

• Unchecked:
Screen change
Screen redisplay
Multi-overlap change (with parts placed on multi-overlap)
Data block change (with parts placed in data block)
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Limitations

Display Limitations

• When the screen is updated, the offset value designation memory is read for the items placed on 
the screen.
For a screen including multiple offset value designation memory locations, the updated screen is 
displayed upon completion of reading all these memory locations.  If updating is time-consuming, 
the use of the internal memory is recommended.

• When setting offset values on a screen, finish the setting before switching the screen to another. 
In a case where an offset value is designated in an OPEN macro, the offset value is not valid when 
the screen is open, but becomes valid when the screen is updated.  

Others

• An offset value designation memory location is counted as one of the number of the set memory 
locations.
For more information on the number of permissible memory locations, refer to the V8 Series 
Operation Manual.

• For the use of the MICREX-SX series (Fuji Electric) in IEC mode (with the variable name 
cooperation function), specify a variable for access with memory designation (memory designated 
in the [AT] field in the dialog).  Specifying any variable without memory designation (in the [AT] 
field) will result in malfunction.

• If a value placed in offset value designation memory is outside the permissible range, an error 
arises.  Observe the specified range for setting.
PLC memory: Communication error Format
Internal memory: Error 46 
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5.2 Attribute Specification Memory
Overview

The macro command CHG_DATA was previously required to change any numerical data display 
attributes during the RUN mode of MONITOUCH.  Meanwhile for character display, no attribute 
change macro command was provided.
However, the attribute specification memory explained in this section helps change those attributes 
(the number of digits, decimal point, display type, text color/background color, or the number of bytes) 
easily for numerical data and character displays while MONITOUCH is in the RUN mode.

Applicable Items

• Numerical data display →  number of digits/decimal point/display type/text color/background color
• Character display →  number of bytes/text color/background color

* Attribute specification memory is not available with table data display, data sampling, 
graphic library, and data sheet (but available with expanded data sheet).

31.5315

D100 315

0
D201
D202

0
D200

D100 315

D201
D202

D200

7

13B

D203 D2030 0

1
2
6

Example: Numerical data display D100 (no transparency)
Decimal point: 0 → 1, Text color: black → red, Background color: white → yellow

<Room Temperature Check>

D200 = 1
D201 = 2
D202 = 6

The display now 
includes one decimal 
place and shows 
red-colored text on 
yellow-colored 
background.

Attribute specification memory

Decimal point: D200

Text color: D201

Background color: D202

Display type: D203

D100

(White)
(Black)

(Yellow)
(Red)

<Room Temperature Check>

(1 decimal place)(No decimal point)

<Room Temperature Check>

D203 = 3

The display type is 
switched from DEC 
to HEX.
The setting for one 
decimal place 
(D200 = 1) is invalid.

(DEC w/o sign) (DEC w/o sign)
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Setting Items

In the [Detail] tab window in the [Num. Display] or [Char. Display] dialog, check  [ Attribute 
Specification Memory].

Attribute Specification 
Memory

Check this option for changing attributes according to the values at 
the attribute specification memory addresses.

DEC/BCD Select either code to be used for reading the attribute specification 
memory.
This selection is commonly applied to all attributes.

[Num. Display] dialog

* The attributes checked in these dialogs will be displayed according to the values 
specified at the attribute specification memory addresses.  However, the attribute 
specification memory is not available with [ Display Type] if [Input Type: Actual 
Number] is selected in the [Main] tab window.  In this case, display in actual number 
is fixed.  
For other settings, refer to the V8 Series Reference Manual.

[Char. Display] dialog
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Digits Set a memory address used to specify the number of digits of the 
numerical data display.
When the numerical data display includes decimal places, the 
number of digits specified at this address must include the number of 
decimal places.

* If the number of digits of a value being read exceeds the 
limit specified, a hyphen is displayed, indicating an 
overflow.  

Decimal Point Set a memory address used to specify the number of decimal places 
of the numerical data display.

* The number of decimal places must be smaller than the 
number of digits.  If the number of decimal places is the 
same as or more than the number of digits, an overflow 
arises.
For HEX, OCT or BIN as [Display Type], decimal point 
setting does not take effect.
Even if a value is set for [Decimal Point] in such a case, it is 
assumed to be zero.

Display Type Set a memory address used to specify the display type of the 
numerical data display.
Place a value at the memory address according to the following:

0: DEC (w/o sign)
1: DEC (w/ -sign)
2: DEC (w/ +-sign)
3: HEX
4: OCT
5: BIN
6: FLOAT*
7: BCD (w/o sign)
8: BCD (w/ -sign)
9: BCD (w/ +-sign)

* This setting takes effect when [Data Length: 2-Word] is 
selected in the [Main] tab window.  The [Display Type] 
setting is invalid when [Input Type: Actual Number] is 
selected in the [Main] tab window.

Display Type Digits

DEC 1 to 10

HEX 1 to 8

OCT 1 to 11

BCD 1 to 8

BIN 1 to 32

FLOAT 1 to 32

Display Type Decimal Point

DEC 0 to 9

BCD 0 to 7

FLOAT 0 to 31

HEX/OCT/BIN * -
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Text Color Set a memory address used to specify the text color.

Bits 0 to 6: Color
Bit 7: Blinking (0: No, 1: Yes) 

You can select a color from 128 colors (with blinking) on [Palette 1] in 
the [Custom Color] dialog.
Colors correspond to the following color codes:

31.5 Foreground color

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

0 - 127 colors

Foreground color

Blinking
0: No
1: Yes

n

Color Code (DEC)
Black 00
Blue 01
Red 02

Magenta 03
Green 04
Cyan 05
Yellow 06
White 07

[Color Palette 1]

00
16
32
48
64
80
96
112

15
31
47
63
79
95
111
127

0 1 2 3 4 5 6 7 8 9 A B C D E F
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Update Timing

The update timing depends on the [Process Cycle] in the [Detail] tab window for each data display.

Limitations

• For a numerical data or character display provided with a frame, the frame size is not changed 
according to the setting of [Digits], [Decimal Point], [Display Type] or [No. of Bytes].  For this 
reason, you need to set the maximum number of digits or bytes in the screen data.    

• For a numerical data or character display with [Property: Not Transparent] selected in the [Style] 
tab window, its background drawing area will be influenced by the setting of [Digits], [Decimal 
Point], [Display Type] or [No. of Bytes].  If the set number of digits or bytes is decreased, therefore, 
the background color will be left.
For this reason, you need to set the maximum number of digits or bytes in the screen data.  Or, 
you may update the display with the macro command SYS (RESET_SCRN) or by screen change.

• If a value displayed in a numerical data display has become higher than the maximum or lower 
than the minimum specified for alarm, the value is shown in the color preset for alarm.

• When [ Attribute Specification Memory] is checked in the [Num. Display] dialog, the macro 
command CHG_DATA is not executable for the numerical data display.

• For a numerical data or character display with [Function: Entry Target], its display is switched when 
the cursor is moved from the display field.

Background Color Set a memory address used to specify the text background color.

Bits 0 to 6: Color
Bit 7: Blinking (0: No, 1: Yes) 

You can select a color from 128 colors (with blinking) on [Palette 1] in 
the [Custom Color] dialog.  For color codes, refer to the section of 
“Text Color”.

* However, the [Background Color] setting does not take 
effect when [Transparent] is selected for [Property] in the 
[Style] tab window.

No. of Bytes Set a memory address used to specify the number of bytes of the 
character display.
No. of Bytes: 1 to 127

* Irrespective of the setting for [No. of Bytes], 127 bytes (64 
words) will always be read.

31.5 Background color

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

0 - 127 colors

Background color

Blinking
0: No
1: Yes

n
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6 Parts with Entry Function
6.1 Data Display (with Entry Keys)

Overview

• A keypad call switch can automatically be set to numerical data display or character data display 
parts.

• The area of the numerical data display or character data display part works, when it is pressed, as 
a switch for calling a keypad registered on the [Multi-Overlap] dialog.

120

1564

554

1653

988

489

156

484

988

489

156

484

120

1564

554

1653

987

654

CLR321

ENT+/-.0

Pressing on a numerical data display part brings up a keypad equipped with entry keys.

Entry Screen Entry Screen

1234

1234

1234

1234

1234

1234

1234

1234

Each numerical data display area works as a switch.

Numerical data display
Keypad call switch area

Entry Screen

Numerical data display
Numerical data area
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Setting Procedure

Setting Position

• Numerical data display part or character data display part
*[Function: Entry Target] must be selected.

Setting Procedure

The procedure is explained with an example of a numerical data display part.

Step 1 Select [Entry Target] for [Function] of the numerical data display part placed on the screen.
The [  With Entry Key] check box appears underneath.

Step 2 Check the box for [  With Entry Key].  The setting items shown below appear.
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Step 3 Set up the multi-overlap settings for showing the keypad.

*1 With [  With Entry Key] checked, if any overlap display other than the multi-overlap 
display has been registered, the following message is displayed.

Select another ID.

If another multi-overlap display is already registered at the same overlap ID, no error 
occurs.
However, when the keypad is displayed on the MONITOUCH, the multi-overlap 
display that is previously displayed will disappear.

*2 Unless you press the [Register] button, the keypad will not be registered in the 
overlap library.

Step 4 When the setup has been completed, an overlap icon (for multi-overlap) is displayed in 
addition to the numerical data display on the screen.

Overlap ID *1 Specify the overlap ID to be used for showing the 
keypad.

Overlap Library No. Specify the overlap library number of the keypad.
Press the [Register] button *2, select the desired 
keypad, and register it in the overlap library.
If it is already registered in the overlap library, simply 
specify the number.

 Display Position When this box is checked, the multi-overlap display 
position can be set.

• [X Coordinate], [Y Coordinate]
Specify the coordinate values to set the display 
position.

• [Specify with Mouse] button
When this button is clicked, a cross-shaped cursor 
appears on the screen.  Move the cursor to the 
desired position and click the mouse to determine the 
position.
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Notes on canceling the data display with entry function
Once the setup has been completed, if you uncheck the box for [  With Entry Key] of a numerical data 
display or character display part, or if a function other than [Entry Target] is selected for [Function], the 
confirmation dialog shown below will be displayed.

Click [OK], and manually delete the overlap ID icon and the overlap library.

Overlap icon

Overlap library
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Other Notes

Checking the Data Display with Entry Function

When checking whether the “data display with entry function” has been set on the screen, use the 
[Item List] view.

Switch Area

The data display with entry function has a switch area.
The switch area will be displayed with dotted lines when you select [Display Environment] →  [Display] 
and check the box for [  Display Area]. 

[Item List] view

This indicates a data display part with 
a pop-up keypad.

Switch area of the numerical 
data display part

Numerical data display partWithout entry function

With entry function
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6.2 Slider Switch

Overview

• The slider switch is useful to change the setting values on the screen.
• A maximum of 1024 parts* (192 parts* for the V806 series) can be placed on one screen.

* Including switches and scroll bars

Position to be pressed and data write timing
• The slider switch works only when the slide switch is pressed (it does not work when a position on 

the rail is pressed).
• When you remove your finger from the slide switch, a value is written and the slide switch is moved 

at the same time.

Display for slide switch movement
• While you are moving your finger to move the slide switch, only a line indicating the switch position 

to be moved is displayed.  The slide switch does not move together with your finger.

MJ1

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

0

0

0

30.5

48.2

25.0

Port 
No. 0

Port 
No. 1

Port 
No. 2

Port 
No. 0

Port 
No. 1

Port 
No. 2

<SV Setting Screen> <SV Setting Screen>

Move the slide switch while holding it down.  When 
you remove your finger, the data is changed.

Port No. 1 Port No. 2 Port No. 3

Movement

Slide switch
RailLine
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Setting Procedure

Select [Parts] → [Slider Switch] to place a slider switch part on the screen.
(Alternatively you can place it by selecting [Slider Switch] on the [Parts List] window that is displayed 
by selecting [Parts] → [Parts List].)

Setting Dialog
[Main] tab window

Memory Specify a memory address to be changed by the slider switch.

Data Length
(1-Word, 2-Word)

Select the data length of the memory address.

Input Type
(BCD, DEC)

Select a code type to be used when importing data into the V series.

Direction
(↑, ↓, →, ←)

Select a sliding direction.
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[Style] tab window

* Parts change can be executed by selecting an option on the [Modify Part] window.
Select a slider switch and select [Edit] → [Change Part] → [Modify Part].  The dialog shown below 
is displayed.  Select [Edit a rail] or [Edit a slider].

Define detent steps 
by the size of the 
item.

When this check box is checked, the number of divisions for the rail is 
automatically defined according to the size and scale value of the rail.

No. of Divisions
(2 to 1024)

Specify the number of divisions of the rail.
If the size of the rail is smaller than the number of divisions, the rail is 
divided into the number defined in the case where [ Define detent steps by 
the size of the item.] is checked.

Scale Specify the setting range available for the slider switch.  It is also possible to 
make it variable by specifying the memory address.

Edit Parts
(Rail + Slide, Rail, 
Slide)

Select the part whose 
design is to be changed.

Color Change the color of the part which is selected for [Edit Parts].
(This is valid only when [Rail] or [Slide] is selected.)

Change Part* Press this button to apply changes to the part selected for [Edit Parts].
For more information, refer to “3.6 Parts” in the V8 Series Operation 
Manual.

Rail
Slide
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6.3 Numerical Data Entry (Numeral Insertion/DELETE 
Keys Enabled)
Overview

To change numerical data already entered through the keypad, you need to type over the data, or 
delete every numeral with the backspace key and then type in new data.
With the numeral insertion/DELETE key function discussed in this section, you can use the arrow keys 
“←” and “→” to move the cursor, and enter/delete numerals to/from the places specified with the 
cursor.

Display During Data Entry

Numerals being typed are displayed in a flush-right format with zero suppress, irrespective of which 
settings (flush right and zero suppress) are currently made for the numerical data display.  After the 
numerals being typed are entered, they are displayed in the set format.

Examples
Insertion of numerals

• The whole number part
A numeral insertion is made to the right of the cursor.
When numerals exist at all places, entering a new numeral deletes the leftmost numeral.
Additionally, entering a numeral at the leftmost place of the whole number part overwrites the 
current numeral.
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+/-
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ENTER0 .

CLEAR

DELETE

BackSpace+
-
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00013

123

123

00123

13

0 0000 0 0---0 1230

Flush right, with zero suppress

Flush left, with zero suppress

Without zero suppress Flush right, with 
zero suppress

Before entry Being typed Entered

1245 2345
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ENTER0 .
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DELETE

BackSpace+
-
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DELETE

BackSpace+
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CLEAR

DELETE

BackSpace+
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Example: Insertion of “3” between “2” and “4” to show “2345”

Cursor 
movement to “2”

Press the “3” key.
“3” is placed at the right 
of the cursor to switch 
the display to “2345”.

Cursor movement 
to the leftmost 
numeral “2” 

Press the “1” key.
“2” is overwritten with 
“1” to switch the 
display to “1234”.

Example: Overwriting the leftmost numeral “2” to show “1234”
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• The fractional part
A numeral insertion is made to the left of the cursor.  When numerals exist at all places, entering a 
new numeral deletes the rightmost numeral of the fractional part.
Additionally, entering a numeral at the rightmost place of the fractional part overwrites the current 
numeral.

Deletion of numerals
The DELETE key deletes the numeral at the cursor.
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CLEAR

DELETE

BackSpace+
-

Example: Insertion of “2” between “5” and “6” to show “1.526”

Cursor 
movement to “6”

Press the “2” key.
The rightmost numeral “0” 
of the fractional part is 
deleted and “2” is placed 
at the left of the cursor.
The display shows 
“1.526”.

Example: Overwriting the rightmost numeral “7” to show “1.560”

Cursor movement 
to the rightmost 
numeral “7” 

Press the “0” key.
“7” is overwritten with “0” 
to switch the display to 
“1.560”.
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Example: Deletion of “1” from the whole number part of “1.234”

Press the DELETE key.
“1” is deleted and replaced 
with “0”.
The display shows 
“0.234”.

• The whole number part

Example: Deletion of the tenth place of “1.234”
• The fractional part

Cursor 
movement to “2”

Press the DELETE key.
“2” is deleted and “0” is 
put at the rightmost place 
of the fractional part.
The display shows 
“1.340”.

Cursor 
movement to “1”
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The backspace key deletes the numeral to the left of the cursor.

Applicable Items

• Numerical data display: [Function: Entry Target]
• Entry mode: [Type: Data Display, Data Block, or Direct] 

Setting Items

Click [System Setting] → [Unit Setting], and open the [General Settings] tab window.  In the tab 
window, click [ Allow to use Insert/DELETE keys when entering values].

* The above setting is reflected throughout the entry mode for all screens.
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Example: Deletion of “5” from “1526”

Cursor 
movement to “2”

Press the BackSpace 
key.
“5” is deleted.
The display shows “126”.

Example: Deletion of “2” from “1.526”

Cursor 
movement to “6”

Press the BackSpace 
key.
“2” is deleted and “0” is 
put at the rightmost place 
of the fractional part.
The display shows 
“1.560”.

• The whole number part

• The fractional part

(Default: unchecked) 
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Keypad

The keys of the keypad work as described below.

Key Function Action Remarks

Character Input 0 to 9, A to F, +, -, .
In a condition immediately after a selection with the cursor, 
pressing any of these key clears the existing data and enters 
the data of the key you pressed.
When the cursor has been moved by the switch function of the 
arrow key “←” or “→”, a numeral can be put at the place 
determined with the cursor.  A decimal number can be 
displayed with the “.” key.  The cursor is then movable through 
the whole number part and the fractional part.  

2-byte valid

Write This key writes the entered data to the specified memory.

Clear This key clears the entered data.

+/- This key inverts the sign of the entered data.

Back Space This key deletes one numeral to the left of the cursor.
However, this key does not delete the leftmost numeral of the 
whole number part as well as the tenth place of the fractional 
part.
When a numeral is deleted from the whole number part, the 
cursor remains in the same place.  When a numeral is deleted 
from the fractional part, the cursor is moved left one space and 
“0” is put at the rightmost place of the fractional part.
Example:
Deletion of “4” from “12.345” results in “12.350”.

Unable to 
delete 
decimal point 
and signs

Delete This key deletes one numeral at the cursor.
After a deletion with this key, the cursor remains in the same 
place.
When the leftmost numeral is deleted from the whole number 
part, “0” is put at the place.  When one numeral is deleted from 
the fractional part, “0” is put at the rightmost place.

Unable to 
delete 
decimal point 
and signs

Cancel Pressing this key while data is being typed returns the display 
to the previous data.

← This key moves the cursor left one space.
The cursor is not put over the decimal point.

→ This key moves the cursor right one space.
The cursor is not put over the decimal point.
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7 Graph
7.1 Real Numbers

Data of real numbers (float) can be read and shown in graphs.

Applicable Items

• Bar graph
• Pie graph
• Closed area graph
• Panel meter

Limitations

• If any real number set for memory, minimum or maximum scale value, target value, or alarm falls 
outside the permissible range of MONITOUCH, the number cannot be displayed.  For more 
information on the permissible range, refer to the V8 Series Reference Manual.

Example: Bar graph

* The [DEC-/BCD] for [Input Type] depends on the setting for [Code] in the 
[Communication Setting] tab window ([System Setting] → [Device Connection 
Setting]).  
For other settings, refer to the V8 Series Reference Manual.
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7.2 Panel Meter (Extended)
Overview

Extended Alarm Function

[Alarm 2] is added on the [Alarm] tab window.  On the [Alarm 2] field, you can set a maximum of 16 
alarm ranges and their respective colors.
Note that the color of the indicator does not change according to the alarm condition.

Extended Indicator/Scale Function

The design of the scale or indicator can be changed to the desired one by using a bitmap file, etc.

Numerical Data Display

The current data can be displayed on the panel meter in numerical form.
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A maximum of 16 alarm ranges can 
be set.

Example: [No. of Divisions] = “3”
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Example: When “8” is set in the memory address D100:
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Applicable Items

• Panel meter

Available V8 Models

*1 Not available on the portrait-oriented model.
*2 Custom bitmap unsupported.

Model

V815iX/V812(i)S
V810(i)S/V810(i)T

V808(i)S

V810(i)C
V808(i)C *1

V808(i)CH
V806(i)T/V806(i)C *1 V806(i)M

64k 
colors, 

32k 
colors

128 
colors

64k 
colors, 

32k 
colors

128 
colors

64k 
colors, 

32k 
colors

128 
colors Monochrome

Alarm 2

Indicator 
extended setting

Scale Show

Extension

Numerical data 
display

 *2  *2  *2  *2
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Extended Alarm Function

Set the color and the number of divisions for [Alarm 2] in the [Alarm] tab window in the [Panel Meter] 
dialog.

 Alarm 1 For more information, refer to the V8 Series Reference Manual.

 Alarm 2 Set the number of divisions and their respective alarm colors.

* Painting is overlaid in order from “Data 0 property” to “Data 15 
property”. 
When a painted range overlaps with another, the color of the 
greater number comes to the fore.

Range Set the color to display for the value outside the 
range specified for data attributes.

No. of Divisions
(1 - 16)

Set the number of divisions for alarm.

Edit Used to set the color and the upper and lower limit 
values for each data attribute.

Indicator’s moving direction: right Indicator’s moving direction: left

Data 1 
attribute

Data 0 
attribute

Data 1 
attribute

Data 0 
attribute

Data 3 attribute

Data 2 attribute

Example: [No. of Divisions] = “4”

(The indicator’s moving direction can be selected in the [Main] tab window.)
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Extended Indicator/Scale Function

In the [Style] tab window in the [Panel Meter] dialog, the graph shape and the color and length of the 
indicator can be specified as desired.  In the [Scale] tab window, settings related to the scale, such as 
show/hide, scale properties, scale direction, etc., can be made.
The design of the scale or indicator can be changed to the desired one by using a bitmap file, etc.  For 
more information, refer to “Customizing the Indicator and Scale” (page 7-10).

Style

Indicator Set the indicator color.
When [Alarm 2] is selected, the indicator color remains in the color set here 
even if a value falls outside the specified alarm range.

Target Value Set the graph color.
When [Alarm 2] is selected, settings for [Target Value] and [Area] cannot be 
made.
For more information on settings, refer to the V8 Series Reference Manual.

Area

 Display Frame

Frame

Graph shape

Indicator
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 Complete Round 
Circle

Check this box to make a complete round graph area.

Outer radius *1 Set the radius of the outer circle of the panel meter.

Inner radius *1 Set the radius of the inner circle of the panel meter.

Change Part Used for changing a part design of the panel meter.

Customize *2 A desired bitmap file can be used for the panel meter design.  The selected 
bitmap file is stored in “.\V-SFT-5\Parts\User”.
For the detailed procedure, refer to “Customizing the Indicator and Scale” 
(page 7-10).

Unchecked (sector) Checked (complete round circle)

Graph area

Start 
Angle

Set the start angle. Example: [Start Angle: 180], 
[End Angle: 0]

End 
Angle

This setting is active only 
when [  Complete Round 
Circle] is not checked.
Set the end angle.

* Panel meter area: Area 
circularly enclosed 
from the start angle to 
the end angle in the 
clockwise direction

Start Angle
End Angle

Outer circle

Radius of the outer circle
Center

Inner circle

Radius of the inner circle
Center
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7*1 The inner circle must be set.  The minimum radius of the inner circle is 10 dots.  The minimum 
difference in radius between the outer and inner circles is 3 dots.

*2 Unavailable with 128-color and monochrome V8(i) series
*3 Available with 64k-color or 32k-color MONITOUCH (V815iX, V812(i)S, V810(i)S, V810(i)T or 

V808(i)S)

 Indicator Setting 
(Extension) *3

Check this box to change the indicator part.  A desired bitmap file can be 
used.

Start Point Select a shape of the top 
and end of the indicator.

End point

Length Specify the length of the 
indicator in dots.
(Maximum value: radius of 
the panel meter, minimum 
value: 1)

Customize Check this box when using a desired bitmap file for the 
design of the indicator.
For more information on the setting, refer to “Customizing 
the Indicator and Scale” (page 7-10).

Start 
Point

End 
Point

Length
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Scale

Direction
Inside / Outside

Select the position of the scale; inside or outside of the outer circle.

Color Set the scale color.

Radius Set the scale radius.

Inside Outside

Scale

Scale radius
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*1 Unavailable with 128-color and monochrome V8(i) series

Major scale Set the number of divisions and length of the major scale.

 Minor scale Check this box and set the number of divisions when drawing a minor scale 
between major scales.  (The length is the half of the one set for [Length] at 
[Major scale].)

 Line Check this box to add the outer line to the scale.

 Customize *1 Check this box when using a desired bitmap file for the scale design.
For more information on the setting, refer to “Customizing the Indicator and 
Scale” (page 7-10).

No. of 
Divisions

1 - 255 Example: [No. of Division] = “8”

Length 1 - 16
(When [  Minor 
scale] is checked, the 
length can be set in 
increments of “2”.)

Major scale

No. of 
Divisions

1 - 16 Example: Major scale [No. of 
Division] = “8”
Minor scale [No of Division] = “5”

Minor scale

Number of 
divisions for 
minor scale

Outer 
line

Example:Major scale [No. of Division] = “8”, 
Minor scale [No. of Division] = “5”

Checked: Unchecked:
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Customizing the Indicator and Scale

A desired bitmap file can be used for the part design (background, indicator and scale).

[Style], [Scale]

Customize 
(background) 
Select (indicator, 
scale)

Choose a bitmap file in the desired folder.
The selected bitmap file is stored in “.\V-SFT-5\Parts\User”.

Width / Height Change the width and height of the imported bitmap image.

 Aspect Ratio 
Fixed

Check this box when changing the size of the bitmap image while fixing the 
ratio between the width and height.

Panel Meter Center 
Point

The coordinate values of the panel meter (circle) center point are displayed.

Base Point X 
Base Point Y

Specify the X or Y coordinate value of the base point in dots.
The indicator turns around the point specified for [Panel Meter Center Point].

Default Resets the X and Y coordinate values of the base point to those specified for 
[Panel Meter Center Point].

ScaleBackground / Indicator

Red mark “×”: base point

Backgr
ound

Indicator

N

S

EW

(0, 0)

Panel meter center point

Indicator

Base point
Specify the X and 
Y coordinate 
values of the base 
point to adjust the 
position of the 
indicator or scale.

Scale
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Procedure
This section explains the procedure for importing a bitmap image into the panel meter.

Scale

Black (code 0000) in the bitmap 
image automatically becomes 
transparent on MONITOUCH.

Indicator

scale_A.bmpback_A.bmp pin_A.bmp

Background of the 
panel meter

Step 1 Place a panel meter on the screen.
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Step 2 Import a background image of the panel meter.
Select [Customize] in the [Style] tab window in the [Panel Meter] dialog and check [  Use 
Custom Bitmap].  Press the [Open] button and select a bitmap file.  (Example: 
back_A.bmp)

Step 3 Enlarge or reduce the size of the graph area by specifying desired values for [Outer radius] 
and [Inner radius] in the [Style] tab window. 

Step 4 Import a bitmap image of the indicator.
Select [  Indicator Setting (Extension)] → [  Customize] on the [Style] tab window in the 
[Panel Meter] dialog and check [  Use Custom Bitmap].  Press the [Open] button and 
select a bitmap file.  (Example: pin_A.bmp)

* The bitmap image of the indicator is imported while it is pointing upward with 
reference to the panel meter center point.
The indicator cannot be rotated on the editor.

Background of the panel meter

Graph area

Indicator

Base point X and Y (= panel meter center point)
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Step 5 Move the indicator part downward by specifying values for [Base Point X] and [Base Point 
Y] in the [Style] tab window.  
It can be enlarged or reduced by specifying values for [Width] and [Height].

* The indicator rotates around the panel meter center point.
Step 6 Import a bitmap image of the scale.

Select [  Show a scale] → [  Customize] in the [Scale] tab window in the [Panel Meter] 
dialog and check [  Use Custom Bitmap].  Press the [Open] button and select a bitmap 
file.  (Example: scale_A.bmp)

Step 7 Specify values for [Width] and [Height] in the [Scale] tab window to reduce the size of the 
scale. 
The scale can be moved by specifying values for [Base Point X] and [Base Point Y].

The necessary settings have been completed.

Indicator base point X, Y

Panel meter center point

Scale
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Numerical Data Display

Make settings in the [Num. Display] tab window in the [Panel Meter] dialog.
The numerical data display is used to show a measurement value in numerical form on the panel 
meter.

[Main] Tab Window

Digits

Specify properties of the numerical data display.
For more information, refer to the V8 Series Reference Manual.

Decimal Point

Display Type

Zero Suppress

Size Automatic 
Adjustment

0
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40
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Numerical data display
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[Style] Tab Window

*1 Unavailable with 128-color and monochrome V8(i) series

Color

Set a color and text size for the numeric data display.
For more information, refer to the V8 Series Reference Manual.

Property

Enlarge

Point

Rotation + Direction

 Spacing

Character Size

 Windows Font

Font

Display Language

Change Part Changes a part design of the numerical data display.

Customize *1 Check this box when using a desired bitmap file for the design of the 
numeric data display.
Black (code 0000) on the image automatically becomes transparent on 
MONITOUCH.  To display black, specify a color approximate to black.

Width / 
Height

Change the width and height of the imported bitmap 
image.

 Aspect 
Ratio 
Fixed

Check this box when changing the size of the bitmap 
image while fixing the ratio between the width and 
height.
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[Coordinates] Tab Window

Panel Meter Center Point The coordinate values of the panel meter center point are displayed.

Base Point X 
Base Point Y

Specify the X and Y coordinate values of the base point on the 
numerical data display.

Default Resets the X and Y coordinate values of the base point on the 
numerical data display to those specified for [Panel Meter Center 
Point].

Red mark “×”: base point

Base point 
X, Y
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Limitations

• The maximum sizes of the panel meter are shown below:

• Draw a panel meter in order from the smaller number shown below.
When any setting is made for [Alarm 2], [Indicator Setting (Extension)] or [Num. Display] and a 
value on the panel meter or [Alarm 2] is changed, the panel meter is updated entirely.

• The numerical data display is displayed even when a value falls outside the range specified for 
[Scale] (in the [Main] tab window).  However, when the number of digits exceeds the specified 
value, “---” is displayed.

MONITOUCH Model Max. Size of Panel Meter (unit: dots)

V815iX Height 768, width 512

V812(i)S / V810(i)S / V808(i)S Height 600, width 400

V810(i)T Height 480, width 320

V810(i)C / V808(i)C / V808(i)CH
V806(i)T / V806(i)C / V806(i)M

Height × width = max. 65936
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8

1. Part area *

3. Scale

2. Alarm

4. Indicator

5. Numerical data display

* When a draw item edited in the [Modify Part] window is placed with the 3D 
panel meter part, the item is placed over the panel meter.

Panel meter structure



7.2    Panel Meter (Extended)

7-18

Please use this page freely.
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8 Trend Graph
8.1 Expansion of X-Axis Point Setting

Overview

A maximum of 1,920 points can be set on the X axis in trend graph (or trend sampling).  This expanded 
point setting is also valid when [Edit Model: TELLUS] or [Size: 1920 × 1080] is specified in the [Edit 
Model Selection] dialog.

Applicable Items

• Trend graph
• Trend sampling

* Enter a value for [X Axis Data Points] smaller than the resolution of MONITOUCH.
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8.2 Scale Display
Overview

Scale

A graph can be provided with a scale along any sides: right, left, top, or bottom.

Grid lines

Grid lines can be drawn in accordance with tick marks.

Numerical Display

Reference numbers can be displayed at tick marks.

Applicable Items

• Trend graph
• Trend sampling

• Scale along the left and bottom sides • Scale along the right and bottom sides

Scale

Major tick mark

Minor tick mark

Axis line

Example: Grid lines at major tick marks

Grid lines

0 10020 40 60 80

Example: Reference numbers at major tick marks

Numerical display

Numerical display
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Setting Items

In the item dialog, open the [Scale] tab window, and check [  Set scale display].

Click or double-click.

Example: Trend sampling
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Color, Back Color Select the color of the major and minor tick marks, and axis lines of the 
scale.
Each setting is common to all left, right, bottom, and top sides.

Length of small scale Set the length of the minor tick marks of the scale.
This setting is common to all left, right, bottom, and top sides.
1 - 16
The thickness of the marks is fixed.

[  Scale] in [Left], 
[Right], [Bottom], and 
[Top] tab windows

Check these boxes as necessary for the sides of the graph when 
showing a scale, grid lines, or reference numbers.
Default: [  Left] and [  Bottom] checked

Small scale alignment • [Equal divide] (based on [No. of divisions]) 
Minor tick marks are equally spaced according to the specified 
number of divisions along the axis line.

• [Equal interval] (based on [No. of intervals]) 
Minor tick marks are equally spaced according to the specified 
interval from the zero point along the axis line within the following 
range.  

 Make small scales 
larger every n scales.

Check this box when placing major tick marks.
The major tick mark is twice the length of the minor.  The thickness of the 
markings is fixed.

Grid Line Check this box when drawing grid lines.  Grid lines are drawn at the 
major and minor tick marks of the scale.

Num. Display Check this box when showing reference numbers at the major and minor 
tick marks of the scale.

Direction Side Range

LFT/RGT Top/Bottom [X Axis Data Points] or [Range 
Setting] in the [Scale] tab windowUP/DW Left/Right

LFT/RGT Left/Right [Range Setting] in the [Scale] tab 
windowUP/DW Top/Bottom

Color, Line Type Set the color or the line type of the grid lines.

Display only large 
scale

Check this box when drawing grid lines only 
at the major tick marks of the scale.  
Uncheck this box to draw grid lines at both 
minor and major tick marks.

Style Set the number of digits or the color of 
reference numbers shown at tick marks.

Display only large 
scale

Check this box when showing reference 
numbers only at the major tick marks of the 
scale.
Uncheck this box to show reference numbers 
at both minor and major tick marks.
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*1 If [  X Scale] is checked in trend graph settings, the range is determined by the minimum and 
maximum values of the X scale.

*2 If the minimum and maximum values are specified with memory addresses (other than 
constants) in the [Range Setting] area and if these values are changed during RUN, an update 
resulting from the change occurs at the following times:
• The screen including a trend graph or trend sampling is redrawn.
• In the case of a trend graph, the bit for redraw or redraw after clear in the control memory is set 

(ON).
• In the case of trend sampling, the macro command TREND_REFRESH is executed.

Range Setting * Settings in this area are valid, provided that [Small scale 
alignment: Equal interval] is set or [  Num. Display] is 
checked.

• [Match with the specified graph]

• [Set values]
Specify the minimum and maximum values using constants or 
memory addresses.*2

Direction Side Range

LFT/RGT Top/Bottom [X Axis Data Points]*1

UP/DW Left/Right

LFT/RGT Left/Right [Graph Min. Value] and [Graph 
Max. Value] specified for the 
selected graph number*2UP/DW Top/Bottom
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Setting Procedure

As an example, this section describes how to set a scale with reference numbers and grid lines for a 
trend graph.

1. Place a trend graph part without scale (*) on the screen.
* If scale settings are made for a graph part with scale, scales will overlap one another.

Be sure to select a part without scale.

2. Click or double-click the trend graph part to open its item dialog.
Make settings as necessary in the [Main] tab window.
For more information on settings, refer to the V8 Series Reference Manual.

100806040200

Direction: RGT
Left side: 0 to 100 
Bottom side: 0 to 100
Grid Line: Display only 

large scale
Num. Display: Display only 

large scale

Left side

Bottom side

Grid lines

Scale

Numerical display

Numerical 
display

Trend graph part with scale

Scales doubly displayed

Trend graph part without scale
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3. Click the [Scale] tab.  Set the [Left] and [Bottom] tab windows as follows.

4. The necessary settings have been completed.

Limitations

Trend Graph

• For asynchronous display of multiple trend graphs, the scale of the parent trend graph is 
displayed.  Scale settings made for child trend graphs are invalid.

Trend Graph and Trend Sampling

• If a tile pattern is selected for [Color] in the [Style] tab window in the above dialog, other color 
settings, such as for [Grid Line], are invalid.  Do not select tile patterns.

[Left] [Bottom]
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8.3 Expansion of Word Count

Overview

A maximum of 256 words can be set for sampling data.

Applicable Items

• Trend sampling
• Data sampling

Location for Setting

• [System Setting] → [Buffering Area Setting]

• Item dialogs

Trend sampling

Data sampling

Setting Range: 0 to 255
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8.4 Real Numbers

Overview

Data of real numbers (float) can be read and shown in trend graphs.

Applicable Items

• Trend graph
• Trend sampling
• Data sampling

Limitations

• If any real number set for memory, minimum or maximum scale value, target value, or alarm falls 
outside the permissible range of MONITOUCH (nonnumeric data included), the number cannot be 
displayed.  For more information on the permissible range, refer to the V8 Series Reference 
Manual.

• If real data set for trend sampling or data sampling exceeds the permissible range of 
MONITOUCH, the data output in a CSV format is expressed as hyphens “---”.

Trend graph/trend sampling

* The [DEC-/BCD] for [Input Type] for trend graph, or trend sampling, depends on the 
setting for [Code] in the [Communication Setting] tab window ([System Setting] → 
[Device Connection Setting]).
For other settings, refer to the V8 Series Reference Manual.
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8.5 Cursor Point Value Display (Trend Sampling)
Overview

When a cursor is displayed on a trend sampling graph by pressing a switch for [Roll Up], [Roll Down], 
[+Block] or [-Block], the values of the trend lines at the cursor point can be displayed by simple settings 
explained in this section.  When the cursor is hidden, the latest values of the trend lines are displayed 
instead.

Applicable Items

• Trend sampling

0

20

40

60

80

100

85

33

mm

mm

mm

Cursor

 Example: Cursor displayed on the graph

Cursor point 
values
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Setting Items

Numerical data display part
• Function: [Sample: Currently Selected Value Display], [Graph No. 0 to 15] 

• Select the same number as the trend sampling ID number.

Limitations

• Windows fonts cannot be used.
• Values at cursor points are only displayed, not stored.  To store these values in memory, use the 

macro command SAMPLE.  For more information, refer to the Macro Reference Manual.

Select the same number.

[Num. Display] dialog

* Values at cursor points are displayed according to [Data Length] and [Input Type] specified 
for the graph number selected in the [Trend Sampling] dialog.
If an unregistered graph number is selected for numerical data display, no value appears in 
the value display fields.  Select a graph number that exists.

Trend sampling
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8.6 Sampling Time Display (Trend Sampling)
Overview

For the currently displayed graph, the sampling times of the newest and oldest data (at the display 
start and end points) can be displayed.  These times will be updated when the cursor is placed by 
pressing a switch for [Roll Up], [Roll Down], [+Block], or [-Block], or when the graph is zoomed in.

Example: [Direction: RGT]

• [  Pen Recorder Display] unchecked

• [  Pen Recorder Display] checked

Applicable Items

• Trend sampling

16:12:48 16:18:48
0

20

40

60

80

100

Sampling time of oldest data
[Sampling Time Display (Starting point of display)]

Sampling time of newest data
[Sampling Time Display (End point of display)]

Numerical display

16:12:48 16:18:48
0

20

40

60

80

100

Sampling time of oldest data
[Sampling Time Display (Starting point of display)]

Sampling time of newest data
[Sampling Time Display (End point of display)]
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Setting Items

Numerical data display part
• Function: [Sample] 

• [Sampling Time Display (Starting point of display)]
• [Sampling Time Display (End point of display)]

• Select the same number as the trend sampling ID number.

* Time data to be displayed depends on the specified number of digits.
YYYY: year, MM: month, DD: day, hh:  hour, mm: minute, ss: second 
Less than 8 digits: No display
8 to 13 digits: “hh : mm : ss”
14 to 18 digits: “MM - DD   hh : mm : ss”
19 digits or greater: “YYYY - MM - DD   hh : mm : ss”

Trend sampling
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8.7 Zooming in/out (Trend Sampling)
Overview

With switches or external commands, a currently displayed graph can be zoomed in to a magnification 
of 2, 4 or 8 times.
Each time the magnification is doubled, the number of X-axis data points is halved.*

* Depending on the number of X-axis data points, however, the number will not be halved.  For more 
information, refer to “Limitations” page 8-18.

Example: Same size →  Magnified by 2 times 
• Cursor displayed

Magnification centered on cursor

0

20

40

60

80

100

0

20

40

60

80

100

1

2

3

76
4

5

8

1211

10

9 13

14

(7)(6)
(4)

(5)

(8)

(10)

(9)

Zoom out

Zoom in

Magnified by 2 times 
(Number of X-axis data points: 7) 

Zoom 
in

Zoom 
out

Cursor

To be zoomed in

Magnification by up to 8 times allowed

Press once.

Transfer “1” to the 
command memory.

Same size (Number of X-axis data points: 14) 

PLC

or
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• No cursor displayed
Magnified with the newest (end) sampling point in the rightmost position

* Immediately after sampling start (sampling data count on the graph is less than the specified 
number of X-axis data points), the graph is zoomed in from point 1 (the oldest sampling point).

Applicable Items

• Trend sampling

0

20

40

60

80

100

0

20

40

60

80

100

1

2

3

76
4

5

8

1211

10

9 13

14

(11)

(10)

(8)

(9)

(12)

(14)

(13)

Same size (Number of X-axis data points: 14) 

Magnified by 2 times 
(Number of X-axis data points: 7) 

Newest sampling point (End point)

Zoom 
in

Zoom 
out

Magnification by up to 8 times allowed

PLC

Zoom out

Zoom in

Press once.

Transfer “1” to the 
command memory.

or

To be zoomed in

Same size Magnified by 2 times

Number of X-axis data points: 7 

Zoom in

Example: Number of X-axis data points: 14 (same size) 

Point 1 = Oldest sampling point

To be 
zoomed in
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Setting Items

• Open the [Detail] tab window in the item dialog.  Check [Internal] or [External] for [Command].  

Command • Internal
A switch is used to zoom in or out the graph.
Zoom in: same size → 2 times  → 4 times  → 8 times 
Zoom out: 8 times → 4 times  → 2 times  → same size

• External
The graph is zoomed in or out according to the value specified in the 
command memory.

Command Memory This setting is valid only when [External] is selected for [Command].
The graph will be zoomed in to a magnification of the following.

0: Same size
1: 2 times
2: 4 times
3: 8 times

Process Cycle
(High Speed, Low 
Speed, Refresh)

Specify the command memory read cycle.  Redrawing of the graph occurs at 
the following times:

• High Speed
Every cycle

• Low Speed
• Once in several cycles
• One cycle when the screen is opened
• At the leading edge (OFF → ON) of bit 15 (data read refresh) in read 

area “n + 1”
For more information, refer to the V8 Series Reference Manual.

• Refresh
• At the leading edge (OFF → ON) of bit 15 (data read refresh) in read 

area “n + 1”
For more information, refer to the V8 Series Reference Manual.

• Macro command TREND_REFRESH
For more information, refer to the V Series Macro Reference Manual.
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• Switch part ([Command: Internal])
• [Function: Zooming in or Zooming out]

• Select the same number as the trend sampling ID number.

Trend Sampling Area and Plot Points

• If a plot point pitch calculation leaves a remainder, depending on the X size of the trend sampling 
display area and the number of X-axis data points, a blank area will be created on the graph.

Calculate the equation below to obtain the plot point pitch.  (Minimum plot point pitch: 1 dot)
Calculation: Plot point pitch = X size ÷ (Number of X-axis data points − 1)

After setting the number X-axis data points, correct the X size of the trend sampling display area 
to eliminate the blank area.

Trend 
sampling

X size: 270
Plot point pitch: 67

Example:  Display area: 270 dots, Direction: RGT
 270 ÷ (5 − 1) = 67, remainder 2
The plot point pitch is 67 dots and the remainder (2 dots) creates a blank area.

Display area

Blank area: 2 

Magnified 
by 2 times

Unit: Dots 

Number of X-axis data points: 10 Number of X-axis data points: 5
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Limitations

• If the number of X-axis data points before zooming in/out is odd, the number after zooming in/out 
will be rounded up.

• The minimum number of the X-axis data points is 3. 
If a magnification in which the number of X-axis points is less than 3 is specified, the magnification 
will be adjusted so that the number of X-axis data points becomes 3.

• [Command: Internal]
• The graph will be restored to the same size when the following actions are taken:

- Turning off and back on the power
- Switching between the RUN mode and the Main Menu screen 
- Switching the screen
- Redisplaying the screen (by the macro command RESET_SCRN or item showing/hiding)

• Operating the zoom-in or zoom-out switches are not recorded in operation logs.

• [Command: External] 
• If any value other than 0 to 3 is specified in the command memory, the graph will initially be 

displayed in the same size.
However, if any value other than 0 to 3 is specified in the command memory for a graph after 
zooming in, its display will not change.

• If trend sampling graphs assigned with the same external command memory address are 
placed on one screen, they will be zoomed in or out at the same time.  Assign different 
command memory addresses to individual trend sampling graphs.

Same size
(6)

2 times
(3)

4 times
(-)

8 times
(-)

Example 1: Number of X-axis data points :6 

Numbers of X-axis data points are parenthesized.

Magnification by 4 times or higher disabled

Same size
(15)

2 times
(8)

4 times
(4)

8 times
(3)

Example 2: Number of X-axis data points: 15

The number of X-axis data points will be 3 (e.g., the minimum 
value) when a magnification of 8 times is specified.

Pressing the zoom-in switch 
sounds an error beep.
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8.8 Graph Show/Hide Function (Trend Sampling)

Overview

It is possible to arbitrarily show or hide trend sampling graph lines registered with a screen.  Showing 
or hiding graph lines can be easily changed as necessary, depending on the operating conditions.

Applicable Items

• Trend sampling

Setting Items

• [ Use Control Memory] in the [Trend Sampling] dialog →  page 8-20
(For trend sampling setting instructions, refer to the Reference Manual provided separately.)

80.9

9.05

46.2

28.0

80.9

9.05

46.2

28.0

ON

ON

ON

ON

ON

ON

OFF

OFF

Temperature A

Temperature B

Temperature C

Temperature D

Trend sampling screen Trend sampling screen

Temperature A

Temperature B

Temperature C

Temperature D
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Setting Procedure

In this section, a graph that shows four lines (Nos. 0 - 3) is used and how to show only two of them 
(graph Nos. 0 and 1) with the PLC memory address D10000 is explained.

1. Click on the trend sampling display area to display the item dialog.

2. Open the [Detail] tab window and check [ Use Control Memory].  Select the PLC memory 
address D10000.  

Use Control 
Memory
(Word designation)

This memory address is associated with showing or hiding graph line 
Nos. 0 - 15.
Each graph line is shown and hidden when the corresponding bit is set 
(ON) and reset (OFF).

15 • • • • • • • • • • • • • • • • • • 04 03 02 01 00

Graph line No. 0

LSBMSB

Graph line No. 15

Graph line No. 1

Graph line No. 2

Graph line No. 3

1: Show
0: Hide
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3. Transfer the screen data to the V8 series.
When bits 0 and 1 are set (ON) at D10000, only graph line Nos. 0 and 1 are drawn.

Limitations

• If memory designation has been selected for [Scale Max.] and [Scale Min.] of reference lines and 
for [Graph Max. Value] and [Graph Min. Value] of graph lines, and also if changes are made to the 
values at the designated addresses, graph redrawing does not occur even at the time of setting or 
resetting the bits in the control memory.  Use the macro command TREND_REFRESH* instead.

* For more information on the macro, refer to the Macro Reference Manual provided separately.

• If memory designation has been selected for [Reference Line], the process cycle set in the [Detail] 
tab window takes effect.

* When [  Use Control Memory] is not checked, the update timing depends on [High Speed] for 
[Process Cycle].

• When [  Use Control Memory] is set, this setting is counted as one of the number of memory 
locations that is permitted for one screen.

* For more information on the number of permissible memory locations, refer to the V8 Series 
Operation Manual.

• Even if all the graph lines are hidden with the use of [  Use Control Memory], the switches for 
[Roll Up], [Roll Down],[+ Block], [− Block] and [Graph Return] work.

• Even if all the graph lines are hidden with the use of [  Use Control Memory], and if any cursor 
movement has been made with the [Roll Up], [Roll Down], [+ Block], or [− Block] switches, any 
variation in cursor point is retained (however, the point is not shown).

• When graph line showing or hiding is implemented with the use of [  Use Control Memory], 
flickering associated with graph redrawing will occur momentarily.

Process Cycle
(High Speed, Low 
Speed, Refresh)

Specify the command memory read cycle.  Redrawing of the graph occurs 
at the following times:

• High Speed
Every cycle

• Low Speed
• Once in several cycles
• One cycle when the screen is opened
• At the leading edge (OFF → ON) of bit 15 (data read refresh) in 

read area “n + 1”
For more information, refer to the V8 Series Reference Manual.

• Refresh
• At the leading edge (OFF → ON) of bit 15 (data read refresh) in 

read area “n + 1”
For more information, refer to the V8 Series Reference Manual.

• Macro command TREND_REFRESH
For more information, refer to the V Series Macro Reference 
Manual.
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9 Alarm Function
The alarm function in the V8 series is provided with new features: parameter addition and alarm 
acknowledgement.

9.1 Parameter Addition Function
Overview

In the event of an alarm, the data associated with its occurrence can be displayed together with the 
alarm message.  Logging the history of such alarm-relevant data will help you locate and investigate 
the causes of alarms.

Touch!!

YAMADA SATO

MJ1

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

65.0

A B

Thermal error!

Material shortage!

The corresponding alarm bit is set.

Example: An alarm on September 24 

Worker change

Temperature control memory D2
PLC memory D100
PLC memory R0

: PV value 65°C
: Worker SATO
: Material 80 g

Temperature rise of Tank-A  65°C 08/9/24    8:12:40

Worker change  Worker: YAMADA → SATO 08/9/24  17:00:00

Lack of materials  80g 08/9/24  15:15:43

Abnormality of conveyor A-Line 08/9/24  19:59:15
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Applicable Items

• Alarm tracking
• Time order alarming
• Alarm logging

Setting Items

• Alarm tracking
Time order alarming
Alarm logging → Refer to the Reference Manual.

• Buffering area → page 9-3
• Message edit → page 9-7

This chapter describes the settings for the additional alarm function in conjunction with the use of 
alarm tracking.

Alarm display example when [Record Parameters] is not checked

Alarm display example when [Record Parameters] is checked

Temperature rise of Tank-A  65°C 08/9/24    8:12:40
Lack of materials  80g 08/9/24  15:15:43
Worker change  Worker: YAMADA → SATO 08/9/24  17:00:00
Abnormality of conveyor A-Line 08/9/24  19:59:15

Temperature rise of Tank-A 08/9/24    8:12:40
Lack of materials 08/9/24  15:15:43
Worker change 08/9/24  17:00:00
Abnormality of conveyor A-Line 08/9/24  19:59:15
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Buffering Area Setting

1. Select [System Setting] → [Buffering Area Setting] → [Others].

* For the determination of the size of the primary storage, refer to “Buffer size calculation for the 
use of parameters and the alarm acknowledge function” page 9-17.

2. Check [ Record Parameters].

Record Parameters Check this box when using parameters.

Word Count This field shows the number of words used for parameters.*
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3. Open the [Discrete memory/CSV format] tab window.
Sliding the scroll bar to the right allows you to view the [Parameter] column.

4. Double-click the box under [Parameter] for your desired message.  The [Parameter Table] dialog 
appears.

The items which can be set depends on the selection under [Display Type].

Parameter
(Yes/None)

Select either option for each message.  Double-clicking the box 
under [Parameter] calls up the [Parameter Table] dialog.

Shows the selected message. Adds a new parameter.

Moves the selection one line above the currently selected line.

Deletes the selected parameter.

Moves the selection one line 
below the currently selected line.

Selected line

No. A maximum of eight parameters can be registered.
No. 0 to 7

Memory Specify the memory address assigned to the parameter.
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Display Type Numerical Data:
Text:

Message No.:

Bit:

This option is for the display of data at the memory address.
This option is for the display of the text set at the memory 
address.
This option is for the display of a message according to a 
designated message number (absolute address) that is 
already registered.
When the bit is set (ON), the message specified under 
[Message No.] is displayed.  When the bit is reset (OFF), 
the next message (corresponding to the number of 
[Message No.] plus one) is displayed.

Data Length Specify the length of the data stored at the address set under [Memory].
1-Word/2-Word

Input Format Select the code to be used at the time of data reading.
DEC/BCD/FLOAT

Display Format Select the format of the data to be displayed.
DEC (w/o sign) / DEC (with sign -) / DEC (with sign +-) / HEX / OCT / BIN (binary) 
/ Real Number Type

Digits Specify the number of digits.
1 to 32

Decimal Point Specify the number of decimal places.  When no decimal point is required, set 
“0”.
0 to 31

Zero Suppress Select whether to execute zero suppress.
(Example: 5-digit numeral display  123;  without zero suppress: 00123)

Message No. Specify the message G number and message number you wish to display.
Message GNo. 0 to 127, Message No. 0 to 255

Char. Place Select either flush right or flush left for text display.
Flush Right/Flush Left

Characters Specify the number of characters.
1 to 127

Text Process Set the recognition of MSB and LSB in one word.
LSB → MSB, MSB → LSB
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5. When the settings have been completed in the [Parameter Table] dialog, click [OK] to close it.
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Message Edit

1. Double-click the area enclosed in the red box as shown below.

2. The [Message Edit] window is displayed.
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3. According to the parameter numbers registered in the [Parameter Table] dialog, specify those 
numbers in the [Message Edit] window.

%PxS
Specify a parameter No. 0 to 7 as registered in the [Parameter Table] dialog.

Go to the [Parameter Table] dialog to see the registered parameter numbers.

Double-click

Parameter numbers 
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Limitations

• When the parameter settings have been made with Windows fonts, parameter symbols (%PxS) 
are shown as they are in the alarm messages to be displayed.

• For parameter Nos. 0 to 7 specified in the [Parameter Table] dialog, the maximum allowable 
number of words is 128 (automatically calculated*).  Be sure to use 128 or fewer words in total.

* To see the number of words used, check “Record Parameters” in “Buffering Area Setting” page 
9-3.

• In the event of a failure to read parameter memory, “****” is displayed in place of the parameter in 
the message.

• If [Message No.] is selected for [Display Type] in the [Parameter Table] dialog and if the 
corresponding message includes parameter symbols, the symbols “%PxS” appear as they are 
when the message is displayed.

• If [Total Frequency of Occurrence Display] or [Total Time of Occurrence Display] is selected for 
alarm history display, the parameter symbols in alarm messages are displayed as “****”.

• If changes are made to the data in the [Parameter Table] dialog, such as the number of 
parameters, the order of parameters, or the assigned memory addresses, after the execution of 
data sampling and then if screen data transfer is performed in this condition, the data previously 
sampled may not be displayed correctly on the screen.  Whenever any changes as mentioned 
above have been made, formatting is required before sampling start.

• Real-time printing of alarm logging data will show parameters as “****”.
• In the case of alarm logging, the parameters will be displayed to indicate alarm bit set (ON) and 

reset (OFF) conditions.
• When [Occurrence/Cancellation Time] is selected for the history display associated with alarm 

tracking, the parameters will not be displayed for alarm bit reset (OFF) conditions.
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9.2 Acknowledge Function
Overview

In the event of an alarm, the data associated with its occurrence, such as when the alarm was caused 
and reset, can be displayed together with the alarm message.  Through the use of the acknowledge 
switch, when the alarm was acknowledged can also be displayed.  Additionally, a distinction between 
acknowledged and unacknowledged messages is drawn in the display of alarm messages.

• The [Acknowledge All] switch enables you to acknowledge all alarm messages and show their 
acknowledged time.

• The [Selective Acknowledge] switch enables you to acknowledge the selected alarm message and 
show its acknowledged time.

08:30:45 
10:45:18  10:51:32 

#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

08:30:45 
10:45:18  10:51:32 

#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

11:32:01 
11:32:01  

Acknowledge 
All

Occurrence 
time

The color of all the messages turns to 
the color for acknowledgement and the 
acknowledged time appears.

Reset 
time

Acknowledged 
time

Selective 
Acknowledge

Press the [Acknowledge All] switch.

Occurrence 
time

Reset 
time

Acknowledged 
time

Selective 
Acknowledge

Acknowledge 
All

10:51:32 
#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

08:30:45 
10:45:18  10:51:32 

#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

11:32:01 
11:32:01  

08:30:45 
10:45:18  

The color of the selected messages turns 
to the color for acknowledgement and the 
acknowledged time is shown.

Select a message with the scroll switch and 
press the [Selective Acknowledge] switch.

Occurrence 
time

Reset 
time

Acknowledged 
time

Selective 
Acknowledge

Acknowledge 
All

Occurrence 
time

Reset 
time

Acknowledged 
time

Selective 
Acknowledge

Acknowledge 
All
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Applicable Items

• Alarm tracking

Setting Items

• Alarm tracking → page 9-11
• Buffering area → page 9-14
• Message edit → Refer to the Reference Manual.
• Acknowledge switch →  page 9-15

Alarm Tracking

1. Go to the [Alarm Tracking] dialog and open the [Main] tab window.  

2. Check the box for [  Acknowledge function].

 Acknowledge function Check this box when using the acknowledge function.
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3. Go to [History Display] and select an option of time information that will be shown with alarm 
messages.

* [History Display] options

History Display* Select an option for time information you wish to display with alarm messages.

When the [  Acknowledge function] is checked, the options 
[Occurrence/Confirmation Time] and [Occurrence/Cancellation/Confirmation 
Time] become additionally selectable.

09/ 2/ 2    08:30:45 
09/ 2/ 2    10:45:18  
09/ 2/ 8    12:11:03
09/ 2/ 9    00:17:58

09/ 2/ 2    11:34:00
09/ 2/ 2    11:34:00 

#2 Roller error
#1 Sensor error
#2 Sensor error
#1 Roller error

[Occurrence/Confirmation Time]

Confirmation TimeOccurrence time

When there are messages which are not acknowledged yet, 
asterisks ∗ are displayed in their time fields.

09/ 2/ 2   08:30:45 
09/ 2/ 2   10:45:18  
09/ 2/ 8   12:11:03
09/ 2/ 9   00:17:58

09/ 2/ 2   10:51:32 

09/ 2/ 9   00:22:15

09/ 2/ 2   11:34:00
09/ 2/ 2   11:34:00 

#2 Roller error
#1 Sensor error
#2 Sensor error
#1 Roller error

When there are alarms which are not reset yet, 
asterisks ∗ are displayed in their time fields.

Occurrence time

[Occurrence/Cancellation/Confirmation Time]

Confirmation TimeCancellation time

When there are messages which are not acknowledged 
yet, asterisks ∗ are displayed in their time fields.
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4. Open the [Style] tab window.

*1 This is settable when [ Acknowledge function] is checked in the [Main] tab window.
*2 This is not settable if [ Windows Font] is checked.

The color selected in the [Message Edit] window takes effect instead.

5. Select your desired colors under [Color Setting] for the display of alarm messages and time 
information.

Color Setting*1

(Unacknowledged 
Occurring/
Unacknowledged After 
Reset/
Acknowledge Occurring/
Acknowledge After 
Reset)

Four colors can be set to display alarm messages, depending on 
the status.

Unacknowledged Occurring*2:
Select a color used to display an occurring alarm, for which the 
acknowledge switch is not pressed yet.

Unacknowledged After Reset:
Select a color used to display a reset alarm, for which the 
acknowledge switch is not pressed yet.

Acknowledge Occurring:
Select a color used to display an occurring alarm, for which the 
acknowledge switch is already pressed.

Acknowledge After Reset:
Select a color used to display a reset alarm, for which the 
acknowledge switch is already pressed.
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Buffering Area Setting

1. Select [System Setting] → [Buffering Area Setting] → [Others].

2. Check the box for [  Alarm Acknowledge function].

Alarm Acknowledge 
function

Check this box when using the alarm acknowledge function.
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Acknowledge Switch

1. Follow the steps below to place an acknowledge switch.

2. Open the [Main] tab window in the [Switch] dialog.  

3. Select [Acknowledge] under [Function].

4. In the [Switch] dialog, open the [Detail] tab window.  

Function Description

Acknowledge Alarm acknowledged times can be displayed in the alarm tracking area.

Selective Acknowledge:
For a selected alarm message, this switch is used to acknowledge the 
message and to show the acknowledged time.

Acknowledge All:
For all the displayed alarm messages, this switch is used to 
acknowledge the messages and to show the acknowledged time.

ID
(0 to 255)

Set the same number as the ID number of the alarm tracking item.
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Example

When the acknowledge function is used, message and time display can have the following four 
conditions:

As an example, the following colors are selected for the message and time display.
A: An alarm is occurring but the acknowledge switch is not pressed yet: black
B: An alarm is reset but the acknowledge switch is not pressed yet: green
C: An alarm is occurring and the acknowledge switch is pressed: red
D: An alarm is reset and the acknowledge switch is pressed: blue

If an alarm occurs and the [Acknowledge All] switch is not pressed, the alarm message is displayed in 
black.  When the alarm is reset afterwards, the message turns green.

When the [Acknowledge All] switch is pressed, the color of the occurring alarm message changes from 
black to red.  
Once the alarm is reset, the message color changes from green to blue.  

1

0

1

0

08:30:45 
10:45:18  10:51:32 

#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

←

(black)
#2 Roller error
Alarm occurrence

Acknowledge 
All

#1 Sensor error
Reset after the alarm 
occurrence

(green)

Alarm occurring but the 
acknowledge switch not 
pressed for it

← Alarm reset but the 
acknowledge switch not 
pressed for it

1

0

1

0

08:30:45 
10:45:18  10:51:32 

#2 Roller error
#1 Sensor error

DWUP -+ DELRET RESET

11:32:01 
11:32:01  

←

(red)

(blue)

        ↑  
[Acknowledge All] switch pressed

← [Acknowledge All] switchAcknowledge 
All

Alarm occurring and the 
acknowledge pressed for it

← Alarm reset and the 
acknowledge switch 
pressed for it
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Limitations

• A displayable alarm acknowledged time ranges from the time of alarm occurrence until the time 
65,535 seconds (18 hours approximately) at the maximum elapse.  If you press the acknowledge 
switch after a lapse of 65,535 seconds or longer, the time to be displayed then is the occurrence 
time plus 65,535 seconds.

• If there is an occurring alarm, for which the acknowledge switch is not pressed yet, and if 
[Occurrence/Cancellation/Confirmation Time] has already been selected for [History Display], the 
alarm reset and acknowledged times will be displayed as “-----” at the time of rebooting the V8 unit 
or change to the Main Menu screen.  Even if you press the acknowledge switch in this state, the 
acknowledged time is not displayed.

Buffer size calculation for the use of parameters and the alarm acknowledge function
The size of the primary storage can be calculated with the equations below.

A: Number of parameter words, B: Number of sampling times, C: Number of sampling words

*1 The addition is performed when [ Memorize initial value] is checked.
*2 The addition is performed when [ Acknowledge function] is checked.
*3 The addition is performed when [ Add Time Order Alarming] is checked.
*4 The addition is performed when [ Add Time Order Alarming] and also [ Acknowledge 

function] are checked.
*5 The addition is performed when [ Record Parameters] is checked.
*6 The addition is performed when [ Add Time Order Alarming] and also [ Record 

Parameters] are checked.

C

BA

Type Sampling 
Method

Equation for capacity calculation

Alarm Alarm Logging {(3 + A + 1 *5) × B} +C *1

Time Order 
Alarming

{(5 + A + 1 *5) + 1 *2} × C × 16

Alarm 
Tracking

{(5 + A + 1 *5) + 1 *2) × B}
+ {((6  + A + 1 *6)   + 1 *4  + 2 *3) × C × 16)} + (7 + C *1)
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10 RGB Display
10.1 Touch Switch Emulation

Overview

With the earlier version of V-SFT, when screen data is displayed on the V8i series by using the RGB 
display function with two computers connected, the touch switch emulation function is available only 
with the one computer connected to “5CH”.
With the version of 5.4.8.0 or later, touch switch operation becomes possible for the two computers at 
the same time by using modular jacks (MJ1/MJ2).
You can operate each computer on MONITOUCH according to different purposes, such as viewing 
data stored by a user on the computer, operating the server computer for maintenance, etc.

* Only “GU-11” (option unit) is equipped with two channels.

MJ1MJ2

RGB-IN1RGB-IN2

V-CP

V-CP

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

V8i

(Server computer)

(Checking the production status)

Checking the 
production statusServer computer

GU-11 (option)

(CH5)(CH6)
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Operating Environment

V8
Applicable models

* For more information on adjustment of the RGB display position, refer to the V8 Series 
Reference Manual provided separately.

Computer
Applicable OS

Microsoft Windows 98/95/NT4.0/2000/Me/2000/XP

Touch panel driver settings
For more information on the touch panel driver, refer to “Chapter 14” in the V8 Series Reference 
Manual provided separately.

V-SFT Setting
How to display the RGB screen → Refer to the V8 Series Reference Manual 

provided separately.
How to enable 2 channels for touch switches → page 10-3

MONITOUCH Model Port Color Option Unit

V815iX/V812iS
V810iS/V810iT/V808iS

MJ1/MJ2 32k or more colors GU-11
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V-SFT Setting

1. Select [System Setting] → [Device Connection Setting] and select [Touch Switch].

2. Check the boxes for [ Use Touch Switch] and [ 2 Port].

3. Select an option for [Connect to:]

* Do not uncheck the box for [  Use Default Comm. Parameter Setting].

Limitations

• When the touch switch emulation of the RGB display function and the remote desktop window 
display function are used at the same time, a USB mouse cannot be used for the remote desktop 
window.

Both MJ1 and MJ2 must be used.
If either port is used for other purpose, this setting is not available.

GU-11 (Option Unit) V-SFT Setting Connection Port

RGB-IN1 Touch Switch (CH5) MJ1/MJ2

RGB-IN2 Touch Switch (CH6)
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10.2 Enlarged Display
Overview

Previously in the case of RGB display by signal input on the V8i series under control bit 12 in the read 
area “n + 1” or the macro command “SYS (SET_RGB)”, the display could be produced only at the 
same magnification regardless of the resolution of the V8i series.  If the V8i series is higher than your 
computer in resolution, therefore, the unit shows the RGB display at the center surrounded with 
margins colored black.
With the enlarged display feature newly made available, an RGB display can be the full-screen size, 
with the solution higher than that of the computer.

Applicable Models

MONITOUCH Model Color Option Unit

V815iX/V812iS
V810iS/V810iT/V808iS 32k or more colors GU-01/GU-10/GU-11

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

Display at the same magnification

Enlarged display

Computer

VGA (640*480)

SVGA (800*600)

SVGA (800*600)

Example: Display from a computer (VGA (640*480)) →  V812iS (SVGA (800*600)):

Margins 
colored black

RGB display by 
signal input
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Setting

1. Click [System Setting] → [Unit Setting] → [Video/RGB].  The [Video/RGB Settings] dialog is 
displayed.

2. Go to [at full-screen] and select [Enlarge].

* For RGB display by signal input and other settings, refer to the V8 Series Reference 
Manual.

Notes

Enlarged display is allowed when switching to the RGB display by signal input is executed at either 
command below.

• Bit 12 in read area “n + 1” → See the V8 Series Reference Manual
• Macro command “SYS (SET_RGB)” →  See the Macro Reference manual.

For full-screen display with RGB display items:
Go to the [Video/RGB Display] dialog.  In the dialog, set [Display Size: Free] and check 
the checkbox of [  Fit to display area]. 
For more information, refer to the V8 Series Reference Manual.

[Same size] selected by default 
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10.3 Size Adjustment
Overview

Even if the signal frequency from the computer is suitable for the V8 series, an RGB display by signal 
input produced on the V8 series may be cut at the side edge because of the difference in BIOS screen 
width.    
If this kind of problem is encountered, a size adjustment to the width is easy to perform on the RGB 
Adjustment screen.  The clip start position remains the same even after the width adjustment.  This 
feature assures adjustments in a smooth manner.

Applicable Models

MONITOUCH Model Color Option Unit

V815iX/V812iS
V810iS/V810iT/V808iS 32k or more colors GU-01/GU-10/GU-11

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

ROM PCI/ISA BIOS (2A69KA1E)
        COMS SETUP UTILITY
     AWARD SOFTWARE, INC.

LOAD SETUP DEFAULTS
LOAD BIOS DEFAULTS
PASSWORD SETTING
IDE HARD DISK DETECTION
SAVE & EXIT SETUP
EXIT WITHOUT SAVING

CPU Name, Type. Speed...

I I CPU SOFT MENU
STANDARD CMOS SETUP
BIOS FETUREES SETUP
CHIPSET FETURES SETUP
POWER MANAGEMENT SETUP
PNP, PCI & ONBOAD I/O

Esc : Quit
F10 : Save & Exit Setup

ROM PCI/ISA BIOS (2A69KA1E)
        COMS SETUP UTILITY
     AWARD SOFTWARE, INC.

LOAD SETUP DEFAULTS
LOAD BIOS DEFAULTS
PASSWORD SETTING
IDE HARD DISK DETECTION
SAVE & EXIT SETUP
EXIT WITHOUT SAVING

CPU Name, Type. Speed...

I I CPU SOFT MENU
STANDARD CMOS SETUP
BIOS FETUREES SETUP
CHIPSET FETURES SETUP
POWER MANAGEMENT SETUP
PNP, PCI & ONBOAD I/O

Esc : Quit
F10 : Save & Exit Setup

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

ROM PCI/ISA BIOS (2A69KA1E)
        COMS SETUP UTILITY
     AWARD SOFTWARE, INC.

LOAD SETUP DEFAULTS
LOAD BIOS DEFAULTS
PASSWORD SETTING
IDE HARD DISK DETECTION
SAVE & EXIT SETUP
EXIT WITHOUT SAVING

CPU Name, Type. Speed...

I I CPU SOFT MENU
STANDARD CMOS SETUP
BIOS FETUREES SETUP
CHIPSET FETURES SETUP
POWER MANAGEMENT SETUP
PNP, PCI & ONBOAD I/O

Esc : Quit
F10 : Save & Exit Setup

Computer

RGB display screen

Adjust the width with the 
function switches [F5] and 
[F6].

The side edge is cut.

Fully displayed

RGB display by 
signal input
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Adjustment

Location for Setting

The size of the width is adjustable with the function switches [F5] and [F6].  

* The display position is adjustable with the function switches [F1] through [F4].
For more information, refer to the V8 Series Reference Manual.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

A BIOS (2A69KA1E)
SETUP UTILITY
SOFTWARE, INC.

LOAD SETUP DEFAULTS
LOAD BIOS DEFAULTS
PASSWORD SETTING
IDE HARD DISK DETECTION
SAVE & EXIT SETUP
EXIT WITHOUT SAVING

me, Type. Speed...

[F5]

Completes an adjustment and 
causes a return to the RGB 
Adjustment screen.

[F6]

[F7]

RGB display for adjustment

Function Switch Function

[F5] Decreases the width by one dot.

[F6] Increases the width by one dot.

[F7] Restores the display to the default. 
When any adjustment made has been saved with the [Save] 
button on the RGB Adjustment screen, this switch brings up the 
screen as adjusted.
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Adjustment Procedure
1. Allow the computer to show the BIOS screen in advance.

2. On the Main Menu screen, press the [RGB Adjustment] button to open the RGB Adjustment 
screen. 

3.  On the RGB Adjustment screen, press the [Adjustment] button under [Setting 1] to switch the 
screen to the RGB display under the BIOS screen.  

4. Decrease the width dot by dot with the function switch [F5].

5. When the width adjustment is complete, press the [SYSTEM] switch.  The RGB Adjustment screen 
is displayed again.
The [Used] lamp for [Setting 1] comes on.

6. Press the [Save] button to save the adjustment.
(Because the setting for adjustment is stored into the flash ROM, it is retained when the power is 
turned off and on.)

The necessary settings have been completed.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

ROM PCI/ISA BIOS (2A69KA1E)
        COMS SETUP UTILITY
     AWARD SOFTWARE, INC.

LOAD SETUP DEFAULTS
LOAD BIOS DEFAULTS
PASSWORD SETTING
IDE HARD DISK DETECTION
SAVE & EXIT SETUP
EXIT WITHOUT SAVING

CPU Name, Type. Speed...

I I CPU SOFT MENU
STANDARD CMOS SETUP
BIOS FETUREES SETUP
CHIPSET FETURES SETUP
POWER MANAGEMENT SETUP
PNP, PCI & ONBOAD I/O

Esc : Quit
F10 : Save & Exit Setup

RGB Adjustment screen RGB display (for adjustment)

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

ROM PCI/ISA BIOS (2A69KA1E)
        COMS SETUP UTILITY
     AWARD SOFTWARE, INC.

LOAD SETUP DEFAULTS
LOAD BIOS DEFAULTS
PASSWORD SETTING
IDE HARD DISK DETECTION
SAVE & EXIT SETUP
EXIT WITHOUT SAVING

CPU Name, Type. Speed...

I I CPU SOFT MENU
STANDARD CMOS SETUP
BIOS FETUREES SETUP
CHIPSET FETURES SETUP
POWER MANAGEMENT SETUP
PNP, PCI & ONBOAD I/O

Esc : Quit
F10 : Save & Exit Setup

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

ROM PCI/ISA BIOS (2A69KA1E)
        COMS SETUP UTILITY
     AWARD SOFTWARE, INC.

LOAD SETUP DEFAULTS
LOAD BIOS DEFAULTS
PASSWORD SETTING
IDE HARD DISK DETECTION
SAVE & EXIT SETUP
EXIT WITHOUT SAVING

CPU Name, Type. Speed...

I I CPU SOFT MENU
STANDARD CMOS SETUP
BIOS FETUREES SETUP
CHIPSET FETURES SETUP
POWER MANAGEMENT SETUP
PNP, PCI & ONBOAD I/O

Esc : Quit
F10 : Save & Exit Setup

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

31540
70
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10.4 Addition of Adaptive Frequencies
RGB display by signal input can be produced at the following frequencies:

* For more information on RGB display, refer to the V8 Series Reference Manual.

Limitations

• The width (640 dots) varies with devices connected.
Make a size adjustment to the width according to your device in use.  For more information on the 
adjustment procedure, refer to “10.3 Size Adjustment”.

• The display position is adjustable with the function switches [F1] through [F4].
For more information on the adjustment procedure, refer to the V8 Series Reference Manual.

• A screen display will not be correctly produced if the input signal is at any unsuitable frequency.  
(This is also the same where [  Check signal changes while displaying RGB input] is checked in 
the [General Settings] tab window ([System Setting] → [Unit Setting]).  
If an input signal at an adaptive frequency is detected, however, a screen display is produced 
under the signal.

Connected Device
Picture 

Element No. 
(Dots)

Horizontal 
(kHz) Vertical (Hz) Remarks

PC-9801 640 × 400 24.826 56.422

VESA  640 × 480  60 Hz 640 × 480 31.469 59.94

VESA  640 × 480  72 Hz 640 × 480 37.861 72.809

VESA  640 × 480  75 Hz 640 × 480 37.5 75.0

VESA  640 × 480  85 Hz 640 × 480 43.269 85.008

VESA  800 × 600  56 Hz 800 × 600 35.156 56.250

VESA  800 × 600  60 Hz 800 × 600 37.879 60.317

VESA  800 × 600  72 Hz 800 × 600 48.077 72.188

VESA  800 × 600  75 Hz 800 × 600 46.875 75.0

VESA  800 × 600  85 Hz 800 × 600 53.674 85.061

VESA  1024 × 768  60 Hz 1024 × 768 48.363 60.004

640 × 400  70 Hz 640 × 400 31.540 70.0 BIOS screen
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1111 Scroll Bar
Overview

• You can bring portions of messages or JPEG data that lie off screen into view by using a scroll bar.
• A maximum of 1024 parts* (192 parts* for the V806 series) can be placed on one screen.

* Including switches and slide switches

Position to be pressed and data write timing
• The scroll bar works when either the slide switch or the rail is pressed.
• When you remove your finger from the slide switch (or the rail), a value is written and the slide 

switch is moved at the same time.

Display for slide switch movement
• While you are moving your finger to move the slide switch, only the line indicating the position of 

the switch you are moving is displayed.  The slide switch does not move together with your finger.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Scroll the screen by moving the slide switch or 
pressing a desired point on the rail.

Moving

Slide switch
RailLine
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Applicable Items

* The scroll direction depends on the [Direction] setting in the [Trend Sampling] dialog.
[UP] [DW]: vertical direction, [RGT] [LFT]: horizontal direction

Setting Procedure

This section describes the settings for the scroll bar in conjunction with the use of JPEG display.

Select [Parts] → [Parts List] to display the [Parts List] window.
Select [Scroll Bar] in the drop-down list*.  Select a part and drag it onto the screen with the mouse.

Item Scroll direction

JPEG display Vertical and horizontal

Bit order alarming and alarm sub-display Vertical and horizontal

Message mode Vertical and horizontal

Trend sampling Vertical or horizontal*

Alarm logging Horizontal

Time order alarming Horizontal

Alarm tracking Horizontal

Memory card mode Vertical and horizontal

Recipe Vertical and horizontal
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11* A part can also be placed by selecting [JPEG Display] in the drop-down list and dragging each 
item onto the screen.

Setting Dialog
[Main] tab window

[Style] tab window

* Parts change can be executed by selecting an option in the [Modify Part] window.
Select a scroll bar and select [Edit] → [Change Part] → [Modify Part].  The dialog shown below is 
displayed.  Select [Edit a rail] or [Edit a slider].

Direction
(UP, DW, RGT, LFT)

Select a sliding direction.

Edit Parts
(Rail + Slide, Rail, 
Slide)

Select the part whose 
design is to be changed.

Color Change the color of the part which is selected for [Edit Parts].
(This is valid only when [Rail] or [Slide] is selected.)

Change Part* Press this button to apply changes to the part selected for [Edit Parts].
For more information, refer to “3.6 Parts” in the V8 Series Operation 
Manual.

RailSlide
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[Detail] tab window

Limitations

• Scrolling is performed in dots.
• A JPEG file with an XGA (1024 × 768 dots) resolution can be displayed at the maximum.
• In the case of alarm tracking, only alarm messages can be scrolled horizontally.  The date and time 

fields cannot be scrolled.
• In the case of the recipe mode, as many rows and columns as displayed can be scrolled in units of 

a row or a column.
• If multiple scroll bars provided with the same ID, which do not link to items, are placed, the scroll 

bar at the front takes effect.

Process Cycle
(High Speed, Low 
Speed, Refresh)

Set a cycle for the PLC to read the PLC data while it is communicating with 
the V8 series.  For more information, refer to “Appendix 5 Process Cycle” in 
the V8 Series Reference Manual.

ID
(0 to 255)

Set the same number as the ID number of the JPEG display item.

Set the same 
ID numbers.
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12 Data Sheet Print (Expanded)
Overview

The parts that are usable on data sheet screens are limited to data display parts (for numerical data 
and characters) and graphic parts (text, lines, and boxes).  Layouts of parts are also limited on data 
sheet screens because parts are not freely changeable in size and require being placed along the 
grids.
With the expanded functions of data sheet explained in this chapter, you can use additional parts, such 
as lamps and graphs, and change the sizes of those parts.  Moreover, the expanded functions allow for 
parts placement irrespective of the grids, thereby diversifying layouts on data sheet screens.  Those 
data sheets can be printed out in color.

Applicable Printer Models

PictBridge-compatible printer

A 
   

   
 3

50
   

 4
2.

9%
B

   
   

  2
09

   
 2

5.
5%

C
   

   
  1

56
   

 1
9.

1%
D

   
   

  1
00

   
 1

2.
2%

81
5

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PictBridge

Print

A        350    42.9%
B        209    25.5%
C        156    19.1%
D        100    12.2%

815

<Current Production Statistics>

Total

Numerical data 
displays

Statistic pie graph

Data sheet screen No. 3

PictBridge printer

Example: Printing data sheet screen No. 3 onto A4 paper in landscape orientation

Top page setting memory

Start data sheet No.: D100

Number of output data sheet pages: D101

Set (ON) bit 9 (for data 
sheet output) in read 
area “n + 1”.

One sheet of data sheet 
screen No. 3 is printed out.

D100 = 3 
D101 = 1
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Setting

Click [System Setting] → [Device Connection Setting] → [Printer].  Make the following settings in the 
[Printer] tab window.  

• Type: PictBridge

• [ Use Extension Data Sheet] checked

* You may go to the [Data Sheet Setting] dialog in another way by clicking [Registration Item] 
→ [Data Sheet] → [Screen Setting] → [Data Sheet Setting].

1

2

3

[Data Sheet Setting] dialog (2)
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1 Always Output 
Status Bit

When a print command is issued, [0 → 1] is output at the start of data 
transmission and [1 → 0] is output at the end of transmission.  
However, if the print data is minimal, the signal may not be output.  
Check this box when you want to output the bit regardless of the data 
size.

• Bit 10 of write area “n + 1”

• Bit 0 of internal memory $s16

2 Top Page Setting 
Memory

Use this memory when printing data sheets by the command given in 
the read area.
Consecutive two words are used.

* For print execution procedure, refer to “Print Execution” 
(page 12-6).

Paper Size
(A4 Portrait/
A4 Landscape)

Select the orientation of the data sheet screen.  (Paper size: A4 fixed)

3 Use PictBridge only 
on USB-B port.

Check this option when using the USB-B port for connection with the 
PictBridge printer during the RUN mode of MONITOUCH.  Switch the 
MONITOUCH display to the Main Menu screen at the time of 
transferring screen data via the USB-B port.

0: End (standby)
1: Transmitting print data 

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0

MSB LSB

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00
0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB LSB

0: End (standby)
1: Transmitting print data 

Memory Description

n Start data sheet number (→ V)

n + 1 The number of pages to be output (→ V)

Paper Size
(Graphic area: height × width) 

Orientation

A4 Portrait (912 × 640 dots) Vertical

A4 Landscape (640 × 912 dots) Horizontal

A4 portrait  A4 landscape

A A

Example: Print on 4 paper fed in portrait orientation 

Data sheet 
screen

Data sheet screen 
turned 90 degrees

Paper 
feed 
direction

Paper 
feed 
direction
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Configuration of Expanded Data Sheet Screen

When creating a data sheet screen, click [Registration Item] → [Data Sheet].
A maximum of 1,024 screens can be registered.

* Background in white only

[Paper Size: A4 Landscape]

Printable items
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Printable Items

The following items can be printed.

* You can paste parts copied from screens; however, component parts cannot be placed.
The number of items that can be placed per page is limited.  For more information, refer to 
“Limited Number of Items” (page 12-8).

Parts Graphics

Lamp
Numerical data display
Text display
Message display
Bar graph
Pie graph
Panel meter
Statistic bar graph
Statistic pie graph
Time display
Calendar

Line/continuous line
Box
Circle
Text/multi-text
Dot
Paint
Scale
Pattern

Line
Box
Circle
Text
Dot
Paint
Scale
Pattern/Library

Frame Type
Line Type
Arrow Type

Paint Color/Background
Line Color/Frame Color
Character Color

Message Display
Text Display
Numerical Data 
Display
Lamp

Statistic Bar Graph
Statistic Pie Graph

Panel Meter
Pie Graph
Bar Graph

Calendar
Time Display
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Print Execution

Data sheet screens can be printed through the V8 series in the following two manners.

Command from Read Area

Bit 9 of read area “n + 1” is the data sheet output bit.
Data sheet is printed at [0 → 1] edge.

Printing procedure
1. Specify the data sheet number to be the first page for [Top Page Setting Memory] “n”.

2. Specify the number of output pages for [Top Page Setting Memory] “n + 1”.
* No printing is executed when “0” is set as the number of output pages.

When the range specified for print includes an unregistered number, the page 
corresponding to the number will not be printed.

3. Set bit 9 of read area “n + 1” (0 → 1).

4. Data sheet is printed.

With the Macro Command

The macro command SYS (STA_LIST) is available to print data sheets.

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
Printing data sheet No. 3

$u100 = 3 (W)  [Print start data sheet number]
$u101 = 1 (W)  [Number of pages to be printed]
SYS (STA_LIST) $u100

One sheet of data sheet No. 3 is printed.

* No printing is executed when “0” is set as the number of pages to be printed.
When the range specified for print includes an unregistered number, the page 
corresponding to the number will not be printed.

Internal Memory PLC1 - PLC8 Memory Memory Card Constant

F1

Value

F0 STA_LIST

F1 Print start data sheet number

F1 + 1 Number of pages to be printed
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System Memory

The status of the connection between the V8 series and the PictBridge printer is output to the internal 
memory address $s1066.

* The error may be output as “-1” (printer error related to hardware) depending on the printer 
used.

Limitations

Compatibility with Data Sheet Screens Before Expansion

• When [Use Extension Data Sheet] is checked ([System Setting] → [  Use Extension Data 
Sheet]), the existing data sheet screen is converted to the expanded data sheet screen.  
Restoration to the original is not possible.
Data display parts then will be converted to the following:
[Display Type: other than CHAR]  →  Numerical data display, [Display Type: CHAR]  → Character 
display
If the contents of a data sheet is not held within the size of paper as a result of expansion, correct 
the data.  

• Unchecking [Use Extension Data Sheet] ([System Setting] → [  Use Extension Data Sheet]) 
brings up the following message dialog.  Clicking [Yes] deletes all parts registered with the data 
sheet screen.  

• Parts placed on a data sheet screen before expansion cannot be copied to an expanded data 
sheet screen. 

Value Description Cause and Remedy

0 The PictBridge printer is not 
connected, or it is in the normal 
state.

-

1 Printing is in process at the 
PictBridge printer.

-

-1 Printer error (related to hardware) The cable is not connected.  Check the USB cable 
connection.

Check if the printer is out of order.

The printer may not be a PictBridge-compatible type.
Review the printer specifications.

-2 Printer error (related to paper) The printer runs out of paper.  Add paper.

Paper is not correct.  Set correct paper.

-3 Printer error (related to ink) * The ink is not set.  Install an ink cartridge.

The ink level is low.  Install a new ink cartridge.
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Printing

• For parts placed on an expanded data sheet screen, the setting with [Display Setting] takes effect.  
When a part should always be printed, select [Show] for [Display Setting] 

• Monochrome print is performed with the V806M.  Otherwise, color print is performed.
• The print size is A4 only.  Use a printer that handles A4 paper.  If A4 paper is fed in landscape 

orientation or a selected print size is different from the paper size set in the printer, printing cannot 
be performed correctly.  (Data that cannot be held in the area is not printed.)

• The print start position and print size cannot be changed.  Margins to be left will slightly vary 
among different printer models.

• How to correct printer errors depends on the printer models.  For more information, refer to the 
instruction manual for the printer. 

Limited Number of Items

The number of items that can be placed on a data sheet page when only one item type is placed is 
limited as follows:  

Item Maximum Number per Page

Straight line, continuous straight line, box, circle, text, multi-text, 
dots, paint, scale, pattern Unlimited

Lamp 768

Numerical data display, character display, message display 768

Bar graph, pie graph, panel meter 762

Statistic bar graph, statistic pie graph 243

Time display 768

Calendar 256
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13 Fonts
13.1 Font Setting

Select [System Setting] → [Font Setting].  The [Font Setting] dialog is displayed.
In the [Font Setting] dialog, set the number of languages to be displayed and the font to be used on the 
MONITOUCH.

1. Font selection Select the desired font from [Bitmap font], [Gothic font] and [Stroke font] 
first.
(For the information on the differences among fonts, refer to the next 
section.)

2. Setting Set the font to be used for each language.
For the operating procedure, refer to the next page.

3. The number of 
interface languages

Set the number of interface languages.  A number up to 16 can be 
registered.

1.

2.

3.
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Differences among Fonts

Bitmap font
([Japanese 32], [Japanese], [English/Western Europe], etc. are included.)
The font data in the 16 × 16 dots or 32 × 32 dots (two-byte characters) are scaled according to the X/Y 
enlargement factors and displayed on the screen.
This font type occupies less memory but is not suitable if a smoother-line typeface is required.

Stroke font, Gothic font
The font data is displayed in a specified point size.
Since the font data of each point size is transferred to the MONITOUCH, the required memory capacity 
is larger than that of bitmap fonts while the displayed typeface has smoother lines.
In the case of Gothic fonts, depending on the function assigned to the part or item, some limitations, 
such as automatic or manual setting for fonts, may apply.
In the case of stroke fonts, there is no limitation that applies depending on the assigned function; 
however, there are other limitations and points to be noted.  (For more information, refer to “13.2 
Stroke Fonts”.)

Windows fonts
No font data is stored in the MONITOUCH but the fonts used on Windows, such as 
“Times New Roman” or “Arial”, are used as image data.
For more information, refer to the V8 Series Operation Manual.
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Font Setting Procedure

Follow the steps below:

Step 1 Select [System Setting] → [Font Setting].
The [Font Setting] dialog is displayed.

Step 2 Choose the font type for [Font].
Choose [Bitmap font] here.
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Step 3 “English/Western Europe” is displayed for “Language 1”.
(If the editor is started for the first time, “Japanese 32” is displayed.)

Step 4 To change to another language, double-click on [Language 1: English/Western Europe], or 
click on [Language 1: English/Western Europe] and then click the [Setting] button.

Click here and then 
click [Setting].

Double-click

or
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Step 5 The dialog shown below is displayed.
Select the desired font from the drop-down list and click [OK].
Choose [Chinese (Simplified)] here.

Step 6 When the font has been selected, click [OK].
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Multiple Language Selection

If you increase the value for [Interface Language], you can set as many fonts as the value set.

Double-click the language name, or click the language name and press the [Setting] button.
A dialog is displayed.  Select the desired bitmap font from the drop-down list and click [OK].

When creating multi-language screens using bitmap fonts, select from the bitmap fonts 
for all the languages to be used.  (It is not possible to use stroke fonts or Gothic fonts in 
combination.)

As many languages as 
the value set for 
[Interface Language] are 
displayed.
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13.2 Stroke Fonts
Overview

• “Stroke fonts” are different from “English/Western Europe” or “Chinese (Simplified)” conventionally 
available and represent the typeface with smoother lines.

* Note that, however, one-byte characters of 8 to 20 points may look rigid compared with those of 
greater point sizes.

• Point size specification can make your screen configuration easier.

Applicable Models

• All units in the V8 series*
* Except for the 128-color mode of V812(i)S/V810(i)S/V810(i)T/V808(i)S

For more information on the limitations, refer to “Limitations” (page 13-15).

The same “OPERATE” button can be 
shown in various point sizes.
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Stroke Font Types

The font types used on the MONITOUCH for each language are shown below.

Font Language Characters

Japanese stroke Japanese, English JIS X 0201
JIS X 0208
NEC special characters
IBM extensions
NEC selection of IBM extensions

English/Western 
Europe stroke

English, Icelandic, Irish, Italian, 
Dutch, Swedish, Spanish, Danish, 
German, Norwegian, Portuguese, 
Finnish, Faeroese, French

CP1252 code

Chinese (Traditional)
stroke

Chinese (traditional), English BIG5 code (A141 to F9FE) 
+ ASCII code

Chinese (Simplified)
stroke

Chinese (simplified), English GB2312 code (A1A1 to F7FE) 
+ ASCII code

Korean stroke Hangul, English KS code (A1A1 to FDFE) 
+ ASCII code

Central Europe
stroke

Croatian, Czech, Hrvatska (Croatian), 
Hungarian, Polish, Romanian, 
Slovakian, Slovene

CP1250 code

Cyrillic stroke Russian, Ukrainian, Kazakh, 
Bulgarian, Uzbek, Azerbaijani

CP1251 code

Greek stroke Greek CP1253 code

Turkish stroke Turkish CP1254 code

Baltic stroke Estonian, Latvian, Lithuanian CP1257 code
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Font Display on MONITOUCH

This section explains the procedure of checking the font on the Main Menu screen.
The font name is displayed in the position shown below on the Main Menu screen.

Font names
The following font names are displayed on the Main Menu screen:

* Multiple fonts can be selected on the [Transfer Font Setting] tab window in the [Font Setting] 
dialog.
For more information, refer to “Transfer Font Setting” (page 13-14).

Font Main Menu screen

Japanese stroke JAPANESE STROKE

English/Western Europe stroke ENGLISH STROKE

Chinese (Traditional) stroke CHINESE (TRD) ST

Chinese (Simplified) stroke CHINESE (SIM) ST

Korean stroke KOREAN STROKE

Central Europe stroke Cent.Eur. STROKE

Cyrillic stroke Cyrillic STROKE

Greek stroke Greek STROKE

Turkish stroke Turkish STROKE

Baltic stroke Baltic STROKE

When two or more fonts shown above are 
selected *

MULTI LANG

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Font setting of screen data
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Font Setting

Step 1 Select [System Setting] → [Font Setting].
The [Font Setting] dialog is displayed.

Step 2 Choose [Stroke font] for [Font].
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Step 3 “Japanese stroke” is displayed for “Language 1”.

Step 4 To change to a stroke font of another language, double-click on [Language 1: Japanese 
stroke], or click on [Language 1: Japanese stroke] and then click the [Setting] button.

Click here and then 
click [Setting].

Double-click

or
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Step 5 The dialog shown below is displayed.
Select the desired stroke font from the drop-down list and click [OK].

Step 6 When the font has been selected, click [OK].

* If you change from a non-stoke font to a stroke font, the message shown below will be 
displayed.

To change, select “Yes”; if you need to make a backup copy, select “No”.
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Multi-language Screen
Font
Select [System Setting] → [Font Setting] → [Font], and increase the value for [Interface Language].  As 
many fonts as this value can be set for the languages to be used.

Double-click the language name, or click the language name and press the [Setting] button.
A dialog is displayed.  Select the desired stoke font from the drop-down list and click [OK].

When creating multi-language screens using stroke fonts, select from the stroke fonts 
for all the languages to be used.  (It is not possible to use bitmap fonts or Gothic fonts in 
combination.)

As many languages as 
the value set for 
[Interface Language] are 
displayed.
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Transfer Font Setting
Set the font to be transferred to the MONITOUCH.
If you select the necessary fonts, the interface language can be switched without using the CF card.

The more fonts selected for transfer, the less the capacity for screen data becomes 
available.  If the total capacity is not sufficient, do not select fonts that are not 
necessary.
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Font Size

Specify the font size in points.  Correspondence between character sizes and points is shown below:

Limitations

• All units in the V8 series*
* Except for the 128-color mode of V812(i)S/V810(i)S/V810(i)T/V808(i)S

• Characters in 12 points
“1/4” and “Italic” typefaces are not available.

• Characters other than those in 12 points
“Bold”, “1/4” and “Italic” typefaces are not available.

Points Remarks

8 One-byte 6 × 11 dots, two-byte 11 × 11 dots

9 One-byte 6 × 12 dots, two-byte 12 × 12 dots

10 One-byte 7 × 13 dots, two-byte 13 × 13 dots

11 One-byte 8 × 15 dots, two-byte 15 × 15 dots

12 One-byte 8 × 16 dots, two-byte 16 × 16 dots

14 One-byte 10 × 19 dots, two-byte 19 × 19 dots

16 One-byte 11 × 21 dots, two-byte 21 × 21 dots

18 One-byte 12 × 24 dots, two-byte 24 × 24 dots

20 One-byte 14 × 27 dots, two-byte 27 × 27 dots

22 One-byte 15 × 29 dots, two-byte 29 × 29 dots

24 One-byte 16 × 32 dots, two-byte 32 × 32 dots

26 One-byte 18 × 35 dots, two-byte 35 × 35 dots

28 One-byte 19 × 37 dots, two-byte 37 × 37 dots

36 One-byte 24 × 48 dots, two-byte 48 × 48 dots

48 One-byte 32 × 64 dots, two-byte 64 × 64 dots

72 One-byte 48 × 96 dots, two-byte 96 × 96 dots



13.3    Windows Fonts (Extended Point Size Range)

13-16

13.3 Windows Fonts (Extended Point Size Range)
Overview

Because the available point sizes have been increased, the desired point sizes from the wider range 
can be selected.  Font size setting is made easy, without the use of the graphic relay mode.  Font sizes 
are changeable smoothly just by manually entering the required point sizes.

* For how to draw and change languages using Windows fonts, refer to the V8 Series 
Operation Manual.

Applicable Items

• All parts that are available with Windows fonts

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

V812S

<Current Production Quantity>

Example: Numerical data display part placed on the screen (Windows font: MS Gothic) 

Numerical data display

<Current Production Quantity>

Font size: 72 point Font size: 400 point
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Setting

In the following dialog, check [  Windows Font] and enter the desired value for [Point]. 

* In terms of the vertical lengths of the individual screens, the maximum permissible point 
sizes should be as shown below.  A point size larger than specified can be set, but a 
character in that size does not fit into the space of the screen.

Example: MS Gothic
 

Point Specify the point size of the selected Windows font in increments of one 
point.

Setting range: 6 to 999*

Model Resolution (in dots) Point (approx.)

V815iX 1,024 × 768 576

V812(i)S/V810(i)S/V808(i)S 800 × 600 450

V810(i)T/V810(i)C 640 × 480 359

V808(i)C 640 × 480 359

V806(i)T/V806(i)C 320 × 240 Landscape orientation 180

Portrait orientation 241

V806(i)M 320 × 240 180

(The maximum point sizes mentioned above may slightly vary with Windows fonts.)

Example: Numerical data display 

Manually enter the 
desired value.
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Limitations

Capacity

The maximum sizes (bitmap sizes) allowed for Windows fonts are as specified below for one screen 
data file.

*1 If font data registered is larger than 4 MB, an error will result.  Reduce the amount of the font 
data.
For saving Windows font data to a CF card, refer to “Saving to CF Card” (on page 13-20).

*2 About one data area
The current status of use is shown in the [Windows Font Registration] dialog ([Tool] → [Register 
Windows Font]).
A maximum of 1,024 areas can be registered in one screen data file.

Part Maximum Size *1

text, multi-text, switch, lamp,
message display (including table data display), bit order alarming,
alarm sub-display, message mode, sampling, comment display

4 MB per part

numerical data display, character display (including table data 
display),
time display, calendar

4 MB per data area *2

Text Character display

One data area
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Transparency

Limitations are placed on the use of transparency for numerical data and character display parts.
If any limitation mentioned here is exceeded, transparency does not work correctly.  Then reduce the 
settings for transparency.

Bitmap size
Monospaced fonts (like MS Gothic or Courier New) are the same in bitmap size, 
provided that they are the same in point size and byte count: one-byte or two-byte 
character.  Meanwhile, proportional fonts (like Arial) slightly vary in bitmap size, 
depending on characters, even if characters are the same in point size and byte count: 
one-byte or two-byte character.

Model Max. Number of Parts Area (Height × Width)

V815iX Without 
video

64k colors
32k colors

256

1,228,800 dots
(= 2,457,600 bytes)

128 colors 1,228,800 dots
(= 1,228,800 bytes)

With video 64k colors
32k colors

393,216 dots
(= 786,432 bytes)

V812(i)S
V810(i)S
V810(i)T
V808(i)S

Without 
video

64k colors
32k colors

256

1,228,800 dots
(= 2,457,600 bytes)

128 colors 1,228,800 dots
(= 1,228,800 bytes)

With video 64k colors
32k colors

1,228,800 dots
(= 2,457,600 bytes)

V810(i)C
V808(i)C
V808(i)CH

64k colors
32k colors

256

131,072 dots
(= 262,144 bytes)

128 colors 262,144 dots
(= 262,144 bytes)

Point (approx.) Width × Height Size
(Unit: Dots)

Bitmap Size
(Unit: Bytes) 

6 4 × 8 8

12 8 × 16 16

72 48 × 97 582

180 120 × 240 3,600

359 240 × 479 14,370

450 300 × 600 22,800

576 384 × 768 36,864

810 540 × 1,080 73,440

999 666 × 1,332 111,888

16 dots

8 dots

Bitmap size: 16 bytes 

Example: 12-point and one-byte character “A” in MS Gothic 
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Saving to CF Card

Limitations below are placed on saving the data of Windows fonts to a CF card ([System Setting] → 
[CF Card Setting] →[  Store Windows Font in CF Card]).  

• When you save one file, WFSxxxx.BIN or WFMxxxx.BIN, to a CF card, note that the file can be of 
the following size at the maximum.  The maximum permissible size depends on the setting with 
[  Range of Screen to be Saved to CF Card] in the [CF Card] dialog ([System Setting] →  [CF 
Card Setting]). 
If a file in excess of the maximum size exists, the error: 99 will be displayed on MONITOUCH.  
Reduce the size or the number of Windows fonts being used to correct the error. 

* The file size assigned to the equation is determined from the maximum size file of 
SCxxxx.BIN files.
For more information on SCxxxx.BIN files, refer to “14.1 Screen Data File Capacity 
Increased”.

Example: Screen data file for V810S (access folder name: CFDATA) 

• Screen data including large characters in height × width size may result in an error, depending on 
the settings of the screen.  Also, such large characters in screen data will interfere with the use of 
operation log or remote desktop window display.  Reduce the size or the number of Windows fonts 
being used to avoid those problems.

V806(i) 64k colors
32k colors

64

131,072 dots
(= 262,144 bytes)

128 colors
Monochrome

131,072 dots
(= 131,072 bytes)

Model Max. Number of Parts Area (Height × Width)

Model
[ Range of Screen to be Saved to CF Card]

Unchecked Checked (See the equation below.)

V815iX
V812(i)S
V810(i)S
V810(i)T
V808(i)S

7.6 MB  7.6 MB - [SCxxxx.BIN file size]*

V810(i)C
V808(i)C
V808(i)CH

6.9 MB 6.9 MB - [SCxxxx.BIN file size]*

V806(i) 3.4 MB 3.4  MB - [SCxxxx.BIN file size]*

The maximum size of one file is approximately 7.4 MB as calculated by the equation 

The size of the SC0005.BIN file is 
assigned to the equation because 
the file is the largest of the screen 
files SCxxxx.BIN.

Size: 163,067 bytes (approx. 
0.2 MB) 

Contents of the CF card
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13.4 Multi-language Editing Function
Multi-language Batch Change

Overview

Properties of items placed on multi-language screens are readily changeable in a batch.  This method 
of batch change can be implemented on a language-by-language basis for languages 1 to 16 used on 
multi-language screens.

Setting Procedure

This section explains the procedures for batch change, taking the following case for an example.

Screen No. 1

Example: Changing the properties of the text on the switches
Language 2: English/Western Europe

Screen 
No. 2

Screen No. 1

Screen 
No. 2

Batch 
change

Switches on screen Nos. 1 and 2 in language 2

[Color]: Black and white
[Property]: Standard

→
→

[Color]: Orange
[Property]: Boldface

Step 1 Open the multi-language screen data.
Select [Tool] → [Multi Language Batch Change] → [Multi Language Batch Change].
The [Multi Language Batch Change] dialog is displayed.
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Step 2 Batch change in this example targets the properties of the switches on screen Nos. 1 and 
2.  Go to the [Range Setting] area in the dialog, check [Select], and press the [Detail] 
button.  In the [Range Setting] dialog to be displayed, check [Screen] and specify screen 
Nos. 1 and 2 as the range.  Also go to the [Target Item] area, check [Select], and press the 
[Detail] button.  In the [Changed Item Setting] dialog to be displayed, check [Switch].

Step 3 Go to the [Font Setting] area in the [Multi Language Batch Change] dialog.  Check 
[Language 2] as the target language.

Step 4 Go to the [Setting on Changes] area.  Check [Color] and select orange.  Also check 
[Property] and select boldface.
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Step 5 Review the settings made in the previous steps, and click [OK].
The following dialog is displayed.

When you are sure about the message, click [Yes].
Changing the properties is complete.
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Multi-language Batch Copy

Overview

On multi-language screens in languages other than language 1, characters on the keypad or item 
numbers may be the same as those placed on the screen in language 1.  Even so, you typically 
needed to enter or copy each of those characters or numbers one by one for placing them on screens 
in different languages.  The function of multi-language batch copy discussed in this section enables 
you to copy such characters or numbers in a batch.

Language 1

Language 2 Language 2

Batch copy

Example: Copying the text and the characters on the switches in a batch
Language 1: Japanese 32
Language 2: English/Western Europe

• Before copying

• After copying
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Setting Procedure

The section explains the procedures for batch copy, taking the following case for an example.
In this example, the text and the characters on the switches placed on a screen in language 1 are 
copied to another screen in language 2.

Step 1 Open the multi-language screen data.
Select [Tool] → [Multi Language Batch Change] → [Multi Language Batch Copy].
The [Multi Language Batch Copy] dialog is displayed.

Step 2 Batch copy in this example targets all the text and switches in language 1.  Go to the 
[Range Setting] area in the dialog, and check [All].  Go to the [Target Item] area, check 
[Select], and press the [Detail] button.  In the [Changed Item Setting] dialog to be 
displayed, check [  Text] and [  Switch].

Step 3 Go to the [Font Setting] area in the [Multi Language Batch Copy] dialog.  Select [Language 
1] for [From], and [Language 2] for [To].
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Step 4 Batch copy in this example targets all properties.  Go to the [Setting on Changes] area and 
check [  All].

Step 5 Review the settings made in the previous steps, and click [OK].
The following dialog is displayed.

When you are sure about the message, click [Yes].
Copying the screen items is complete.
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Multi-language Editing Function

Multi-language Switching Tool

Interface languages from language 1 to language 16 can be switched easily using this tool.

Setting Procedure

The procedure is explained with an example shown below.

Set as shown below:

Language 1: Japanese 

Language 2: 
English/Western Europe

Language 3: Chinese (Simplified)

Language 1: English/Western Europe

Language 2:
Chinese 
(Simplified)

Language 3: Japanese 32

Language 1: Japanese 32
Language 2: English/Western Europe
Language 3: Chinese (Simplified)

→
Language 1: English/Western Europe
Language 2: Chinese (Simplified)
Language 3: Japanese 32

Step 1 Open the multi-language screen data.
Select [Tool] → [Multi Language Batch Change] → [Rearrange Language Order].
The [Rearrange Language Order] dialog is displayed.
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Step 2 To change language 1 to [Chinese (Simplified)], select [Language 2] (= Chinese 
(Simplified)) in the drop-down list for [Language 1].

Step 3 To change language 2 to [Japanese], select [Language 3] (= Japanese) in the drop-down 
list for [Language 2].
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Step 4 To change language 3 to [English/Western Europe], select [Language 1] (= 
English/Western Europe) in the drop-down list for [Language 3].

Step 5 Check the settings, and click [OK].
The dialog shown below is displayed.

If the settings are correct, click [Yes].
The selected languages are rearranged and displayed.
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Unicode Text Supported for Export / Import

• When exporting or importing text from multi-language screens, conventionally only “.csv” files are 
supported.  With V-SFT version 5.1.0.0, Unicode text (*.txt) is also supported.

• Since Unicode text can be edited on Excel, translation or editing can be made while showing two 
languages side by side using that program.

<Earlier than version 5.1.0.0>
1. Change the file extension “*.csv” to “*.txt”.
2. Translate the text as an encoded text on Word and save the file.
3. Change the file extension “*.txt” to “*.csv”.

From this new version, it is not necessary to change the file extension.  Simply open the file 
directly in Excel, translate the text into the desired language, and import the file.

• Note that, however, in the case of Unicode text, batch import is not possible.  Import the files for 
each language one by one.

Export / Import Procedure

Step 1 Select [System Setting] → [Font Setting].
The [Font Setting] dialog is displayed.
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Step 2 Click the [Export] button (or [Import] button).
The [Save As] dialog (or [Open] dialog) is displayed.  “*.txt” is selected for [Save as type].

* If you do not want to save into a Unicode text file but a .csv file, select “*.csv” for [Save 
as type].

Step 3 Click the [Save] button (or [Open] button).
The file is saved in Unicode text format.
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Unicode Text Editing Procedure

Exported Unicode text files can be edited on Excel.  When editing, follow the steps below:

Step 1 Start Excel.

Step 2 Select the Unicode text file you have exported, and drag and drop the file on Excel.

Step 3 Unicode text is displayed on Excel.

Test_2.txt
Drag and drop
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Step 4 Edit the text as desired.  (In the example below, Chinese (simplified) is input).

Step 5 To save the file, select [File] → [Save As].
The [Save As] dialog is displayed.

Step 6 Select “Unicode Text (*.txt)” for [Save as type] and save the file under the same filename.
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Please use this page freely.
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14 CF Card
14.1 Screen Data File Capacity Increased

Overview

• When the data of the following items included in the screen data file is saved on a CF card, the 
memory space of the MONITOUCH can be used sparingly.

• Screen BIN data
• Windows fonts
• 3D parts

• If you store data for the items that would occupy a large memory space, such as Windows fonts or 
3D parts, on a CF card, you can reduce the MONITOUCH memory space required for elaborate 
screen configuration.

Storing Screen BIN Data

Setting Procedure

Store screen BIN data on a CF card as shown below.

1. Editor settings

A maximum of 4,000 screens can be registered in the range of Nos. 0 - 9999.

Step 1 Select [System Setting] → [CF Card Setting].
The [CF Card] dialog is displayed.
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2. Writing data to a CF card
This is the same as writing ordinary screen data.

Step 2 Check the box for [  Range of Screen to be Saved to CF Card].
Specify the start screen number and the end screen number to be saved on a CF card.

* Screens must be selected in consecutive numbers.

Step 3 Click [OK].

Step 1 Start V-SFT.

Step 2 Select [File] → [CF Card Manager].
The dialog shown below is displayed.
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Step 3 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager will 
start.

Step 4 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

Step 5 If the screen data is being edited, check the box for [  Write Data Being Edited].
If the screen data is not being edited, uncheck the box for [  Write Data Being Edited].  In 
the [Path of File to Be Converted] field, click the [Open] button and select the “*.V8” file 
that you want to write to the CF card.
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3. Operations on MONITOUCH
Insert the CF card with screen BIN data that is saved as described above into the MONITOUCH.  
When opening a screen on the MONITOUCH, the CF card is automatically referenced for the screen.

* If screen BIN data is not stored correctly on the CF card or if the CF card is not inserted into the 
MONITOUCH, the MONITOUCH recognizes that there is no screen BIN data present.
If you press the [Function: Screen] switch, an error beep sounds and the switch operation cannot 
be accepted.  If a screen number is specified in the read area from the PLC, the screen will not be 
displayed.  (If this occurs immediately after the power is turned on, the error message “Screen No. 
Error” will be displayed.)

“SCRN” Folder

The “SCRN” folder contains the following files:

* In addition to the folder shown above, the “DSP0000.BIN” file stored in the “DSP” folder is also 
required when returning the screen files from the CF card to the computer.
For more information, refer to the next page.

Step 6 When completing the setting, click [OK].
The files shown are saved in the “SCRN” folder under the access folder on the CF card.

SCHEADER.BIN Header file

SCxxxx.BIN Screen file xxxx = Screen No.: 0 to 9999

MCRxxxx.BIN Macro block file in a component part xxxx = Block No.: 0 to 1023

MSGxxxx.BIN Sampling message file in a 
component part xxxx = Buffer No.: 0 to 11

BITMAP

SRAM

CARD
DSP
FONT
HDCOPY
JPEG

MSG
RECIPE
SAMPLE

SNAP

WAV
WEBSERV

DAT0000

SC0001.BIN
SC0002.BIN

MEMO

SCRN

SCHEADER.BIN

(Access folder)

CF card

SCxxxx.BIN: Screen BIN data

   xxxx = Screen No.: 0 to 9999

SCHEADER.BIN: Header file
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To Return Screen BIN Data to the Computer

To return screen BIN data in the “SCRN” folder to the original data file, the following files are required.

* However, if data information of “DSP0000.BIN” in the “DSP” folder does not match that of 
“SCHEADER.BIN” in the “SCRN” folder, data will not be combined and screen data is returned 
while the screen BIN data in the “SCRN” folder is missing.

To return to the original data file, it is necessary to convert “DSP0000.BIN” in the “DSP” folder.
Follow the steps below:

Step 1 Start V-SFT.

Step 2 Select [File] → [CF Card Manager].
The dialog for specifying the CF card drive is displayed.

Step 3 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager 
will start.

Step 4 Check that “DSP0000.BIN” (BIN file) exists in the “DSP” folder in the access folder, and 
select the file.

BITMAP

SRAM

CARD
DSP

FONT
HDCOPY

SAMPLE

SNAP

DAT0000

SC0001.BIN
SC0002.BIN

SCRN

SCHEADER.BIN

DSP0000.BIN xxxxxxx.V8

The “DSP0000.BIN” file in the “DSP” folder 
and the files in the [SCRN] folder are 
combined into the original data file.
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Notes

• The screen BIN data size that can be stored on a CF card is 512 kB maximum per file.
The size of each screen BIN data can be viewed by selecting [Tool] → [List of Memory Use].
However, the sizes of the screen BIN data to be saved on a CF card according to the [CF Card 
Setting] dialog (select [System Setting] → [CF Card Setting]) are not displayed in this list.
Check the data size before setting the [CF Card Setting] dialog.

• The screen BIN data stored on a CF card may take longer before the screen appears on the 
MONITOUCH than the one stored in the MONITOUCH memory.
Please keep such a time lag in mind.

Step 5 Select [File] → [Put BIN File Back].  Alternatively, right-click and click [Put BIN File 
Back]. 

Step 6 The dialog shown below is displayed.
Specify the location and the file name and click [Save].

or
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Storing Windows Fonts

Setting Procedure

Store Windows fonts on a CF card as shown below:

1. Editor settings

Step 1 Select [System Setting] → [CF Card Setting].
The [CF Card] dialog is displayed.

Step 2 Check the box for [  Store Windows Font in CF Card].

Step 3 Click [OK].
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2. Writing data to a CF card
This is the same as writing ordinary screen data.

Step 1 Start V-SFT.

Step 2 Select [File] → [CF Card Manager].
The dialog shown below is displayed.

Step 3 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager will 
start.



14.1    Screen Data File Capacity Increased

14-9

14

3. Operations on MONITOUCH
Insert the CF card with Windows fonts that are saved as described above into the MONITOUCH.
When opening a screen on the MONITOUCH or when switching a message displayed, the CF card is 
automatically referenced for displaying Windows fonts on the MONITOUCH.

* If Windows fonts are not stored correctly on the CF card or if the CF card is not inserted into the 
MONITOUCH, the characters in Windows fonts will not be displayed on the MONITOUCH.

Step 4 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

Step 5 If the screen data is being edited, check the box for [  Write Data Being Edited].
If the screen data is not being edited, uncheck the box for [  Write Data Being Edited].  In 
the [Path of File to Be Converted] field, click the [Open] button and select the “*.V8” file 
that you want to write to the CF card.

Step 6 When completing the setting, click [OK].
The files shown are saved in the “SCRN” folder under the access folder on the CF card.

BITMAP

SRAM

CARD
DSP
FONT
HDCOPY
JPEG

MSG
RECIPE
SAMPLE

SNAP

WAV
WEBSERV

DAT0000

WFM0000.BIN
WFS0000.BIN

MEMO

SCRN
SCHEADER.BIN

(Access folder)

CF card

WFSxxxx.BIN: Windows font data (graphics)

xxxx = Data No.: 0 to 4095

WFMxxxx.BIN: Windows font data (message)

xxxx = Data No.: 0 to 4095

SCHEADER.BIN: Header file
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“SCRN” Folder

The “SCRN” folder contains the following files:

Notes

• The Windows fonts stored on a CF card may take longer before the characters appear on the 
MONITOUCH than those stored in the MONITOUCH memory.
Please keep such a time lag in mind.

Storing 3D Parts

Setting Procedure

Store 3D parts on a CF card as shown below:

1. Editor settings

SCHEADER.BIN Header file

WFSxxxx.BIN Windows font (graphics) file xxxx = Data No.: 0 to 4095

WFMxxxx.BIN Windows font (message) file xxxx = Data No.: 0 to 4095

Step 1 Select [System Setting] → [CF Card Setting].
The [CF Card] dialog is displayed.
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2. Writing data to a CF card
This is the same as writing ordinary screen data.

Step 2 Check the box for [  Store 3D Parts in CF Card].

Step 3 Click [OK].

Step 1 Start V-SFT.

Step 2 Select [File] → [CF Card Manager].
The dialog shown below is displayed.
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Step 3 Specify the drive where the CF card is inserted and click [OK].  The CF Card Manager will 
start.

Step 4 Click [File] → [Write to CF Card].
The [Write to CF Card] dialog is displayed.

Step 5 If the 3D part is being edited, check the box for [  Write Data Being Edited].
If the 3D part is not being edited, uncheck the box for [  Write Data Being Edited].  In the 
[Path of File to Be Converted] field, click the [Open] button and select the “*.V8” file that 
you want to write to the CF card.
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3. Operations on MONITOUCH
Insert the CF card with 3D parts that are saved as described above into the MONITOUCH.  When 
opening a screen on the MONITOUCH, the CF card is automatically referenced for showing the 3D 
parts on the MONITOUCH.

* If 3D parts are not stored correctly on the CF card or if the CF card is not inserted into the 
MONITOUCH, the 3D parts will not be displayed on the MONITOUCH.

“SCRN” Folder

The “SCRN” folder contains the following files:

Notes

• The 3D parts stored on a CF card may take longer before the 3D parts appear on the 
MONITOUCH than those stored in the MONITOUCH memory.
Please keep such a time lag in mind.

Step 6 When completing the setting, click [OK].
The files shown are saved in the “SCRN” folder under the access folder on the CF card.

SCHEADER.BIN Header file

3Dxxxx.BIN Bitmap file for 3D part xxxx = Bitmap No.: 1 to 1023

BITMAP

SRAM

CARD
DSP
FONT
HDCOPY
JPEG

MSG
RECIPE
SAMPLE

SNAP

WAV
WEBSERV

DAT0000

MEMO

SCRN
SCHEADER.BIN

3D0005.BIN

3D0001.BIN
3D0002.BIN
3D0003.BIN
3D0004.BIN

(Access folder)

CF card

3Dxxxx.BIN: 3D part data

xxxx = Bitmap No.: 1 to 1023

SCHEADER.BIN: Header file
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14.2 Storing Message Data
Overview

• Message data can be stored on a CF card not as a BIN file but as a TXT file.

• If the messages need changing quickly, it may be useful to save the messages in TXT file format 
on a CF card; the messages in TXT file format can be edited anywhere without the dedicated 
editor and in addition the MONITOUCH memory space is saved.

* Note that, however, the TXT file must be saved on a CF card manually.
This will not be created automatically.

Setting Procedure

1. Editor settings

Step 1 Set up the following settings on the screen data file beforehand.
Select [System Setting] → [CF Card Setting].
The [CF Card] dialog is displayed.
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2. Storing TXT files

Step 2 Check the box for [  Range of Messages to be Saved to CF Card] and set the range of 
messages to be stored.

* Message groups must be selected in consecutive numbers.

When the setting has been made, click [OK] and save the screen data file.

TXT files must be prepared manually separately.
Create files under the filenames shown below and store them in the “MSG” folder on 
the CF card.

BITMAP

SRAM

CARD
DSP
FONT
HDCOPY
JPEG

RECIPE
SAMPLE

SNAP

WAV
WEBSERV

DAT0000

MEMO

SCRN

MSG
MSG00000.TXT
MSG00001.TXT
MSG01000.TXT
MSG01001.TXT

(Access folder)

CF card

(Message
xxyyy
xx = Language No.: 0 to 7
yyy = Message group No.: 0 to127)
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* TXT files must be created in accordance with the message group numbers specified on the [CF 
Card Setting] dialog (select [System Setting] → [CF Card Setting]).
If the TXT file is not in accordance with the specified group number, it will not be recognized.

3. Operations on MONITOUCH
Insert the CF card with messages that are saved as described above into the MONITOUCH.
When opening a screen on the MONITOUCH, the CF card is automatically referenced for showing the 
messages on the MONITOUCH.

“MSG” Folder

Store the following files in the “MSG” folder:

Notes

• If both text files “MSGxxyyy.BIN” conventionally used and “MSGxxyyy.TXT” available from this 
version exist in the same “MSG” folder on a CF card, only “MSGxxyyy.TXT” will be recognized.

When creating TXT files, you can either create text data from scratch and give the 
required filenames correctly or convert the “MSGxxyyy.BIN” files, which are 
automatically created when screen data is written to a CF card, into TXT files.
For the procedure of converting BIN files into TXT files, refer to “18 CF Card” in the V8 
Series Reference Manual.

MSGxxyyy.TXT Text file for messages xx = Language No.: 0 to 15
yyy = Message group No.: 0 to127
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14.3 Addition of Titles to a CSV File (Sampling Data)
Overview

When sampling data in the V8 series is saved in a CSV-format file to a CF card, the sampling data in 
the CSV file shows only the buffering area number in the header line.  The titles of the sampling data 
items do not appear.
However, when you create a CSV file for titles and store it on the CF card beforehand, sampling data 
converted to CSV format shows titles in the header line.

Applicable Items

• Trend sampling
• Data sampling
• Alarm tracking
• Alarm logging

No titles

Example: Output of sampling data in buffering area 2 to a CSV file

Buffering area 
number

With titles
The titles appear 
in place of the 
buffering area 
number.
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Setting Procedure

1. Creating a CSV file for titles
Create a CSV file for titles.

2. Operations on MONITOUCH
Insert a CF card that stores the CSV file for titles into MONITOUCH.
When sampling data is output from MONITOUCH in CSV format to the CF card, the titles automatically 
appear in the header line of the sampling data.

Users are requested to create a CSV file for titles.
Name a CSV file for tiles as designated below and store it in the “SAMPLE” folder on a 
CF card.

BITMAP

SRAM

CARD
DSP
FONT
HDCOPY
JPEG

RECIPE
SAMPLE

SNAP

WAV
WEBSERV

DAT0000

MEMO

SCRN

MSG

SMH0002.CSV

(Access folder)

CF card

CSV file for titles*
SMHxxxx.CSV
xxxx = 0000 - 0011: Buffering area number

* Enter the buffering area number, to which you 
intend to add titles.  If the buffering area 
number specified in the file name does not 
exist, the file has no effect.

SMH0002.CSV file

* There is no limitation to the number of rows and columns for 
titles.
A CSV file for titles must be within 239 KB in size.

CSV0002.CSV file



14.3    Addition of Titles to a CSV File (Sampling Data)

14-19

14

“SAMPLE” Folder

Store the following file in the “SAMPLE” folder.

Notes

• There is no limitation to the number of rows and columns in a CSV file for titles named 
“SMHxxxx.CSV”.

• A CSV file for titles must be within 239 KB in size.

SMHxxxx.CSV CSV file for (sampling data) titles xxxx = 0000 - 0011: Buffering area number
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15 Item Show / Hide Function
Overview

• The switch or numerical data display parts registered on the screen can be shown or hidden 
according to its operating status.
The “show/hide” attribute can be set using the activation of a memory address in the PLC, bit/word 
designation, etc.

• The registration items can be equipped with the “show/hide” attribute even if it is not to be used 
during operation.
For example, if you plan a future expansion, such as an additional switch or numerical data display 
parts, you can register these parts in advance and set them with the “hide” attribute, which will 
make your future expansion easier.

PLC

10.23

9.89

7.23

11.02

12.03

A B C D E

No. 1

No. 2

No. 3

No. 4

No. 5

10.23

9.89

7.23

11.02

12.03

849

988

489

156

484

A B C D E

No. 6

No. 7

No. 8

No. 9

No. 10

No. 1

No. 2

No. 3

No. 4

No. 5

M200 = ON

Monitor Screen Monitor Screen

For example, it is possible to bring up the 
numerical data display group on the right 
side when M200 is set to “ON” in the PLC.

MENU

MENU

Operation 1 Operation 2 Setting 1 Setting 2

Setting 3 Error Monitor Monitor 1 Monitor 2

Maintenance 
1

Maintenance 
2

Trouble
Monitor 1

Trouble
Monitor 2

The switches with the “hide” attribute will 
not be displayed on the MONITOUCH.

Operation 1 Operation 2 Setting 1 Setting 2

Setting 3 Error Monitor Monitor 1 Monitor 2
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Applicable Items

The “show/hide” attribute can be set for the following items:

Registration positions
Screen, overlap library, screen library, data block

Setting Procedure

Setting Position
For parts:
Make the setting on the [Display Setting] tab window in the item dialog.

Switch

Lamp

Numerical data display

Character display

Message display

Graph

Statistic graph

Closed area graph

Link parts

Grouped items (including graphic items)
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For link parts or grouped items:
The dialog will be displayed for a link or grouped item.
Make the settings on the [Display Setting] tab window.

Setting Items

Make the following settings:

* For the timing of showing or hiding (drawing), refer to the next page.

Show The item is displayed on the MONITOUCH.

Hide The item is not displayed on the MONITOUCH.

Memory 
Designation

The “show/hide” attribute can be controlled using a bit or word memory address.
Select either method described below.
When the condition is satisfied, the item will be shown or hidden.*

Bit Designation The item is shown or hidden according to the activation at the 
specified bit memory address.

Bit ON: Item shown
Bit OFF: Item hidden

Word Designation The item is shown or hidden according to the status at the 
specified word memory address.

Security 
level

The setting is valid when the security function is used.
The “show/hide” attribute can be controlled according to the user’s login level of 
MONITOUCH.
For more information, refer to “22 Security Function”.

Display Type Choose data type of the conditional 
expression.
[DEC+-] / [DEC] / [BCD]

Condition 1 Set an equal sign, value, and memory 
address as the condition for comparison.Condition 2
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Timing of Drawing (Memory Designation)

When [Memory Designation] is selected, the item will be shown or hidden according to the settings in 
the [Screen Setting] dialog.

Screen Setting (Screen)

Select [Screen Setting] → [Screen Setting].
The [Screen Setting] dialog is displayed.  Open the [Show/Hide Item] tab window.

Redraw the section
When [  Redraw the section] is checked, the screen is redrawn each time the specified memory 
status changes.

• If the relevant item is registered on the screen, the screen will be redrawn.
(Any item on the normal overlap part or call overlap part is also applicable.)
If an item on the multi-overlap library or data block is equipped with the “show/hide” attribute, the 
multi-overlap or data block will be redrawn.

• Since memory status change is monitored at all times, the MONITOUCH may be placed under a 
loaded condition.
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Settings for screen redrawing
When the screen is redrawn, the following operations are also performed at the same time.

- Open macro, close macro (screen, multi-overlap library)
- Cycle macro (screen)
- $T memory zero clear (screen)
- Screen interrupt command transfer (PLC type: universal serial) (screen)

If you do not want to execute these operations at the time of redrawing, check the boxes as required.

Prohibition of screen redrawing
When [  Redraw the screen] is checked, the screen is redrawn each time the item “show/hide” 
memory status changes.
If it is not necessary to check status change each time, uncheck this box.  In this case, the screen is 
redrawn only when the screen is switched or when the SYS (RESET_SCRN) macro is executed.
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Screen Setting (Overlap Library)

Select [Screen Setting] → [Screen Setting] in the overlap library ([Registration Item] → [Overlap 
Library]).  The [Screen Setting] dialog for the overlap library is displayed.

Determine overlap library operations to be performed at the time of screen redrawing.

Blinking during Screen Redrawing

When the screen is being redrawn, blinking may occur.
To avoid such blinking, select [System Setting] → [Unit Setting] → [General Settings], and check the 
box for [Perform Drawing in the Background].
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How to Check the Settings on the Editor

Use either method when checking the “show/hide” attribute of each item on the editor.

[Item List] View

Click [View] → [View] → [Item List], or click the [Item List] icon.  The [Item List] view is displayed.

The items set as other than [Show] for the “show/hide” attribute are shown in green, yellow or light 
blue.
The items set as [Show] have no color.

[Item List] view

Yellow:
Security level

Light blue:
Hide

Green:
Memory designation
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Right-click Menu or [Display Environment]
Right-click menu
Right-clicking on the screen brings up a right-click menu.
Click [Customize] → [Do not display the Hide items].  The items set as [Memory Designation] or [Hide] 
on the [Display Setting] tab window of the item dialog will disappear from the screen.

[Display Environment]
When [  Hide Items not displayed] is checked on the [Display Environment] dialog ([View] → [Display 
Environment]), the items set as [Memory Designation] or [Hide] on the [Display Setting] tab window of 
the item dialog will disappear from the screen.
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Examples

[Memory Designation: Bit Designation]

1. Create data display parts with the following settings:

2. When the PLC sets M100 to “ON”, a numerical data display appears as shown below:

3. When the PLC sets M200 to “ON”, a character display appears as shown below:

ABCDEFGH

1234Numerical data display
[Display Setting: Memory 
Designation]

Bit Designation
PLC Memory: M100 Character display

[Display Setting: Memory 
Designation]

Bit Designation
PLC Memory: M200

100

PLC

M100 = ON

M100 = ON
M200 = OFF

M100 = OFF
M200 = OFF

RECORD-A 

100

PLC

M200 = ON

100

M100 = ON
M200 = ON

M100 = ON
M200 = OFF
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[Memory Designation: Word Designation]

1. Create switch parts with the following settings:

2. When the PLC sets [D100=1234], a switch appears as shown below:

3. When the PLC sets [D200=9999] with [D100=1234], another switch appears as shown below:

A B

Switch
[Display Setting: Memory 
Designation]

Word Designation
Display Type: DEC+-
Condition 1: 1234 = D100
Condition 2: None

Switch
[Display Setting: Memory 
Designation]

Word Designation
Display Type: DEC+-
Condition 1: 9999 = D200
Condition 2: None

A

PLC

D100 = 1234

D100 = 1234
D200 =       0

D100 =       0
D200 =       0

A B

PLC

D200 = 9999

A

D100 = 1234
D200 = 9999

D100 = 1234
D200 =       0
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Display Order

The display order of the items is the same as that of registration on the screen.
For example, if the items are overlaid, they will appear in order of registration on the screen, 
regardless of the timing of display command memory status change.

The items with [Process Cycle: High Speed] that are updated every cycle or those with status change 
will be displayed on top.

M101 = ON

B
A

B
C

B
C

M100 = ONM102 = ON

A
B

C

Switch “A”
[Display Setting: Memory Designation]

Bit Designation
PLC Memory: M100

Switch “B”
[Display Setting: Memory Designation]

Bit Designation
PLC Memory: M101

Switch “C”
[Display Setting: Memory Designation]

Bit Designation
PLC Memory: M102

For example, with the settings shown above, the switches will be displayed according 
to the display command memory status change.

A
B

C
B

C

A

When the switch is turned ON, it is displayed on top.
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16 FTP Server
Overview

The V8 series is allowed to work as a FTP server in such a manner that an FTP client tool installed on 
a computer accesses the V8 series over Ethernet, and writes/reads data to/from the CF card inserted 
in the V8 series.

A standard FTP tool included with Windows is available for data writing to, reading from, and editing in 
a CF card, without the need for installing any special tool.

Available V8 Models

The V8 series is equipped with a built-in LAN port
(such as V8i series, V806i series, etc.)

* The Ethernet unit cannot be used because TCP/IP is not available on it.

CF

CF

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8i

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8i

Ethernet

Ethernet

FTP server

FTP server

Router

FTP client tool
FTP client
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Specifications

Function Specifications

*1 What is a client or an FTP client?
A computer that transmits data reading/writing commands to an FTP server is called a client or 
an FTP client in this manual.  A maximum of three client computers can access a V8 unit.

*2 If no command is input from the FTP client within the time specified for [Input Supervisory 
Period], the V8 automatically disconnects the connection.

Item Description Location for 
Setting

Protocol TCP/IP −

User name 1 to 12 one-byte alphanumeric characters
(case-sensitive)

Editor

Password 1 to 8 one-byte alphanumeric characters
(case-sensitive)

Editor

Port number 20, 21 (Fixed)

No. of clients*1 3 sets maximum −

Input supervisory time 1 to 60 minutes (default: 15 min.)*2 Editor

File readout size Unlimited
(within the capacity of the CF card)

−

File name One-byte alphanumeric characters only −

Requirement Operable in RUN mode only
(not operable when the Main Menu screen is 
displayed)

−

CF

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8i

Ethernet

Ethernet

FTP server

FTP client

Router

FTP client FTP client
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FTP Client Tools (Operation Checked)

FTP Commands

The following commands are enabled as FTP commands.

Tool Applicable OS

Command Prompt (included with Windows as standard)

Windows 98/Me/2000/XPInternet Explorer version 6 or 7 (included with Windows as 
standard)

FFFTP version 1.96b (freeware)

Command Name Function Refer to:

cd Changes the current directory. −

close Disconnects the connection. −

dir Displays the file information. page 16-13

ls Displays folder and file names. page 16-14

put Writes to a file. page 16-15

get Reads a file. page 16-15

delete Deletes a file. page 16-16

rename Renames a file. page 16-16

pwd Displays the current folder name. −

mkdir Creates a folder. page 16-17

rmdir Deletes a folder. −

quit Terminates the FTP client tool after disconnecting the 
connection.

page 16-11
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Setting

Select [System Setting] → [Ethernet Communication] → [FTP Server].
The [FTP Server Setting] dialog is displayed.
Check [  Use FTP server function].  The items below become active.

* If no command is input from the FTP client within the time specified for [Input Supervisory Period], 
the V8 automatically disconnects the connection.

User Name 1 to 12 one-byte alphanumeric characters
(case-sensitive)

Password 1 to 8 one-byte alphanumeric characters
(case-sensitive)

Input Supervisory Period 1 to 60 minutes (default: 15 min.)*

 Write enable Check this box if you allow the FTP client to write to, delete, or edit 
files.
When this box remains unchecked, only file reading is possible.
(Default: unchecked)
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Designation of File Location

How to designate a file location

• Drive names
C: Built-in CF card drive
D: USB-A port (USB-CFREC, USB memory, etc.)

C:  V8  JPEG  JP00000.JPG

C:  DAT0000  RECIPE  TEST  TYPE0421.CSV

Drive name

Maximum number of characters for a path: 255 one-byte characters (including “:”, “\”, and an extension)

Maximum number of characters for a path: 255 one-byte characters 
(including “:”, “\”, and an extension)

*1 Maximum number of characters for a file name: 194 one-byte characters

*2 “¥” = “/”

File name*1Folder name*1Access folder name
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Login

This section explains the steps needed to log in and demonstrates how to operate the FTP tools.
To begin, prepare your MONITOUCH as instructed below.

1. Transfer the screen data, for which the [FTP Server Setting] is finished, to MONITOUCH (the V8i 
series).

2. Connect your computer to MONITOUCH via Ethernet.
3. Insert a CF card into MONITOUCH and set the unit to the RUN mode.

With the Command Prompt

Step 1 Click [Start] → [Programs] → [Accessories] → [Command Prompt].
[Command Prompt] starts.

Step 2 Enter the FTP command.
Key in “ftp”, a one-byte space, and the MONITOUCH IP address.  Press the Enter key.
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Step 3 The following message appears.
Key in the user name that is the same as specified in the [FTP Server Setting] dialog.  
Press the Enter key.

Step 4 The following message appears.
Key in the password that is the same as specified in the [FTP Server Setting] dialog.  
Press the Enter key.  (The password is not shown on the screen.)

Step 5 The following message appears indicating the completion of login.



16    FTP Server

16-8

Causes of login failure:
If a wrong IP address is entered, the following message is displayed.

If a wrong password is entered, the following message is displayed.

If you enter the correct command after the occurrence of an error, the error message 
remains.

In order to proceed, execute the quit command to disconnect the connection once and 
enter the correct command.
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With Explorer (or Internet Explorer)

Step 1 Start [Explorer].

Step 2 Enter the FTP command in the [Address] field.
Key in “ftp://<user name>:<password>@<MONITOUCH IP address>”.  Press the Enter 
key.

* When you use Explorer or Internet Explorer, key in “ftp://<user 
name>:<password>@<MONITOUCH IP address>”.
Typing only “ftp://<MONITOUCH IP address>” may end in failure of user 
authentication.
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Step 3 The computer displays Explorer as the following:

Login has been completed.

Step 4 In Explorer, you can view the contents of the CF card inserted into MONITOUCH.

Contents of the CF card inserted into the V8
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Logout

This section explains the steps needed to log out and demonstrates how to operate the FTP tools.

With the Command Prompt

Step 1 When the client logs in to the server, key in “quit” and press the Enter key.

Step 2 The following message appears.
Logout has been completed.
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With Explorer (or Internet Explorer)
To log out, close Explorer.

Click the close button to log out.
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Usage Examples

This section provides examples of executing commands in the Command Prompt.

Acquisition of File and Folder List
“dir” command
This command is used to display the list of file and folder information, containing properties, sizes, 
dates and times of update, and names of files and folders.

drw-rw-rw- 1 owner group 0 Apr 16    2008 xxxxxxxxx

• Details of the list

r--r--r--: Write-protected
rw-rw-rw-: Write-permitted

(Fixed)
Date and 
time of 
update

Folder name
File name

d: Folder
-: File For a folder: “0” fixed

For a file: File size
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“ls” command
This command is used to display the names of files and folders.
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Reading from and Writing to a File
“get” command (reading)
This command is used to read files stored in the CF card in the computer.
The file is read into the folder placed in the computer specified in the Command Prompt.

“put” command (writing)
This command is used to write files stored in the computer to the CF card.

“get” command:
get    <file to be read>

To be read into this location

“put” command:
put    <file in the PC (example: in drive e)>    <file in the CF card (in drive c)>
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Deleting a File
“delete” command

Renaming a File/Folder
“rename” command

Name before the 
folder is renamed

Name after the 
folder is renamed
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Creating a Folder
“mkdir” command

To be stored in the 
V8 folder

“mkdir” command
↓

Creates a TEST2 
folder in the 
RECIPE folder.

To be stored in the 
RECIPE folder
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Error Display

If accessing the FTP server ends in error, the FTP client displays the error message.

Example 1: In the case of attempting to read a file that does not exist

Example 2: In the case of attempting to write to a write-protected file
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Connection Check

System Memory ($s)

The following describes the system memory associated with the FTP server.

Connection Check

Create a lamp to which the internal memory $s1070-00 is assigned, and place it on the screen.
When the lamp is lit, it indicates login, i.e. connection is established.

Address Description Remarks

$s1070 Storage of FTP information

* If two or more FTP clients log in to the FTP server, the data stored in the system 
memory is based on the status of all these FTP clients.
(Even if only one FTP client is executing a command, bit 1 is set (ON).)

← V

1071 Number of FTP clients that log in to the server (3 sets maximum) ← V

1072 FTP connection: Forced disconnection

→ V

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB

FTP client
0: Logoff
1: Login

System reserved (setting “0”)

LSB

FTP client
0: Command not executed
1: Command being execute

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0 0 0

MSB

Connection to FTP client
0→1: Disconnected forciblySystem reserved (setting “0”)

LSB

$s1070-00

CF

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

CF

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

In a state of login
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Disconnection
Automatic disconnection
If no command is sent from the FTP client within the time specified for [Input Supervisory Period] in the 
[FTP Server Setting] dialog (click [System Setting] → [Ethernet Communication] → [FTP Server]), the 
V8 automatically disconnects the connection with the client.

Manual disconnection from V8
By resetting (OFF to ON) bit 0 of $s1072 on the V8, the connection with the FTP client is disconnected 
forcibly.

Disconnection from FTP client
The FTP client is disconnected from the V8 when the FTP client logs out.
For more information, refer to “Logout” on page 16-11.

Limitations

Number of FTP Clients

A maximum of three FTP clients can be connected to one V8.
Requests from multiple FTP clients cannot be processed at the same time.  They are processed one 
by one.  Therefore, while an FTP client is transferring a large-size file, another client cannot transfer a 
file and must wait until the current file transfer is completed.

File Property Change

Changing file properties (such as a change between write protection and write permission) is not 
allowed.

CF

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

$s1070-00

$s1072-00

CF

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Logoff occurs.

Resetting $s1072-00 (OFF to ON) causes logoff.
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Notes

Notes on FTP Server System Design

1. In a case where an FTP client writes a recipe file to the CF card inserted in the V8, the recipe file 
from the FTP client and the recipe in operation in the V8 must be in the same format.
In a case where a recipe file is written to a remote location, be sure in advance that writing is 
enabled in the target location.

2. Before using an FTP client tool, read its manual to understand the functions and operational 
procedures, and also conduct a trial operation.
The V8 (FTP server) may not support some functions, depending on the model of the FTP client 
tool.

Notes on File Transfer

1. If no command is sent from the FTP client within the time specified for [Input Supervisory Period] in 
the [FTP Server Setting] dialog, connection between the FTP server and the FTP client will be 
disconnected automatically.

2. While the V8 is in communication with the FTP client, setting the V8 to local mode (Main Menu 
screen) disconnects them.

3. While the V8 is accessing a file in the CF card, do not allow the FTP client to write to or delete the 
same file.
Such an action will cause a malfunction.  A file deletion from the CF card, even while the V8 is not 
accessing the file, will cause a file reading error at the time of the next access by the V8.
Basically, for any files relevant to V8 operation, do not execute the writing and deleting commands.

4. When a file in the CF card has been overwritten via the FTP server, check that the data in the file 
is correct.
If writing to the file ends in error, the file will be deleted from the CF card.  In the event of such a 
deletion, repeat writing from the FTP client.

5. If the FTP client is down, wait until the time for [Input Supervisory Period] elapses and then retry 
logging in.

6. While the FTP client is accessing a file in the CF card inserted into the V8, do not shut off the V8.  
Doing so may corrupt data on the CF card.

7. If the V8 is reset or shut off while its connection with the FTP client is established, the next action 
that the FTP client takes depends on the specifications of the FTP client tool.
With this in mind, choose an FTP client tool which supports the detection of a FTP server down 
and also the safe termination in such a case.

8. If the CF card cover is open on the V8, access to the CF card is not allowed.
9. Depending on the model of the FTP client tool, there may be a mismatch in timestamp between a 

file in the CF card and the FTP client tool.  If such a mismatch is found, check the configuration of 
the FTP client tool.
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Please use this page freely.
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17 Ethernet
Some functions are added to the Ethernet communication executed on the V8 series.

17.1 E-mail
Overview

Authentication method setting is additionally made available an e-mail feature from the V8 series.
This addition ensures greater security in e-mailing.

Authentication Methods

*1 Only POP3 is supported.
*2 Quality of Protection supports “auth” mode only.  It does not support “auth-int” and “auth-conf” 

modes.

Setting

Location for Setting

Select [System Setting] → [Ethernet Communication] → [E-Mail].
The [E-Mail Setting] dialog is displayed.

Authentication Method Type in Editor

POP before SMTP  *1 POP before SMTP

LOGIN

SMTP Authentication
PLAIN

CRAM-MD5

DIGEST-MD5  *2
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Setting Items

What is POP before SMTP?
POP before SMTP utilizes authentication with POP3 that is performed at the time of receiving e-mail.  
SMTP permits the sending of e-mail from the authenticated IP address for a limited time.
Since authentication is disabled after a specific time has elapsed, authentication with POP3 will be 
required again.

* In the case of authentication with POP3, a password is sent in clear text.  POP before SMTP using 
APOP is also available.  With APOP, a password is sent in encrypted form.
The V8 series, however, supports POP3 only.
 

What is SMTP Authentication?
Authentication is performed with the SMTP server.
SMTP Authentication is classified into several authentication methods.
The V8 series supports LOGIN, PLAIN, CRAM-MD5, and DIGEST-MD5.
Since the SMTP server automatically performs authentication according to the available method, users 
are not requested to make configurations.

<Automatic authentication steps>
1. Compliant with DIGEST-MD5?
2. Compliant with CRAM-MD5?
3. Compliant with PLAIN?
4. Compliant with LOGIN?
5. Authentication failure

Port No.
(0 to 65535)

Specify the SMTP port number.
Example: Yahoo Corporation’s Yahoo e-mail: Port No. 587

Certify Type The following two methods are supported.

POP before SMTP Authentication is performed with the POP3 server.
The settings below must be made.

• POP3 IP address
• Account name (within 63 one-byte characters)
• Password (within 63 one-byte characters)

SMTP Authentication Authentication is performed with the SMTP server.
The settings below must be made.

• Account name (within 63 one-byte characters)
• Password (within 63 one-byte characters)

(Default: 25) 
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About the authentication methods
• PLAIN

This method sends user names/passwords in clear text (not in encrypted form). 
• LOGIN

LOGIN is similar to PLAIN.  But it often sends information, as performed with POP3, in divided 
forms, such as USER xxxxx or PASS xxxxxx.  Because the standard specifications of LOGIN are 
not established, there are e-mail servers that use LOGIN in their own way.

• CRAM-MD5
With CRAM-MD5, the server sends an arbitrary character string (a challenge string) to the client.  
The client then performs a specific computing process called MD5 (Message Digest V5) by using 
the challenge string and the password, and returns the result to the server.
The server that receives the result also performs the same process.  When both results match 
each other, the server judges that the client knows the correct password and authorizes it.

• DIGEST-MD5
DIGEST-MD5, an expanded version of CRAM-MD5, has an enhanced resistance to dictionary 
attack and brute force attack. 

Notes
• A name consisting of both one-byte and two-byte characters is not allowed for [Sender’s Name] in 

the [E-Mail Setting] dialog.

• The e-mail transfer of the V8 series does not support SSL/TLS encryption.  Transfer to the SMTP 
server that requires encryption is therefore impossible. 
Example: Google’s Gmail
The available languages for sending e-mails are English and Japanese.  If any other languages 
are used, characters will get garbled.

System Memory ($s1006)

Some changes are made to the error information relevant to e-mailing, which will be stored in memory 
at $s1006.
The following error numbers will be stored.

Error No. Description Solution Remarks

0 Normal −

1 E-mail address error Check the sender’s e-mail address.

6 Network not connected Check the connection to the network.

50 SMPT transmission error Check the IP address for the SMTP server.
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17.2 Two Ethernet Ports
Overview

• On the V8i series (equipped with a built-in LAN port), both the built-in LAN port and an Ethernet 
unit are usable at the same.  They can serve as two different physical ports.

For instance, while the V8i is communicating with PLCs via the built-in LAN port over Ethernet, 
the V8i can also communicate with the V-Server via the Ethernet unit.

• Networks via the built-in LAN port and the Ethernet unit can be designed separately.
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Ethernet

Ethernet

PLC

Ethernet unit

Computer
(V-Server)
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PLC

Ethernet

Ethernet
F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8i

Computer
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PLC

Ethernet unit
172.16.200.xxx

Built-in LAN port
192.168.1.xxx

PLC

172.16.200.xxx

192.168.1.xxx
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Usage Example
With only one port
V8i is allowed to perform Ethernet communication with PLCs of different manufacturers (PLC for unit A 
and PLC for unit B) on a LAN (IP address: 192.168.1.xxx) inside the factory.

With two ports
By mounting an Ethernet unit on the present V8i, a new network can be additionally established 
without the need for changing the current Ethernet network.  As a result, a LAN can easily be designed 
in the office so as to enable the computer installed in the office to monitor the factory.
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Factory 
monitoring
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With an additional 
Ethernet unit mounted, a 
network that achieves 
remote monitoring 
through the host 
computer can simply be 
established.

Factory

Office
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Setting Procedure

IP Address Setting

Two IP addresses must be set for the built-in LAN port and the Ethernet unit.
Click [System Setting] → [Ethernet Communication] → [Local Port IP Address].
The [IP Address Setting] dialog is displayed.

For the built-in LAN port
Set the items in the [IP Address Setting] tab window for the built-in LAN port.

For the Ethernet unit
Set the items in the [IP Address Setting (extended)] tab window for the Ethernet unit port.

The included items are the same between the [IP Address Setting] and [IP Address Setting 
(extended)] tab windows.
For more information, refer to the V8 Series Connection Manual.
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Network Table

In a case where MONITOUCHs are connected as illustrated below, they may communicate with one 
another using macro commands EREAD and EWRITE (and SEND to send data to the host computer).  
Communication in this style requires the registration of the IP addresses of the MONITOUCHs (or the 
host computer) used as the access targets, in addition to the registration of the local port address.  
Network table registration must therefore be registered.

Network table registration
When you use the two ports, go to the [Network Table Edit] window and register network tables (click 
[System Setting] → [Ethernet Communication] → [Network Table]).
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Even when different networks exist, register their respective data including IP addresses in network 
table editing.

Ethernet Setting on MONITOUCH
Viewing the Ethernet information
The Main Menu screen on MONITOUCH provides information about the built-in LAN port and the 
Ethernet unit.
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When [Built-in LAN] is displayed in the [Ethernet Information] section on the Main Menu screen, the 
section shows the information on the built-in LAN port.
Pressing the [Built-in LAN] switch switches it to [Extended LAN].  The section then shows the 
information on the LAN port for the Ethernet unit.

Changing the IP address
When you change the IP address on MONITOUCH, press [Main Menu] → [Ethernet].
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When you set the address for the built-in LAN port, show [Built-in LAN].
Pressing the [Built-in LAN] switch switches it to [Extended LAN].



17.2    Two Ethernet Ports

17-11

17

System Memory ($s)

The following describes the system memory associated with two Ethernet ports.

* If an Ethernet unit is mounted on the V8 series without the built-in LAN port, $s518 is used for 
Ethernet status storage.

Description of Addresses
$s512
This address is used to specify a port for sending/receiving Ethernet macros (EREAD/EWRITE/SEND) 
when two Ethernet ports are used.

0: Built-in LAN port
Other than 0: Ethernet unit

The addresses $s514 and $s515 are pertinent to the port selected at $s512.
For more information on $s514 and $s515, refer to the V8 Series Connection Manual.

$s519
This address is enabled only when two ports are used.
The Ethernet status of the Ethernet unit will be stored in memory at $s519.
$s519 is used in the same manner that $s518 is used for the built-in LAN port.
For more information on the address $s518, refer to the V8 Series Connection Manual.

Address Description Remarks

$s512 Selection from two Ethernet ports (0: built-in LAN port, other than 0: Ethernet unit)

513 (Blank)

514 Macro: Wait request (0: no, 1: yes)

515 Result of macro execution when the above request is made

516 (Blank)

517 (Blank)

518 Ethernet status (for built-in LAN port)

519 Ethernet status (for Ethernet unit)*
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Please use this page freely.
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18 Network Camera
18.1 Overview

• Viewing images taken with a network camera is possible via Ethernet.

• Network cameras can be redirected easily from remote locations.*

* Some network cameras are not remotely operable.  See the specifications of your network 
camera.
Network camera settings are required for Axis network cameras.
For more information, refer to “Camera Lens Operation from the V8 Series” on page 18-16.
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• A currently displayed image can be saved as a JPEG file on a CF card.
Double-tap the display area to capture the image.  (With BANNER sensors only)

Operating Environment

Available V8 Models

* Except for portrait-oriented V808iC or V806i

Available Network Cameras or Sensors

* When connection between a V8 and a camera or a sensor is first established, no image is 
displayed on the V8.
To display images, set the sensor memory PI10000-00 (Trigger) 0 to 1 (leading edge).
To access sensor memory from V8, click [System Setting] → [Device Connection Setting] 
and set [Maker: BANNER].

MONITOUCH Model Port Color

V815iX/V812iS
V810iS/V810iT/V810iC
V808iS/V808iC/V808iCH
V806iT/V806iC

Built-in LAN 32k or more colors

Maker (Model) Type Protocol

Axis
MOTION-JPEG 
(Moving images) HTTP protocol communication (TCP/IP)Panasonic

BB series
BL series

BANNER
PresencePLUS P4 OMNI

Bitmap
(Static images)* Dedicated protocol

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

PASS POWER
READY

FAIL ERROR
TRIGGER

CF

Ethernet

V8i series

Vision sensor

Double-tapping the display area on V8 
saves the image to the “SNAP” folder 
on the CF card.

* Macro commands to save captured images are not supported.
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Setting Items

V-SFT Setting

• [Network Camera Display] dialog setting

Network Camera Setting

• Axis models → “18.3 Axis Network Camera (Example: Axis 214PTZ)” (page 18-10)
• Panasonic models → “18.4 Panasonic Network Camera (Example: BB-HCM580)” (page 18-17)
• BANNER models → “18.5 BANNER (Example: PresencePLUS P4 OMNI)” (page 18-30)
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18.2 V-SFT Setting
[Network Camera Display] Setting

Select [Parts] → [Multimedia] → [Network Camera Display].  An image display part is placed on the 
screen.  (Alternatively you can go to [Parts] → [Parts List], and select [Network Camera Display].)
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[Network Camera Display] Dialog

[Main] Tab Window

Click or 
double-click.

1.

2.

3.

4.
5.

6.
7.
8.

1. Maker AXIS, Panasonic, BANNER

2. Network Camera: 
IP address*1 

Specify the IP address of the network camera.

3. Network Camera: 
Port no. 
(1 - 65535)

Specify the port number of the network camera.

* This setting can be omitted for [Maker: AXIS]. 
4. Use basic 

authentication
If basic authentication is used for the network camera, check this 
box.  For more information, refer to your network camera settings.

* This setting can be omitted for [Maker: BANNER].
5. User ID

Password
Enter the user name and password registered in the network 
camera settings.  For more information, refer to your network 
camera settings.

* These settings can be omitted for [Maker: BANNER]. 

Maker Default Remarks

Panasonic 80

BANNER 20000 Setting range for the 
sensor: 20000 to 20009
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*1 For how to register the IP address for the network camera, refer to the network camera user’s 
manual.

*2 Updating the display of images taken with a network camera is dependent on the image 
processing cycle.  Smaller display sizes are recommended to improve image processing 
performance.

[Action] Tab Window (For [Maker: BANNER])

6. Port No.
(1024 - 65535)

Specify the port number of V8.
Depending on the network camera manufacturer, the number of 
ports to be used following the specified port number differs.

7. Display Size*2

(160*120, 192*144, 
320*240, 640*480)

Select a display size.
* The option “192*144” is invalid for [Maker: AXIS or 

BANNER].
8. Rotate

(0, 90, 180, 270)
Select an image rotation angle.  Select an angle appropriate for the 
installed network camera.
When the image display area is linked to the camera icon on the 
editor software, the area also rotates according to this angle 
setting.

* The options “90” and “270” are invalid for [Maker: 
Panasonic or BANNER]. 

Maker No. of Ports Default

Axis
Panasonic

Consecutive 3 ports 50000 to 50002

BANNER 1 port 1969 (fixed)

Maker Model 
(example)

Remarks

Axis 214PTZ Use Axis’s dedicated tool when changing the default 
(default: 192.168.0.90). 

Panasonic BB-HCM580 Use the network camera’s accessory CD-ROM when 
changing the default (default: automatic setup). BANNER PresencePLUS 

P4 OMNI

Double Click Action When [Single Snap] is selected, double-tapping the display area saves 
the image.  The file of the image is saved to the “SNAP” folder on the 
CF card.

* Macro commands to save captured images are not supported.
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[Snap] Tab Window (For [Maker: BANNER])

1.

2.

3.

4.

5.

1. Snap File Name*1  *2

([Auto]: 0 - 254
[Specify]: 0 - 32767) 

[Auto]:  
Snapshot files are saved automatically under consecutive 
numbers starting from “VD00000.jpg”.  When the number of 
snapshot files reaches the [Maximum Number of Snap Files in 
Auto] (“3” below), previous files will be overwritten starting from 
the file “VD00000.jpg”. 

[Specify]:
A snapshot file is saved to the specified file “VDxxxxx.jpg”.  If the 
specified file already exists, it is overwritten.

2. Snap Settings The [Video/RGB Settings] dialog is displayed.
The dialog is commonly used for video and RGB settings.

3. Maximum Number of 
Snapshot files in Auto
(0 - 255)

Specify the maximum number of times for saving snapshot files to 
the CF card.
This is valid when [Auto] is checked for [Snap File Name] 
(“1” above).
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*1 Setting examples
• [Snap File Name: Auto] and [Maximum Number of Snap Files in Auto: 10]: 

Snapshot files ranging from “VD00000.jpg” to “VD00009.jpg” will be created in sequence.  
When the file “VD00009.jpg” is created, the previous files will be overwritten from 
“VD00000.jpg”.  

• [Snap File Name: Specify] and [Maximum Number of Snap Files in Auto: 30]:
Only the file “VD00030.jpg” is created and will be overwritten.

*2 When screen data contains both [Auto] and [Specify] selected for [Snap File Name], enter a 
value for [Specify] in the 255 to 32767 range so that files according to [Auto] do not overwrite the 
file according to [Specify].
When [Auto] is selected, the file number saved last is stored in system memory $s932.

[Detail] Tab Window

4. When the Snapshot file 
Limitation is Exceeded

Select the action to take when [Maximum Number of Snap Files in 
Auto] (“3” above) is exceeded.

[Stop]:
When the maximum number of snapshots have been taken, 
saving files stops.

[Overwrite]:
When the maximum number of snapshots have been taken, the 
previous snapshot files will be overwritten from the initial file.

5. Snap File Compression 
Rate (Low/Middle/High)

Select a snapshot file compression rate.

[High]: 
File size decreases with image degradation.

[Middle]: 
File size and image quality are at a medium level.
(Approximately twice the level of [High])

[Low]: 
File size increases with improved image quality.
(Approximately twice the level of [Middle])

ID (0 - 255) Specify the ID.  For more information, refer to the V8 Series Operation 
Manual.
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Switches

*1 Some models do not support these functions.  See your network camera specifications.
(No BANNER products support these functions.)  

*2 When these switches are linked to the network camera image display, the camera channel 
settings are invalid.

Category Function *1 Description

Network 
camera 
image

Step Left Turns the camera to the left.

Step Right Turns the camera to the right.

Step Up Turns the camera upward.

Step Down Turns the camera downward.

Zoom In Zooms in on an image.

Zoom Out Zooms out on an image.

Focus Far Focuses the camera on a distant point.

Focus Near Focuses the camera on a nearby point.

Video Pause *2 Stops the movie display.

Restart *2 Restarts the movie display.

If the [ON repeat] setting is made in the [Delay] tab window in the [Switch] dialog, the 
action by the corresponding switch is repeated while it is held down.
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18.3 Axis Network Camera (Example: Axis 214PTZ)
Access from the Computer

1. Start up Microsoft Internet Explorer on your computer.
2. Enter the IP address of the network camera in the address field.

3. When the use of basic authentication* is selected, the following dialog is displayed.
If basic authentication is not in use, go to step 5.

* For more information on basic authentication, refer to “Basic Authentication Setting” page 18-14.

4. Enter the user name and the password as already registered, and click the [OK] button.

http://xxx.xxx.xxx.xxx

IP address of the network camera
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5. The [Live view] window is displayed.
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Network Camera Setting

IP Address Check and Change

1. Open the [Setup] window.

2. In the menu located to the left of the screen, click [Basic Configuration Instructions] → [2. TCP/IP].
3. Make settings of the network camera IP address, subnet mask, and gateway.

4. If you have made any changes, click the [Save] button to save the changes.

If basic authentication is not in use, pressing the [Setup] button calls up the dialog as 
shown in step 3 in “Access from the Computer” page 18-10.  Enter the user name and 
the password as already registered.

1.

2.

4.

3.



18    Network Camera

18-13

18

HTTP Setting

1. Open the [Setup] window.

2. In the menu located to the left of the screen, click [System Options] → [Security] → [HTTPS].
3. Select “HTTP” for the options under [HTTPS Connection Policy].  (“HTTP” is selected as default.)

If basic authentication is not in use, pressing the [Setup] button calls up the dialog as 
shown in step 3 in “Access from the Computer” page 18-10.  Enter the user name and 
the password as already registered.

1.

2.

3.
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Basic Authentication Setting

Basic authentication is provided to permit or prohibit access from anonymous users.
The use of basic authentication prohibits access from anonymous users.

1. Open the [Setup] window.

2. In the menu located to the left of the screen, click [Basic Configuration Instructions] → [Users].
3. If there is no check mark for the options under [User Settings], basic authentication is required for 

the network camera.

4. If basic authentication is not necessary, check [  Enable anonymous viewer login (no user name 
or password required)] for [User Settings] and click the [Save] button for confirmation.

* When operating the camera by the switch on the V8 series, check [  Enable anonymous PTZ 
control login (no user name or password required)] and click the [Save] button for confirmation.  
For more information, refer to “Camera Lens Operation from the V8 Series” (page 18-16). 

If basic authentication is not in use, pressing the [Setup] button calls up the dialog as 
shown in step 3 in “Access from the Computer” page 18-10.  Enter the user name and 
the password as already registered.

When selecting the use of basic authentication, make the following settings in the V-SFT 
software: As shown below, check [  Use basic authentication] and then enter the user 
ID and the password as already registered.  To see the registered user name and the 
password, refer to “User Name and Password Check and Registration” page 18-15.

1.
2.

4.

3.
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User Name and Password Check and Registration

1. Open the [Setup] window.

2. In the menu located to the left of the screen, click [Basic Configuration Instructions] → [Users].
3. If user registration has already been completed, the registered contents are displayed under [User 

List].
4. When registering a new user, click the [Add...] button.  When making changes to the registration, 

click the [Modify...] button.

5. The [User Setup] window is displayed.
Enter the desired name for [User name].  Also enter the same password for [Password] and 
[Confirm password].

6. Click [OK] to complete the setting.

If basic authentication is not in use, pressing the [Setup] button calls up the dialog as 
shown in step 3 in “Access from the Computer” page 18-10.  Enter the user name and 
the password as already registered.

Check [Administrator] for [User group].

1.
2.

4.

3.

6.

5.



18    Network Camera

18-16

Camera Lens Operation from the V8 Series

You can manipulate the camera lens by using the switches from the V8 series.

• With basic authentication
Open the [User Setup] window* and check [ Enable PTZ control].

*  For how to reach the [User Setup] window, refer to “User Name and Password Check and 
Registration” page 18-15.

• Without basic authentication 
Open the [Users] window*.  Check both boxes under [User Settings] and click the [Save] button 
for confirmation.

*  For how to reach the [Users] window, refer to “Basic Authentication Setting” page 18-14.
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18.4 Panasonic Network Camera 
(Example: BB-HCM580)
Access from the Computer

You can access from your computer to a network camera via the CD-ROM included with the network 
camera or via web browser.

* Choose the method using the CD-ROM when setting a factory-shipped network camera 
first.

CD-ROM

1. Load the CD-ROM included with the network camera into your computer.
2. The [Network Camera] dialog is displayed.  Click [Search for Cameras].  Search starts to find the 

camera, which you are attempting to connect with the computer.

3. The following message appears.  Click [OK].
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4. When the target network camera is found, its information, such as the MAC address and IP 
address, is displayed in the [Easy Setup] dialog.  Click [Access Camera].*

* If the IP address of the network camera does not exist in the network group of the 
computer, click the [Network Settings] button.  In the dialog to be displayed, change the 
IP address of the network camera so that it belongs to the network group of the 
computer.

5. When you attempt to connect a factory-shipped network camera to your computer first, the [Initial 
Authentication Setting] screen appears.
Register a user name and a password for the administrator.  (When they have already been 
registered, go to step 6.)  For more information, refer to the network camera user’s manual.

The password registered in this step is required for access to the network camera.
Be careful in managing your password not to forget it.
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6. The authentication dialog is displayed.
Enter the administrator-level user name and the password and click [OK].

7. The [Top] tab window is displayed.
 (This tab window is displayed when login authentication is performed with the administrator-level 
user name and password.  In the case of login by a general or guest user, the tab window to be 
displayed slightly varies in menu.)

When [Permit access from guest users] is checked on the [Administrator] page, the 
[Top] tab window is displayed.  Click the [Login] tab.
For more information, refer to “Authentication Setting” page 18-24.
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Web Browser (Microsoft Internet Explorer)

1. Start up Microsoft Internet Explorer on your computer.
2. Enter the IP address and the port number of the network camera in the address field.

* When the factory-set port No. 80 is used, the entry of the port number may be omitted.

3. The authentication dialog is displayed.
Enter the administrator-level user name and the password and click [OK].

When [Permit access from guest users] is checked on the [Administrator] page, the 
[Top] tab window is displayed.  Click the [Login] tab.
For more information, refer to “Authentication Setting” page 18-24.

http://xxx.xxx.xxx.xxx

Network camera IP address

: Port number/
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4. The [Top] tab window is displayed.
(This tab window is displayed when login authentication is performed with the administrator-level 
user name and password.  In the case of login by a general or guest user, the tab window to be 
displayed slightly varies in menu.)
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Network Camera Setting

IP Address Check and Change

* Login with the administrator-level user name and password is required to proceed to the 
following tab window setting.

1. Click the [Setup] tab.
2. Check that [Network (IPv4)] is selected in the [Basic] menu at the left of the screen.  Go to the 

[Connection Mode] area and click [Static].

3. Make settings of the network camera port number*, IP address, subnet mask, and gateway.
* The default port No. is 80.  Enter a port number in the 1 to 65535 range.

Enter a port number for [Network Camera: Port no.] in the [Network Camera 
Display] dialog in V-SFT. 

1.

2.
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4. Click [Save] to save the settings made in the previous steps.

3.

4.

With the CD-ROM accompanying the network camera, reviewing and changing the IP address is 
possible through the [Network Settings] button placed in the [Easy Setup] window.
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Authentication Setting

Authentication setting is made to permit or prohibit access from anonymous users.
This setting enables you to deny access from anonymous users.

* Login with the administrator-level user name and password is required to proceed to the 
following tab window setting.

1. Click the [Setup] tab.
2. Go to the [Account] menu at the left of the screen.  Click [Administrator].
3. In the [General Authentication] area, choose either [Permit access from guest users] or [Do not 

permit access from guest users].

4. Click [Save] to save the setting made in the previous step.

Permit access from guest 
users

This option allows anyone to access the network camera 
without the user name and the password.

Do not permit access from 
guest users

Whenever you attempt to access the network camera, the 
authentication dialog appears.  By entering the user name and 
the password as registered, you are granted access to the 
network camera.

When the option [Do not permit access from guest users] is checked, make the following 
settings in the V-SFT software.  As shown below, check [  Use basic authentication] 
and then enter the user ID and the password as already registered.  To see the 
registered user ID and password, refer to “User Name and Password Check and 
Registration” page 18-27.

1.

2.

4.

3.
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General User Registration and Change

When anyone other than the administrator should gain access to the network camera, general user 
registration is required.

* Login with the administrator-level user name and password is required to proceed to the 
following tab window setting.

New general user registration
1. Click the [Setup] tab.
2. Go to the [Account] menu at the left of the screen.  Click [General User].
3. Click [Create].

4. The [New General User Registration] page is displayed.  Set the data items as specified below.

5. Click [Save] to save the settings made in the previous steps.

The password registered in this step is required for access to the network camera.
Be careful in managing your password not to forget it.

1.

2.

3.

* A maximum of 50 names 
can be registered as 
general users.

4.
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Changes to the guest user settings
The explanation hereafter is associated with a case where [Permit access from guest users] is 
checked in the [General Authentication] area.
When someone gains access to the network camera without the user name and the password, the 
features of the camera made available are limited according to the settings in the following tab window.

1. Click the [Setup] tab.
2. Go to the [Account] menu at the left of the screen.  Click [General User].
3. Check that [Guest User] is selected in the [User ID List].  Click [Modify].

4. The [Modify Guest User] page is displayed.  Set the data items as specified below.
5. Click [Save] to save the settings made in the previous steps.

1.

2.

3.

5.

4.
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User Name and Password Check and Registration

In a case where [ Do not permit access from guest users] is checked in the [General Authentication] 
area, the user name and the password registered for the administrator or a general user in the network 
camera setting tab window must be set in the V-SFT software.
For more information on the authentication settings, refer to “Authentication Setting” (page 18-24).

* Login with the administrator-level user name and password is required to proceed to the 
following tab window setting.

For the administrator
1. Click the [Setup] tab.
2. Go to the [Account] menu at the left of the screen.  Click [Administrator].
3. Review the settings in the [Administrator Authentication] area.
4. If any changes are made to these fields, click [Save] to save the changes.

When a password has already been registered, the [Password] field is blanked out.
Be careful in password management.  If you forget the password, a password newly 
registered is usable for authentication.

1.

2.

4.

3.
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For general users
1. Click the [Setup] tab.
2. Go to the [Account] menu at the left of the screen.  Click [General User].
3. Select the target user name from the [User ID List].
4. Click [Modify].

5. Review the settings in the [Input User Name and Password] area.
6. If any changes are made to these fields, click [Save] to save the changes.

1.

2.

4.

3.

6.

5.
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Image Display Setting

* Login with the administrator-level user name and password is required to proceed to the 
following tab window setting.

1. Click the [Setup] tab.
2. Go to the [Advanced] menu at the left of the screen.  Click [Image Display].
3. Set the data items as specified below.

4. Click [save] to save the settings made in the previous steps.

While the V8 unit is in communication with the network camera, the settings for the V8 
unit will be overwritten according to the following tab window.  Because this overwriting 
is likely to be somewhat time-consuming, the V8 settings should be made the same as 
the contents in the tab window beforehand.

1.

2.

4.

3.



18    Network Camera

18-30

18.5 BANNER (Example: PresencePLUS P4 OMNI) 
Access from the Computer

When accessing from a computer to a sensor, use the software “PresencePLUS” dedicated to the 
sensor.
The CD-ROM accompanying the sensor includes this software.  Load the CD-ROM into the computer 
and install the software.
For installation procedure, refer to the manual issued by BANNER.

1. Start the software “PresencePLUS”.
2. The [System Setup] dialog is displayed.

When a connected sensor is found, the information on the sensor, including the IP address and 
MAC address, appears in the dialog.
Select the desired sensor listed under [Sensor Neighborhood] with the cursor and click [Change 
Sensor IP Address].
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3. The [Select Ethernet Adapter] dialog is displayed.
Select the Ethernet adapter of the computer and click [Next].

4. The [Set Sensor IP Address] dialog is displayed.
Make changes to the sensor IP address or subnet mask as necessary and click [Finish].

5. Click [OK] in the [System Setup] dialog to exit the dialog.
6. When connection between the computer and the sensor is established, the monitor screen is 

displayed on the computer.

The sensor is reset in this step.

* Make sure that the computer network group and the sensor IP address are on the 
same network.
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Sensor Settings

Port Number Setting

1. Click the [Tools] menu button.

2. Click the [Analysis] tab → [Communication].

3. The [Communication Tool] menu opens.
Enter an arbitrary name for [Name], and check [Image] for [Select].

4. In the [Connection(s)] section, select an Ethernet socket number.  The sensor port number 
corresponding to the selected socket number is used for connection with V8.  To see more 
information on each Ethernet socket number, go to the [Connection Detail] dialog by clicking [View 
Settings].  

5. In the [Resolution] section, select the size of the image to be displayed on V8.

1.

2.

Socket No. Port No. (Fixed)

Ethernet socket 1 20000

Ethernet socket 2 20001

Ethernet socket 3 20002

Ethernet socket 4 20003

Ethernet socket 5 20004

Ethernet socket 6 20005

Ethernet socket 7 20006

Ethernet socket 8 20007

Ethernet socket 9 20008

Ethernet socket 10 20009

* The sensor port number 
corresponding to each 
Ethernet socket number is 
fixed.

Resolution Description*

1 : 1 At the same magnification (640 × 480 dots)

4 : 1 One-half (320 × 240 dots) of the width and height in 1 : 1 resolution

16 : 1 One-quarter (160 × 120 dots) of the width and height in 1 : 1 resolution 

64 : 1 One-eighth (80 × 60 dots) of the width and height in 1 : 1 resolution 

* The size of images captured with the sensor is based on 640 × 480 dots (default).  
When changing the size, refer to the manual issued by BANNER.
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6. Click [Next] to exit the menu.

If connecting two or more V8 units (10 units maximum), repeat steps 2 through 5.
Only one V8 unit can be connected per sensor port number.

3.

4.

6.

5.
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[Run] Menu

1. Click the [Run] menu button.

2. The [Save Inspection] dialog is displayed.
Select “Sensor” for [Save in].
Enter an [Inspection Number] and [Inspection Name] for registration, and click [Save].

Example
[Inspection Number: 3] 
[Inspection Name: LINE.ins] 
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3. Click the [Select] tab in the [Run] menu.  Go to [Hardware Input] and select the name that was 
entered for [Inspection Name] in step 2.  

4. Click the [Monitor] tab → [Start].

Settings in the [Run] menu are complete.
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18.6 Limitations
Limitations for individual manufacturers are as follows.

AXIS and Panasonic

• With no basic authentication, size and rotation settings made for a network camera on the screen 
are invalid.  The previous size and rotation settings take effect for the display of images captured 
with the network camera.  

• Focus and brightness of images displayed by a network camera are automatically adjusted.

BANNER

• Focus and brightness of images displayed by a sensor are not automatically adjusted.  Sensors do 
not support these automatic adjustments.

• The resolution of snapshot files saved on V8 is dependent on the resolution of the network camera 
or sensor.

All Manufacturers

• The display size is dependent on the resolution of the network camera or sensor.  If a display area 
placed on the screen is smaller than the resolution of the network camera or sensor, captured 
images displayed in the area are partially cut off.

• A single layer (such as a screen or an overlap) cannot show multiple network camera displays at 
the same time.  If multiple displays are placed, the display first shown is active.
Other images can be displayed by switching the screen. 

• In a case where an overlap display area containing a network camera/sensor display is called up 
while a network camera/screen display is shown on the screen, only the display on the overlap 
display area will be active.
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19 Remote Desktop Window Display
19.1 Overview

Overview

• The remote desktop window display function enables you to view remote computer screens on 
your V8 series.
This function serves the purpose of remote monitoring through the V8 series connected to, for 
instance, a server (computer) that controls the entire production line or computers that are 
installed in a clean room where access is limited.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Example: Monitoring the server (computer) in Clean room B

Ethernet

Clean 
room A

Clean 
room B

Clean 
room C
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• It is also possible to operate the screens of remote computers from the V8 series while you are 
using a mouse and a keyboard connected to the V8 unit.  You can easily enter data or read 
manuals through the V8 unit even if you are at the worksite where it is difficult to bring a computer 
with you.

* For more information, refer to “Remote Desktop Window Configuration and Operation” (page 
19-23).

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Ethernet

Example: Editing the V8 screen data in the V-SFT installed in a computer at your office

Office
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Operating Environment

Available V8 Models

Server (Computer)

Setting Items

Server (Computer) Setting

• “UltraVNC Installation and Setting”  → page 19-4

V8 Setting

• “Registering/Unregistering the License” → page 19-12

V-SFT Setting

• “[Remote Desktop Table Setting] Dialog” → page 19-14
• “Remote Desktop Window Display Procedure”

Placement of a Display Area to Show Remote Desktop Window → page 19-15
Switch to Show/Hide Remote Desktop Window → page 19-18
Macro Command to Show/Hide Remote Desktop Window → page 19-20

MONITOUCH Model *1 Port Color Touch Switch 
Specifications Applicable Version *2

V815iX/V812iS
V810iS/V810iT/V810iC
V808iS/V808iC/V808iCH
V806iT/V806iC

Built-in LAN 32k or more 
colors Analog

V-SFT
Version 5.4.1.0 or later

SYSTEM PROG.
Version 1.410 or later

*1 Not available on the portrait-oriented V808iC.
*2 If your software is an earlier version, perform a system update.  You can download the V-SFT 

update program from the Hakko Electronics website.

Item Description

OS Windows XP/Vista 32-bit

Protocol TCP/IP

About VNC (Virtual Network Computing)
This software is developed by AT&T Laboratories Cambridge (U.K.) and designed to 
operate remote computer screens across a network.
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19.2 Server (Computer) Setting
UltraVNC Installation and Setting

This section describes the settings necessary for remote desktop window display, using the UltraVNC 
as an example.

1. Download the UltraVNC from the website (“Location to access”) below.

2. Select an option for [Save in:] and click the [Save] button.

3. The above step completes the download.
When proceeding to installation, click the [Run] button and go to step 7.

4. Click the [Run] button.

Item Description

Location to access http://www.uvnc.com/download/index.html

Recommended version UltraVNC Win32 Server 1.0.5
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5. Select the language to be used for setup.

6. Follow the installation steps.  Click the [Next] button.

7. Read the License Agreement.  When you agree to it, check [I accept the agreement] and click the 
[Next] button.
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8. Read the Information and click the [Next] button.

9. Select the location of where to install the UltraVNC and click the [Next] button.

10. Select [UltraVNC Server Only] and click the [Next] button.
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11. For registering the UltraVNC on the start menu, specify its location and the name of the program.  
Then click the [Next] button.

12. Click the [Next] button.  (You do not need to check the box below if your OS is not Windows Vista.)

13. Be sure that the box for [Download the mirror driver] is checked and click the [Next] button.
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14. Check the following boxes and click the [Next] button.

15. Double-check the settings that you have made so far.  If there is no problem, click the [Install] 
button.  If any correction is necessary, go back to the previous step using the [Back] button.

16. Installation starts.

Check this box to register the 
UltraVNC server as a 
Windows service.

Check this box to start or 
restart the UltraVNC service 
upon completion of the 
UltraVNC installation.
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17. The following two dialogs appear.
 In the [Setup] dialog, click the [Next] button.  Go to step 21.
 In the [Info] dialog, click the [OK] button.  Go to step 22.

18. Click the [Finish] button.  The software has been installed.

About the [Info] dialog
This dialog is a notice that it is required to uncheck the box for [ Protect my computer 
and data from unauthorized program activity] in step 23.

[Setup] dialog [Info] dialog
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19. Set the options as the following in this dialog (in Windows Vista, be sure to check the boxes in the 
dotted frames).  Click the [OK] button.

* For the establishment of connection with multiple V8 units, check [Keep existing 
connections] under [Multi viewer connections].

20. Uncheck the box enclosed in the red circle and click the [OK] button.

About [VNC Password]
The password set in the above dialog must be entered in the V-SFT when setting the 
remote desktop table (“[Remote Desktop Table Setting] Dialog” (page 19-14)).  Be careful 
in managing your password not to forget it. 
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21. The above is the final step of the installation procedure.
The “UltraVNC” icon is now added to the taskbar on your computer.

About the UltraVNC icon
Whenever you attempt to display the window of a remote desktop, the UltraVNC must be 
activated on the computer.  (If the UltraVNC is deactivated, the display of the remote 
desktop window is disabled.)  The icon turns orange while connection to the V8 series is 
established.

UltraVNC activated (green)

Connected to the V8 series (orange)
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19.3 V8 Setting
Registering/Unregistering the License

License registration is required for remote desktop window display.  One license is granted to one V8 
unit.

Registering the License

1. Bring up the Main Menu screen on your V8 series.
2. Press the [Extended Setting] switch on the Main Menu screen.  The Extended Setting screen 

appears.
* If the Main Menu screen does not include the [Extended Setting] switch, the system program 

version of your V8 unit may be outdated.  Update update your system (version 1.410 and later 
supported).

3. Press the [Remote Desktop Key Code] switch.  The Remote Desktop screen appears.

4. Type the key code (8-digit numerals) on the keypad and press the [Setting Finished] switch to 
enter.

5. The completion of the registration automatically returns you to the Main Menu screen.

For purchasing the license “V-RemoteDT”, contact your local distributor.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Extended Setting screen

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Remote Desktop screen
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Unregistering the License

You can unregister the license from the V8 series.

1. Bring up the Remote Desktop screen.
For how to switch to the screen, refer to “Registering the License” (page 19-12).

2. Press the [Delete] switch and press the [Execute] switch in the dialog that appears accordingly.

3. The [Delete] switch disappears and [Not registered] appears in its place.

4. The license is now unregistered.

If you wish to display the window of a remote desktop again, you will be requested to register the key 
code.  Please be careful in managing the key code as reissuing is not allowed.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Password registered

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Password unregistered
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19.4 V-SFT Setting
If you transfer screen data provided with remote desktop table settings to the V8 series, with which no 
license is registered, “Warning: 214” will be issued to the V8.  For more information on license 
registration, refer to “Registering/Unregistering the License” (page 19-12).

[Remote Desktop Table Setting] Dialog

Proceed to the registration of the computer (server) that is connected to the V8 series.
Click [System Setting] → [Remote Desktop Table Setting].  The [Remote Desktop Table Setting] dialog 
is displayed.

Local Port No. Select a local port number for the V8 series.
This port is used as a sending/receiving port for remote desktop window display 
(default: 8050, range: 1024 to 65533).

Computer Name Specify the name of the server (computer).

IP Address Specify the IP address of the server (computer).

LAN Port No. Specify the port number of the server (computer) (default for UltraVNC: 5900).

Password Specify the password.  Typing the password shows eight asterisks (one-byte 
254 alphanumerics maximum).

Auto-reduction Check this box when you zoom out a computer screen to show it entirely.

PC resolution When [ Auto-reduction] is checked, specify the resolution of the computer.
(800*600, 1024*768, 1152*864, 1280*1024, 1600*1200, or specify a width in the 
800-1600 range and a height in the 600-1200 range) 

The password to be entered here must be the same as that set in the UltraVNC.
(Refer to step 22 in “UltraVNC Installation and Setting” (page 19-4)).
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Remote Desktop Window Display Procedure

Remote desktop windows can be displayed on your V8 series in the three methods below:

• Placement of a Display Area to Show Remote Desktop Window → page 19-15
• Switch to Show/Hide Remote Desktop Window → page 19-18
• Macro Command to Show/Hide Remote Desktop Window → page 19-20

Placement of a Display Area to Show Remote Desktop Window

A display area placed is readily usable to show the screen of a server (computer) connected to the V8 
unit.
Click [Parts] → [Remote Desktop Display].  A display area part to display a remote desktop window is 
placed.

Switch

Remote desktop item
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[Remote Desktop Display] dialog
Double-clicking or clicking the remote desktop item brings up the [Remote Desktop Display] dialog. 

• [Main] tab window

• [Detail] tab window

*1 With [Display on-startup] unchecked, the window of the connected server (computer) can be 
displayed by a switch that is explained in the next section.

*2 The [ Auto-reduction] box requires to be checked in the [Remote Desktop Table Setting] 
dialog.
For more information, refer to “[Remote Desktop Table Setting] Dialog” (page 19-14).

[Main] tab window 

Remote Desktop 
Table No.

Specify the table number of the target server (computer) that has been 
registered in the [Remote Desktop Table Setting] dialog.

Display on-startup The window of the connected server (computer) appears at V8 
startup.*1

Auto-reduction on 
start-up

A computer screen is automatically zoomed out for its entire display. *2
This is enabled when the screen of the connected computer is 
displayed initially on the V8 unit.
From the second display and after, the computer screen will be 
displayed at the same magnification.

ID (0 - 255) Specify the ID.  For more information, refer to the V8 Series Operation 
Manual.
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Switch
Under [Function], select [Remote Desktop] and an option from [Connect], [Disconnect] and 
[Connect/Disconnect].

• [Main] tab window

* While the auto-reduction function is in use, showing or hiding the scroll bar (S menu) is 
not selectable.

• [Detail] tab window

Switch 
Function

Auxiliary 
Setting Item Description

Remote 
Desktop

Connect Connection between the V8 unit and the target server (computer) is 
established to enable the display of the remote desktop window.  

Disconnect Connection between the V8 unit and the target server (computer) is 
disconnected to disable the display of the remote desktop window.

Connect/
Disconnect

Each time you press the switch provided with this function, 
connection with the server (computer) is established to enable and 
canceled to disable the display of the remote desktop window.

Show/hide a 
scroll bar 
(S menu)

Each time you press the switch provided with this function, the scroll 
bar (S menu) is either shown or hidden.*

Reduce 
Display/
100% Display

Each time you press the switch provided with this function, the 
display of the computer screen is switched between the 
automatically reduced size and the same magnification.

ID (0 - 255) The ID specified here must be the same as that set in the [Remote 
Desktop Display] dialog.  For more information on the ID, refer to the V8 
Series Operation Manual.
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Switch to Show/Hide Remote Desktop Window

With the use of a switch placed on the screen, the window of a target server (computer) can be shown 
in and hidden from an area at the specified coordinates.  In the [Switch] dialog for such a switch, select 
[Standard] and [Remote Desktop Show/Hide] under [Function]. 

* Function switch setting is disabled.

*1 The [ Auto-reduction] box is required to be checked in the [Remote Desktop Table Setting] 
dialog.
For more information, refer to “[Remote Desktop Table Setting] Dialog” (page 19-14).

Switch 
Function

Switch Function/
Auxiliary Setting Item Description

Standard Remote Desktop Show/Hide Each time the switch provided with this function is 
pressed, the display of a remote desktop window is 
enabled and disabled.

Specify with 
Mouse

The mouse is used to specify the position where a 
remote desktop window is displayed.

Start X Specify an X coordinate as the start point where a 
remote desktop window is displayed.

Start Y Specify a Y coordinate as the start point where a 
remote desktop window is displayed.

Width Specify the width of the area where a remote 
desktop window is displayed.

Height Specify the height of the area where a remote 
desktop window is displayed.

Remote
Desktop 
Table No.

Specify the table number of the target server 
(computer) that has been registered in the [Remote 
Desktop Table Setting] dialog.

Auto-
reduction 
on start-up

A computer screen is automatically zoomed out for 
its entire display. *1



19    Remote Desktop

19-19

19

* The macro command REMOTEDT_CTL is used in conjunction with showing/hiding the 
scroll bar (S menu).  For more information, refer to “Macro Command to Show/Hide Remote 
Desktop Window” (page 19-20).

About [Remote Desktop Table No.]
Click the [Select] button.  Enter the table number the same as the number of the target 
server (computer) set in the [Remote Desktop Table Setting] dialog (No. 0 in the example 
dialog).
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Macro Command to Show/Hide Remote Desktop Window

The following macro commands are provided to show/hide or switch the window of a target remote 
server (computer).

SET_REMOTEDT  F0 F1

Function: Showing/hiding a remote desktop window
This macro command is used to show/hide the window of a computer (server) provided with remote 
desktop table No. [F1] specified in the [Remote Desktop Table Setting] dialog, according to [F0].

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
Display in an area based on the specified coordinates (V812S, remote desktop table No. 10):

$u00100 = 2 (W) for same-sized 
display based on the 
specified coordinates

$u00101 = 0 (W) for X coordinate as 
the start point

$u00102 = 0 (W) for Y coordinate as 
the start point

$u00103 = 400 (W) for width
$u00104 = 300 (W) for height
SET_REMOTEDT ($u00100, 10)

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

Value Remarks

F0

0: Hide
1: Same-sized display
2: Same-sized display (based on the specified coordinates)
3: Automatically reduced display
4: Automatically reduced display (based on the specified 

coordinates)

F0 + 1 X coordinate as the start point

Valid when F0 = 
2 or 4

F0 + 2 Y coordinate as the start point

F0 + 3 Width

F0 + 4 Height

F1 0 to 255: Remote desktop table number

Start point (0, 0)
(400, 0)

Remote desktop
window

(0, 300) (400, 300)

Remote desktop table number
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Supplementary information
• The macro command SET_REMOTEDT is enabled, provided that the [Remote Desktop Table 

Setting] dialog has been set.  For how to set the dialog, refer to page 19-14.
• This macro command is not usable as an initial macro.
• $s1063 stores the result of macro execution.

REMOTEDT_CTL  F0  F1  F2

Function: Switching the display in the remote desktop window
This macro command is used to switch the display in the window of a computer (server) provided with 
remote desktop table No. [F1] specified in the [Remote Desktop Table Setting] dialog, according to 
[F0].

Available memory

: Setting enabled (indirect designation disabled)  
: Setting enabled (indirect designation enabled)

Range

* About “2: Automatic”

Code (DEC) Description

0 Normal

−1 Execution error

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

F2

Value

F0
0: Computer screen reduction
1: Computer screen rotation
2: Show/hide scroll bar (S menu)

F1 0 to 255: Remote desktop table number

F2

(F0 = 0) (F0 = 1) (F0 = 2)

0: Same-sized
1: 1/4
2: 1/9
3: 1/16
4: Auto-reduction

0: 0°
1: 90°
2: 270°

0: Hidden
1: Shown normally
2: Automatic*

Computer (page 19-14) and 
V8 resolutions Scroll bar (S menu)

Computer resolution > V8 resolution Shown

Computer resolution = V8 resolution Hidden

Computer resolution < V8 resolution Hidden
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Example
Hiding the scroll bar (S menu) (remote desktop table No. 10):

REMOTEDT_CTL  2  10  0 

Supplementary information
• The macro command REMOTEDT_CTL is enabled, provided that the [Remote Desktop Table 

Setting] dialog has been set.  For how to set the dialog, refer to page 19-14.
• While the auto-reduction function is used to display a screen of the computer, the scroll bar (S 

menu) cannot be displayed.
• The result of macro execution is stored in $s1063.

Code (DEC) Description

0 Normal

−1 Execution error

Remote desktop table No. 10
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19.5 Remote Desktop Window Configuration and 
Operation
Window Configuration

When connection is normally established between the V8 series and a target remote server 
(computer), the window of the server is displayed on the V8 unit.  When the V8 series and the server 
(computer) are disconnected, the window disappears after a momentary display of the “Disconnected.” 
screen.

Example: [ Auto-reduction] unchecked

* The scroll bar (S menu) cannot be displayed while the auto-reduction function is used.

Scroll bar
If the resolution of the server (computer) is higher than that of the remote desktop window display 
area, you can view the hidden part in the area by scrolling either horizontally or vertically with the scroll 
bar.

[S] switch
Pressing this switch shows or hides the [S] menu.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Handshaking...

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

At the time of connection start Remote desktop window

[S] switch*[S] menuScroll bar*

Remote 
desktop 
window



19    Remote Desktop

19-24

[S] menu
This is a switch menu dedicated to the remote desktop window display.  The switches in the menu 
work as shown in the following table, such as rotating or reducing the display area.

Item Description Item Description

ESC Esc key entry ↓ ↓ key entry

SHFT Shift key entry Up Page-up key entry

CTRL Ctrl key entry Down Page-down key entry

ALT Alt key entry R/L OFF: Equivalent to left-clicking of the mouse
  ON: Equivalent to right-clicking of the mouse

ENT Enter key entry Zin Screen enlargement: 1/16 → 1/9 → 1/4 → 100% (maximum)

← ← key entry Zout Screen reduction: 100% (maximum) → 1/4 →  1/9  → 1/16

→ → key entry Key Not used

↑ ↑ key entry Rot Screen rotation: 90°, 180°, 270°
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Operation

A remote desktop connected to the V8 series is operative from the V8 unit by pressing the screen and 
using a USB mouse and a USB keyboard.

USB Mouse

The left-click button, right-click button, and wheel of a USB mouse are usable.
For USB mouse specifications, refer to “26 USB Connection”.  

USB Keyboard

Language setting must be made for the USB keyboard on the Main Menu screen of the V8 series.
For USB keyboard setting and specifications, refer to “26 USB Connection”.  

When no USB keyboard is used, the on-screen keyboard is usable instead.  When using 
the Windows standard on-screen keyboard, follow the steps below:
Click [Start] → [All Programs] → [Accessories] → [Accessibility] → [On-Screen Keyboard].

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Ethernet

USB mouseUSB keyboard
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19.6 System Memory
The following addresses in the system memory are used to store the data regarding the table number 
(set in the [Remote Desktop Display Setting] dialog) of the remote desktop window currently displayed 
and whether connection with the remote desktop is established.

19.7 Error
Disconnected. Screen

If connection between the V8 series and a server (computer) fails or is disconnected due to a cable 
disconnection or an error, the “Disconnected.” screen appears in place of the remote desktop window.  
Check to see the cable and the server (computer) for any problem, and reestablish connection.

Error Number

For the error number detected during data transfer, refer to “Appendix 2 Error”.

$s Description

1380 Remote desktop window status
0: Hidden (disconnected)
1: Shown (connected)

1381 Remote desktop connection status
0 or greater: Remote desktop table No.
-1: Disconnected
-2: Connection failure

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Disconnected.

At the time of disconnection
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19.8 Limitations
License Limitations

• One license is granted to one V8 unit.
• Reissuing a license key code is not allowed.  Please take care in managing the key code.

Display Limitations

• Remote desktop window display is enabled on the screen (in the screen library) only.  Display in 
the overlap library is disabled.

• Multiple remote desktop windows cannot be displayed at the same time.  If display areas are 
concurrently placed for multiple remote desktops and the box for [ Display on-startup] is 
checked, the display area placed first takes effect.

• While a remote desktop window is displayed, an attempt to bring up another on the same screen 
will turn off the initial window and switches to the next window.

• While a remote desktop window is displayed, a change to the server (computer) resolution will 
forcibly turn off the window.

• While a remote desktop window is displayed, you can turn it off via a method that is different from 
the method used to display the window, provided that the same remote desktop table number is 
specified.  However, the [disconnect] switch explained in “Placement of a Display Area to Show 
Remote Desktop Window” (page 19-17) does not work to turn off the remote desktop window that 
was displayed by a switch or the macro command.  

• If any part placed behind a remote desktop window is updated, the part will be displayed over the 
window.

• While a remote desktop window is displayed, any switches placed behind the window do not work.  
(Those switches work when no remote desktop window is displayed.)

• The display of a remote desktop window is always based on the upper left corner of the server 
(computer) screen as the start point.

• If a remote desktop window display area shows an image smaller than the area, the margin of the 
area turns black.  

• While a remote desktop window is displayed in a display area, turning it off leaves the area in the 
color as set in the V-SFT.

• When a remote desktop window is displayed by a switch or the macro command, tuning it off will 
clear the window as well as its display area.

• When a remote desktop window is initially displayed, the image is scaled to 100%.
• Once a remote desktop window is turned off, the settings for the [S] menu will return to the 

defaults.
• When a remote desktop window is turned off by a switch or the macro command, the V8 screen is 

refreshed.  If there is an overlap being displayed then, it will be deleted at the same time.  
However, the overlap remains if [ Display Overlap during bit ON] is checked in the [General 
Settings] tab window ([System Setting] → [Unit Setting] → [General Settings]).

• While a remote desktop window is displayed, switching to the Main Menu screen turns the window 
off.

• While the auto-reduction function is used to display a screen of the target server (computer), the 
scroll bar (S menu) cannot be displayed.

• For the V806 series, the auto-reduction function is available in the range 800*600 (SVGA) - 
1024*768 (XGA).

• The auto-reduction function adjusts the display of a computer screen to the display area of the 
remote desktop window on the V8 unit, provided that the length and the height of the display area 
is at the ratio of 4 to 3.  (At a ratio other than this, an empty area painted black will be left in the 
display area.) 
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Other Limitations

• The macro command SET_REMOTEDT for remote desktop window display is not usable as an 
initial macro.

• A USB mouse and a USB keyboard are not available with V808CH.
• When the remote desktop window display function and the touch switch emulation of the RGB 

display function are used at the same time, a USB mouse cannot be used for the remote desktop 
window.
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20 MES Interface Function
20.1 Overview

Overview

• The V8 series supports the MES interface function.

• The MES interface function enables the V8 to add data to, search, and delete data from 
databases.
Production control from the computer in the office is made simple by using real-time production 
information transmitted from the factory to the databases.

• The V8 sends commands to the V-Server in the computer connected via Ethernet.  The V-Server 
sends the commands in SQL statements to ODBC, and ODBC accesses the database.

MES: Manufacturing Execution System
MES provides information necessary to optimize the production activities (about quality, 
yield, time of delivery, cost, etc.) throughout processes from order receipt until the 
completion of products.  Based on real-time information obtained from the shop floor, MES 
serves as a bridge linking management and production, in order to help improve the 
management of a manufacturer. 
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• When two Ethernet ports are used, two IP addresses can be set for the V8 so that different 
networks can be established respectively in the factory and the office.  System configuration is 
therefore made simple in the existing facilities.

* An optional unit is mounted on MONITOUCH equipped with a built-in LAN port.

ODBC: Open DataBase Connectivity
ODBC is the interface between an application (V-Server) and databases.
Because ODBC accommodates the differences in specifications between databases, 
users just need to create programs based on the ODBC-specified procedure in order to 
access those databases.

V-Server

ODBC
SQL Server

Oracle

MSDE

DB1

DB2

DB3

Data source name

AAA

BBB

CCC

Database name

DB1

DB2

DB3
Link

Application

Database

Ethernet
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IP 211.13.204. x

ODBC

Office

Factory
Built-in LAN
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• Separate management through multiple V-Servers is enabled.
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Operating Environment

Available V8 Models

The MES interface function is available with all models in the V8 series.  However, a V8 unit without 
the built-in LAN port requires an optional unit because it communicates with a computer over the 
Ethernet.

Server PC

Make sure that your system meets the system requirements in the following table before using Hakko 
Electronics’ software “V-Server”.

MONITOUCH Model Port Applicable Version*1

V815iX/V812iS
V810iS/V810iT
V808iS
V808iCH
V806iT/V806iC/V806iM

Built-in LAN V-SFT
Version 5.1.0.0 or later

SYSTEM PROG.
Version 1.100 or later

Option unit*2
CU-03-2
CU-03-3

V812S
V810S
V810T
V808S
V806T/V806C/V806M

Option unit
CU-03-2
CU-03-3

*1 If your software is in earlier version, perform a system update.  You can download the 
V-SFT update program from the Hakko Electronics website.

*2 Not available with the V808iCH

Item Description

Computer Pentium II 450 MHz or equivalent

OS Windows 98 / Me / NT Ver. 4.0 / 2000 / XP (32-bit, 64-bit) / 
Vista (32-bit, 64-bit) / 7 (32-bit, 64-bit) / 8 (32-bit, 64-bit)

Memory Min. 32 MB

Hard disk 50 MB of free disk space

Database • SQL Server (Microsoft)
• MSDE (Microsoft)
• Oracle (Oracle Corporation)
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20.2 Setting Procedure
System Configuration

The following illustrates the system configuration including the MES interface function.

Preparation on Server Computer

1. V-Server installation (page 20-26)
2. Database installation and table creation (page 20-27)
3. ODBC setting (page 20-40)

Ethernet
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V8

V-Server

ODBC
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Download

• Network table
• MES setting
• Macro

Server computer



20    MES Interface Function

20-6

V8 Setting

Make the V8 settings in screen data.

1. Configuration software V-SFT version check
If your software version is earlier than designated, download the updated program from the Hakko 
Electronics website and install it.

2. Network table editing (page 20-6)
3. V8 IP address setting (page 20-9)
4. MES setting (page 20-12)
5. Macro programming (page 20-19)
6. Screen data transfer to the V8
7. V8 version check

If your V8 version is earlier than designated, perform a system update.
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20.3 V8 Setting
Network Table Editing

Regarding the computer installed with the V-Server, register its IP address and port number in network 
table editing.

1. Click [System Setting] → [Ethernet Communication] → [Network Table].  The [Network Table Edit] 
window is displayed.

2. Double-click a number under [No.].  The [Network Table Setting] dialog given the same number is 
displayed.

Port Name Set the name of the computer.

IP Address Set the IP address of the computer.
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3. Click [OK].  The network table is registered.

4. If multiple computers are connected, perform the above registration steps for each of them.

Port No. Set a port number for the V-Server running on the computer.
* The port number is shown at [Port No.] in the [V-server Detail 

Setting] dialog (in the V-Server, click [File] → [V-server Detail 
Setting]).

Send Timeout
Retrials
Port
Memory Protect
Default Gateway
Subnet Mask

Setting not required

* Setting these items is not required when you register the IP 
address of the computer, but these items must be set for 
registering the V8’s IP address.

It is also possible to register the IP address of the V8.  At this time, be sure to set the items 
mentioned in step 2 that are not necessary for registering the computer’s IP address.



20    MES Interface Function

20-9

20

IP Address Setting of the V8

To use the Ethernet functions, it is necessary to set the IP addresses.  The IP address can be set 
either in: setting it through the screen data or selecting a registered network table number on 
MONITOUCH.

Method 1: Setting within Screen Data

Set the IP addresses within the screen data.

1. Select [System Setting] → [Ethernet Communication] → [Local Port IP Address].  The [IP Address 
Setting] dialog is displayed.

2. Check [  Set IP] and make the settings.

Select IP Address from 
Network Table

This is valid when the IP address of the V8 has been registered in 
the network table.  An IP address can be selected from network 
table No. 0 to 99.

IP address *1 Set the IP address of the V8.

 Default Gateway *1 Set the default gateway.

 Subnet Mask *1 Set the subnet mask.
When this box is not checked, the subnet mask is automatically 
recognized based on the extreme left byte of the IP address.
Example
When the IP address is “172.16.200.185”, “255.255.0.0” is set.
When the IP address is “192.168.1.185”, “255.255.255.0” is set.

 Port No. *1 Set a port number (1024 - 65535). (except for “8001”)

Send Time Out Specify the timeout time to be used when sending the 
EREAD/EWRITE macro command.

Retrials 0 - 255
Specify the maximum number of retrials to be attempted in the 
case a timeout occurs.

Memory Protect Check this box when disabling data writing from a computer or 
another port.

*1 For more information on the setting items, refer to the V8 Series Connection Manual.
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Method 2: Setting at the Main Menu Screen on MONITOUCH

Select the network table number, which is set in the screen data, from the Main Menu on 
MONITOUCH.

* When IP address setting is made within the screen data, the setting within the screen data 
becomes valid.

Screen data setting
1. Click [System Setting] → [Ethernet Communication] → [Network Table].  The [Network Table Edit] 

window is displayed.
2. Select a number not in use, and make the necessary settings including the IP address of the V8.

For more information on the setting items, refer to the V8 Series Connection Manual.
3. Transfer screen data to MONITOUCH.

MONITOUCH setting
1. Press the [SYSTEM] button on MONITOUCH.  The MODE menu is displayed.
2. With the MODE menu displayed, press the [F1] button.  The Main Menu screen is displayed on 

MONITOUCH.
3. Press the [Main Menu] switch at the upper left corner of the screen.  The menu is displayed.
4. Press the [Ethernet] switch.  The Ethernet screen is displayed.
5. Press the [IP Address Setting] switch and select [Select IP Address from Network Table].

6. Press the [EDIT] switch and set the network table number.  The IP address specified in the 
network table number is displayed.
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7. Press the [Setting Finished] switch to end the setting.  Check the IP address under [Ethernet] on 
the Main Menu screen.
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MES Setting

There are 256 MES setting numbers from 0 through 255.  You can make the MES settings for adding 
data to and searching databases and database search conditions.

Location for Setting

1. Click [System Setting] → [MES Setting].  The [MES Setting] dialog is displayed.

2. Proceed to the setting in the [Write], [Read], and [Search condition] tab windows.
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Setting Items

No. Specify the MES setting number from 0 to 255.

 
Skip Unregistered No.

Use this button to skip unregistered numbers during selecting a MES 
setting number.

Copy Use this button when copying data 
in the current MES setting number 
to another chosen MES setting 
number.

Delete Use this button when deleting the current MES setting.

Comment Enter a comment on the MES setting.  
16 one-byte (or 8 two-byte) characters maximum

Data source Name Specify a data source name.
32 bytes maximum

Login Name Specify a login name used for accessing the database.
32 bytes maximum

Password Specify a password used for accessing the database.
32 bytes maximum

Table Name Specify a table name.
128 bytes maximum

Required No. of Word 
Count for Macro 
Command

This section shows the number of words used for each macro command 
based on the current settings.  A number more than a maximum of 
2,000 words is highlighted in red.  Adjust the number of registrations, 
the length of line name, and the number of words so that 2,000 words 
are not exceeded.

Words in total 
for each macro 
command

Macro 
commands

Word counts for [Write], [Read], 
and [Search condition]

With [ ]: Valid 
None: Invalid (always “0”) 
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[Write] tab window
The [Write] tab window is used for data addition to the database.

[Write], [Read] and 
[Search condition] tabs

Select these tabs to open the individual tab windows for addition to or 
search of the database or search condition setting.  See the following 
pages for further explanation of the tab windows.

[Memory use] checked

[Memory use] unchecked

a.

Add Use this button to bring up the [Detailed setting] dialog.
In the dialog, enter a line name as the target for writing and a data type to 
be additionally registered.  
256 maximum  

Change Use this button to bring up the [Detailed setting] dialog.
In this dialog, you can make changes to registered settings.

Delete Use this button when deleting registered settings.

Import Use this button when importing a CSV file into the current MES setting 
([Write]).
When the button is pressed, settings already registered (“a.”) are updated.

Export Use this button when exporting the current MES setting ([Write]) into a 
CSV file.
When the button is pressed, settings already registered (“a.”) are output.

Line Name Specify the name of the line to which you will add data.  
128 bytes maximum

* The line name must not begin with a one-byte numeral.
* The following characters are not usable:

~ - ! , {  % } ^ ’ & . (\) ` blank
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Memory use Specify the data you wish to add.  256 bytes maximum
• Checked: Select memory.

Specify the memory address at which the data you wish to add is 
placed.

• Unchecked: Fixed
Specify a constant or a fixed string.

Data Type
Length
Bytes

For the data you wish to add, specify the data type, the data length, and 
the number of bytes.

Memory Input Type Text Process

PLC1 - PLC8 memory Depends on the communication 
settings for each unit.

Internal memory
Memory card memory

DEC LSB → MSB

Data Type Length Bytes

DEC- 1-Word, 2-Word -

CHAR 128-Word 256 bytes maximum

BCD 1-Word, 2-Word -

FLOAT 2-Word -
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[Read] tab window
The [Read] tab window is used for database search setting.

a.

Max. Record Specify the maximum number of records that will be displayed as the result 
of search.
65536 maximum

Add Use this button to bring up the [Detailed setting] dialog.
In this dialog, enter a line name for search and a data type to be 
additionally registered.  
256 maximum

Change Use this button to bring up the [Detailed setting] dialog.
In this dialog, you can make changes to registered settings.

Delete Use this button when deleting registered settings.

Import Use this button when importing a CSV file into the current MES setting 
([Read]).
When the button is pressed, settings already registered (“a.”) are updated.

Export Use this button when exporting the current MES setting ([Read]) into a 
CSV file.
When the button is pressed, settings already registered (“a.”) are output.

Line Name Specify the name of the line to be searched.  128 bytes maximum
* The line name must not begin with a one-byte numeral.
* The following characters are not usable:

~ - ! , {  % } ^ ’ & . (\) ` blank
Data Type
Length
Bytes

For the data you wish to add, specify the data type, the data length, and 
the number of bytes.

Sort Select an option for sorting the search result.
Non / Up / Down

Data Type Length Bytes

DEC- 1-Word, 2-Word -

CHAR 128-Word 256 bytes maximum

BCD 1-Word, 2-Word -

FLOAT 2-Word -
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[Search condition] tab window
The [Search condition] tab window is used for database search condition setting or deletion from the 
database.

a.[Memory use] checked

[Memory use] unchecked

Add Use this button to bring up the [Detailed setting] dialog.
In this dialog, enter a search condition to be additionally registered. 
256 maximum

Change Use this button to bring up the [Detailed setting] dialog.
In this dialog, you can make changes to registered settings.

Delete Use this button when deleting registered settings.

Import Use this button when importing a CSV file into the current MES setting 
([Search condition]).
When the button is pressed, settings already registered (“a.”) are updated.

Export Use this button when exporting the current MES setting ([Search 
condition]) into a CSV file.
When the button is pressed, settings already registered (“a.”) are output.

Line Name Specify the name of the line to be searched.  128 bytes maximum
* The line name must not begin with a one-byte numeral.
* The following characters are not usable:

~ - ! , {  % } ^ ’ & . (\) ` blank
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Search Condition Use this button when setting search conditions.  When searching based on 
multiple conditions, use AND.

Memory use Specify the data you wish to retrieve.  256 bytes maximum
• Checked: Select memory.

Specify the memory address at which the data you wish to retrieve is 
placed.

• Unchecked: Fixed
Data is searched using a specified constant or fixed string.

Data Type
Length
Bytes

For the data you wish to retrieve, specify the data type, the data length, 
and the number of bytes.

Search Condition Remarks

Equal (=)

Not equal (!=)

Big (> value)

Small (< value)

Upper (>= value)

Under (<= value)

Include character string Wildcard (%) usable
Example:

AA%: Text beginning with AA to be 
retrieved

Update From the specified line name, records 
that do not mach the data you wish to 
retrieve are extracted.  These records are 
then replaced with the data for retrieval.

Memory Input Type Text Process

PLC1 - PLC8 memory Depends on the communication 
settings for each unit.

Internal memory
Memory card memory

DEC LSB→MSB

Data Type Length Bytes

DEC- 1-Word, 2-Word -

CHAR 128-Word 256 bytes maximum

BCD 1-Word, 2-Word -

FLOAT 2-Word -
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Macro

The MES interface function uses the following five kinds of macros.

MES Macro Command List

Notes

• If writing the result (returned value, data retrieved by search) of an access to the database ends in 
error, the result is not output to the V8 and the log data.

• A maximum of 2,000 words can be used for each of the macro commands MES WRITE, MES 
READ, MES DEL, and MES UPDATE.  The [Required No. of Word Count for Macro Command] 
section shows the current word counts ([System Setting] → [MES Setting]).  

Category Command 
Name Mnemonic Description Refer to:

MES MES

MES CHECK (F1, F2, F3) V-server start check page 
20-20

MES WRITE (F1, F2, F3) Adding data to the 
database

page 
20-21

MES READ (F1, F2, F3) Searching the database page 
20-22

MES DEL (F1, F2, F3) Deleting data from the 
database

page 
20-24

MES UPDATE (F1 , F2 , F3) Updating the database page 
20-25
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MES CHECK (F1, F2, F3)
Function: V-server start check
This macro is used to check whether the V-Server at the location specified in table No. [F2] is running.  
The returned value [F3] as a result will be stored in memory at the return address [F1].

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• MES CHECK ($u0000, 10, 1) 

The above program checks whether the V-Server in the computer specified in network table No. 
10 is running.  If the V-server is running, the returned value 1 is stored in memory at the return 
address $u0000.

Supplementary information
• The value set as a return address must be different from the returned value.
• With $s514, you can set the execution style of the macro.  For more information, refer to the V8 

Series Connection Manual.
When a macro command is executed, if “1” (other than “0”) is set for $s514 while the V-Server is 
not running, no response is given from the V-Server and the V8 will enter in the standby state.  It is 
recommended to execute this command when “0” is set for $s514.

• The result of the macro execution is stored in memory at $s515.  For more information, refer to the 
V8 Series Connection Manual.

• The returned value will not be placed at the address [F1] immediately.  The [F1] address can be 
monitored by the event timer macro, etc.

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F1

F2

F3

Value

F0 MES CHECK

F1 Return address

F2 0 to 99: Network table number

F3 0 to 65535 (−32768 to 32767): Returned value

Network table No. 10
Return address

Returned value 1
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MES WRITE (F1, F2, F3)
Function: Adding data to the database
This macro is used to add the data set in the [Write] tab window under MES setting No. [F3] to the 
database.  The data will be added via the V-Server at the location specified in table No. [F2].  The 
result will be stored in memory at the return address [F1].

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• MES WRITE ($u0000, 10, 0)

The above program adds data to the database in the computer specified in network table No. 10.  
The data to be added depends on the settings made in MES setting No. 0.
When the data addition is completed normally, the returned value 0 will be stored in memory at 
the return address $u0000.

Supplementary information
• With $s514, you can set the execution style of the macro.  For more information, refer to the V8 

Series Connection Manual.
• The result of the macro execution is stored in memory at $s515.

-40: The [Write] tab window setting is not made in the specified MES setting number, or any 
setting error is found.
For information on other error numbers, refer to the V8 Series Connection Manual.

• The returned value will not be placed at the address [F1] immediately.  The [F1] address can be 
monitored by the event timer macro, etc.

• The primary key for the V-Server must be set for the database table (page 20-36).

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F1

F2

F3

Value

F0 MES WRITE

F1 Return address
Returned value

0: Normally finished
−1: End in error

F2 0 to 99: Network table number

F3 0 to 255: MES setting number

Network table No. 10

Return address

MES setting No. 0
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MES READ (F1, F2, F3)
Function: Searching the database
This macro is used to search the line set in the [Read] tab window under MES setting No. [F3].  The 
search will be performed based on the specified search conditions via the V-Server at the location 
specified in table No. [F2].  The result will be stored in memory at the return address [F1].

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Return address
The following data will be stored in memory at the addresses starting from the return address [F1].

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F1

F2

F3

Value

F0 MES READ

F1 Return address

F2 0 to 99: Network table number

F3 0 to 255: MES setting number

Value
n Execution result

Normally finished: 0
Error: Other than 0

n + 1 Number of retrieved records
The number of records that match the search conditions is stored.
If no such record is found, 0 is stored.
The maximum number of records is set in the [Read] tab window in the MES setting.

n + 2 - Obtained data 1
The retrieved data is stored in the format as specified in the [Read] tab window in the 
MES setting.

: Obtained data 2
: Obtained data 3
: :
: Obtained data m (= maximum number of records)
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Example
• MES READ ($u0000, 10, 0)

The above program searches the database in the computer specified in network table No. 10.  
The search is performed according to the settings in the [Read] and [Search condition] tab 
windows under MES setting No. 0.
When the search has been completed normally, the returned value 0 and the obtained data are 
stored in memory at the addresses starting from the return address $u0000.

Supplementary information
• With $s514, you can set the execution style of the macro.  For more information, refer to the V8 

Series Connection Manual.
• The result of the macro execution is stored in memory at $s515.

-40: The [Read] tab window setting is not made in the specified MES setting number, or any 
setting error is found.
For information on other error numbers, refer to the V8 Series Connection Manual.

• The returned value will not be placed at the address [F1] immediately.  The [F1] address can be 
monitored by the event timer macro, etc.

• If no [Search condition] tab window setting is made in the specified MES setting number, all 
records will be the results of the search.

Network table No. 10

Return address

MES setting No. 0
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MES DEL (F1, F2, F3)
Function: Deleting records from the database
This macro is used to search the database according to the [Search condition] tab window setting in 
MES setting No. [F3].  The search is performed via the V-Server at the location specified in table No. 
[F2].  The records that match the conditions are deleted.  The result will be stored in memory at the 
return address [F1].

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• MES DEL ($u0000, 10, 0)

The above program searches the database in the computer specified in network table No. 10 and 
deletes the retrieved data.  The search is performed according to the [Search condition] tab 
window in MES setting No. 0.
When the data deletion has been completed normally, the returned value 0 is stored in memory 
at the return address $u0000.

Supplementary information
• With $s514, you can set the execution style of the macro.  For more information, refer to the V8 

Series Connection Manual.
• The result of the macro execution is stored in memory at $s515.

-40: The [Search condition] tab window setting is not made in the specified MES setting number, 
or any setting error is found.
For information on other error numbers, refer to the V8 Series Connection Manual.

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F1

F2

F3

Value

F0 MES DEL

F1 Return address
Returned value

0: Normally finished
−1: End in error

F2 0 to 99: Network table number

F3 0 to 255: MES setting number

Network table No. 10

Return address

MES setting No. 0
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MES UPDATE (F1 , F2 , F3)
Function: Updating the database
This macro is used to search the line set in the [Write] tab window under MES setting No. [F3].  The 
search will be performed based on the specified search conditions via the V-Server at the location 
specified in table No. [F2], then the database will be updated.  The result will be stored in memory at 
the return address [F1].

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• MES UPDATE ($u0000, 10, 0)

The above program searches the database in the computer specified in network table No. 10 and 
updates the database.  The search is performed according to the settings in the [Write] and 
[Search condition] tab windows under MES setting No. 0.
When the data addition is completed normally, the returned value 0 will be stored in memory at 
the return address $u0000.

Supplementary information
• With $s514, you can set the execution style of the macro.  For more information, refer to the V8 

Series Connection Manual.
• The result of the macro execution is stored in memory at $s515.

-40: The [Write] or [Search condition] tab window setting is not made in the specified MES setting 
number.  Or any setting error is found.
For information on other error numbers, refer to the V8 Series Connection Manual.

• The returned value will not be placed at the address [F1] immediately.  The [F1] address can be 
monitored by the event timer macro, etc.

• This macro command cannot be executed when “Update” is set in the [Search condition] tab 
window.

Internal memory PLC1 - PLC8 
Memory Memory Card Constant

F1

F2

F3

Value

F0 MES UPDATE

F1 Return address Returned value
0: Normally finished
-1: End in error

F2 0 to 99: Network table number

F3 0 to 255: MES setting number

Network table No. 10

Return address

MES setting No. 0
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20.4 V-Server
V-Server

Hakko Electronics’ V-Server is the software that enables accesses to databases.  Once the V-Server is 
installed on a computer, no configuration is needed.

Installation

1. Download the V-Server to your computer from the Hakko Electronics website at the URL given 
below.
http://www.hakko-elec.co.jp/en/download/03tellus/index.html

2. Install the V-Server on the computer.
3. Start V-Server.

* The message that appears at start-up indicates that the V-Server is usable within one hour.
If you wish to use the V-Server without the limitation, please apply for the software’s license and 
obtain its password.  For more information, refer to the TELLUS and V-Server manual.
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20.5 Database
Kinds of Databases

The following databases can be used.
• SQL Server: Microsoft
• MSDE: Microsoft
• Oracle: Oracle Corporation

This manual describes a setting example of Microsoft SQL Server 2005 Express Edition.

SQL Server 2005 Express Edition

Installation

1. Download SQL Server 2005 Express Edition from Microsoft’s website.
2. Double-click the downloaded “exe” file.  “License Agreement” is displayed.  Check “I accept the 

licensing terms and conditions” and click the [Next] button.

3. The installation screen of the components is displayed.  Proceed by following the instructions.

SQL Server 2005 Express Edition
This is a simple version of the SQL Server 2005.  You can download the software free of 
charge from Microsoft’s website.
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4. The [Microsoft SQL Server 2005 Setup] screen is displayed.  Proceed by following the instructions 
and start installation.

5. The [Registration Information] screen is displayed.  Enter your name, your company name, and 
click the [Next] button.

6. The [Feature Selection] screen is displayed.  Select an installation path and click the [Next] button.
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7. The [Authentication Mode] screen is displayed.  Select [Mixed Mode] and set a password.

8. Proceed by following the instructions to complete installation.

The password is required at the time of connecting to the database or MES setting in the 
V-SFT.  Be careful in managing your password and take care not to lose it.
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9. Click [Start] → [Program] → [Microsoft SQL Server 2005] → [Configuration Tools] → [SQL Server 
Configuration Manager].

10. SQL Server Configuration Manager starts.  Check that SQL Server (SQL Express) is running.

To start or stop operation, select [SQL Server (SQL Express)] 
and select a menu from [Action].
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Creating a SQL Server Database

The SQL Server database can be created by using SQL Server Management Studio Express.

Installation

1. Download “SQL Server Management Studio Express” from Microsoft’s website.
2. Double-click the downloaded file.  The installation wizard of the SQL Server Management Studio 

Express is started.

3. Click the [Next] button.  “License Agreement” is displayed.  Check “I accept the terms in the 
license agreement” and click the [Next] button.

Microsoft SQL Server Management Studio Express: SSMSE
Easy-to-use, graphical management tool intended for the management of the SQL Server 
2005 Express Edition and the SQL Server 2005 Express Edition with Advanced Services



20    MES Interface Function

20-32

4. The [Registration Information] screen is displayed.  Enter your name, your company name, and 
click the [Next] button.

5. The [Feature Selection] screen is displayed.  Select an installation path and click the [Next] button.

6. The [Ready to Install the Program] screen is displayed.  Click the [Install] button.  Installation is 
started.
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7. The setup completion message is displayed.  Click the [Finish] button and close the window.
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Starting SQL Server Management Studio Express

1. Click [Start] → [Program] → [Microsoft SQL Server 2005] →[SQL Server Management Studio 
Express].

2. The [Connect to Server] screen is displayed.  Make the settings and click the [Connect] button.

3. SQL Server Management Studio Express is started.

Server name Select an SQL Server.

Authentication Select an authentication.  In this example, the authentication of SQL 
Server is selected.

Login Specify a user name.  In this example, “sa” is specified.
Password Specify a password.

The password for “sa” has been specified on the [Authentication Mode] screen displayed 
during installation of SQL Server 2005 Express Edition (see page 20-29).
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Creating a New Database

1. Select [Database] and click [New Database] from the right-click menu.

2. The [New Database] screen is displayed.  Specify a database name and click the [OK] button.

3. A new database is created.
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Creating a New Table

1. Start SQL Server Management Studio Express.

2. Select a database created in the previous section and click [New Database] from the right-click 
menu.
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3. The table creation screen is displayed.  Create a table by registering a column name and a data 
type.

• For a database table to which data is to be added, set the primary key for the V-Server.

• The following data types are available with the MES interface function.  They correspond to the 
MES settings in the V-SFT.

4. When the table setting has been completed, close it.  The confirmation screen is displayed.  Click 
the [Yes] button.

5. Enter a name and click the [OK] button.

Column Name Data Type Length Allow Nulls Primary Key

VsPrimaryKey varchar 26 bytes or 
more 

No

Database: Table V-SFT: MES Setting

Column 
Name Data Type Length Allow Nulls Data Type Length

(Arbitrary) smallint 1 word Yes DEC-
BCD

1 word

(Arbitrary) int 2 words Yes 2 words

(Arbitrary) Float 2 words Yes FLOAT 2 words

(Arbitrary) varchar Arbitrary Yes CHAR Max. 256
bytes
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6. The table is created.
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Opening a Table

The data saved in the database can be checked by following the procedure given below.

1. Select a table and click [Open Table] from the right-click menu.

2. The table is opened.  A column name registered when the table was created is displayed.  Data is 
saved in “NULL” in order.
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20.6 Data Source (ODBC) Setting
V-Server accesses the database via data source (ODBC).  For allowing V-Server to access the 
database, make the settings for the data source.  This manual describes a setting example of the 
Microsoft SQL Server 2005 Express Edition.

1. From the Windows [Start] menu, click [Settings] and [Control Panel].  The [Control Panel] folder is 
opened.

2. Double-click [Administrative Tools].

ODBC: Open DataBase Connectivity
ODBC is the interface between an application (V-Server) and databases.
Because ODBC accommodates the differences in specifications between databases, 
users just need to create programs based on the ODBC-specified procedure in order to 
access those databases.

V-Server

ODBC
SQL Server

Oracle

MSDE

DB1

DB2

DB3

Data source name

AAA

BBB

CCC

Database name

DB1

DB2

DB3
Link

Application

Database
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20

3. The [Administrative Tools] screen is displayed.  Double-click [Data Sources (ODBC)].

4. The ODBC Data Source Administrator dialog box is displayed.  Open the [System DSN] tab 
window and click the [Add] button.

5. The Create New Data Source dialog box is displayed.  Select SQL Server and click the [Finish] 
button.
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6. The following dialog is displayed.  Make the settings and click the [Next] button.

7. The following dialog is displayed.
Select the option [With SQL Server authentication using a login ID and password entered by user], 
and specify a login ID and a password.

Name Specify a data source name.
Server Specify a SQL Server name.

• The data source name is used in the MES setting in the V-SFT.

• The SQL Server name can be checked on the SQL Server Management Studio Express.



20    MES Interface Function

20-43

20

8. Click the [Next] button.  The following dialog is displayed.

9. Check [Change the default database to] and select a database.

10. Click the [Next] button.  The following screen is displayed.

11. Click the [Finish] button.  The following screen is displayed.

Login ID Specify a login ID (sa).
Password Specify a password.

The password for “sa” has been specified on the [Authentication Mode] screen displayed 
during installation of the SQL Server 2005 Express Edition (see page 20-29).

Select a database created using Microsoft SQL Server Management Studio Express (see 
page 20-31).
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12. Click the [Test Data Source] button.  When a connection has been successfully established, the 
following screen is displayed.

13. Click [OK].  The following screen is displayed.

14. Click [OK].  The data source is then registered.

The necessary settings have been completed.
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2121 Operation Logs
21.1 Operation Log Function

Overview

The operation log function is available to store the screen operation history records (operation logs) in 
the SRAM area.  When the SRAM area becomes full, the logs can be output to a CF card.
In the event of an error, these logs stored will allow you to examine what was conducted at that time; 
thus helping you analyze the causes of the error.  Also, in conjunction with the security function (to be 
discussed later), you can identify the name of the operator.
Log files to be output to a CF card are in binary format.  A dedicated tool is prepared to convert such a 
log file to a CSV file so that you can view the contents.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

MENU
1 2
3 4

CF

DATA
10.5

DATA
35.2

SRAM

SRAM

SRAM

Screen changeover

Power ON

Entry through the 
numerical keypad

Output to CF card

1 20080601 Start

1 20080601 Start
2 20080601 Screen changeover Input screen 0 5

1 20080601083010 Start
2 20080601083200 Screen changeover Input screen 0 5
3 20080601084055 Update of the displayed 5 data items 

Numerical data display DEC 10.5 35.2

\DAT0000\OPELOG\080601\OPELOG_110320.BIN

Screen 0

Screen 5
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The table below shows the items that can be contained in operation logs and when storage of those 
logs takes place.

*1 Logging does not take place when transferring the MONITOUCH system program. 

*2 When using a switch to store operation logs, [ Save an operation log] must be checked in its 
[Switch] dialog.

*3 Table data display is not supported.

Item Timing of Log Storage

Start At power-on

Transfer At the time of transferring the screen data or the I/F driver∗1

Mode changeover At the time of switching between the RUN screen and the Main Menu screen

Screen changeover At the time of screen change

Language changeover At the time of language selection

Switch At the press of a switch∗2

Data display update∗3 At the time of updating numerical data/character displays in the entry mode 
(Write/↓/↑key)

CF Card Writing Error At the occurrence of an error during writing into a CF card
* 1,024 words are used in SRAM.  The words in use are added and 

displayed at [Unit Setting] → [SRAM/Clock Setting] → [Operation 
log storage point].

Log destruction At the time of newly restarting to store log data after clearing the SRAM area 
due to the reasons below:

• SRAM data corruption
• Failure to output to CF card

Output Action Momentary, Set, Reset, Alternate, Momentary W

Function Standard Screen, Overlap Display, Multi-Overlap Display, 
Word Operation, Reset, CF Card Format, CF 
Card Removal, Language changeover

Entry Delete (sampling only)

Memory 
Card

Card Format, Transfer Card  →  PLC, Transfer 
PLC → Card

Digital 
Switch

Digital Switch +, Digital Switch −

JPEG File Delete

Security Login/Logout

Default: checked

Example of conversion to a CSV file 
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21Setting

Location for Setting

Click [System Setting] → [Operation log setting].  The [Operation log setting] dialog is displayed.  

Setting Items

Use operation log function Check this box when you use the operation log function.

Log objects Select the options to be contained in log data.  
(For more information, refer to page 21-2.)

SRAM save number
100 to 512

Specify the number of log data to be stored in the SRAM area.*1

CF Card Connection Target
Built-in Socket 
USB Port

Select the location of the CF card, to which operation logs will be 
output.
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*1 A memory space required is automatically provided based on the [SRAM save number] setting.

*2 Control memory allocation

• Bit for output to CF card <No. 0>
[0 → 1] Log data will be output from the SRAM to the CF card.

Action to be taken when store 
target capacity is not enough.

Erase old log and continue
Stop operation log

Select the action to be taken when CF card has become full.

Control memory*2 Specify a memory address for log output to the CF card.

Control memory 15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

System reserved Bit for output to CF card
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21System Memory

The following describes the system memory associated with the operation log function.

Address Description Remarks

$s1050 CF card in processing flag

← V

$s1051 CF card processing completed flag

← V

$s1052 CF card processing error flag

* If an error occurs during the execution of the operation log function, it should be 
a writing error.  To know about the condition of the CF card insertion, see 
$s1030/1035.

← V

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0

MSB

Hardcopy
0: Not processed
1: In processing

System reserved (setting: 0)

LSB

Sampling
0: Not processed
1: In processing

Operation log
0: Not processed
1: In processing

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0

MSB

Hardcopy
0: Not completed
1: Completed

System reserved (setting: 0)

LSB

Sampling
0: Not completed
1: Completed

Operation log
0: Not completed
1: Completed

15 14 13 12 11 10 09 08 07 06 05 04 03 02 01 00

0 0 0 0 0 0 0 0 0 0 0 0 0

MSB

Hardcopy
0: Normal
1: Error

System reserved (setting: 0)

LSB

Sampling
0: Normal
1: Error

Operation log
0: Normal
1: Error
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Log File

SRAM

Log data is stored in the SRAM area in binary format.
The SRAM area consumes a maximum of 64 kB and is capable of storing 512 log data.
After output to the CF card, the SRAM area is cleared and data storage in the area is resumed.  The 
next section describes when output to the CF card takes place.

CF Card
Timing of output to CF card
The output of log data from the SRAM area to the CF card takes place when: 

• The SRAM area has become full (up to 64 kB/512 log data).
• The bit for output to CF card is set (ON) at the [Control memory] address.
• The [CF Card Removal] switch is activated.
• The CF card cover is opened.

Log File Storage Target and File Name

The following designates the location of where to store log files and their naming.

Storage Target File Name

Access folder\OPELOG\YYMMDD OPELOG_hhmmss.BIN 

year, month, and day hour, minutes, and seconds

BITMAP
CARD
DSP
FONT
HDCOPY
JPEG

MSG
OPELOG

RECIPE
SAMPLE

DAT0000

OPELOG_103005.BIN
OPELOG_141002.BIN

MEMO

OPELOG_204250.BIN

080702

080703
080704

CF card Access folder

Operation logs
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21Conversion to CSV File 

A log file output to the CF card can be converted by a dedicated tool to a CSV file, which enables you 
to view the contents.

File Conversion Tool (LogToCsv.exe)

When you have installed the V-SFT-5 version 5.2.0.0 or later from the CD, “LogToCsv.exe” is also 
installed.
If the version of your V-SFT-5 is earlier than the above, please visit the Hakko Electronics website, and 
download and install “LogToCsv.exe”.
http://www.monitouch.com

File Conversion Procedure

Step 1 Start the tool, LogToCsv.exe.

Step 2 Click the [Open] button at [Source file] and select a log file desired.
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Step 3 Click the [Open] button at [Target file] and specify the location of where to store the CSV 
file and the name of the file.

Step 4 Click the [Convert] button.

Step 5 The completion message is displayed.

Step 6 Open the CSV file.
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21Contents of CSV File

The table below shows the contents of a CSV file.

*1 For explanation of the items displayed in a file, refer to the individual sections below.

[Start]

A log is saved at power-on.  The log contains the data items below.

[Transfer]

A log is saved when the screen data or the I/F driver is transferred.  The log contains the data items 
below.

Title Description

No. Log number

Date Log acquisition date

Time Log acquisition time

Scrn_No Screen No. 0 - 9999

User_ID User ID (8 characters)

Level Security level (0 - 15)

Action Action*1

Function Function*1

Comment Comment on screen/item (32 bytes)

Type Numerical data type

Prev_Val Value before change

Chg_Val Value after change

No. Date Time Scrn_No User_ID Level Action Function Comment Type Prev_Val Chg_Val

- - - - - - - -

Start

No. Date Time Scrn_No User_ID Level Action Function Comment Type Prev_Val Chg_Val

- - - - - - -

Screen data
Driver, expansion program

Transfer
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[Mode changeover]

A log is saved when the mode is switched between RUN and STOP.  The log contains the data items 
below.

[Screen changeover]

A log is saved when the screen is changed.  The log contains the data items below.

Comment
The comment entered in the [Screen Setting] dialog is stored ([Screen Setting] → [Screen Setting]).  
When no comment is entered in the dialog, the [Comment] field is left blank.

[Language changeover]

A log is saved when the language is changed.  The log contains the data items below.

No. Date Time Scrn_No User_ID Level Action Function Comment Type Prev_Val Chg_Val

- - - - - - -

Change to RUN mode
Change to STOP mode (Main Menu)

Mode changeover

No. Date Time Scrn_No User_ID Level Action Function Comment Type Prev_Val Chg_Val

- - -

Screen changeover

No. Date Time Scrn_No User_ID Level Action Function Comment Type Prev_Val Chg_Val

- - - -

Language changeover
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21[Switch]

A log is saved when a switch is pressed.  The log contains the data items below.

* When an alternate switch is used, switched ON logs will be saved, irrespective of the bit setting 
(ON)/resetting (OFF).

* When a multi-output switch is used, No. 0 operation logs will be saved.

Comment
The text entered in the [OFF] section in the [Text] tab window is stored ([Item View] → [Text] → [OFF]).

* If the registered text consists of two or more lines, only the first line will be output to log data.

No. Date Time Scrn_No User_ID Level Action Function Comment Type Prev_Val Chg_Val

- -

Switch operation (Mom)
Switch operation (Set)
Switch operation (Rst)
Switch operation (Alt)
Switch operation (Word)

[Standard] Screen
Overlap Display
Multi-Overlap Display
Word Operation
Reset
CF Card Format
CF Card Removal
Language changeover

Switch operation (Sample)
Switch operation (Alm)

[Entry] Delete (sampling only)

[Memory Card] Card Format
Transfer Card → PLC
Transfer PLC → Card 

[Digital Switch] Digital Switch +
Digital Switch −

[JPEG] File Delete

[Security] Log In
Log Out
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[Data display update]

A log is saved when any numerical data/character display is updated in the entry mode ([Write] key).  
The log contains the data items below.

* Log saving is not available for updates to table data displays.

Comment
The comment entered in the [Comment] field in the [Comment] tab window is output ([Item View] → 
[Comment]).  

[CF Card Writing Error]

A log is saved when an error has occurred during writing into a CF card and writing has ended in 
failure.  The log contains the data items below.

Comment
The directory path of the drive or file where an error has occurred is output.

• Error during access to a CF card: “drive name:\Directory Information”
(Example)For built-in socket: “C:\Directory Information”

• Error during access to a file “drive name:\full pathname” *

(Example)In the event of an error occurred during writing of “REC0000.CSV” in the recipe mode 
C:\DAT0000\RECIPE\REC0000.CSV

* When the number of characters exceeds 32 one-byte characters (16 two-byte 
characters), the top of the pathname is omitted and displayed as “..”.
(Example) C:\..\RECIPE\REC0000.CSV

[Log destruction]

A log is saved when the SRAM area is cleared and saving new logs is started because of SRAM data 
corruption or failure to output to the CF card.  The log contains the data items below.

No. Date Time Scrn_No User_ID Level Action Function Comment Type Prev_Val Chg_Val

Numerical data display
Character display

Data display update

No. Date Time Scrn_No User_ID Level Action Function Comment Type Prev_Val Chg_Val

- - - - - -

Power OFF
Removal of card

Writing error detection

No. Date Time Scrn_No User_ID Level Action Function Comment Type Prev_Val Chg_Val

- - - - - - - -

Log destruction
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2121.2 Operation Log Viewer
Overview

• The operation history records (operation logs) stored in the SRAM area can be displayed on the 
V8 series.
Because the above-mentioned logs help you search for the operational description associated with 
an alarm (if any occurs), you will be able to track down the causes promptly.
In addition to the logs stored in the SRAM area, the log files output to the CF card can also be 
displayed.
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• Through the [Setting] switch on the log viewer screen, you can proceed to showing/hiding items, 
setting the number of characters, and changing the date/time format.

Press the [Setting] switch.

The date field is hidden.

Under [Show/Hide], select [Hide] for [Date] 
and press the [Setting] switch.

Example: Hiding the date field
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21Setting

1. Click [System Setting] → [Operation log setting].  The [Operation log setting] dialog is displayed.  

2. Check the box for [ Use operation log function].

* For description of the operation log function, refer to “Operation Log Function” on page 21-1.

Screen registration
Operation log viewer

Check this box when you use the operation log viewer.
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3. Check the box for [ Operation log viewer].
The dialog shown below is displayed.

4. When the settings have been completed, click [OK].

5. Place the switch used to read the operation log viewer screen ([Function: Screen]).

* For description of the registered log viewer screen, refer to “Log Viewer Screen” on page 21-17.

Yes The operation log viewer part will be stored at the location as specified in the 
message.

No The [Screen] dialog appears and you can select a screen number arbitrarily.

Cancel The box for [ Operation log viewer] becomes unchecked.

• If you wish to change the screen registration location, go to the [Operation log 
setting] dialog, press the [Re-register] button, and perform the above steps 3 and 
4.  Do not move the screen by manual operation.  Do not change or modify any 
part that has been automatically registered.
If any changes have been made by the user, there will be no guarantee of proper 
operation.

• The log data will be displayed in the display area.  The size of the area is fixed.  
Note that a display area of this fixed size will be automatically registered with a 
screen.
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21Log Viewer Screen

This section explains the log viewer screen.

Screen Configuration

A log viewer screen is displayed as the following.

Item Description

1. Roll-down switch Scrolls the screen down one row to show the previous data.

2. Roll-up switch Scrolls the screen up one row to show the next data.

3. - block switch Scrolls the screen one page to show the previous data.

4. + block switch Scrolls the screen one page to show the next data.

5. Scroll bar* Scrolls the screen in the specified direction.

6. Log file change switch (↑) When the log data in the SRAM area is displayed:
This switch does not work.

When the log data in the CF card is displayed:
Pressing this switch brings up the next new file.
When the file currently displayed is the newest one, the switch 
shifts the screen to the log data in the SRAM area.

7. Log file change switch (↓) When the log data in the SRAM area is displayed:
Pressing this switch shifts the screen to the newest log file in the 
CF card.

When the log data in the CF card is displayed:
Pressing this switch brings up the next older file.

8. Multi-overlap display switch Brings up the display item setting screen.
For more information, refer to “Display Item Setting Screen” on 
page 21-19.

9. Multi-overlap display switch Brings up the display selection setting screen.
For more information, refer to “Display Selection Setting Screen” 
on page 21-22.

10. Normal overlap* Displays the contents of the selected log data on the overlap.

11. Return switch Returns you to the previously displayed screen.

5. Scroll bar

5. Scroll bar

1. Roll-down switch

2. Roll-up switch

3. - block switch

4. + block switch

7.Log file change 
switch (↓)

8. Multi-overlap display switch
11. Return switch

10. Normal overlap

6.Log file change 
switch (↑)

9. Multi-overlap display switch
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* If the display area is not large enough to show the entire data, use the scroll bar to show the 
hidden portion or press your desired log data on the screen to display its contents on the 
overlap.

Press on a log data.

The overlap displays the contents of the selected log data.

Press the top left corner (inside the red 
dotted frame) on the overlap display twice.

The overlap display is cleared.
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21Display Item Setting Screen

When the [Setting] switch is pressed on the log viewer screen, the display item setting screen is 
displayed.

• Show/Hide
Whether to show or hide each item on or from the log viewer screen can be selected.

Press the cell under [Show/Hide] for 
[Date] to select [Hide] and press the 
[Setting] switch.

Example: Hiding the date field

The date field is hidden.
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• Letter counts
You can set the number of characters for each item to be displayed on the log viewer screen.

• Display order (fixed)
The order of the items displayed in the display area is shown.

Press the cell under [Letter counts] for 
[Date] to display the numerical keypad.
Enter your desired value and press the 
[Setting] switch.

Example: Increasing the number of characters for [Date] from 11 to 16

The [Date] field is enlarged.

After change:

Before change:

Item Description

Date Log acquisition date (16 characters maximum)

Time Log acquisition time (15 characters maximum)

Scrn_No Screen No. 0 - 9999 (4 characters maximum)

User_ID User ID (8 characters maximum)

Level Security level 0 - 15 (2 characters maximum)

Action Action (32 characters maximum)

Function Function (32 characters maximum)

Comment Comment on screen/item (32 characters maximum)

Type Numerical data type (3 characters maximum)

Prev_Val Value before change (32 characters maximum)

Chg_Val Value after change (32 characters maximum)



21.2    Operation Log Viewer

21-21

21• Display Format
You can specify the formats of the dates and times to be displayed in the display area.

(1) Press the cell under [Display Format] for [Date].
(2) The [Date Format Setting] window is called up.  Select a 

format option and press the [OK] switch.
(3) Press the [Setting] switch for confirmation.

Example: Changing the format for [Date] from “06/04/01” to “04/01/06”

The [Date] format has been changed.

Example: Changing the format for [Time] from “13:30:20” to “1:30 PM”

The [Time] format has been changed.

(1) Press the cell under [Display Format] for [Time].
(2) The [Time Format Setting] window is called up.  Select a 

format option and press the [OK] switch.
(3) Press the [Setting] switch for confirmation.
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Display Selection Setting Screen

When the [Select logs] switch is pressed on the log viewer screen, the display selection setting screen 
is displayed.
On the screen, you can select items so that their logs will be displayed on the log viewer screen.

Example: Displaying the mode change logs (between the RUN screen and the Main Menu screen)

(1) Press the [Select logs] switch.
(2) Turn on the [Mode changeover] switch only.
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21Log Data Change

While the log data in the SRAM area is displayed on the log viewer screen, a log file output to the CF 
card can be displayed instead by the switch on the screen.

* The log data stored in the SRAM is displayed at the time of the opening of the log viewer 
screen.

Press the [ ] switch (lower).

The newest log file stored in the CF card is displayed.

Example: Changing the contents on the screen from the log data in the SRAM to a file in the CF card
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System Memory

The following describes the system memory associated with the operation log viewer.

* When the log data in the SRAM is displayed, 0 is stored at both addresses $s1365 and $s1366.
When a log file in a CF card is displayed, the files stored in the CF card are numbered sequentially, 
starting at 1, from the file given the most recent date.
The following illustrates the file and folder configuration in a CF card.

Address Description Remarks

$s1365 Log file number being displayed  
← V

$s1366 Log folder number being displayed  

BITMAP
CARD
DSP
FONT
HDCOPY
JPEG

MSG
OPELOG

RECIPE
SAMPLE

DAT0000

OPELOG_103005.BIN
OPELOG_141002.BIN

MEMO

OPELOG_204250.BIN

090118

090119
OPELOG_182301.BIN

CF Card

Folder number
File number

2

1
1

1
2
3
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22 Security Function
Overview

In a case where a user ID and a password that match your privilege have been registered, you can 
manage the display and operation of screens at the corresponding security level.

Screen Security Levels
It is possible to set a security level for each screen.  An attempt to switch to a higher-security screen 
will automatically call up the login screen.
By entering a user ID and a password at a level equivalent to or higher than that of the target screen, 
the screen can be displayed.

Security levels
Security is settable to level 0 to 15.

Security Level Precedence Description

0 Low Screen display and operation permitted at level 0 (no security)

1 Screen display and operation permitted at levels 0 and 1 

: :

15 High Screen display and operation permitted at all levels from 0 
through 15
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F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

MENU
Level 0

Level 5

Change to screen 1

Screen 0: Level 0

Screen 1: Level 5

The login screen appears 
due to the difference in 
security level.

When a user ID and a password at 
security level 5 - 15 are entered,
the desired screen is displayed.

If you enter a user ID and a 
password at security level 1 
- 4, the message “Level 
does not match.” appears.  
Pressing [CANCEL] causes 
a return to the previous 
screen.
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When a screen currently displayed is switched to a lower-security screen, the security level may be 
maintained or automatically lowered, depending on your choice.

Item Security Levels

Security levels can be set for every item on the screen, such as switches and data displays.
Once security levels are specified for screen items, these items can be shown or hidden based on the 
security level you select when you log in to the system.  Also, switches can be provided with an 
interlock setting.

Showing/hiding items

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

MENU
Level 0

Level 5

Security level 5 Security level 0

Screen 1: Level 5 Screen 0: Level 0

• Level lowered

Security level 5 Security level 5• Level maintained

* For switching to a higher-security screen, you are required to 
log in to the system again.

* The security level is maintained until a login or a logout is 
performed.
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SYSTEM

F 1

F 2

F 3

F 4
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F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEMLogin

Login

Items at level 10 or lower are shown.

Operator A
Security level 2

Operator B
Security level 10

Login

Level-1 items
Level-10 items

Items at level 2 or lower are shown.

Items at level 3 or higher are hidden.
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Prohibition of switch operation

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Items at level 10 or lower are operative.Items at level 3 or higher are inoperative.
Items at level 2 or lower are operative.

Operator A
Security level 2

Operator B
Security level 10

Level-1 items
Level-10 items
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Login/Logout

In addition to the login screen that automatically appears at the time of screen change, a switch for 
security level change is also available.

Login
Security level change is allowed through the switch for [Function: Log In].

* A login is not allowed if a password used is at a lower security level than that of the 
currently displayed screen.  Such an attempt yields the error message “Level does not 
match.”.  

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Level 1

Level 4

NG

OK

The login screen is 
displayed.
Enter the user ID and the 
password at security level 4.

Press the [Login] switch.

An error message is 
displayed.
Pressing [CANCEL] 
causes a return to the 
previous screen 
maintained at security 
level 1.

The previous screen is displayed again, 
the security of which is updated to level 4.  

Login

Login
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Logout
Pressing the switch for [Function: Log Out] sets the security level to zero (0).

* When a logout is executed, the security level of the screen is set to zero (0).
Since the same screen is displayed continuously after the execution of the logout function, 
it should be executed on a lower-security screen.  If this method is not desirable, the 
SET_SCRN macro (for screen number change) should be used in conjunction with the 
function in order to change the screen at the time of a logout.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

Level 4

Level 0

Logout

Security level 4

Logout

Security level 0
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Security Setting

Location for Setting

Click [System Setting] → [Security setting].  The [Security Setting] dialog is displayed.
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Setting Items

Use security function Check this box when you use the security function.

User ID
Password
Level

Register user IDs, passwords, and security levels through the 
buttons of [Add], [Delete], and [Change].
A maximum of 64 IDs can be registered.
Use eight or fewer one-byte characters.  Input is case-sensitive.

* The same user ID cannot be registered repeatedly.
* The same password can be registered repeatedly with 

multiple different user IDs.
Maintain original security 
level when opening lower 
security level screen(s) 
than original security level

Select the action to be taken at the time of screen change.
• Unchecked:

When you switch to a lower-security screen, the security level 
being currently valid is also lowered to the level of the target 
screen.
If you switch to a higher-security screen next, you are prompted 
to enter a password.

• Checked:
The same security level is maintained until the level is changed 
through login by another user or a logout occurs.

Screen registration
Login

Register a login screen.
Default: Unregistered, maximum screen number
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Security Level Selection

The following three are provided as the locations for security level selection.  Their procedural steps 
differ.

• [Screen Setting] dialog
• [Display Setting] tab window in each item dialog
• [Interlock] tab window in the [Switch] dialog

[Screen Setting] Dialog
1. Click [Screen Setting] → [Screen Setting].  The [Screen Setting] dialog is displayed.  

2. Select a desired value for [Security Level].

Security Level 0 to 15

* For information on other setting items, refer to the V8 Series Operation Manual.
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Setting to Show/Hide Items

Screen items can be shown or hidden according to their security levels.
For more information, refer to “15 Item Show / Hide Function”.

Applicable items
The items below can be provided with security level settings.

Location for setting
Make the setting in the [Display Setting] tab window in the item dialog.

Example:  Numerical data display

Switches

Lamps

Numerical data displays*1

Character displays*1

Message displays*1

Graphs

Statistic graphs

Closed area graphs

Link parts

Grouped items (including graphic items)

*1 Table data display not supported

Security level 0 to 15

* For information on other setting items, refer to the V8 Series Operation Manual.
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[Interlock] in the [Switch] Dialog

The operation of switches can be prohibited according to their security levels.

Location for setting
Make the setting in the [Interlock] tab window in the item dialog.

Security level 0 to 15

* For information on other setting items, refer to the V8 Series Reference Manual.
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Login/Logout

A switch for security level change can be created.

Setting Items

Make the setting in the [Main] tab window in the [Switch] dialog.

System Memory ($s)

The following describes the system memory associated with the security function.

Function: Security [Log In]
The login screen that is registered in the [Security Setting] dialog 
([System Setting] → [Security setting]) is displayed.

[Log Out]
The security level is set to zero (0).
* Since the same screen is displayed continuously after the 

execution of the logout function, it should be executed on a 
lower-security screen.  If this method is not desirable, the 
SET_SCRN (for screen number change) should be used in 
conjunction with the function in order to change the screen 
at the time of a logout.

* For information on other setting items, refer to the V8 Series Reference Manual.

Address Description

$s1360 The current security level 0 - 15 specified when you log in to the system is stored.

$s1361 The current user ID specified when you log in to the system is stored.

$s1362

$s1363

$s1364
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Please use this page freely.
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23 Macro
Overview

• You can obtain a sine, cosine, or tangent of trigonometric functions by using macro commands.
• A conditional branch macro is added for a comparison macro so that a comparison command can 

be executed more simply.
• You can designate a file name when creating a CSV file or using the hardcopy function.

Macro Commands List

The macro commands given below have newly been added.

Category Command Name Mnemonic Contents Refer to:

Mathematics/
trigonometric

ABS
F0 = ABS (F1) (W)
F0 = ABS (F1) (D)
F0 = ABS (F1) (F)

Absolute value page 23-3

NEG
F0 = NEG (F1) (W)
F0 = NEG (F1) (D)
F0 = NEG (F1) (F)

Sign inversion page 23-4

SIN F0 = SIN (F1) (F) Sine page 23-5

COS F0 = COS (F1) (F) Cosine page 23-6

TAN F0 = TAN (F1) (F) Tangent page 23-7

ASIN F0 = ASIN (F1) (F) Arcsine page 23-8

ACOS F0 = ACOS (F1) (F) Arccosine page 23-9

ATAN F0 = ATAN (F1) (F) Arctangent page 23-10

DEG F0 = DEG (F1) (F) Convert radian to degree page 23-11

RAD F0 = RAD (F1) (F) Convert degree to radian page 23-12

Conversion

CLND_TO_GRE CLND_TO_GRE (F0) (F1) 
(F2)

Conversion from calendar 
data to GMT-based UNIX time

page 23-13

GRE_TO_CLND GRE_TO_CLND (F0) (F1) 
(F2)

Conversion from GMT-based 
UNIX time to calendar data 

page 23-15

FORMAT_DATA FORMAT_DATA (F0) (F1) 
(F2)

Conversion from a string to 
numerical data

page 23-17

FORMAT_STR FORMAT_STR (F0) (F1) 
(F2)

Conversion from numerical 
data to a string

page 23-21

Comparison
IF
ELSE
ENDIF

IF (F0 (condition) F1) (W)
IF (F0 (condition) F1) (D)
IF (condition 2) (F0) (B)
ELSE
ENDIF

Conditional branch page 23-25

CF Card
(Sampling)

SMPL_CSV2 SMPL_CSV2 (F0) (F1) CSV file creation 
(file name designation)

page 23-27

SMPL_CSVBAK2 SMPL_CSVBAK2 (F0) (F1) CSV file backup saving
(file name designation)

page 23-29
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CF Card
(Others)

HDCOPY3 HDCOPY3 (F0) Hardcopy 
(file name designation)

page 23-31

MOVE_FILE MOVE_FILE (F0) (F1) (F2) File movement page 23-32

READ_FILE READ_FILE (F0) (F1) (F2) 
(F3)

Read universal file page 23-33

WRITE_FILE WRITE_FILE (F0) (F1) (F2) Write to universal file page 23-35

Category Command Name Mnemonic Contents Refer to:
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Mathematics/trigonometric

F0 = ABS (F1) (W)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . WORD
F0 = ABS (F1) (D) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . DWORD
F0 = ABS (F1) (F) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FLOAT

Function: Absolute value
This macro command is used to store an absolute value of [F1] in [F0].

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• $u100 = ABS ($u200) (W)

When $u200 = “-1”, on command execution “1” is stored in $u100.

Supplementary information
• $s1056 stores the result of macro execution.

When the execution of the macro is normally complete, the value at the address is not updated.  
Therefore, before macro execution, resetting the value at the address to zero is recommended.

* An indefinite value is stored in [F0].

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

WORD DWORD FLOAT

F0 -32767 to +32767
(Decimal system 

with signs)

-2147483647 to +2147483647
(Decimal system with signs)

IEEE 32-bit single precision 
real numberF1

Code (DEC) Contents

1 Overflow*

2 Underflow*

F1
WORD

F0 F1+1 F1

DWORD

F0+1 F0
FLOAT

+ +

FFF F

1 1111111111111 1 1 BIN
HEX
DEC

000 1

0 0000000000000 0 1 BIN
HEX
DEC

-1

1

$u200

$u100

ABS
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F0 = NEG (F1) (W)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . WORD
F0 = NEG (F1) (D) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . DWORD
F0 = NEG (F1) (F) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FLOAT

Function: Sign inversion
This macro command is used to store a value with its sign inverted from [F1] in [F0].

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• $u100 = NEG ($u200) (W)

When $u200 = “-1”, on command execution “1” is stored in $u100.

Supplementary information
• $s1056 stores the result of macro execution.

* An indefinite value is stored in [F0].

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

WORD DWORD FLOAT

F0 -32767 to +32767
(Decimal system 

with signs)

-2147483647 to +2147483647
(Decimal system with signs)

IEEE 32-bit single precision 
real numberF1

Code (DEC) Contents

0 Normal

1 Overflow*

2 Underflow*

F1
WORD

F0 F1+1 F1

DWORD

F0+1 F0
FLOAT

- + - +

F1 F0+ - F1+1 F1 F0+1 F0+ -

FFF F

1 1111111111111 1 1 BIN
HEX
DEC

000 1

0 0000000000000 0 1 BIN
HEX
DEC

-1

1

$u200

$u100

NEG
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F0 = SIN (F1) (F) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FLOAT

Function: Sine

This macro command is used to store a sine of the angle (in radians) specified for [F1] in [F0].
Specify values for [F0] and [F1] in the format of decimal floating-point data (FLOAT).

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• To obtain the value for sin 90° in radians;

$u200 = RAD (90) (F)
$u100 = SIN ($u200) (F)
The operation result of “1” is stored in $u100.

Supplementary information
• For more information on IEEE 32-bit single precision real number, refer to the V8 Series Reference 

Manual.
• To convert the unit of an angle, use the macro command of DEG (page 23-11) or RAD (page 

23-12).

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

Value

F0
IEEE 32-bit single precision real number

F1

The sine, cosine and tangent of the 
trigonometric functions can be 
obtained based on the formula given 
to the right.

• Radian (circular measure)
1 rad = 360/2π = 
Approx. 57.29578 degrees

F1+1 F1 F0+1 F0
FLOAT FLOAT

SIN

(x,y)

(0,0) (1,0)

(0,1)

(0,-1)

(-1,0)

r
X axis

Y axis
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F0 = COS (F1) (F) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FLOAT

Function: Cosine
This macro command is used to store a cosine of the angle (in radians) specified for [F1] in [F0].
Specify values for [F0] and [F1] in the format of decimal floating-point data (FLOAT).

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• To obtain the value for cos 0° in radians;

$u200 = RAD (0) (F)
$u100 = COS ($u200) (F)
The operation result of “1” is stored in $u100.

* For more information on cosθ of the trigonometric functions, refer to “Example” of sine on 
page 23-5.

Supplementary information
• For more information on IEEE 32-bit single precision real number, refer to the V8 Series Reference 

Manual.
• To convert the unit of an angle, use the macro command of DEG (page 23-11) or RAD (page 

23-12).

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

Value

F0
IEEE 32-bit single precision real number

F1

F1+1 F1 F0+1 F0
FLOAT FLOAT

COS
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F0 = TAN (F1) (F)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FLOAT

Function: Tangent
This macro command is used to store a tangent of the angle (in radians) specified for [F1] in [F0].
Specify values for [F0] and [F1] in the format of decimal floating-point data (FLOAT).

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• To obtain the value for tan 45° in radians;

$u200 = RAD (45) (F)
$u100 = TAN ($u200) (F)
The operation result of “1” is stored in $u100.

* For more information on tanθ of the trigonometric functions, refer to “Example” of sine on 
page 23-5.

Supplementary information
• $s1056 stores the result of macro execution.

*1 An indefinite value is stored in [F0].
*2 When the value specified for [F1] is π × (0.5 + n), “-1” is stored in [F0]. (n: integer)

• To convert the unit of an angle, use the macro command of DEG (page 23-11) or RAD (page 
23-12).

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

Value

F0
IEEE 32-bit single precision real number

F1

Code (DEC) Contents

0 Normal

1 Overflow*1

2 Underflow*1

3 Operation execution error*2

F1+1 F1 F0+1 F0
FLOAT FLOAT

TAN
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F0 = ASIN (F1) (F). . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FLOAT

Function: Arcsine
This macro command is used to store an arcsine of the angle (in radians) specified for [F1] in [F0].
Specify values for [F0] and [F1] in the format of decimal floating-point data (FLOAT).

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• To obtain the value for sin-1 1;

$u100 = ASIN (1) (F)
The operation result of 
“1.570796” (= π/2) is stored in 
$u100.

Supplementary information
• $s1056 stores the result of macro execution.

*1 An indefinite value is stored in [F0].
*2 When the value specified for [F1] is outside the range from “-1” to “1”, “-1” is stored in [F0].

• To convert the unit of an angle, use the macro command of DEG (page 23-11) or RAD (page 
23-12).

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

Value

F0
IEEE 32-bit single precision real number

F1

Code (DEC) Contents

0 Normal

1 Overflow*1

2 Underflow*1

3 Operation execution error*2

F1+1 F1 F0+1 F0
FLOAT FLOAT

SIN-1

The sin-1 of the trigonometric functions is 
expressed in the graph shown below.

2

2

-1

-1

1

1

0

X axis

Y axis
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F0 = ACOS (F1) (F). . . . . . . . . . . . . . . . . . . . . . . . . . . . . FLOAT

Function: Arccosine
This macro command is used to store an arccosine of the angle (in radians) specified for [F1] in [F0].
Specify values for [F0] and [F1] in the format of decimal floating-point data (FLOAT).

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• To obtain the value for cos-1 0;

$u100 = ACOS (0) (F)
The operation result of 
“1.570796” (= π/2) is stored in 
$u100.

Supplementary information
• $s1056 stores the result of macro execution.

*1 An indefinite value is stored in [F0].
*2 When the value specified for [F1] is outside the range from “-1” to “1”, “-1” is stored in [F0].

• To convert the unit of an angle, use the macro command of DEG (page 23-11) or RAD (page 
23-12).

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

Value

F0
IEEE 32-bit single precision real number

F1

Code (DEC) Contents

0 Normal

1 Overflow*1

2 Underflow*1

3 Operation execution error*2

F1+1 F1 F0+1 F0
FLOAT FLOAT

COS-1

The cos-1 of the trigonometric functions is 
expressed in the graph shown below.

-1 10

2

X axis

Y axis
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F0 = ATAN (F1) (F)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FLOAT

Function: Arctangent
This macro command is used to store an arctangent of the angle (in radians) specified for [F1] in [F0].
Specify values for [F0] and [F1] in the format of decimal floating-point data (FLOAT).

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• To obtain the value for tan-1 0;

$u100 = ATAN (0) (F)
The operation result of “0” is 
stored in $u100.

Supplementary information
• $s1056 stores the result of macro execution.

* An indefinite value is stored in [F0].
• To convert the unit of an angle, use the macro command of DEG (page 23-11) or RAD (page 

23-12).

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

Value

F0
IEEE 32-bit single precision real number

F1

Code (DEC) Contents

0 Normal

1 Overflow*

2 Underflow*

F1+1 F1 F0+1 F0
FLOAT FLOAT

TAN-1

The tan-1 of the trigonometric functions is 
expressed in the graph shown below.

2

0

2

X axis

Y axis
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F0 = DEG (F1) (F) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FLOAT

Function: Convert radian to degree
This macro command is used to convert the unit of an angle specified for [F1] from radians to degrees 
and store the converted value in [F0].
Specify values for [F0] and [F1] in the format of decimal floating-point data (FLOAT).

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• To obtain a value in degrees;

$u100 = ASIN (1) (F)
$u200 = DEG ($u100) (F)
The operation result of “90” is stored in $u200.

Supplementary information
• $s1056 stores the result of macro execution.

* An indefinite value is stored in [F0].

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

Value

F0
IEEE 32-bit single precision real number

F1

Code (DEC) Contents

0 Normal

1 Overflow*

2 Underflow*

F1+1 F1 F0+1 F0
FLOAT FLOAT

DEG



23    Macro

23-12

F0 = RAD (F1) (F) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . FLOAT

Function: Convert degree to radian
This macro command is used to convert the unit of an angle specified for [F1] from degrees to radians 
and store the converted value in [F0].
Specify values for [F0] and [F1] in the format of decimal floating-point data (FLOAT).

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• To obtain the value for 180° in radians;

$u100 = RAD (180) (F)
The operation result of “3.141592” (= π) is stored in $u100.

Supplementary information
• $s1056 stores the result of macro execution.

* An indefinite value is stored in [F0].

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

Value

F0
IEEE 32-bit single precision real number

F1

Code (DEC) Contents

0 Normal

1 Overflow*

2 Underflow*

F1+1 F1 F0+1 F0
FLOAT FLOAT

RAD
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Conversion

CLND_TO_GRE  F0 F1 F2

Function: Conversion from calendar data to GMT-based UNIX time
This macro is used to convert the calendar data [F1] in format [F2] to the UNIX time based on GMT, 
and to store the converted result in [F0].

Available memory

: Setting enabled (indirect designation disabled)  
: Setting enabled (indirect designation enabled)

Range

: ← V series (Return data)

Example
The calendar data in $u200 - $u205 in DEC format, 17 (hour):25 (minutes):10 (seconds) on June 10 in 
2010, is converted to the GMT-based UNIX time, and the converted result is stored in $u100 and 
$u101.

$u200 = 2010 (W)
$u201 = 6 (W)
$u202 = 10 (W)
$u203 = 17 (W)
$u204 = 25 (W)
$u205 = 10 (W)
$u300 = 0 (W)
CLND_TO_GRE $u100 $u200 $u300

The GMT-based UNIX time “1276190710 seconds” is obtained.
Time data 0 → $u100 = 8182 DEC
Time data 1 → $u101 = 19473 DEC

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

F2

Value Remarks

F0 Time data 0 DEC only

F0 + 1
Time data 1

F1 4 or 2 digits: Year 

F1 + 1 1 to 12: Month

F1 + 2 1 to 31: Day

F1 + 3 0 to 23: Hour

F1 + 4 0 to 59: Minutes

F1 + 5 0 to 59: Seconds

F2 0: DEC
1: BCD

Data format 
for [F1]

Calendar data GMT-based UNIX time

CLND_TO_GRE

F1 F0

Time data 1 Time data 0

UNIX time since January 1, 1970 GMT
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Supplementary information
• The result of macro execution is stored in $s1057.

When the execution of the macro is normally complete, the value at the address is not updated.  
Therefore, before macro execution, resetting the value at the address to zero is recommended.

Restrictions
• When setting a numerical data display to show the converted result of calendar data, 3 (hour):14 

(minutes):7 (seconds) on January 19, 2038 or after, enable the display to show 2-word long data 
without sign.

• This macro handles any year divisible by 4 as a leap year.  For example, the year 2100 is 
recognized as a leap year though it is not so.  Therefore, an error of one day will result.

• The calendar data displayable on the V8 unit ranges from January 1, 2006 to December 31, 2105.  
Any calendar data outside this range cannot be converted with this macro correctly.

Code (DEC) Description

-1 Execution error
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GRE_TO_CLND  F0 F1 F2

Function: Conversion from GMT-based UNIX time to calendar data
This macro is used to convert the UNIX time based on GMT in [F1] to the calendar data in format [F2], 
and to store the converted result in [F0].

Available memory

: Setting enabled (indirect designation disabled)  
: Setting enabled (indirect designation enabled)

Range

: ← V series (Return data)
Example
The GMT-based UNIX time, 1278663500 seconds, in $u200 is converted to the calendar data in DEC 
format, and the converted result is stored in $u100 and after.

GRE_TO_CLND $u100 $u200 0
The calendar data, “8 (hour):18 (minutes):20 (seconds) on Friday on July 9, 2010,” is obtained.

Year  → $u100 = 2010 DEC
Month  → $u101 = 7 DEC
Day  → $u102 = 9 DEC
Hour  → $u103 = 8 DEC
Minutes  → $u104 = 18 DEC
Seconds  → $u105 = 20 DEC
Day of the week  → $u106 = 5 DEC

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

F2

Value Remarks

F0 4 digits: Year

F0 + 1 1 to 12: Month

F0 + 2 1 to 31: Day

F0 + 3 0 to 23: Hour

F0 + 4 0 to 59: Minutes

F0 + 5 0 to 59: Seconds

F0 + 6

0: Sunday
1: Monday
2: Tuesday
3: Wednesday
4: Thursday
5: Friday
6: Saturday

F1 Time data 0 DEC only

F1 + 1
Time data 1

F2 0: DEC
1: BCD

Data format 
for [F0]

GMT-based UNIX time Calendar data
GRE_TO_CLND

F1 F0

Time data 1 Time data 0

UNIX time since January 1, 1970 GMT
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Supplementary information
• The result of macro execution is stored in $s1057.

When the execution of the macro is normally complete, the value at the address is not updated.  
Therefore, before macro execution, resetting the value at the address to zero is recommended.

Restrictions
• This macro handles any year divisible by 4 as a leap year.  For example, the year 2100 is 

recognized as a leap year though it is not so.  Therefore, an error of one day will result.
• The calendar data displayable on the V8 unit ranges from January 1, 2006 to December 31, 2105.  

Any data outside this range cannot be converted with this macro correctly.

Code (DEC) Description

−1 Execution error
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FORMAT_DATA  F0 F1 F2

Function: Conversion from a string to numerical data
This macro is used to convert the string [F1] according to the attributes [F2], and to store the converted 
result in [F0].

Available memory

: Setting enabled (indirect designation disabled)  
: Setting enabled (indirect designation enabled)

Range

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

F2

String (JIS/ASCII)  Numerical data

FORMAT_DATA

F1 F0

Value Remarks

F0 Target memory: BIN The number of words depends on [F2 + 1] (data length).

F1
Source memory: String (ASCII) The number of bytes depends on [F2 + 3] (character count).

32 bytes maximum (16 words)
Character processing LSB → MSB fixed

F2

0: DEC without sign (decimal)
1: DEC with a negative sign 

(decimal)
2: DEC with a positive/negative 

sign (decimal)
3: HEX (hexadecimal)
4: OCT (octal)
5: BIN (binary)
6: FLOAT (real number)

Format for [F1] 
If “DEC with a negative sign” or “FLOAT” is selected for [F2] for 
the conversion of a positive value, add a space code (20H) to 
the leftmost position of the positive value.  Otherwise, an error 
will result.
A space code is not included in the number of digits.
Example:
For a string “123” to be converted, add a space to make it as 
“ 123”.

F2 + 1 0: 1 word 
1: 2 words

Data length for [F0]
If “FLOAT” is selected for [F2], specify “0”.

F2 + 2
0: DEC
1: BCD

Data format for [F0]
If “HEX,” “OCT,” “BIN,” or “FLOAT” is selected for [F2], specify 
“0”.

F2 + 3

1 - 32: [F2] = 0, 1, 2, 5, or 6 
1 - 8: [F2] = 3
1 - 11: [F2] = 4

Number of digits for [F1]
A positive/negative sign and a decimal point are not included in 
the number of digits.
Example:
For a string “-12.3” to be converted, the number of digits is three.

F2 + 4
0 - 10: [F2] = 0, 1, or 2
0 - 31: [F2] = 6

Decimal place for [F1]
Example:
For a string “12.34” to be converted, specify two decimal places.

F2 + 5 0: With zero suppress
1: Without zero suppress

Format for [F1]
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Example
The string in $u100 is converted to the numerical data, and the converted result is stored in $u300.

• String “1234”: DEC without sign

$u00100 = '1234' (STRING)
$u00200 = 0 (W)  [DEC without sign]
$u00201 = 0 (W)  [1 word]
$u00202 = 0 (W)  [DEC]
$u00203 = 4 (W)  [4 digits]
$u00204 = 0 (W)  [Without decimal point]
$u00205 = 0 (W)  [With zero suppress]
$u00206 = 0 (W)  [Leading spaces removed]
$u00207 = 0 (W)  [0 fixed]
FORMAT_DATA $u00300 $u00100 $u00200
The result “1234” is stored in $u300.

• String “12.34”: A positive value in DEC with a negative sign format and with two decimal places
$u00100 = ' 12.34' (STRING) 
;(For a positive value, add a space code 20H in the leftmost position.)
$u00200 = 1 (W)  [DEC with a negative sign]
$u00201 = 0 (W)  [1 word]
$u00202 = 0 (W)  [DEC]
$u00203 = 4 (W)  [4 digits]
$u00204 = 2 (W)  [Two decimal places]
$u00205 = 0 (W)  [With zero suppress]
$u00206 = 0 (W)  [Leading spaces removed]
$u00207 = 0 (W)  [0 fixed]
FORMAT_DATA $u00300 $u00100 $u00200
The result “1234” is stored in $u300.

F2 + 6

Valid only when F2 + 5 = 0
0: Leading spaces removed
1: Trailing spaces removed

Format for [F1]
When a value in [F1] includes leading spaces, specify “0”.  When 
a value in [F1] includes trailing spaces, specify “1”.
Example:

F2 + 7 0 fixed

Value Remarks

0:              12 → 12
1: 12             → 12 

Display
$u100 3 2 3 1 HEX “12”
$u101 3 4 3 3 HEX “34”

$u300 1234 “1234”

↓ FORMAT_DATA
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• String “−12.34”: A negative value in DEC with a negative sign format and with two decimal places
$u00100 = '−12.34' (STRING) 
$u00200 = 1 (W)  [DEC with a negative sign]
$u00201 = 0 (W)  [1 word]
$u00202 = 0 (W)  [DEC]
$u00203 = 4 (W)  [4 digits]
$u00204 = 2 (W)  [Two decimal places]
$u00205 = 0 (W)  [With zero suppress]
$u00206 = 0 (W)  [Leading spaces removed]
$u00207 = 0 (W)  [0 fixed]
FORMAT_DATA $u00300 $u00100 $u00200
The result “−1234” is stored in $u300.

• String “1234”: FLOAT
$u00100 = ' 12.34' (STRING) 
;(For a positive value, add a space code 20H in the leftmost position.)
$u00200 = 6 (W)  [FLOAT]
$u00201 = 0 (W)  [0 fixed]
$u00202 = 0 (W)  [0 fixed]
$u00203 = 4 (W)  [4 digits]
$u00204 = 0 (W)  [Without decimal point]
$u00205 = 0 (W)  [With zero suppress]
$u00206 = 0 (W)  [Leading spaces removed]
$u00207 = 0 (W)  [0 fixed]
FORMAT_DATA $u00300 $u00100 $u00200
The result “1234” is stored in $u300 and $u301.

• String “001234”: In DEC without sign format and without zero suppress
$u00100 = '001234' (STRING)
$u00200 = 0 (W)  [DEC without sign]
$u00201 = 0 (W)  [1 word]
$u00202 = 0 (W)  [DEC]
$u00203 = 6 (W)  [6 digits]
$u00204 = 0 (W)  [Without decimal point]
$u00205 = 1 (W)  [Without zero suppress]
$u00206 = 0 (W)  [Leading spaces removed]
$u00207 = 0 (W)  [0 fixed]
FORMAT_DATA $u00300 $u00100 $u00200
The result “1234” is stored in $u300.

• String “  1234”: In DEC without sign format and with two leading spaces 
$u00100 = '  1234' (STRING)
$u00200 = 0 (W)  [DEC without sign]
$u00201 = 0 (W)  [1 word]
$u00202 = 0 (W)  [DEC]
$u00203 = 6 (W)  [6 digits]
$u00204 = 0 (W)  [Without decimal point]
$u00205 = 0 (W)  [With zero suppress]
$u00206 = 0 (W)  [Leading spaces removed]
$u00207 = 0 (W)  [0 fixed]
FORMAT_DATA $u00300 $u00100 $u00200
The result “1234” is stored in $u300.
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• String “1234  ”: In DEC without sign format and with two trailing spaces 
$u00100 = '1234  ' (STRING)
$u00200 = 0 (W)  [DEC without sign]
$u00201 = 0 (W)  [1 word]
$u00202 = 0 (W)  [DEC]
$u00203 = 6 (W)  [6 digits]
$u00204 = 0 (W)  [Without decimal point]
$u00205 = 0 (W)  [With zero suppress]
$u00206 = 1 (W)  [Trailing spaces removed]
$u00207 = 0 (W)  [0 fixed]
FORMAT_DATA $u00300 $u00100 $u00200
The result “1234” is stored in $u300.

Supplementary information
• If “HEX” is specified as an attribute for conversion, characters “A” - “F” of the source data is not 

case-sensitive.
• If this macro, with “FLOAT” specified as an attribute, results in underflow, “0” is obtained as the 

converted result.
• Conversion with this macro is in the order of LSB → MSB.
• The following PLCs provided with PLC-specific data format are capable of handling negative 

values in BCD with a sign format.  When you run this macro using such a value with any of these 
PLCs, the internal memory is not valid for [F0].  Therefore, be sure to assign the PLC memory 
(specific to the PLC model) to [F0].

1) Fuji Electric: All of the MICREX-F series
2) Yaskawa: Memobus (transfer mode 1) 
3) OMRON: All (transfer mode 2) 

• The result of macro execution is stored in $s1057.
When the execution of the macro is normally complete, the value at the address is not updated.  
Therefore, before macro execution, resetting the value at the address to zero is recommended.

Code (DEC) Description

−1 Execution error
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FORMAT_STR  F0 F1 F2

Function: Conversion from numerical data to a string
This macro is used to convert the numerical data [F1] according to the attributes [F2], and to store the 
converted result in [F0].

Available memory

: Setting enabled (indirect designation disabled)  
: Setting enabled (indirect designation enabled)

Range

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

F2

String (JIS/ASCII) Numerical data

FORMAT_STR

F1 F0

Value Remarks

F0
Target memory: String (ASCII code) The number of bytes depends on [F2 + 3] (character count).

32 bytes maximum (16 words)
Character processing LSB → MSB fixed

F1 Source memory: BIN The number of words depends on [F2 + 1] (data length).

F2

0: DEC without sign (decimal)
1: DEC with a negative sign 

(decimal)
2: DEC with a positive/negative sign 

(decimal)
3: HEX (hexadecimal)
4: OCT (octal)
5: BIN (binary)
6: FLOAT (real number)

Format for [F1] 

If “DEC with a negative sign” or “FLOAT” is selected for [F2] 
and the converted result is a positive value, a space code 
(20H) is added to the leftmost byte of the positive value.
Example:
For numerical data “123” to be converted, a space is added 
to provide a converted result as “ 123”.

F2 + 1 0: 1 word
1: 2 words

Data length for [F1]
If “FLOAT” is selected for [F2], specify “0”.

F2 + 2
0: DEC
1: BCD

Data format for [F1]
If “HEX,” “OCT,” “BIN,” or “FLOAT” is selected for [F2], 
specify “0”.

F2 + 3

1 to 32: [F2] = 0, 1, 2, 5, or 6 
1 to 8: [F2] = 3
1 to 11: [F2] = 4

Number of digits for [F0]
A positive/negative sign and a decimal point are not included 
in the number of digits.
If the number of digits specified for [F2 + 3] is smaller than 
that of the converted string, the result is given as a hyphen 
“-”.
Example:
For a string “-12.3” as the converted result, the number of 
digits is three.

F2 + 4

0 to 10: [F2] = 0, 1, or 2
0 to 31: [F2] = 6

Decimal place for [F0]
Example:
For a string “12.34” as the converted result, the number of 
digits is four and two decimal places are given.
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Example
The numerical data in $u100 is converted to a string according to the specified attributes, and the 
converted result is stored in $u300.

• Numerical data “1234”: DEC without sign

$u00100 = 1234 (W)
$u00200 = 0 (W)  [DEC without sign]
$u00201 = 0 (W)  [1 word]
$u00202 = 0 (W)  [DEC]
$u00203 = 4 (W)  [4 digits]
$u00204 = 0 (W)  [Without decimal point]
$u00205 = 0 (W)  [With zero suppress]
$u00206 = 0 (W)  [Leading spaces added]
$u00207 = 0 (W)  [0 fixed]
FORMAT_STR $u00300 $u00100 $u00200
The result “1234” is stored in $u300 and $u301.

• Numerical data “1234”: In DEC without sign format, and with zero suppress and leading spaces
$u00100 = 1234 (W)
$u00200 = 0 (W)  [DEC without sign]
$u00201 = 0 (W)  [1 word]
$u00202 = 0 (W)  [DEC]
$u00203 = 6 (W)  [6 digits]
$u00204 = 0 (W)  [Without decimal point]
$u00205 = 0 (W)  [With zero suppress]
$u00206 = 0 (W)  [Leading spaces added]
$u00207 = 0 (W)  [0 fixed]
FORMAT_STR $u00300 $u00100 $u00200
The result “ 1234” is stored in $u300 - $u302.

F2 + 5

0: With zero suppress
1: Without zero suppress

Format for [F0]
Select whether to execute zero suppress.
Example:
For a string “00012” as the converted result, specify “1”.

F2 + 6

Valid only when F2 + 5 = 0
0: Leading spaces inserted
1: Trailing spaces inserted

Format for [F0]
When a value in [F0] includes leading spaces, specify “0”.  
When a value in [F0] includes trailing spaces, specify “1”.
Example:

F2 + 7 0 fixed

Value Remarks

0: 12 →                12
1: 12 →  12

Display

$u100 1234 “1234”

$u300 3 2 3 1 HEX “12”
$u301 3 4 3 3 HEX “34”

↓ FORMAT_STR
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• Numerical data “1234”: In DEC without sign format, and with zero suppress and trailing spaces
$u00100 = 1234 (W)
$u00200 = 0 (W)  [DEC without sign]
$u00201 = 0 (W)  [1 word]
$u00202 = 0 (W)  [DEC]
$u00203 = 6 (W)  [6 digits]
$u00204 = 0 (W)  [Without decimal point]
$u00205 = 0 (W)  [With zero suppress]
$u00206 = 1 (W)  [Trailing spaces added]
$u00207 = 0 (W)  [0 fixed]
FORMAT_STR $u00300 $u00100 $u00200
The result “1234 ” is stored in $u300 - $u302.

• Numerical data “1234”: In DEC without sign format and without zero suppress
$u00100 = 1234 (W)
$u00200 = 0 (W)  [DEC without sign]
$u00201 = 0 (W)  [1 word]
$u00202 = 0 (W)  [DEC]
$u00203 = 6 (W)  [6 digits]
$u00204 = 0 (W)  [Without decimal point]
$u00205 = 1 (W)  [Without zero suppress]
$u00206 = 0 (W)  [Leading spaces added]
$u00207 = 0 (W)  [0 fixed]
FORMAT_STR $u00300 $u00100 $u00200
The result “001234” is stored in $u300 - $u302.

• Numerical data “12.34”: In DEC with a negative sign format and with two decimal places
$u00100 = 1234 (W)
$u00200 = 1 (W)  [DEC with a negative sign]
$u00201 = 0 (W)  [1 word]
$u00202 = 0 (W)  [DEC]
$u00203 = 4 (W)  [4 digits]
$u00204 = 2 (W)  [Two decimal places]
$u00205 = 0 (W)  [With zero suppress]
$u00206 = 0 (W)  [Leading spaces added]
$u00207 = 0 (W)  [0 fixed]
FORMAT_STR $u00300 $u00100 $u00200
The result “ 12.34” is stored in $u300 - $u302.
(For a positive value, a space code 20H is added to the leftmost position.)

• Numerical data “1234.00”: FLOAT
$u00100 = 1234 (D)
$u00100(F) <- $u00100(D) 0 (D)
$u00200 = 6 (W)  [FLOAT]
$u00201 = 0 (W)  [0 fixed]
$u00202 = 0 (W)  [0 fixed]
$u00203 = 6 (W)  [6 digits]
$u00204 = 2 (W)  [Two decimal places]
$u00205 = 0 (W)  [With zero suppress]
$u00206 = 0 (W)  [Leading spaces added]
$u00207 = 0 (W)  [0 fixed]
FORMAT_STR $u00300 $u00100 $u00200
The result “ 1234.00” is stored in $u300 - $u303.
(For a positive value, a space code 20H is added to the leftmost position.)
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Supplementary information
• Conversion with this macro is in the order of LSB → MSB.
• A NULL code is added to the end of the string as a result of conversion.  If a conversion results in 

even bytes, one more word is used for this reason.
• The following PLCs provided with PLC-specific data format are capable of handling negative 

values in BCD with a sign format.  When you run this macro using such a value with any of these 
PLCs, the internal memory is not valid for [F1].  Therefore, be sure to assign the PLC memory 
(specific to the PLC model) to [F1].

1) Fuji Electric: All of the MICREX-F series 
2) Yaskawa: Memobus (transfer mode 1) 
3) OMRON: All (transfer mode 2) 

• The result of macro execution is stored in $s1057.
When the execution of the macro is normally complete, the value at the address is not updated.  
Therefore, before macro execution, resetting the value at the address to zero is recommended.

Code (DEC) Description

−1 Execution error
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Comparison

IF (F0 (condition) F1) (W)  . . . . . . . . . . . . . . . . . . . . . . . WORD
IF (F0 (condition) F1) (D) . . . . . . . . . . . . . . . . . . . . . . . DWORD
IF (condition 2) (F0) (B) . . . . . . . . . . . . . . . . . . . . . . . . . . . . BIT
(1)
ELSE
(2)
ENDIF

Function: Conditional branch
The above-mentioned macro commands for data in WORD and DWORD formats are used to compare 
[F0] and [F1], and to execute processing (1) if true, or (2) if false.
The macro command for data in BIT format is used to compare [F0] and condition 2, and to execute 
processing (1) if true, or (2) if false.
Processing of “ELSE” and (2) can be omitted.

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Conditions 1 Conditions 2
Symbol Contents Symbol Contents

== Equal ZERO 0

!= Different NON ZERO Other than 0

< Less than

> Greater than

<= Less than or equal to

>= Greater than or equal to

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

WORD DWORD BIT

F0 -32768 to +32767
(Decimal system with signs)

-2147483648 to +2147483647
(Decimal system with signs)

0, 1

F1 -
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Example
• IF ($u100 < 10) (W)

$u100 = $u100 + 1 (W)
ELSE
$u100 = 0 (W)
ENDIF
“$u100 = $u100 + 1” is executed when $u100 is smaller than 10.  When $u100 is 10 or more, 
“$u100 = 0” is executed.

• Comparison of data in BIT format
IFNZ ($u100-00) (B)
$u100 = $u100 + 1 (W)
ELSE
$u100 = 0 (W)
ENDIF
If $u100-00 is ON, $u100 = $u100 + 1 is executed.  If $u100-00 is OFF, $u100 = 0 is executed.

Restrictions
• IF-ELSE-ENDIF commands can be nested up to 8 levels.

Supplementary information
• An error occurs to the macro editor when any of the following conditions is met.

1) When IF-ELSE-ENDIF commands are nested beyond 8 levels;

2) When the number of IF commands is not the same as the one of ENDIF commands;

3) When the number of IF commands is not the same as the one of ELSE commands;

4) When FOR and NEXT commands are specified in a series of IF-ELSE-ENDIF commands.

Example: IF ($u100 > 0)

IF ($u100 < 10) There are 9 or more IF commands between IF-ENDIF 
commands.:

IF ($u200 == 1)

ENDIF

Example: IF ($u100 == 0) There are two IF commands while there is one ENDIF 
command.IF ($u100 == 0)

ENDIF

Example: IF ($u100 == 0)

There is one IF command while there are two ELSE 
commands.

ELSE

ELSE

ENDIF

Example: IF ($u100 == 0)

FOR 10

ELSE Only ELSE and ENDIF commands are specified between 
FOR and NEXT commands.ENDIF

NEXT
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• $s1059 stores the result of macro execution.
When the execution of the macro is normally complete, the value at the address is not updated.  
Therefore, before macro execution, resetting the value at the address to zero is recommended.

* When reading from [F0] and [F1] ends in failure, an error occurs and “−1” is stored in $s1059.
When an execution error occurs, it is regarded as a fault.

CF Card (Sampling)

SMPL_CSV2

Function: CSV file creation (file name designation)
This macro command is used to convert the sampling data in buffering area No. [F0] into the CSV file 
format under the name [F1] and saves the file in the SAMPLE folder in the CF card.
If the specified file does not exist, a new file will be created.

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

File
Storage target: \access folder\SAMPLE
File name: xxxxxxxx.csv 

Example
• The file named “SEISAN.CSV” is created in buffering area No. 1.

$u00100 = ’SEISAN’ (STRING)
SMPL_CSV2 1 $u00100 

Code (DEC) Contents

−1 Execution error*

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

Value

F0 0 to 11: Buffering area number

F1 ASCII code (64 one-byte uppercase alphanumerics at the maximum): CSV file name

If [  Insert/Overwrite together with STRING Command] is checked in the [Memory 
Setting] or [Macro Editing Support] dialog, the macro command STRING can also be 
registered.
For more information on the STRING command, refer to the Macro Reference Manual.

Buffering area number designation

File name designation
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Supplementary information
• When the CF card or the memory card is selected as the secondary storage target, the data saved 

to the primary storage target is output first and then saved as a CSV file.
• The [CSV format] setting must be made for each buffer number.

• If the specified file already exists, it will be overwritten.
• If there is no buffer data, no CSV file will be created.
• The result of macro execution is stored in memory at $s1062.

When the execution of the macro is normally complete, the value at the address is not updated.  
Therefore, before macro execution, resetting the value at the address to zero is recommended.

Limitations
• These symbols, [\], [/], [:], [*], [?], [“], [<], [>] and [|], are not usable for a file name.

Code (DEC) Description

−1 Execution error

96
M

B

CompactFlash Card

RECIPE
SAMPLE

DAT0000

SMP0000.bin
SMP0001.bin
SMP0002.bin

96
M

B

CompactFlash Card

RECIPE
SAMPLE

DAT0000

SMP0000.bin
SMP0001.bin
SMP0002.bin

96
M

B

CompactFlash Card

RECIPE
SAMPLE

DAT0000

CSV file creation

In the case of [Primary storage target: SRAM] and [Secondary storage target: CF Card]:

Primary 
storage target
(SRAM)

CSV file creation

Header
Buffer No. 0

Buffer No. 2
Buffer No. 1

Memo pad

$L/$LD

In the case of [Primary storage target: SRAM] and [Secondary storage target: None]:

SEISAN.CSV

SEISAN.CSV
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SMPL_CSVBAK2

Function: CSV file backup creation (file name designation)
This macro command is used to convert the sampling data in buffering area No. [F0] into the CSV file 
format under the name [F1] and saves the file in the year/month/day folder in the SAMPLE folder 
saved to the CF card.

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

File
Storage target: \access folder\SAMPLE\year/month folder\year/month/day folder
File name: \xxxxxxxx _ xx . csv 

Example
• A CSV file is created for buffering area No. 1 backup.

February 14, 2009, file name “SEISAN.CSV”

$u00100   = ’SEISAN’ (STRING)
SMPL_CSVBAK2 1 $u00100 

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

Value

F0 0 to 11: Buffering area number

F1 ASCII code (64 one-byte uppercase alphanumerics at the maximum): CSV file name

If [  Insert/Overwrite together with STRING Command] is checked in the [Memory 
Setting] or [Macro Editing Support] dialog, the macro command STRING can also be 
registered.
For more information on the STRING command, refer to the Macro Reference Manual.

File name
00 - 99: Backup count

Buffering area number designation

File name designation
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Supplementary information
• When the CF card or the memory card is selected as the secondary storage target, the data saved 

to the primary storage target is output first and then saved as a CSV file.
• The [CSV format] setting must be made for each buffer number. (page 23-28)
• If backup is repeated more than 100 times for a file given the same date, the final 99th backup file 

will be overwritten.
• If there is no buffer data, no CSV file will be created.
• The action to be taken associated with an insufficient available space in the CF card is selectable 

in the [General Settings] tab window in the [Unit Setting] dialog provided under [System Setting].  

• The result of macro execution is stored in memory at $s1062.
When the execution of the macro is normally complete, the value at the address is not updated.  
Therefore, before macro execution, resetting the value at the address to zero is recommended.

Limitations
• These symbols, [\], [/], [:], [*], [?], [“] [<], [>] and [|], are not usable for a file name.

96
M

B

CompactFlash Card

RECIPE
SAMPLE

DAT0000

SMP0000.bin
SMP0001.bin
SMP0002.bin

96
M

B

CompactFlash Card

RECIPE
SAMPLE

DAT0000

SMP0000.bin
SMP0001.bin
SMP0002.bin

96
M

B

CompactFlash Card

RECIPE
SAMPLE

200902

DAT0000

20090214

200902
20090214

In the case of [Primary storage target: SRAM] and [Secondary storage target: CF Card]:

(year/month folder)
(year/month/day folder)

In the case of [Primary storage target: SRAM] and [Secondary storage target: None]:

Primary 
storage target
(SRAM)

Buffer No. 0
Buffer No. 1
Buffer No. 2

Header

Memo pad

$L/$LD

(year/month folder)
(year/month/day folder)

CSV file 
creation

CSV file 
creation

SEISAN_00.CSV

SEISAN_00.CSV

Code (DEC) Description

−1 Execution error
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CF Card (Others)

HDCOPY3

Function: Hardcopy (file name designation)
This macro command is used to save the screen image (JPEG) displayed at the time of the macro 
execution, under the file name [F0], to the CF card.

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

File
Storage target: \access folder\HDCOPY
File name: \xxxxxxxx.JPG (64K-/32K-/128-color display)

: \xxxxxxxx.BIN (128-color display)

Example
• The file named “SCREEN10.JPG” is created.

$u00100 = ’SCREEN10’ (STRING)
HDCOPY3 $u00100 

Supplementary information
• One file saves one screen.  If a file name you designated already exists in the CF card, the file will 

be overwritten.
• If 128-color display is selected for the V8 series, the format of the file to be stored can be selected.  

When selecting a file format, click [System Setting] → [CF Card Setting] and go to [ Store 
HDCOPY Macro in JPEG Format]*. 

* If this option is unchecked, the BIN format is adopted for file saving.
When using a BIN file as image data, conversion into bitmap by the CF Card Manager is 
required.

• The result of macro execution is stored in memory at $s1062.
When the execution of the macro is normally complete, the value at the address is not updated.  
Therefore, before macro execution, resetting the value at the address to zero is recommended.

Limitations
• These symbols, [\], [/], [:], [*], [?], [“], [<], [>] and [|], are not usable for a file name.

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

Value

F0 ASCII code (64 one-byte uppercase alphanumerics at the maximum): CSV file name

If [  Insert/Overwrite together with STRING Command] is checked in the [Memory Setting] 
or [Macro Editing Support] dialog, the macro command STRING can also be registered.
For more information on the STRING command, refer to the Macro Reference Manual.

Code (DEC) Description

−1 Execution error

File name

File name designation
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MOVE_FILE F0 F1 F2
Function: File movement
This macro command is used to move the file or folder [F0] to the path [F1].
File renaming is also possible.

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• Movement from “C:\DAT0000\RECIPE\REC0000.csv” to “C:\DAT0000\RECIPE\SEISAN\abc.csv”:

$u00100 = 'C:\DAT0000\RECIPE\REC0000.csv'
$u00200 = 'C:\DAT0000\RECIPE\SEISAN\abc.csv'
MOVE_FILE $u00100 $u00200

Supplementary information
• If an illegal full pathname is specified, this macro command does not work.  An error will result.
• For the V8 series, the result of macro execution is stored in $s1062.

When the execution of the macro is normally complete, the value at the address is not updated.  
Therefore, before macro execution, resetting the value at the address to zero is recommended.

• In the case of a read-only file movement between drives, the file is copied to the target location, 
and the file at the original location is not deleted.

• A folder to be moved is allowed to contain a maximum of 5 hierarchical levels under the folder.  If 
files or folders at further lower levels exist under the folder, the folder and the files/folders placed 
under it are copied to the target location, but those at the original location are not deleted.

Internal Memory PLC1 - PLC8 Memory Memory Card Constant
F0
F1
F2

Value Remarks

F0
Source full pathname (within 255 
alphanumerics)

Drive designation
A: USB-FDD drive
B: (not used)
C: Built-in CF card drive 
D: Memory connected to USB port 

F1
Target full pathname (within 255 
alphanumerics)

F2 0 fixed

Code (DEC) Description
−1 Execution error

96
M

B

CompactFlash Card

RECIPE

DAT0000

REC0000.csv
REC0001.csv
REC0002.csv

96
M

B

CompactFlash Card

RECIPE

DAT0000

SEISAN
abc.csv

REC0001.csv
REC0002.csv

(Drive C:)                               (Drive C:)

Move

* The file 
“REC0000.csv” is 
deleted.
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Restrictions
• Use alphanumerics to specify full pathnames as the source and the target.  If any characters other 

than alphanumerics are used, the function of this macro command is not assured.
• Wildcard characters (such as “*” and “?”) cannot be used for full pathnames as the source and the 

target.

READ_FILE F0 F1 F2 F3

Function: Read universal file 
This macro command is used to read the file [F0] in binary format and to store the obtained data in 
memory [F1] and after.
It is also possible to acquire the size of the file [F0].

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

: ← V series (Return data)

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

F2

F3

Value
Remarks

File read File size acquisition

F0

Source full pathname (within 255 alphanumerics) Drive designation
A: USB-FDD drive
B: (not used)
C: Built-in CF card drive 
D: Memory connected to USB 
port 

F1 Target memory 0 fixed

F2 0 to 10485760 bytes: Size 0 fixed DEC

F2 + 1

F2 + 2 0 to 10485760 bytes: 
Offset from the beginning of the file 

0 fixed DEC

F2 + 3

F2 + 4 0 fixed

F3 Read data size storage memory
(Data size successfully read)

File size storage memory

F3 + 1
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Example
• File read

The file “ABC.DAT” is read from its 11th byte by 512 bytes into $u1000 to $u1255.
$u00100 = 'C:\DAT0000\ABC\ABC.DAT' [Source full pathname]
$u00200 = 512 (D) [Size]
$u00202 = 10 (D) [Offset]
$u00204 = 0 (W) [0 fixed]
READ_FILE $u00100 $u01000 $u00200 $u00300

• File size acquisition
The size of the file “ABC.DAT” is read into $u300.
$u00100 = 'C:\DAT0000\ABC\ABC.DAT' [Source full pathname]
$u00200 = 0 (W) [0 fixed]
$u00202 = 0 (W) [0 fixed]
$u00204 = 0 (W) [0 fixed]
READ_FILE $u00100 $u01000 $u00200 $u00300

Supplementary information
• If any characters other than alphanumerics are used to specify a source full pathname, this macro 

command may not work normally.  Be sure to use alphanumerics.
• Wildcard characters (such as “*” and “?”) cannot be used for a full pathname as the source.
• If the file specified as the source does not exist, an error will result.
• If an illegal full pathname is specified, this macro command does not work.  An error will result.
• In the event of an error during file reading, the data having been read is stored in memory.  

However, the size of the data does not affect the successfully read data size in [F3] and [F3 + 1].
• For the V8 series, the result of macro execution is stored in $s1062.

When the execution of the macro is normally complete, the value at the address is not updated.  
Therefore, before macro execution, resetting the value at the address to zero is recommended.

Code (DEC) Description
−1 Execution error
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WRITE_FILE F0 F1 F2

Function: Write to universal file
This macro command is used to write the data from memory [F1] and after in binary format to the file 
[F0].

Available memory

: Setting enabled (indirect designation disabled)
: Setting enabled (indirect designation enabled)

Range

Example
• New file creation

The 512 bytes of data in $u1000 to $u1255 is written to the new file “ABC.DAT” created in the 
folder “ABC”.
$u00100 = 'C:\DAT0000\ABC\ABC.DAT' [Target full pathname]
$u00200 = 0 (W) [0: New creation]
$u00201 = 512 (D) [Size]
$u00203 = 0 (W) [0 fixed]
$u00205 = 0 (W) [0 fixed]
WRITE_FILE $u00100 $u01000 $u00200

Internal Memory PLC1 - PLC8 
Memory Memory Card Constant

F0

F1

F2

Value
RemarksNew file 

creation Overwriting Addition

F0

Target full pathname Drive designation
A: USB-FDD drive
B: (not used)
C: Built-in CF card drive
D: Memory connected to USB 
port 

F1 Source memory

F2 0 fixed 1 fixed 2 fixed

F2 + 1 0 to 10485760 bytes: Size DEC

F2 + 2

F2 + 3 0 fixed 0 to 10485760 bytes: 
Offset from the beginning of the file

0 fixed

F2 + 4

F2 + 5 0 fixed
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• Overwriting
The 33rd byte and after in the existing file “ABC.DAT” is overwritten with the 16 bytes of data in 
$u1000 to $u1007.
$u00100 = 'C:\DAT0000\ABC\ABC.DAT' [Target full pathname]
$u00200 = 1 (W) [1: Overwrite]
$u00201 = 16 (D) [Size]
$u00203 = 32 (D) [Offset]
$u00205 = 0 (W) [0 fixed]
WRITE_FILE $u00100 $u01000 $u00200

• Addition
The 512 bytes of data in $u1000 to $u1255 is added to the existing file “ABC.DAT”.
$u00100 = 'C:\DAT0000\ABC\ABC.DAT' [Target full pathname]
$u00200 = 2 (W) [2: Add]
$u00201 = 512 (D) [Size]
$u00203 = 0 (W) [0 fixed]
$u00205 = 0 (W) [0 fixed]
WRITE_FILE $u00100 $u01000 $u00200

Supplementary information
• If the name of a new file you intend to create is already used, delete the existing file first and create 

a new file.
• If the size specified with [F2 + 1] and [F2 + 2] is zero for a new file, an empty file will be created.
• If the file you specified for overwriting or data addition does not exist, an error will result.
• Wildcard characters (such as “*” and “?”) cannot be used for a full pathname as the target, to which 

data is written.
• If an illegal full pathname is specified, this macro command does not work.  An error will result.
• In the event of an error during writing to a file, the data having been written remains in the file.
• For the V8 series, the result of macro execution is stored in $s1062.

When the execution of the macro is normally complete, the value at the address is not updated.  
Therefore, before macro execution, resetting the value at the address to zero is recommended.

Code (DEC) Description
−1 Execution error
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24 Tag
24.1 Overview

“Tag editing” is a function used to give names (tags) to addresses of PLC memory or internal memory 
($u, $L, etc.) and use these names for screen data creation.
There are two methods for tag designation: address designation and variable designation.

Address Designation

Give a tag name to the address of PLC memory or internal memory, and set the memory address for 
the part or item with the given name.

D100
D101

556
600

M0M1

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

ON Hz

s

Tag

Alarm 1
Frequency

Acceleration 
time

M0

D100

D101

Address

Alarm 1

Example: On the [Tag Database Edit] window, register PLC memory addresses “M0”, “D100” and 
“D101” with names “Alarm 1”, “Frequency” and “Acceleration Time”, respectively.

[Tag Database Edit] window

Set memory addresses for parts by using tags.
Lamp memory: “Alarm 1” (M0)
Numerical data memory: “Frequency” (D100), “Acceleration time” (D101)

Frequency
Acceleration 
time

Tag

Alarm 1 Frequency

Acceleration time
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Variable Designation

Give a tag name to the variable in the V8 variable area, and set the variable in memory for parts and 
items with given names.  This is useful for specifying a working area of the V8 internal processing, 
such as macro, password, etc.

Array

The array format can be specified for the tag.  If there are multiple data of the same type, they can be 
registered at one time.  It makes your data management or maintenance easier.
For more information, refer to “Array” (page 24-11).

What is “variable”?
“Variable” is an area that stores data temporarily.  This area is used for temporarily storing 
data, such as a default value, calculated value.
The capacity of the variable area is 4096 words for single word and double word, 
respectively.  For more information, refer to ““Tag” Variable Capacity” (page 24-19).

(Example) Variable area in the V8

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

V8

SRAM

$L
$LD

DRAM

$u/$s/$T/$P

“Tag” variable

Use this variable area.  (No address 
is allocated.  The variable is 
identified by a name given freely).
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24.2 Tag Editing
Structure of [Tag Database Edit] Window

The [Tag Database Edit] window consists of 256 groups, and 256 lines can registered per one group.  
Accordingly, a maximum of 65,536 lines can be registered in total.

* The capacity of the variable area is 4096 words for single word and double word, 
respectively.
For more information, refer to ““Tag” Variable Capacity” (page 24-19).

Displaying the [Tag Database Edit] Window

Click [Registration Item] → [Tag Database].
Specify the group number and click [OK].  The [Tag Database Edit] window is displayed.

No.  256

No.  65280

No.  0

No.255

No.  1

No.  512

[Tag Database Edit] window

Acceleration time, word address

Frequency, word address

Alarm, bit address

Group No. 0

Group No. 1

Group No. 255

Group No. 2

Group number range: No. 0 - Group number range: No. 0 - 255
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Configuration of the [Tag Database Edit] Window

ID Line number

Tag Specify a tag name.
Max. 70 one-byte alphanumeric characters* (Two-byte characters allowed.  
Sensitive to two-byte and one-byte characters, or upper case and lower case 
characters.)

Type
Address

Specify the data type for the tag.

Array Check this box when using the array format.
For more information, refer to “Array” (page 24-11).

Number of 
Elements

When [ Array] is checked, specify the number of elements to be used for the 
array.
Max. 4096

Comment Specify the detail information as necessary.
Max. 130 one-byte alphanumeric characters.  (Two-byte characters allowed.  
Sensitive to two-byte and one-byte characters, or upper case and lower case 
alphabetic characters.)

Address Type Data Type

PLC Memory
Internal Memory
Memory Card
I/O Memory
Common Memory

Bit Address 1-bit data

Word Address 1-word data

Double-Word Address Double-Word Data

Actual Number 
Address

32-bit single precision 
real number format

Variable Bit Variable 1-bit data

Integer Variable 1-word data

Double-Word Integer 
Variable

Double-Word Data

Actual Number 
Variable

32-bit single prevision 
real number format
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* If an unavailable character is used, the following message box will appear.  In such a 
case, reset the name again.

Registering a Tag

This section describes the procedure for registering “D100” and “D101” (word addresses) and “M0” (bit 
address) of PLC1 memory by using tags.

1. Enter a desired name in the [Tag] field.

2. Click the [Type] field, and select a data type from the list.

3. If you want to register the same type of data at one time, use the array format.
Check the box for [Array] and specify the number for the [Number of Elements] field.

For more information on [Array], refer to “Array” (page 24-11).
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4. Click the [Address] field and select a memory address to be registered for the tag.

5. Click the [Comment] field and enter a comment as desired.

6. To register a new address using a tag, select another ID number and repeat steps 1. to 5.

The necessary settings have been completed.
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Editing in a CSV File

The [Tag Database Edit] window data registered with the screen data in the V-SFT software can be 
exported to a CSV-format file.  The CSV-format file can be edited on the computer and then imported 
to the screen data.

* CSV-format files created in PLC software can also be imported to screen data.
For more information, refer to “Import of Tags” (page 24-21).

CSV File Editing

In the example below, changes are made to the data registered with ID No. 0 in the [Tag Database 
Edit] window, by using Excel.

Tag: Frequency_setup → Run_status 
Address: D100 → D105
Comment: Inverter Port No. 1 → ON: RUN, OFF: STOP

1. Open the [Tag Database Edit] window.  Click [File] → [Tag Export].

2. The [Save As] dialog is displayed.
Enter an arbitrary file name in the dialog.  In the [Save as type] field, select [Csv File (*.csv)].  
Click [Save].  

3. The above step completes the export from the [Tag Database Edit] window to a CSV file.  Open 
the CSV file in Excel.
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4. Make changes to the data of ID No. 0 and save the CSV file.

* For more information on a CSV file, refer to “CSV File Configuration” (page 24-9).

5. Open the [Tag Database Edit] window.  Click [File] → [Tag Import].

6. The [Open] dialog is displayed.
Select the CSV file saved in step 4.  In the [Files of type] field, select [Csv File (*csv)].  
Click [Open].

The data of ID No. 0 is overwritten.
The necessary settings have been completed.

* IDs that are already with tags are overwritten with the imported data.
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CSV File Configuration

A CSV file opened in Excel is formatted as shown below.

* Do not change the header information enclosed in the red dotted frame.  Otherwise, the 
data in the CSV file cannot be imported to the screen data normally.

No. Item Description Remarks

1 ID 0 - 65535
* Numbers within square brackets [ ]: Element No. 0 - 

4095 with the use of arrays

1-byte

2 Tag*1 Within 70 one-byte characters 1-byte / 
2-byte

3 Type 0: Bit address
1: Word address
2: Double-word address
3: Bit variable
4: Integer variable
5: Double-word integer variable
6: Real number variable
7: Real number address

1-byte

4 Array Setting 0: Not used
1: Used

1-byte

5 No. of 
Elements

Setting in this column is enabled only when “1” is specified for 
[Array Setting].
1 - 4096

1-byte

[Tag Database Edit] data exported to a CSV file

The number of elements of an array must be the 
same as the number shown in [No. of Elements].

1 2 3 5 6 74
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*1 Data including unusable characters cannot be imported.
For more information on characters to be used, refer to “Configuration of the [Tag Database Edit] 
Window” (page 24-4).

6 Address PLC memory 1-byte

Example: PLC1 MITSUBISHI ELECTRIC D100
• 1:1 connection

Word designation: PLC1 [D00100]
Bit designation: PLC1 [D00100-00]

• 1:n connection (port No. 0)
Word designation: PLC1 [0: D00100]
Bit designation: PLC1 [0: D00100-00]

Internal memory: $u/$T/$s/$L/$LD

Example: Internal memory $u100
Word designation: $u00100
Bit designation: $u00100-00

Memory card memory

Example: File No. 0, Record No. 0, and Data No. 100
Word designation: [0:0] #0100
Bit designation: [0:0] #0100-00

I/O memory

Example: PLC1 Fuji Electric T-link TI00
Word designation: PLC1 [TI00]
Bit designation: PLC1 [TI00-00]

The following settings are enabled only when the 
general-purpose FL-Net is designated as PLC1.
Common memory: CW/CB/MW/MB/VW

Example:
• Specifying CW100

Word designation: PLC1 [CW0100]
Bit designation: PLC1 [CW0100-00]

• Specifying MW100 (port No. 1)
Word designation: PLC1 [1: MW0100]
Bit designation: PLC1 [1: MW0100-00]

7 Comment Within 130 one-byte characters 1-byte / 
2-byte

No. Item Description Remarks

Device + memory address
PLC No. 1 - 8

PLCx[xxxxx]

Device + memory address
xxxxx

Record No. 0 - 4095

[xx:xxxx]#xxxx

File No. 0 - 15

Data No. 0 - 4096

Device + memory address
PLC No. 1 - 8

PLCx[xxxxx]

Device + memory address
PLC No. 1 - 8

PLCx[xxxxx]
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Array

Tags can be registered in the array format.
For example, when allocating 10 variables which have the same properties (DEC, 1 word) without 
using the array format, 10 variables must be registered individually as shown below.

When registering one tag with 10 elements in the array format, you can secure 10 variables in the 
same way as shown above.  If there are multiple data of the same type, you can use the array format 
to make settings easier.

In the case of the bit variable:

Data 1

Data 2

Data 3

Data 10

Dec

Dec

Dec

Dec

ID0
ID1

ID9

Data 1
Data 2

Data 10

1 word

1 word

1 word

1 word

[Tag Database Edit] window Data  10 pcs.

ID0 Data [10] 
Data [0]
Data [1]
Data [2]

Data [9]

“Data [2]” is 
automatically 
assigned here.

[Tag Database Edit] window Data [10] = DEC, 1 word for each

Error 1

Error 2

Error 3

Error 4

Error 5

ID0 Error [5] 
[0] [1] [4] 

[Tag Database Edit] window Error (5) = 1 bit for each

“Error [2]” is automatically 
assigned here.

Array
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Setting Procedure

This section describes the procedure to specify “5” for [Number of Elements] for the PLC1 memory 
“D200”, and “3” for the integer variable in the array format.

1. Check the box for [Array].

2. Specify the number of elements for [Number of Elements].

3. Enter a comment for each element as desired.
Move the cursor to the corresponding ID number, click [Edit] → [Detail Setting], and enter a 
comment in the [Comment] field on the [Detail Setting] dialog.

• A maximum of 4096 elements can be set.
• If the bit variable is specified in the array format, 1 word is occupied in the variable 

area even if “16” or smaller number is specified for the number of elements.
For more information, refer to ““Tag” Variable Capacity” (page 24-19).

The [Detail Setting] dialog can also be displayed by the procedure shown below.
• Right-click the mouse and click [Detail Setting].
• Double-click the ID number.

D200-D204 are used.

3 words are occupied 
in the variable area.

Total [0] (= D200)
Total [1] (= D201)
Total [2] (= D202)
Total [3] (= D203)
Total [4] (= D204)
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24.3 How to Use the Tag
Setting Procedure

Select a tag for [Memory] on the item dialog of each part.

• Word designation:

• Bit designation: Tag-xx (xx: 00 - 15, 00 - 31)

• Array format: Tag [n] (n: number of elements for array)

Notes

No tag can be specified for the following items.
• Screen setting (transfer source PLC memory, transfer target PLC memory)
• Device memory map (transfer source memory, transfer target memory 1, transfer target memory 2, 

control memory)
• Modbus memory table
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24.4 Tag Status List
You can search the whole screen data and bring up the tag status list.  You can also check the total 
word count registered on the [Tag Database Edit] window.

Displaying the [Tag Use] Window

1. Click [Tool] → [Tag Use].

2. The [Tag Use] dialog is displayed.
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[Tag Use] Dialog

[Status of Use] Tab Window

1 The display is updated.  Specify the search criteria for “3.” and click 
this icon.

2 By pressing this icon, the [Tag Database Edit] window is displayed 
when the cursor is placed in the status list (4.), and the corresponding 
screen or item dialog is displayed when the cursor is placed in the 
[Used Point] field.

3 Search criteria Specify criteria for searching the status of tags on the screen data.

4 Status list Displays the search result.

5 Used Point Displays the position where the tag selected in the status list (4.) is 
used.

6 Total Word Count of 
the Tag Variables

Displays the status of variable area.
Max. 4096 words for single and double words

* If the occupied word count exceeds the maximum value, the 
value is displayed in red.  Set a value smaller than the 
maximum.  For more information, refer to ““Tag” Variable 
Capacity” (page 24-19).

1. 2.

3.

4.

5.

6.
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[Search] Tab Window

1 Specify the search range for the screen data.  Items with check marks 
are set as a search target.

2 The display is updated.  After entering a name for [Tag Name], click 
this icon.

3 Displays the screen or the item dialog of the tag selected in the status 
list (6.).

4

Tag Name Enter a tag name to search.  If this field is left blank, a search will be 
performed for all tags used on the screen data.

* Discriminating between one-byte and two-byte characters, or 
uppercase and lowercase characters

5

Matched 
completely.

Checked:
Searches for a tag name exactly the same as the one specified 
for [Tag Name].

Unchecked:
Searches for all tags including characters specified for [Tag 
Name].

6 Status list Displays the search result.

1. 2.

4.

3.

5.

6.

[Search Item Setting] dialog (1.)
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Operation

To Check the Status of Use:

This section describes the procedure to search for tags used on the screen data.

1. Select the [Status of Use] tab window on the [Tag Use] dialog.

2. Select [In use] for [Status of Use], [All] for [Tag Data Type] and [All] for [Memory Type], and click 
the [Update] icon.

3. The list of the search result is displayed.

4. When “2” under [ID] is selected, the position where the tag is used is displayed in the [Used 
Position] field.

You can jump to the position where the tag is used by double-clicking the item shown in 
the [Used Position] field or clicking [VIEW] in the right-click menu.
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To Search for the Position Where the Tag is Used:

This section describes the procedure to search for the tag “Alarm 1” used on the screen data.

1. Select the [Search] tab window on the [Tag Use] dialog.

2. Enter “Alarm” into [Tag Name] and click the [Update] icon.

3. All tags that include “Alarm” are displayed as a search result.

You can jump to the position where the tag is used by double-clicking the item shown in 
the [Used Position] field or clicking [VIEW] in the right-click menu.
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24.5 “Tag” Variable Capacity
When “tag” variables are registered on the [Tag Database Edit] window, the variable area inside the 
MONITOUCH is used.
Since the capacity of the variable area is limited, check the word count currently used, and be careful 
not to exceed the capacity.

Capacity of Variable Area

* If the bit variable is specified in the array format, 1 word is occupied in the variable area 
even if “16” or smaller number is specified for the number of elements.

Variable Type Data Type Capacity

Bit Variable * 1-bit data
4096 words

Integer Variable 1-word data

Double-Word Integer Variable Double-word data
4096 wordsReal Number Variable 32-bit single prevision real number 

format

= 4096

= 4096

Bit Variable

Integer Variable

Double-Word Integer 
Variable

Real Number Variable

Variable Area

words

words
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Checking the Capacity of “Tag” Variable

You can check the capacity when the “tag” variables are registered as shown below.

In this case, 6 words of word area and 4 words of double-word area are occupied.

* The value is indicated in red when it exceeds the maximum value of 4096.  If the tag 
indicated in red is used on the screen, the message “Error: 46” appears and you cannot 
run MONITOUCH.  Set a value smaller than the maximum.

Integer variable “3” + bit variable “3”

Double-word integer variable in the array 
format “2”
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24.6 Import of Tags
Tags or system labels registered in PLC software can be imported to V-SFT and used as tags.

Manufacturers of Applicable PLCs

• MITSUBISHI ELECTRIC → page 24-21
• Siemens

Model S7 → page 24-26
Model S7-200 → page 24-31

MITSUBISHI ELECTRIC

Global labels registered in Simple Project (with labels) or Structured Project in MITSUBISHI 
ELECTRIC’s software GX Works2 can be registered as system labels in the software MELSOFT 
Navigator.  These system labels can be exported in CSV file format.  When such CSV files are 
imported to V-SFT, system labels in the files can be used as tags in V-SFT.

* For PLC software usage, refer to the manual for the PLC.

Applicable PLC Models

* Import to V-SFT is allowed, provided that [PLC1] and [Connection Mode: 1:1] are set in the 
[Device Connection Setting] dialog ([System Setting] → [Device Connection Setting]).  
Import is not possible for [PLC2] and after.

When whole program compiling is executed in GX Works2, devices registered with 
global labels will be reassigned to global labels.  If there are global labels with no PLC 
memory address assigned, devices of such labels will be assigned according to the 
automatic assignment device setting made in GX Works2.  
Therefore, assigning PLC memory addresses to global labels is recommended.

Maker Model

MITSUBISHI ELECTRIC QnH (Q) series link

QnH (Q) series CPU

QnU series CPU

Q00J/00/01 CPU

QnH (Q) series (Ethernet)

QnH (Q) series (Ethernet ASCII)

QnU series (built-in Ethernet)

QnH (Q) series (CC-LINK)

L series link

L series (built-in Ethernet)

FX3U/3UC/3G series CPU

FX3U/3UC/3G series link (A protocol)
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Procedure

This section describes the steps to import the [Device A] data registered in the system label list to 
screen data.

* This table lists the types of data that can be imported to V-SFT and the data types after 
import.

*1 No other types of data can be imported to V-SFT.
*2 With the PLC model QnH (Q) series (CC-LINK), data of the type: Retentive Timer cannot be 

imported.

MITSUBISHI ELECTRIC System Label
Data Type for Tags in V-SFT

Data Type  *1 Data Length

Bit 1 bit Bit address

Word [Signed] 1 word Word address

Word [Unsigned] 1 word

Timer 1 word

Counter 1 word

Retentive Timer*2 1 word

Double Word [Signed] 2 words Double-word address

Double Word [Unsigned] 2 words

Time 2 words

FLOAT [Single Precision] 2 words Real number address

Structure
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1. Start MELSOFT Navigator.

2. Right-click [DeviceA] under [System Label List].  Click [System Label List] → [Export].

3. The message dialog is displayed.  Click the [Yes] button.

4. The [Select Export Destination Folder] dialog is displayed.
Select “CSV” for [Save as type] and click [Save].
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5. Open the destination folder.  Check that the CSV file under the same name in the system label list 
is created.  (Example: DeviceA.csv)

* The data in the dotted frame specifies the structure. A structure name with a period is 
added to the top of each label name.

6. Start V-SFT and open screen data.
Click [Registration Item] → [Tag Database].  The [Tag Database Edit] window opens.  

7. Click [File] → [Tag Import].

8. The [Open] dialog is displayed.
Select “MELSOFT Navigator File (*.csv)” for [Files of type].
Select the desired CSV file name (e.g., “DeviceA.csv”) and click [Open].

Structure.Elements_1

Structure name

Period

Label name
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The contents in the file are registered as tags in the [Tag Database Edit] window.  Types ([Type]) 
are specified for individual addresses. 
The import procedure is complete.

* Periods “.” cannot be used with tags.  If any system label exported from MELSOFT 
Navigator includes a period, the period is converted to an underscore “_”.

Notes

Note the following for importing CSV files.
• If a file to be imported includes a tag that is already registered in V-SFT, the tag in V-SFT is 

overwritten.  Unregistered tags are registered with ID numbers in blank rows (in the [Tag Database 
Edit] window).

• Only memory addresses available with V8 can be imported to V-SFT.  For more information, refer 
to the V8 Series Connection Manual.
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Siemens

Applicable PLC Models

* Tags can be imported, provided that [PLC1] and [Connection Mode: 1:1] are set in the 
[Device Connection Setting] dialog ([System Setting] → [Device Connection Setting]).  Tag 
import is not possible for [PLC2] and after.  

Model S7

When a project file (*.s7p) created in Siemens software “SIMATIC Manager (version 5.5 or 5.4)” is 
imported to V-SFT, names registered in data blocks “DBx” can be used as tags in V-SFT. 

* For PLC software usage, refer to the manual for the PLC.

Maker Model Page

Siemens S7 page 24-26

S7-300/400 MPI

S7-300/400 (Ethernet ISOTCP)

S7-300/400 (Ethernet TCP/IP PG protocol)

S7 PROFIBUS-DP

S7-200 PPI page 24-31
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Procedure
This section describes the steps to import a project file (e.g., “test.s7p”), in which data blocks DB1 and 
DB2 are registered, to screen data.  

* This table lists the types of data that can be imported to V-SFT and also the data types after 
import.

* No other types of data can be imported to V-SFT.
Data types BYTE and CHAR (bytes) are imported as word addresses.
If any odd bytes are registered ([Address]) in PLC software, the data cannot be imported 
to V-SFT.

Siemens “DBxx”
Data Type for Tags in V-SFT

Data Type Data Length

BOOL 1 bit Bit address

BYTE* 1 byte Word address

CHAR* 1 byte

WORD 1 word

S5TIME 1 word

DATE 1 word

INT 1 word

DWORD 2 words Double-word address

DINT 2 words

TIME 2 words

TIME_OF_DAY 2 words

REAL 2 words Real number address

Double-
click.
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1. Start V-SFT and open screen data.
Click [Registration Item] → [Tag Database].  The [Tag Database Edit] window opens.  

2. Click [File] → [Tag Import].

3. The [Open] dialog is displayed.
Specify “Siemens S7 Project File (*.s7p)” for [Files of type].
Select the desired project file (e.g., “test.s7p”) and click [Open].

4. The [Tag List] dialog is displayed.  Check the tags to import.
• [Data Block List]: Displayed block by block (data block “DBx”)

• [Tag List]: All tags displayed

Checked: To be imported
Unchecked: Not to be imported 

Checked: To be imported 
Unchecked: Not to be imported



24    Tag

24-29

24

When specifying further search criteria, go to [Filter setting].  Only tags that match the specified 
data type, data block name, or tag name will be displayed in the [Tag List] dialog.

5. Click [OK].

Filtering out “a1”
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The contents in the file are registered as tags in the [Tag Database Edit] window.  Types ([Type]) 
are specified for individual addresses. 
The import procedure is complete.

*1 A tag name with an underscore “_” registered in a SIMATIC Manager data block (DBxx) is 
added to the top of each tag in V-SFT.

*2 No period “.” can be used with tags.  If a period is added to a tag, it is converted to an 
underscore “_”.

Notes
Note the following for importing CSV files.

• File import is impossible if the OS of the computer is Windows 98SE, Windows NT 4.0, or 
Windows Me.

• If a file to be imported includes a tag that is already registered in V-SFT, the tag in V-SFT is 
overwritten.  Unregistered tags are registered with ID numbers in blank rows (in the [Tag Database 
Edit] window).

• Memory addresses unavailable with V8 cannot be imported.
For more information on memory addresses available with V8, refer to the V8 Series Connection 
Manual.  Data types BYTE and CHAR (bytes) are imported as word addresses.  If any odd bytes 
are registered ([Address]) in PLC software, the data cannot be imported to V-SFT.

DB1

Example: Only DB1 imported 

a1 _  DB_VAR

Tag name with “_”

Name
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Model S7-200

When a CSV file copied from the Symbol Table in the software “SIMATIC STEP 7-Micro/WIN” for 
Siemens S7-200 is imported to V-SFT, the contents in the file can be used as tags.

* For PLC software usage, refer to the manual for the PLC.

Procedure
1. Start the software “SIMATIC STEP 7-Micro/WIN” for Siemens S7-200.
2. Open [Symbol Table].

* Only memory addresses available with V8 can be imported to V-SFT.  For more 
information, refer to the V8 Series Connection Manual.  Double-word addresses are 
imported as one-word addresses.  
Addresses: VD → VW, ID → IW, QD → QW, MD → MW, SMD → SMW, SD → SW 

3. Select all columns under [Symbol], [Address], and [Comment].  Right-click and select [Copy] from 
the right-click menu.  

Select all.
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4. Start Excel.  Paste the copied data to the worksheet from cell A1.

* The first row on the Excel sheet corresponds to tag ID No. 0.  The data on worksheets 
will be imported from the first row to the [Tag Database Edit] window (65536 maximum). 

5. Click [File] → [Save As].  The [Save As] dialog is displayed.

6. Enter a file name.  Select “CSV” for [Save as type] and click [Save].

7. Open screen data.
Click [Registration Item] → [Tag Database].  The [Tag Database Edit] window opens.  

Tags Addresses Comments

[Tag Database Edit] in V-SFT
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8. Click [File] → [Tag Import].

9. The [Open] dialog is displayed.
Select the CSV file saved in step 6.  Specify “Siemens S7-200 File (*.csv)” for [Files of type] and 
click [Open].  

The contents in the file are registered as tags in the [Tag Database Edit] window.  Types ([Type]) 
are specified for individual addresses. 
The import procedure is complete.

Notes
Note the following for importing CSV files.

• IDs that already have tags are overwritten with the imported data.
• Memory addresses unavailable with V8 cannot be imported.  If such a memory address is 

included, the row is displayed as a blank space.
For more information on memory addresses available with V8, refer to the V8 Series Connection 
Manual.  Double-word addresses are imported as one-word addresses.
Addresses: VD → VW, ID → IW, QD → QW, MD → MW, SMD→ SMW, SD → SW 
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25 Edit Tool
25.1 Jump to the Target Screen

Overview

When [Function: Screen] is specified for a switch you create, you need to open the target screen of the 
switch in the editor software for confirmation.  
With the jump function discussed below, you can open the target screen easily using the icon in the 
[Switch] dialog or on the toolbar.  Moreover, such a switch is marked with the screen change symbol 
for you to recognize it at a glance.

Procedure

This section describes the procedure for using a switch placed on screen No. 1 to bring up its target 
screen No. 5.

Step 1 Select the appropriate switch ([Function: Screen]).

* Display of the screen change symbol
Click [View] → [Display Environment].  
In the [Display] tab window, click 
[ Switch: Display the screen switch-
over symbol]. 
As a result, only the [Function: Screen] 
switches are marked with the symbol.  

Screen change symbol
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Step 2 Click the icon to jump to the target screen.

Step 3 Screen No. 5 is opened.
(Screen No. 1 is also still open.)

or

[Switch] dialog

Edit toolbar

* If the toolbar does not include the 
icon, go to [Tool] → [Customize] → 
[Edit] and add the icon.  
For how to add an icon, refer to the V8 
Series Operation Manual.
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25.2 Refined Search Filter for Project List-view Window
Overview

On the project list-view window, the displayed items can be narrowed down by specifying a comment 
as a filter.
Since partial match retrieval is possible, the desired item can easily be retrieved even if a large number 
of items are registered.

Target Items

• Screen
• Macro block
• Graphic library
• Overlap library
• Screen library
• Data block
• Pattern
• Data sheet

Project list-view window

Comment

Example: When “Japan” is specified:
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Comments can be set as shown below.
• Screen*, graphic library, overlap library, screen library, data block, pattern and data 

sheet
Setting position: [View] → [Screen List]

* A comment can also be set on the [Main] tab window displayed by selecting 
[Screen Setting] → [Screen Setting].

• Macro block
Setting position: [Edit] → [Edit Comment]

For screen

Comment
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Procedure

This section describes the procedure for narrowing down the displayed part items to those which 
include “Japan” as their comments.

* The project list-view window can be displayed by clicking [View] → [View] → [Project View].  
For more information, refer to the V8 Series Operation Manual.

Step 1 Open the [Screen] tab window on the project list-view window.
The number of registered screens and the relevant comments can be viewed in a tree-
structured list.

Project list-view window
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Step 2 Enter “Japan” in the search field and press the [Narrow down items in listview] button.

* A maximum of 16 one-byte characters (8 two-byte characters) can be set.  
Characters are distinguished between one-byte and two-byte.
If no word is specified in the search field, part items with no comment registered 
are retrieved.

Step 3 Parts to which the refined search filter is applied* are displayed in red, and part items are 
narrowed down to those which include “Japan” as their comments.

* To display all the registered part items, click the [+] mark at the left.

Search field *

Japan

[Narrow down items in listview] button
Raised: Not used
Depressed: Refined search valid

Target item
With specified comment: Red
Without specified comment: Black
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25.3 Memory Batch Change
Overview

As for memory addresses assigned to a screen you are editing, they are changeable to different 
memory locations in a batch.
In addition to [Memory Designation], the option [Memory Count Designation] is now available to 
designate memory locations.

Procedure

The procedure is explained with an example shown below.

 

Numerical data display

PLC1 memory
D15000 - D15016 →

Internal memory
$u15000 - $u15016 

Step 1 Click [Tool] → [Change Memory] → [Batch Change].  
The [Batch Change Memory] dialog is displayed.
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Step 2 Check [No. 0] and click the [Detail Setting] button.

* For more information on the [Option] button, refer to the V8 Series Operation 
Manual.

Step 3 The [Memory Setting] dialog is displayed.  

Step 4 Check either [Memory Designation] or [Memory Count Designation] as desired.  Specify 
memory locations in the following fields of [Before Change] and [After Change].

• [Memory Designation] checked: 

• [Memory Count Designation] checked: 

Step 5 Click [OK].

The [End Memory] location is 
displayed according to the value 
of [Memory Count] you set.
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Step 6 Review the memory locations of [Before Change] and [After Change] at No. 0.  Click the 
[Change] button.

Step 7 The message dialog is displayed.  Click the [Yes] button.

Step 8 According your change, memory addresses $u15000 - $u15016 are now used on the 
screen.
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25.4 Selection Order Batch Change
Overview

When numerical data or character display parts in the entry mode are placed on the screen, the cursor 
will be moved to these parts according to the selection order numbers ([Order INC]) allocated to the 
parts.  If these display parts are the same in [Order INC], the cursor movement order depends on the 
sequence of part placement during screen creation.
With the function of selection order batch change explained in this section, the selection orders of 
display parts can be changed in a batch according to the order of coordinates (or placement).  
Selection order batch change is also possible according to the order of mouse clicking.

* [Order INC] can be set to the order of placement.  For more information on the procedure, 
refer to “Automatic Allocation: Placement Order” (page 25-16).

1
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4

5

2
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1
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4

6
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1234

<0>

<1>

<2>

<3>

<4>

1234

1234

1234

1234
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<0>

<0>

<0>

<0>

<0>

1234

1234

1234

1234

1234

<0>

<1>

<2>

<3>

<4>

(0,0)

(0,20)

(0,40)

(0,60)

(0,80)

Click the numerical 
data display parts in 
order.

Order INC

• Order of coordinates “↓” • Order specified with mouse

Batch change 
according to 
the order of 
coordinates

Order INC
Batch change 
according to the 
order of clicking

Because all display parts are 
provided with “0” for [Order 
INC], the cursor is moved to 
the parts according to the 
order of their placement on the 
screen.  

The cursor is moved according to the 
numbers for [Order INC].

Example: Change the cursor movement out of order to descending order.

Selection order batch 
change

Placement 
order

Order 
INC

Placement 
order

Order 
INC
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Applicable Items

• Numerical data display (Function: Entry Target) 
• Character display (Function: Entry Target) 

Setting

Location for Setting

Click [Tool] → [Change Order INC] → [Batch Change] or [Selected Item].  
If there is no numerical data or character display part ([Function: Entry Target]), the message “Target 
item is not registered.” appears. 

* To see the selection order currently set for the display parts, click [View] → [Display 
Environment] → [Display].  In the [Display] tab window, check [  Display Order INC].  
Order numbers are displayed in yellow at the bottom-left corners of the individual display 
parts.

Order INC
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Setting Items
[Change Order INC] dialog

1. Automatic Allocation/
Specify with Mouse

Automatic Allocation
Check this option when changing the selection order numbers 
in a batch according to [Direction for Allocation] explained in “5.”

Specify with Mouse
Check this option when changing the selection order numbers 
according to the order in which you click the display parts.
The window for order setting is to be displayed for [Specify with 
Mouse].  In the window, pointing a numerical data or character 
display part ([Function: Entry Target]) with a mouse changes the 
cursor pointer to a pointing finger icon.

2. Base/Overlap Base
Display parts placed on the screen being edited are targeted for 
selection order change.

Overlap
Display parts placed on the overlap of the checked ID are 
targeted for selection order change.

3. Target Item
Num. Display 
Char. Display

Check your desired option.

4. Start No. Specify the first number of the selection order.  Order numbers 
starting from the number specified here will be allocated.

1.

2.

3.

4.

5.

Order INC

Pointing 
finger icon 



25.4    Selection Order Batch Change

25-13

25

5. Direction for Allocation This setting is valid when [Automatic Allocation] (“1”) is selected.

Coordinate Order
Selection order is determined based on the top-left coordinates 
of the display parts.  You may select a different direction through 
the [Change] button.

Placement Order
Selection order is determined based on the order in which 
display parts were placed on the screen.  

1234
<1>

1234
<0>

1234
<0>

1234
<0>

1234
<0>

1234
<0>

1234
<0>

(10,10) (50,10) (90,10)

(10,50) (50,50) (90,50)

1234
<2>

1234
<3>

1234
<4>

1234
<5>

1234
<0>

(10,10) (50,10) (90,10)

(10,50) (50,50) (90,50)

Top-left x and y coordinates of the display part

Before change After change
Example:  Start No. 0, Direction → (to the right) 
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Order Change Procedure
Automatic Allocation: Coordinate Order
The procedure is explained with an example shown below.

• Target Item: Num. Display 
• Direction for Allocation: Downward “↓”
• Start No.: 5 

Step 1 Select five numerical data display parts for selection order change.

Step 2 Click [Tool] → [Change Order INC].  

Step 3 Click [Selected Item].

Step 4 The [Change Order INC] dialog is displayed.
Set as shown below:

Order INC
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Step 5 Select [Coordinate Order] for [Direction for Allocation].  
Go to the [Direction Select] dialog through the [Change] button.  Select the downward 
direction “↓”.

Step 6 Review the settings made in the previous steps, and click [OK].

Step 7 Order numbers are allocated to the display parts based on the order of coordinates. 

The necessary settings have been completed.
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Automatic Allocation: Placement Order
The procedure is explained with an example shown below.

• Target Item: Num. Display 
• Start No.: 5 

Step 1 Select five numerical data display parts for selection order change.

Step 2 Click [Tool] → [Change Order INC].  

Step 3 Click [Selected Item].

Step 4 The [Change Order INC] dialog is displayed.
Set as shown below:

Placement order

1

2

3

4

5

Order INC
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Step 5 Select [Placement Order] for [Direction for Allocation].  

Step 6 Review the settings made in the previous steps, and click [OK].

Step 7 Order numbers are allocated to the display parts based on the order of placement.

The necessary settings have been completed.
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Specify with Mouse
The procedure is explained with an example shown below.

• Target Item: Num. Display 
• Start No.: 5 

Step 1 Select five numerical data display parts for selection order change.

Step 2 Click [Tool] → [Change Order INC].  

Step 3 Click [Selected Item].

Step 4 The [Change Order INC] dialog is displayed.
Set as shown below:

Step 5 Review the settings made in the previous step, and click [OK].

Step 6 The message dialog is displayed.
Click [OK].

Order INC
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Step 7 The following window is displayed.*
Selection order numbers appear at the top-left corners of the numerical data display parts 
([Function: Entry Target]).  Click the numerical data display parts one by one to set their 
order numbers.  Once an order number has been set at the top-left corner of a data 
display part, the number turns yellow.

* This window is provided solely for setting selection order numbers of display 
parts.  To exit, select [Finish] or [Cancel] from the right-click menu.

Step 8 When changing the start number of selection order, select [Change Start No.] from the 
right-click menu.  Select your desired number for [Start No.] and click [OK].
Now order numbers starting from the newly specified number are allocated.*

* Even if the top-left numbers are confirmed (in yellow), changing the [Start No.] 
restores the numbers starting from [Star No.] to the unconfirmed status (in 
gray).
Example:  [Start No. 6]

When entirely re-setting the selection order numbers, click [Cancel] from the 
right-click menu.  Perform the previous steps again from step 1.

Click

Order INC
Confirmed: In yellow 
Unconfirmed: In gray 

Selection order Nos. 6 to 9 are 
restored to the status before 
change, showing “0” in gray.
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Step 9 When the selection order setting you have made is OK, click [Finish] from the right-click 
menu.
(To cancel the changes to the selection order, click [Cancel].)

Step 10 Order numbers are allocated to the display parts according to the settings you made.

The necessary settings have been completed.
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25.5 Cross-reference and Macro Command Search
Overview

• Cross-reference
In a case where there is an attempt to edit the screen data created by another operator, it is 
important to first understand the configuration of the screen data.
For dealing with screen data including macro blocks, for example, it would be time-consuming to 
find where these macro blocks exist one by one because macro blocks may be set in areas other 
than those on the screen.
Cross-referencing, however, will make it easy to find where the target macro block number is set 
and to call up the area to the screen.  

• Macro command search
Search for specified macro commands is also possible.  The ability to search for multiple macro 
commands at a time will save time for editing.

Setting

Location for Setting
Cross-reference
Click [Tool] → [Cross-reference].
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Macro command search
Click [Tool] → [Search and Replacement] → [Macro Command Search].

Setting Items
[Search Item Setting] dialog 

1. Function Select [Cross-reference]
The screen data is searched for the item specified as [Item to 
search for] and the result is displayed in a list form.

[Search]
The screen data is searched for the specified macro command 
and the result is displayed in a list form.

[Function Select: Search]

3.

2.

1.

[Function Select: Cross-reference] 

1.

Search item list
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Search result list: [Cross-reference] view or [Macro Command Search] view

2. Item to search for/Macro 
command to search for

• [Function Select: Cross-reference]
Specify the item and its range being searched. 

• Macro block
• Screen
• Overlap library
• Screen library

• [Function Select: Search]
Specify the macro command(s) you wish to search for.

3. Search Area Setting The areas you specified will be searched for target items.

1. Display Only Top When an item targeted for search is used in multiple areas, only 
the first area is displayed.

2. Search Item Setting The [Search Item Setting] dialog is displayed.  Another search 
may be performed through the icon.

3. Update The display is updated.

4. VIEW JUMP A jump is made to the area where the selected item is included.

5. Item for search The item being searched for is displayed.
Nothing is displayed during search for macro commands.

Add Use this button to add macro command(s) 
selected from the list to the search item list.

Del Use this button to delete macro command(s) 
from the search item list.

1.  2.   3.  4.           5.
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Procedure
Cross-reference
This section explains how to locate the areas where certain macro blocks are used.

Step 1 Click [Tool] → [Cross-reference].  The [Search Item Setting] dialog is displayed.  

Step 2 Select options as [Function Select: Cross-reference] and [Item to search for: Macro Block].

Step 3 Check all the checkboxes under [Search Area Setting], and enter numbers to designate 
the ranges where the search takes place.
Review the settings made, and click [OK].

Example: Searching for the areas where macro block Nos. 0 to 1023 are set

In this example, the 
entire screen data 
will be searched.



25.5    Cross-reference and Macro Command Search

25-25

25

Step 4 The [Cross-reference] view lists the macro block numbers that fit the search criteria and 
the areas where the macro blocks are used.

* When nothing is found, “None / No occurrence.” appears.

Macro block numbers

The macro block numbers shown on 
the left are used in the above areas.



25.5    Cross-reference and Macro Command Search

25-26

Step 5 In the [Cross-reference] view, double-click the desired item, or select an item and click the 
[VIEW JUMP] icon.
A jump is made to the area where the above-selected item is included.  The dialog of the 
item is also displayed.*  

* The item dialog is not displayed when [Prohibit Item View Display by Single Click] is 
selected in the [General] tab window that is displayed by selecting [File] → [Property].

Step 6 The necessary settings have been completed.
For re-search, click the [Search Item Setting] icon and follow steps 2 through 4.

A jump to screen No. 106 is made.  The 
[Interval Timer] dialog is displayed.*

Double-click
or
click the [VIEW JUMP] icon.

Interval timer
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Macro command search
This section explains how to locate the areas where the macro commands “BSET” and “BCLR” (bit 
setting and resetting) are used.

Step 1 Click [Tool] → [Search and Replacement] → [Macro Command Search].  The [Search Item 
Setting] dialog is displayed.  

Step 2 Select [Bit Operation].  In the category of [Bit Operation], select [BCLR] and [BSET] and 
click the [Add] button.
These commands are added to the search item list (up to 20 pcs).

Multiple macro commands are 
selectable.  (logical OR)

• Consecutive selection by 
dragging the mouse

• Random selection by the 
Ctrl key and clicking

Search item list
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Step 3 Check all the checkboxes under [Search Area Setting], and enter numbers to designate 
the ranges where the search takes place.
Review the settings made, and click [OK].

Step 4 The [Macro Command Search] view lists the areas where the macro commands “BSET” 
and “BCLR” are used.  

* When nothing is found, “None / No occurrence.” appears.

In this example, the 
entire screen data 
will be searched.

Macro commands

The macro commands shown on 
the left are used in the above areas.
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Step 5 In the [Macro Command Search] view, double-click the desired item, or select an item and 
click the [VIEW JUMP] icon.
A jump is made to the area where the above-selected item is included.  The dialog of the 
item is also displayed.*  

* The item dialog is not displayed when [Prohibit Item View Display by Single Click] is 
selected in the [General] tab window that is displayed by selecting [File] → [Property].

Step 6 The necessary settings have been completed.
For re-search, click the [Search Item Setting] icon and follow steps 2 through 4.

A jump to overlap library No. 100 is made.  The 
[Switch] dialog is displayed.*

Double-click
or
click the [VIEW JUMP] icon.
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25.6 Text Search and Replacement
Overview

• The search and replacement functions explained in this section enable you to find the location of 
your target text, a switch, or a lamp, and to change the text or its name.  

• Case-sensitive search and condition settings such as a search range designation are allowed for 
the search and replacement functions.  
These functions should help improve your work efficiency and avoid correction omissions.

Setting

Location for Setting

Click [Tool] → [Search and Replacement] → [Text Search and Replacement].
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Setting Items
[Search] and [Replacement] tab windows

1. Text to search for Specify the text to search for.
Within 256 one-byte characters

2. Replaced text Specify the replacement text.
Within 256 one-byte characters

* When replacing text, execute search for the text beforehand.  

3. Language Select a language according to the entry for [Text to search for] and 
[Replaced text].

4. Search This button executes searching for the specified text.

6.2.
1.

3.

5.

7.4.

8.

[Replacement]

[Search]

1.

3.
4.

5.

7.

8.
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5. Icons a. Option This icon opens the [Option Setting] dialog for 
search range and conditions setting.
For more information, refer to [Option Setting] 
dialog (page 25-33).
(The same as “7. [Option]”)

b. Update This icon updates the display.

c. VIEW JUMP This icon makes a jump to the area where the 
selected item exists.

6. Next
Replace
Replace All

These buttons are provided for the replacement function.  The buttons 
become active after a search execution with the [Search] button.

Next
This button executes no replacement and moves the line selection to 
the next line.
(Lines where text has been replaced (cyan colored) are skipped.)

Replace
This button replaces the text in the selected line and then moves the 
line selection to the next line.
Lines where text has been replaced turns cyan. 

Replace All
This button replaces all text in the search result list.
The following dialog is displayed on completion of replacement:

7. Option This button opens the [Option Setting] dialog.
The dialog is available to specify a search range or other conditions.
For more information, refer to [Option Setting] dialog (page 25-33).
(The same as “a.  [Option]”)

8. Search result list A search/replacement result is displayed in a list form.
Any line where text has been replaced turns cyan.
By double-clicking the selected line, a jump is made to the area where 
the selected item exists.
(The same as “5. c.   [VIEW JUMP]”)

a. b. c.
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[Option Setting] dialog

1. Search Range Specify the range of search for text.
[ Check All] selected as default 

2. Target to search for Select a target item to search for.

All
All text registered in the file

Text
Text registered with text in drawing/multi-text, switch/lamp, or message 
edit*

Comment
Text registered with comments on screens or in macro blocks*

Port Name
Text registered with port names in Ethernet network table or Modbus 
extended format

;(Comment) Macro
Text registered with “;” in the macro editor

2.

1.

3.
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* The following details the targets for search.

• [Target to search for: Text] 

• [Target to search for: Comment] 

3. Search condition [ Matched completely]
• Checked

Only text perfectly matching the target is searched for.
• Unchecked

Text perfectly matching or partially matching the target is searched 
for.

[ Match case]
• Checked

Search is executed case-sensitive.
• Unchecked

Search is executed not case-sensitive.

[ Match half/full width forms]
• Checked

Search is executed with distinction between one-byte and two-byte 
characters.

• Unchecked
Search is executed without distinguishing between one-byte or two-
byte characters.

Item Text; multi-text; text on switch/lamp; comment on numerical data/character display; 
text on table data display; [Day-Week Message Setting] for calendar

Macro Quoted (“ ”) text specified with macro commands CHAR or STRING

[Registration Item] 
menu

Text in [Message Edit]/[Comment Edit]; comment in [Tag Database Edit]

[System Setting] 
menu

Comment, table name, and line name in [Write]/[Read]/[Search condition] in [MES 
Setting]; computer name in [Remote Desktop Table Setting]

Relevant to folder 
and file names

Access folder name in [System Setting] → [CF Card Setting]; 
folder name/file name for switch provided with [Function: Folder Select]/
[Function: File Select]; 
file name for sound/JPEG parts; 
JPEG file name in [Screen Setting] → [Screen Setting] → [Others]

Screen, graphic library, overlap library, screen library, data block, pattern, data sheet (expanded data sheet 
included)

Setting location: [View] → [Screen List]

Macro block, device memory map (V8 series), temperature control network/PLC2Way table (V6/V7 series)
Setting location: [Edit] → [Comment] 
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Procedure
Search
This section explains how to locate the areas including the text “switch”.

Step 1 Click [Tool] → [Search and Replacement] → [Text Search and Replacement].  Open the 
[Search] tab window.

Step 2 Key in “switch” in the [Text to search for] field.  Click [Search].

Switch
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Step 3 The search result list shows the areas including the text “switch”.*

* When nothing matching the target is found, the message “None / No occurrence.” 
appears.

Step 4 Move the cursor to your desired line in the list.  Double-click the line or click the [VIEW 
JUMP] icon.  A jump is made to the area where the above-selected item is present.  The 
dialog of the item is also displayed.*  
To narrow down the search, go to step 5.

* The item dialog is not displayed when [Prohibit Item View Display by Single Click] is 
selected in the [General] tab window that is displayed by selecting [File] → [Property].

Screen No. 1

Click or double-
click.
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Step 5 This step and after are explained on the condition that [ Matched completely] is checked 
for [Search condition]. 
Click [Option] (or the [Option] icon) to open the [Option Setting] dialog.
Set the dialog as shown below:

• [Search Range: Check All] checked
• [Target to search for: All]

Step 6 Check [ Matched completely] for [Search condition].  Click [OK]. 

Step 7 The search result list shows only the areas including the text “switch”.

This step completes the search procedure.

Click.
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Replacement
This section explains how to replace all occurences of the text “switch” with “SW”.

Step 1 Click [Tool] → [Search and Replacement] → [Text Search and Replacement].  Open the 
[Replacement] tab window.

Step 2 Key in “switch” in the [Text to search for] field.  Click [Search].

* Search is required before replacement.
When setting search conditions, click [Option] (or the [Option] icon) to open the [Option 
Setting] dialog and make necessary settings.
When you wish to include all options in search conditions, set as the following:

• [Search Range: Check All] checked
• [Target to search for: All]
• [Search condition]: Nothing checked

switch

When search has been conducted 
in the [Search] tab window, the 
same text as that for search is 
copied to this field.
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Step 3 The search result list shows the occurences of the text “switch”.*
Key in “SW” in the [Replaced text] field.

* When nothing matching the target is found, the message “None / No occurrence.” 
appears.

Step 4 Click [Replace] or [Replace All] to execute text replacement.

This step completes the replacement procedure.

Lines turn cyan 
after text 
replacement. 

Screen No. 1 before text replacement Screen No. 1 after text replacement
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25.7 Image File 3D Part Conversion
Overview

• 3D parts using bitmap files can be created easily.
With versions earlier than V-SFT version 5.1.0.0, it is necessary to place a part, select [Style] → 
[Customize] → [  Use Custom Bitmap], and select the required bitmap file.

From V-SFT version 5.1.0.0, a 3D part can be created by pasting a bitmap image from the [Tool] 
menu.  An image can be imported and 3D part creation can be started.

• In the same way as pasting a bitmap image, it is possible to start 3D part creation by copying & 
pasting a bitmap file.

Applicable Items

3D part conversion is available with the following items:

Switch

Lamp

Numerical data display

Character display

Message display

Graph

Statistic graph

Closed area graph

Calendar

Bitmap file

Converted to a lamp part

3D lamp part created
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Setting Procedure

There are two kinds of setting procedures available.

Placing Parts from the [Tool] Menu

Step 1 Select [Tool] → [Paste Image File] → [Parts].
(When [Pattern] is selected, the same image pasting method as before must be used.)

The [Image List] dialog is displayed.

The [Displayed Image] directory indicates the path to the “User” folder under the “Parts” 
folder where bitmap files for 3D parts are stored.
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Step 2 Choose the desired bitmap image.
If the desired bitmap image is not displayed in the list, click [Open] and select the desired 
folder where the bitmap file you need is contained.

Step 3 Click [Select].
The dialog shown below is displayed.

[Delete] button:
from the “User” folder
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Step 4 Choose the part type.
Choose [Switch] here.

Step 5 Specify the number for [No. of Patterns].  Select “2” here.

In the case of [Switch] or [Lamp] parts, select as many bitmap images as the number set 
for [No. of Patterns].  This is not only for bitmap images for [OFF] but also those for [ON] 
must be selected.  (If not selected, the same bitmap images as those selected for [OFF] 
are also used for [ON].)

Step 6 Click the [ON] button.
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Step 7 Click the [Change] button.  The [Image List] dialog for bitmap image selection is displayed 
again.

Select a bitmap image for [ON] and click [Select].

Step 8 When you have selected bitmap images for [OFF] and [ON], click [Place].
The selected bitmap image converted to a switch part appears together with a cross-
shaped cursor.  Click the mouse button at the desired position to place the switch part on 
the screen.

An image appears with 
a cross-shaped cursor.

Click the mouse button to place the part.

Image size
(If the image size is different between 
OFF and ON, the part size will be that 
of the OFF image.)
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Placing Parts with Copy & Paste

Step 1 Select and copy the image you have prepared using a Windows image processing 
software.
(In this example, Paint is used for copying.)

Step 2 Select [Edit] → [Paste] on the editor.
The [Image Target Selection] dialog is displayed.
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Step 3 Select [Parts] and click [OK].
The [Image Conversion] dialog is displayed.

Step 4 Choose the part type.
Choose [Lamp] here.

Step 5 In the case of a switch or lamp part, specify the number for [No. of Patterns].
Select “2” here.
The pasted image is regarded as the OFF image.
(The ON image must be set later.)

Step 6 Click the [ON] button.
Click the [Change] button.  The [Image List] dialog for bitmap image selection is displayed.
If the desired bitmap image is not displayed in the list, click [Open] and select the bitmap 
image you created.

Select a bitmap image for [ON] and click [Select].
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Step 7 When you have selected bitmap images for [OFF] and [ON], click [Place].

Step 8 The dialog shown below is displayed.

Save the OFF image you pasted in step 5.
The image is saved in the “User” folder.  Enter a name for [Save the image in .BMP file] 
and click [OK].

Step 9 The selected bitmap image converted to a switch part appears together with a cross-
shaped cursor.  Click the mouse button at the desired position to place the switch part on 
the screen.

An image appears with 
a cross-shaped cursor. Click the mouse button to place the part.
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Note

• If you want to change the image of a part that is placed in this way, handle it as an ordinary 3D 
part.  Select [Customize] in the [Style] tab window and change the bitmap file.
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25.8 Text Comparison
Overview

This text comparison function enables you to compare two files in the computer or a file in the 
computer with the data in the V8 unit.  You will be notified of the result after comparison.
Compared to file comparison in the previous manner, mismatches found as the result of comparison 
are shown in detail.  You can view a comparison result in text format, and store the information as a 
report or a CSV file.
Furthermore, you may copy those mismatches item by item.  For more information on the copy 
procedure, refer to the V8 Series Operation Manual.

Procedure

Comparison on the Computer

Step 1 Click [File] → [File Management] → [File Comparing].

Step 2 Enter your desired files in the [Comparison] (source) and [Comparison Target] fields.  
Check [ Text comparison].

Step 3 Click the [OK] button.  Comparison starts.
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Comparison between Computer and V8

Step 4 Upon completion of comparison, the [Comparison] window appears to show the result.  
The locations where mismatches are found are highlighted in red.
For how to check those mismatches in detail, refer to “Check in Detail” (page 25-51).

* In the case of perfect matching, the message “Data 
Match” appears.  Clicking [OK] brings up the 
[Comparison] window.

Step 1 Open the file you wish to compare in the V-SFT software.  Click [File] → [Transfer].  The 
[Transfer] dialog is displayed.

Step 2 Check [ Text comparison].

Step 3 Click [PC <->].  Comparison starts.
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Check in Detail

This section explains how to check the mismatches found on screen No. 0, for example.

Step 4 Upon completion of comparison, the [Comparison] window appears to show the result.  
The locations where mismatches are found are highlighted in red.
For how to check those mismatches in detail, refer to “Check in Detail” (page 25-51).

* In the case of perfect matching, the message “Data 
Match” appears.  Clicking [OK] brings up the 
[Comparison] window.

Step 1 Right-click [Screen [0]] (highlighted in red) and select [Detail].

* Clicking [Detail] on the right-click menu of [System Setting] shows all contents 
of the [System Setting] menu.
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Step 2 The [Detail] window is displayed.
Matches are shown in black, and mismatches are highlighted in red.

Step 3 [Upward search]/[Downward search]: 
These buttons are used to search for mismatches upward or downward.
[CSV]: This button is used when you output the contents currently displayed to a CSV file. 

(The CSV file shows even the mismatches in black.) 

Mismatched coordinates
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25.9 Selective Transfer
Overview

If multiple operators edit one set of screen data, it is not possible to independently manage the screen 
data edited by, for instance, operator A and operator B.  In this event, an operator may mistakenly edit 
any portion of the screen data that belongs to someone else and may transfer the screen data to the 
V8 unit.
With the selective transfer function, one set of screen data can be divided into sections under the 
management of the administrator, and those sections can be assigned separately to target operators.  
Each operator then will edit only his/her assignment and transfer the data to the V8 unit.  Improved 
work efficiency will consequently be expected because they have no need to bother the sections 
undertaken by other operators.

V8

1

2

1’’

2’’

2

1

1’’

2’’
Original screen 

data

Transfer

1. Screen data for operator A
2. Screen data for operator B

Administrator Operator A

Operator B
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Example

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

.V8
Hakko

.V8
AAA

.V8
BBB

Hakko.V8

Operator A 
(user 1)

Operator B 
(user 2)

Administrator

Original screen data: Hakko.V8  
Screen data for operator A: AAA.V8 (transfer items assigned to A: screen Nos. 0 to 10)
Screen data for operator B: BBB.V8 (transfer item assigned to B: screen No. 99)

The administrator assigns the 
transfer items to A and B.

Operator A: Screen Nos. 0 to 10 
Operator B: Screen No. 99

Screen Nos. 1 and 99 are reflected throughout “Hakko.V8”.

Screen data

Screen No. 1 Screen No. 99

Screen No. 1
Transfer

Change from 
D101 to D102

Part addition

* Operator B 
cannot reflect 
his/her 
modification to 
screen No. 1 
because 
operator B is not 
authorized to 
edit screen No. 1.
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Setting

Location for Setting

Click [File] → [Property].  Open the [Selective Transfer] tab window.  

Setting Items

1. Use Selective 
Transfer

Checked:
Selective transfer is available.

2. User Select a user who undertakes screen editing in this field.
• Administrator

The administrator assigns transfer items to users 1 to 4 and 
determines their passwords.
The administrator transfers the whole screen data to the V8 unit.

• User 1 to 4
Users are not permitted to change the assignment of transfer 
items and the passwords.  Each user may transfer only the 
item(s) that is/are shown with the [Item] button.

1.

2.

3.

4.

5.

Administrator User 1 to 4
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3. Administrator
[Password]
(within 6 
alphanumerics)

An administrator-level password * can be set through this button.
Switching in the [User] field can be password-protected.  (No 
password protection is provided for switching from “Administrator” to 
“User” in the [User] field as detailed in the table below.) Password 
protection will prohibit users to change the assignment of transfer 
items on their own.
Also when a user attempts to export screen data from the V8 unit, he 
or she will be prompted to enter the password for authentication.

* For the assurance of data security, password setting is 
recommended.
A password once set cannot be reviewed.  Great care should 
be taken in password management.

4. User 1 to 4
[Item] and [Password]

Through the individual buttons, transfer items and a password can be 
assigned to each user.  (See section 3 (above) for more information 
on password.)
A maximum of four users can be set.

* All items other than the registration items belong to [System 
Setting].
The items “a.” are also included in [System Setting].  Check 
an item in “a.” if you wish to transfer it independently.

Before 
change After change Password

Administrator User 1 to 4 No password Not required

Password-protected Not required

User 1 to 4 Administrator No password Not required

Password-protected Required

User 1 to 4 No password Not required

Password-protected Required

Registration 
items

a.
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Procedure

This section describes the usage of the selective transfer function, taking the following case for 
example.

• Transfer items assigned to user 1: Screen Nos. 0 to 10
• Transfer items assigned to user 2: Screen No. 99

Administrator

Step 1 Check [  Use Selective Transfer].

Step 2 Check [  User 1].  Click the [Item] button.
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Step 3 In the [Transfer Item Selection] dialog, check [Screen] and specify screen Nos. 1 to 10.  
Click the [OK] button.

Step 4 In the [Selective Transfer] tab window, click the [Password] button for [User 1].  Set a 
password for user 1 (within six alphanumerics).

Step 5 In the [User] field, select “User 1”.  Click the [OK] button.

Step 6 Name and save the screen data file for user 1.
This step completes the user 1 settings.

Click the [Item] button for user 1.  The 
transfer items assigned to user 1 are 
reviewed.
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User 1 to 4
This section describes how user 1, for example, performs a selective transfer.

Step 7 Proceed to user 2 settings.
In the [User] field, select “Administrator”.
Check [ User 2].  Follow steps 2 through 6 for user 2.

Step 8 Two screen data files for users 1 and 2 are now prepared.
The necessary settings have been completed.
Pass these files to the individual users.

Step 1 Open the screen data file for user 1.
Click [File] → [Property].  Open the [Selective Transfer] tab window.  
 Review the user number selected in the [User] field.  (Example: “User 1”) 

Step 2 Press the [Item] button.  The [Transfer Item Selection] dialog is displayed.
Review the transfer items assigned to user 1.  (Example: Screen Nos. 0 to 10)

Step 3 Edit these screens and transfer the data to the V8 unit.
* Even if modifications are made to any item outside the range assigned, the 

modified data will not be transferred to the V8 unit.
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Export from V8 to Computer 

When password protection is set, the following confirmation dialog is displayed before screen data 
export from the V8 unit.

Notes

• The administrator should take care not to assign the same item repeatedly to multiple users in the 
[Transfer Item Selection] dialog.

• Only the administrator is allowed to edit the Windows fonts registered with text.
• Tags cannot be transferred by the selective transfer function.

• Only the user, for whom [ System Setting] is checked in the [Transfer Item Selection] dialog, is 
allowed to change the number of interface languages in the [Font Setting] dialog and to transfer 
the I/F driver data for the simulator.

• If a screen includes a component part, the relevant memory table and text table will be transferred 
together with the screen to the V8 unit.  In the [Transfer Item Selection] dialog, it is recommended 
that the item [Buffering Area] or [Device Memory Map] be checked if either one is used.

• Screen data transfer is executable via a serial port, a USB port, or an Ethernet port.  However, 
transfer via a CF card is not supported.
Data transfer from the V8 unit to the CF card is possible.  Note that the [ID] dialog that appears 
before the export of data from the V8 unit shows the user who transferred data to the V8 unit most 
recently.  Therefore, change the [User] field in the [ID] dialog to the name who attempts to export 
data from the V8 unit.
(If you wish to prohibit data export from the V8 unit to the CF card, go to the [CF Card] dialog from 
the [System Setting] menu, and set a password at [Password].  For more information, refer to the 
V8 Series Reference Manual.)

• If passwords are set in both the [File Information] tab window and the [Selective Transfer] tab 
window ([File] → [Property]), you will be requested to enter the password set in the [File 
Information] tab window first and then will be prompted to enter the password set in the [Selective 
Transfer] tab window.

• At the time of the initial transfer, the administrator must transfer the whole screen data to the V8 
unit.  If the V8 unit includes screen data, which is not provided with selective transfer settings, and 
then if a user transfers his/her screen data assigned by the selected transfer function to the V8 
unit, the security of the data in the V8 will not be assured.

User Screen data is exported from the V8 unit under the 
name of the user selected in this field.  The default 
shown in this field is the user who performed data 
transfer to the V8 most recently.

Password Enter the password assigned to the user selected in 
the [User] field.
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25.10 Message/Comment Transfer
Overview

If it is necessary to display, for example, different unit names on alarm messages depending on the 
situation while using the same screen data, the message/comment transfer function can be used to 
transfer a text file for messages only.
Messages can easily be edited in text format.

Example

* Messages can also be changed by saving them in text format on the CF card.  For more 
information, refer to “14.2 Storing Message Data”.
(Comments cannot be changed in this way.)

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

Hakko

text

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

MSG00000.txt

Hakko.V8

When changing alarm messages in message GNo. 0:
Original screen data: Hakko.V8
Text file: MSG00000.txt (Language 1, message GNo. 0)

Transfer

Screen 
data

Message

Computer

Store the screen data and text file 
in the same location.
(Example: desktop)

Line #1  Emergency stop
Line #1  Sensor error
Line #1  Preparation
Line #1  Stopped

Emergency stop
Sensor error
Preparation
Stopped

<ALARM>

<ALARM>
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Target Items

•  [Registration Item] → [Message]
•  [Registration Item] → [Comment]

Setting

Location for Setting

Check [  Importing message and comment data from text file when data transfer].  
([File] → [Property] → [Transfer])

Procedure
Message
The section explains the case where messages in message GNo. 0 of Language 1 are changed.

Step 1 Start up Notepad.
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Step 2 Register messages in order from the top.

* A maximum of 127 one-byte (63 two-byte) characters per line and a maximum of 
256 lines can be registered.  All of the 256 lines are transferred.
Note that character properties are not transferred.

Step 3 Click [File] → [Save As]. 
Be sure to select the same location where the screen data “*.V8” is saved. (Example: 
desktop)

Step 4 Name the file in the format shown below and save it.

[Message Edit] window of the screen data

V8 screen data

MSGxxyyy.txt
Message GNo.: 000 - 127
Language No.: 00 - 15 (Language 1 - 16)

(Example: Language 1, message GNo. 0)
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Step 5 Check that the screen data and the text file are saved in the same location.
(Example: desktop)

Step 6 Start V-SFT and open the [Transfer] dialog ([File] → [Transfer]).  
Click [PC ->].

Step 7 Select screen data. (Example: Hakko.V8)

Step 8 Transfer of the screen data and text file starts.
Transfer has been completed.

Screen data
Message
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Comment
The section explains the case where comments of Language 1 are changed.

Step 1 Open the screen data. (Example: Hakko.V8)

Step 2 Open the [Commend Edit] window ([Registration Item] → [Comment]).

Step 3 Click [File] → [Export].  The [Save As] dialog is displayed.
Be sure to select the same location where the screen data “*.V8” is saved. (Example: 
desktop)

* In multi-language editing, select the language number currently edited.
Step 4 Select [All Files] for [Save as type].  Name the file in the format shown below and save it.  

CMNTxx.txt
Language No.: 00 - 15 (Language 1 - 16)

(Example: Language 1)



25.10    Message/Comment Transfer

25-66

Step 5 Check that the screen data and the text file are saved in the same location.
(Example: desktop)

Step 6 Open the text file on Notepad. (Example: CMNT00.txt)
Edit a comment in double-quotation marks.

Step 7 Click [File] → [Save].

Screen data

Comment

Comment No. 1

Comment No.:  //1 - 32767
Contents:  “(comment)”
Multiple lines:  Insert a line break.

[Comment Edit] window of the 
screen data

* A maximum of 127 one-byte (63 two-byte) characters can be registered per 
line.
A maximum of 32767 comments (32 lines, 1024 one-byte characters per 
comment) can be registered.
Note that character properties are not transferred.

Character properties 
(Cannot be transferred)
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Step 8 Start V-SFT and open the [Transfer] dialog ([File] → [Transfer]).  
Click [PC ->].

Step 9 Select screen data. (Example: Hakko.V8)

Step 10 Transfer of the screen data and comment file starts.
Transfer has been completed.
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Notes

• When a text file is transferred with the screen data that includes a blank line or comment for which 
Windows font properties are set, properties set for the blank line or comment will be deleted.

• Unicode text cannot be used.  Accordingly, when a file saved in Unicode text format is transferred, 
text will not be displayed correctly.

• When the message/comment transfer function is used, the message storing function with a CF 
card is disabled.  ([  Range of Messages to be Saved to CF Card] ([System Setting] → [CF Card 
Setting]) becomes inactive.) 
To use the message storing function with a CF card, uncheck [  Importing message and 
comment data from text file when data transfer]. 
(For more information on the message storing function, refer to “14.2 Storing Message Data”.) 

• The selective transfer function cannot be used when the message/comment transfer function is 
used.

• After transfer with the message/comment transfer function from the computer to the V8, the screen 
data in the computer remains the same as before.  The screen data to which changes are reflected 
must be exported from the V8 to the computer.

Example: Message
Text file [Message Edit] window

Windows font properties are 
deleted.

Third line is blank. Transfer
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26 USB Connection
This section describes the equipment that can be connected at the USB-A port.

• USB barcode reader
(Refer to “26.3 USB Barcode Reader”.)

• USB keyboard
(Refer to “26.4 USB Keyboard”.)

• USB mouse
(Refer to “26.5 USB Mouse”.)

• USB FDD
(Refer to “26.6 USB FDD (Floppy Disk Drive)”.)

26.1 Applicable Models
Depending on the USB equipment, the applicable models vary.  Check the availability of each USB 
equipment.

* Except for portrait-oriented V808C or V806

USB Equipment

V815iX
V812(i)S

V810(i)T/(i)S
V808(i)S

V810(i)C
V808(i)C

V806(i)T
V806(i)C
V806(i)M

USB barcode reader

USB keyboard

USB mouse  *  *

USB FDD × ×
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26.2 Notes on USB Connection
Limitations on Connection Devices

• It is not possible to connect multiple USB devices of the same kind at the same time.
(Example:  Two USB barcode readers = × (not connectable), Two USB keyboards = × (not 
connectable))
Using a USB hub, one device of each kind can be connected.

• A USB barcode reader and a USB keyboard cannot be used at the same time.
If both are connected, only the USB barcode reader will be recognized.

USB-A

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8
USB-B

USB-CFREC can 
also be used.

USB-A

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8
USB-B

OK
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Device Combinations

Combination of devices usable at the same time: 
Combination of devices not usable at the same time: ×

Notes on Use of USB Hubs

• A maximum of two USB hubs (= max. 2 tiers) can be connected to the V8 series.
Note that, however, the system’s performance may slow down when two hubs are used.

• If you connect a USB hub to the V8 series while using a power adaptor at the USB hub, do not turn 
the power adaptor OFF or remove the connector between the power adaptor and the USB hub.
If the power adaptor is turned OFF or disconnected, the power supply to the V8 series will become 
insufficient and the V series may become unstable such as restarting repeatedly.

• If two USB hubs are connected to the V8 series, supply the power to the USB hub using the power 
adaptor provided to these USB hubs.
When connecting one USB hub, if a power adaptor is provided to the USB hub, supply the power 
to the USB hub using that power adaptor.

USB barcode 
reader USB keyboard USB mouse USB-FDD

USB barcode 
reader − ×

USB keyboard × −

USB mouse −

USB FDD −
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26.3 USB Barcode Reader
Overview

• The USB HID class barcode reader can be connected.

• A variety of barcodes can be read in the same way as the case of RS-232C connection.

Operation Verified Readers

• The USB HID class barcode reader is supported.
• For a list of USB barcode readers of which operations have been verified, visit our website 

(http://www.monitouch.com).

Connection

Use the USB-A port on the V8.

* Only one USB barcode reader can be connected to the V8.

4902580302447

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

4942621576213

Code No.

Importing data

USB-A

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8
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Setting Procedure

Select [System Setting] → [Device Connection Setting], and select [Barcode].  In addition to [CN1], 
[MJ1] and [MJ2], [USB A] is added and becomes selectable for [Connect to:].
For USB connection, select [USB A].

The items that require setting are the same as those with [CN1], [MJ1] or [MJ2].
For more information, refer to “17 Barcode” in the V8 Series Reference Manual.
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26.4 USB Keyboard
Overview

• In place of a keypad or character entry keys, a USB keyboard can be used in entry mode.

Applicable USB Keyboards

• Japanese keyboard (106 keyboard, 109 keyboard, etc.)
• US keyboard (101 keyboard, 104 keyboard, etc.)
• Keypad

Connection

Use the USB-A port on the V8.

* Only one USB keyboard can be connected.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

R-L-00A

1564

554

1653

T-L-00B

T-L-00A

USB-A

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8 Keyboard

or

Keypad
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Setting Procedure

To enable the USB keyboard, settings are required on the editor and the MONITOUCH.

Settings on MONITOUCH

Select the language for the keyboard on the Main Menu screen.
(When using a keypad, this setting is not necessary.)

1. Press the [Main Menu] switch and press [I/O Test].

2. The I/O Test screen is displayed.
Press the [Keyboard] switch.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM
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3. The Keyboard Selection screen is displayed.
Select the language to be used for the keyboard, and press the [Setting Finished] switch.

4. The I/O Test screen is displayed again.
Press the [Return] switch to move back to the Main Menu screen.

The settings on the MONITOUCH have been completed.

Settings on the Editor

An [Entry] icon must be registered on the screen where the USB keyboard is to be used.
In addition, numerical data or character display parts of [Display Function: Entry Target] are required.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

← Press [Setting Finished] to end.

Setting Item Mandatory / As Required Setting Procedure

[Entry] icon Mandatory Place an [Entry] icon on the screen 
where the keyboard is to be used.

Entry Target Mandatory When entering characters through the 
keyboard, register [Entry Target] for 
character display; when entering 
numerical data through the keyboard, 
register [Entry Target] for numerical 
data display.
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Keyboard Key Functions

The V8 functions assigned to the keys on the keyboard are listed below:

USB Keyboard Switch Function Remarks

Character keys Character input

Enter Write

Clear

− (minus) Toggle sign

Space Space

Back Space Backspace

Delete DELETE

+1

−1

Addition

Subtraction

Esc Cancel

← ←

→ →

↑ ↑

↓ ↓

Page Up >>

Page Down <<

Graphic library

80 compatible HEX key

80 compatible HEX key change

Maximum value entry

Minimum value entry

Multi-character input

Shift + Caps Lock Switching (Caps Lock)

Word edit

Word registration

Character switching (+)

Character switching (−)
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26.5 USB Mouse
Overview

• A USB mouse can be connected.
Instead of pressing on the screen, the mouse can be used for switch operation.

• When the touch switch driver is installed on the computer and the computer is connected with the 
V8 series via the transfer cable (V-CP), operations on the RGB input screen can be performed 
using a USB mouse.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

RUN STOP

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

D-sub 9pinV-CPMJ1

PC

GU-10/GU-11/GU-01

RGB cable

RGB display

Mouse coordinate information
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Connection

Use the USB-A port on the V8.

* Only one USB mouse can be connected.

Setting Procedure

There is no special setting required for using a USB mouse.

Mouse Operation

Mouse Pointer Shape

The mouse pointer displayed on the MONITOUCH is shown below:

Mouse Operation

The mouse operations available with the MONITOUCH are listed below:

Limitations

• When the touch switch emulation of the RGB display function and the remote desktop window 
display function are used at the same time, a USB mouse cannot be used for the remote desktop 
window.

USB-A

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8

Mouse Operation Action

Move Moving the mouse pointer

Left-click Pressing the button
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26.6 USB FDD (Floppy Disk Drive)
Overview

• A USB FDD can be connected.

• Memory media available with the V8 are:  CF card in the built-in FC card slot; CF card in the CF 
card reader/writer that is USB connected, floppy disk inserted in the USB FDD.

Connection

Use the USB-A port on the V8.

* Only one USB FDD can be connected.

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

SAVE LOAD

Data read / write

USB-A

F 1

F 2

F 3

F 4

F 5

F 6

F 7

SYSTEM

V8
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Setting Procedure

There is no special setting required for using a USB FDD.

Applicable Media

• 2HD type (1.44 MB, PC/AT format)
• 2DD type (640 kB, MS-DOS format)

Available Functions

Macro Command

• COPY_FILE

System Memory

The system memory addresses relating to the USB FDD are shown below.

• Address $s1025
The result of access to the USB FDD port (drive: A) is output.

• Address $s1026 - 1027
Stores the free capacity on the USB-FDD port (drive: A) in kB.

• Address $s1028
Stores the status of the [Function: CF Card Removal] switch.

[0]: Switch OFF (CF card removal disabled)
[Other than 0]: Switch ON (CF card removal enabled)

Address ($s) Description Memory Type

1025 USB FDD (drive: A) FDD error state

← V
1026 USB FDD (drive: A) FDD free capacity (low-order) Unit: kB

1027 USB FDD (drive: A) FDD free capacity (high-order)

1028 USB FDD (drive: A) [CF Card Removal] switch status

4 Floppy disk not mounted

6 Too small floppy disk size

7 Different floppy disk type

12 Floppy disk write error

15 Disk error (open failure)

16 Floppy disk read error
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Please use this page freely.



27    Ladder Transfer via USB or Ethernet

27-1

27

27 Ladder Transfer via USB or Ethernet
Overview

You can write or monitor PLC ladder programs via the V8i or V8 series using the USB port or Ethernet.

• Ladder transfer via USB

• Ladder transfer via Ethernet

* For information on the available PLC models, refer to “Available PLC Models” (page 27-2).
The ladder transfer function is enabled, provided that [PLC1] is selected as the connection 
target PLC and [1:1] is selected for [Connection Mode] in the [Device Connection Setting] 
dialog in V-SFT.  

USB-AUSB-B

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

USB cable

Computer

PLC ladder 
software

Ladder program/monitor, etc.

V8 series

PLC

Serial
RS232C/422

Ethernet

SYSTEM

F 7F 6F 5F 4F 3F 2F 1

Computer

PLC ladder 
software

Ladder program/monitor, etc.V8i series

PLC

Serial
RS232C/422
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Operating Environment

Available V8 Models

Applicable OS for Computer

Applicable OS varies depending on the version of our ladder tool software LadderComOp.

* For more information on the versions, refer to “LadderComOp Setting” (page 27-3).

Available PLC Models

*1 The ladder transfer function via USB or Ethernet is enabled, provided that [PLC1] is selected as 
the connection target PLC and [1 : 1] is selected for [Connection Mode] in the [Device 
Connection Setting] dialog in V-SFT. 

*2 Only LadderComOP version 2 is supported. 

MONITOUCH Model Port

V815iX/V812iS/V810iS/V810iT/V810iC
V808iS/V808iC/V808iCH/V806iT/V806iC/V806iM Built-in LAN or USB-B

V812S/V810S/V810T/V810C
V808S/V808C/V808CH/V806T/V806C/V806M USB-B

LadderComOp 
Version* Applicable OS Remarks

Version 2 Microsoft Windows 2000/XP/Vista/7/8

Version 1 Microsoft Windows 2000/XP

Windows 2000 is not compatible with the 
following PLCs:

Maker Model Setting in V-SFT *1 Remarks

MITSUBISHI 
ELECTRIC

A series CPU

Ladder transfer is enabled only 
with PLCs (CPUs) connected to 
V8.
For more information on the 
available PLC models, refer to 
the V8 Series Connection 
Manual.

QnH (Q) series CPU

Q00J/Q00/Q01 series CPU

QnH (Q) series CPU (multi-CPU)

QnU series CPU

FX series CPU

FX2N/1N series CPU

FX1S series CPU

FX3U/3UC/3G series CPU

OMRON SYSMAC CS1/CJ1

Panasonic FP series (RS232C/422)

Yokogawa Electric
FA-M3

FA-M3R

Fuji Electric MICREX-SX SPH/SPB CPU

Siemens S7-200 PPI *2

Maker Model Setting in V-SFT

MITSUBISHI 
ELECTRIC

A series CPU

FX2N/1N series CPU

Panasonic FP Series (RS232C/422)
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Setting Items

V-SFT Setting

• [Device Connection Setting] → page 27-4

LadderComOp Setting

• Installation  → page 27-7
• [Ladder Transfer Setting]  → page 27-18

PLC Programming Software Setting

• COM port setting → page 27-22

About LadderComOp
This is an application required for ladder transfer via USB/Ethernet.
“LadderComOp.exe” can be installed at the time of installing (updating) V-SFT-5, or can 
be downloaded from the Hakko Electronics website at 
http://www.hakko-elec.co.jp/en/download/05other/index.php.
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V-SFT Setting

This section explains the settings for ladder transfer using the QnH (Q) series (MITSUBISHI 
ELECTRIC) as an example.

[Device Connection Setting] 

1. Click [System Setting] → [Device Connection Setting].  The [Device Connection Setting] dialog is 
displayed.

2. Open the [Ladder Transfer Port] tab window.
Check [ Use Ladder Tool] and select an option for [Connection].

• For ladder transfer via USB: [Connection: USB B] 
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3. The necessary settings have been completed.  Transfer the screen data to the V8 series.

About [Port No.]
The [Port No.] selected above will be used as the receiving port on the V8i series during 
ladder transfer between the V8i unit and a computer.  Also, the port of [Port No.] plus 1 
will be used as the sending port on the V8i series for transmission to a computer.  
Therefore, check that the same port number is not already assigned to a different 
function in the screen data.

Example: [Port No.] set to “1024”
Receiving port on the V8i series: 1024
Sending port on the V8i series: 1025

* The port number assigned here is used for the LadderComOp setting.
Go to the sections below for more information:

• LadderComOp version 2 setting → page 27-19
• LadderComOp version 1 setting → page 27-21

Notes on ladder transfer via USB
Observe the following when transferring screen data via a USB cable.

• Switch to the Main Menu screen on the V8 series.
(Ladder communication is enabled on the RUN screen only.)

• Place LadderComOp version 2 offline. 
(For more information on this setting, refer to [Ladder Transfer Setting] (page 
27-18).)

• For ladder transfer via Ethernet: [Connection: Built-in LAN], [Port No.: 1024] (as default) 

[Port No.]:
1024 - 65533 (1024 as default) 
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LadderComOp Setting

Ladder transfer via USB/Ethernet is available, provided that the dedicated tool, LadderComOp, is 
installed on the computer.  If LadderComOp has already been installed, go to [Ladder Transfer Setting] 
(page 27-18).

There are LadderComOp version 1 and version 2.  When the OS in your computer is 
Windows Vista, 7 or 8, install LadderComOp version 2.  
LadderComOp version 2 is obtainable in either of the two below ways:

• A CD of V-SFT version 5.4.23.0 or higher, or V-SFT updated version offered at Hakko 
Electronics website
Downloading from:  http://www.hakko-elec.co.jp/en/download/09vsft5/index.php

• “LadderComOp.exe” at Hakko Electronics website
Downloading from:   http://www.hakko-elec.co.jp/en/download/05other/index.php

* How to review the version of LadderComOp
Click the mark at the top left corner of the [Ladder Transfer Setting] dialog and select [About 
LadderComOp] to see the software version.  

Version 2 Version 1

Example: Version 2
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Installation

Perform the steps below to install LadderComOp.
• New installation of version 2  → page 27-7
• Update from version 1 to version 2  → page 27-11
• New installation of version 1  → page 27-16

New installation of version 2
This section explains how to install LadderComOp version 2 on Windows XP as an example.  If you 
download “LadderComOp.exe” from the website and install it, start from step 2.

1. When V-SFT-5 has been installed or updated, the following dialog is displayed.
Click [Yes].

2. Click [Next]. 

3. Select the destination of where to install the software and click [Next].

LadderComOp version 2 is obtainable in either way below:
• A CD of V-SFT version 5.4.23.0 or higher, or V-SFT updated version offered at 

Hakko Electronics website
Downloading from:  http://www.hakko-elec.co.jp/en/download/09vsft5/index.php

• “LadderComOp.exe” at Hakko Electronics website
Downloading from:  http://www.hakko-elec.co.jp/en/download/05other/index.php 

Destination for installation (default):
Windows 2000 / XP: Program Files 
Windows Vista / 7 / 8: MONITOUCH 



27    Ladder Transfer via USB or Ethernet

27-8

4. Click [Install].  

5. Installation starts.

6. The dialog indicating the completion of installation is displayed.  Click [Finish].  

The window below appears during installation.
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7. The message “Found New Hardware” is displayed and then the installation wizard is displayed on 
the computer.  Check [No, not this time] and click [Next].  

8. When the dialog below is displayed, check [Install the software automatically (Recommended)] 
and click [Next].  

9. Installation starts. 

10. The dialog indicating the completion of installation is displayed.  Click [Finish]. 

11. Repeat steps 7. through 10. for installation.
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12. Open the [Device Manager] of the computer.
When installation has been successful, “LadderComOp2” appears in the [Device Manager] 
window.

This step completes the installation of LadderComOp version 2.

If installation has failed, a yellow exclamation mark “!” is present at “LadderComOp2” in 
the [Device Manager] window.
In such a case, uninstall and reinstall LadderComOp.



27    Ladder Transfer via USB or Ethernet

27-11

27

Update from version 1 to version 2
This section explains how to update LadderComOp from version 1 to version 2 on Windows XP as an 
example.

1. When V-SFT-5 has been installed (updated)* or “LadderComOp.exe” downloaded from the 
website is executed, the following dialog is displayed.
Click [Yes].

2. Click [Next]. 

LadderComOp version 2 is obtainable in either way below:
• A CD of V-SFT version 5.4.23.0 or higher, or V-SFT updated version offered at 

Hakko Electronics website
Downloading from:  http://www.hakko-elec.co.jp/en/download/09vsft5/index.php 

• “LadderComOp.exe” at Hakko Electronics website
Downloading from:  http://www.hakko-elec.co.jp/en/download/05other/index.php 

Following the uninstallation of LadderComOp version 1, the installation of version 2 
starts.
Be sure to reboot the computer after installing LadderComOp version 2.
Also re-setting LadderComOp is required.
For more information on the setting, refer to [Ladder Transfer Setting](page 27-18).

* V-SFT-5 version 5.4.23.0 or higher supported
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3. A LadderComOp update starts.

4. Click [Finish]. 

The dialog for rebooting the computer is displayed.
Do not reboot the computer yet.  Go to step 5.

The window below appears during installation.
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5. The message “Found New Hardware” is displayed and then the installation wizard is displayed on 
the computer.  Check [No, not this time] and click [Next].  

6. When the dialog below is displayed, check [Install the software automatically (Recommended)] 
and click [Next].  

7. Installation starts. 
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8. The dialog indicating the completion of installation is displayed.  Click [Finish]. 

9. Repeat steps 5 through 8 for installation.

10. The dialog indicating the completion of update is displayed.  Click [Finish].  Reboot the computer. 

11. Open the [Device Manager] of the computer.
When installation has been successful, “LadderComOp2” appears in the [Device Manager] 
window.

Be sure to reboot your computer.  Failure to reboot your computer may cause a 
malfunction.
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This step completes updating LadderComOp from version 1 to version 2.

If installation has failed, a yellow exclamation mark “!” is present at “LadderComOp2” in 
the [Device Manager] window.
In such a case, uninstall and reinstall LadderComOp.
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New installation of version 1
This section explains how to install LadderComOp version 1 on Windows XP as an example.  If the OS 
in your computer is Windows Vista or Windows 7, install LadderComOp version 2.   For installation 
procedure, refer to New installation of version 2 (page 27-7). 

1. When V-SFT-5 has been installed or updated, the following dialog is displayed*.
Click [Yes].

2. Click [Next].  

3. Select the destination of where to install the software and click [Next].

4. Click [Install].  

LadderComOp version 1 is obtainable from the following:
• A CD of V-SFT version 5.3.0.0 to version 5.4.22.0

* V-SFT version 5.3.0.0 or higher supported

Destination for installation (default):
Windows 2000 or Windows XP: Program Files
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5. Installation starts. 

6. The dialog indicating the completion of installation is displayed.  Click [Finish].  Reboot the 
computer. 

This step completes the installation of LadderComOp version 1.

Whenever you have installed or uninstalled LadderComOp version 1, reboot your 
computer.  Failure to reboot your computer may cause a malfunction.
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[Ladder Transfer Setting]
Start
1. From the [Start] menu of your computer, click [Programs] → [V-SFTV5] → [LadderComOp] → 

[Ladder Transfer Setting].

2. The [Ladder Transfer Setting] dialog is displayed.

Version 2

Version 1
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LadderComOp version 2 setting

1. Icon Clicking this icon and selecting [About LadderComOp] opens the dialog 
that displays the version of LadderComOp.

2. PC Two COM ports on the computer are used.

Used Port
Select a COM port for ladder transfer from the list.
Range: COM1 to COM256 
(COM ports already assigned to other purposes on the computer are not 
listed.)
The COM port number selected in this field is to be set in the PLC 
programming software*.

* The range of COM port numbers is limited, depending on the PLC 
programming software.  For more information, refer to the manual for 
your PLC.

Example: 
COM 1 to COM 15 for FPWIN GR (Panasonic)
(COM 1 to COM 5 for version 2.2 or lower)

Virtual Port
A COM port number not in use is to be automatically assigned.

3. MONITOUCH Select a method of connecting the computer and the V8 series.

USB
No special setting required

Ethernet
• IP address

Specify the local IP address of the V8i series (with built-in LAN port).
• Port No.

Specify the port number of the V8i series.
Set the same port number as set in [Ladder Transfer Port] under 
[PLC1] ([System Setting] → [Device Connection Setting] → [PLC1]). 
Range: 1024 to 65533 (1024 as default) 

4. PLC Select the maker and the model of the PLC.

2.

1.

3.

5.

6.

7.

4.
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5. ONLINE and 
OFFLINE

Each button places the ladder transfer online or offline between the 
computer and the V8 series.

ONLINE
This button establishes connection between the computer and the V8 
series to activate the ladder transfer mode.

OFFLINE
This button disconnects the computer from the V8 series.
This button causes a forced disconnection even during ladder transfer. 

6. Add in the task 
tray

Select whether LadderComOp resides on the task tray.

• Checked
While ladder transfer is online or the [Ladder Transfer Setting] dialog is 
minimized, the icon of the dialog resides on the task tray.
While ladder transfer is online, the message “Transferring” appears in 
the tooltip displayed at the task tray. 

Right-clicking the icon on the task tray opens the menu.

• Unchecked (default)
The [Ladder Transfer Setting] dialog is left open.
The dialog can be minimized to be placed on the taskbar. 

7. END This button disconnects the computer from the V8 series and closes the 
[Ladder Transfer Setting] dialog.

Right-click.

Return
This option opens the [Ladder Transfer Setting] dialog.

Quit
This option disconnects the computer from the V8 series.
This option causes a forced disconnection even during ladder transfer. 
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LadderComOp version 1 setting

1. Icon Clicking this icon and selecting [About LadderComOp] opens the 
dialog that displays the version of LadderComOp.

2. COM port • Checked
Checking this item selects the use of ladder transfer.
Also every serial communication that uses the COM port 
specified in this dialog is converted to communication via USB 
or Ethernet.

• Unchecked
Unchecking this item deselects the use of ladder transfer.
Whenever the ladder transfer function is not used, uncheck this 
box.

3. COM port Select a COM port from the list.  Be sure that the COM port you 
select is not already used for any software or tool on the computer.
The COM port number selected in this field is to be set in the PLC 
programming software. 
Range: COM1 to COM256 (COM9 as default) 

* Do not select any COM port number already used for another 
serial communication.
The range of COM port numbers is limited, depending on the 
PLC programming software.  For more information, refer to the 
manual for your PLC.

Example: COM 1 to COM 15 for FPWIN GR (Panasonic)
(COM 1 to COM 5 for version 2.2 or lower)

4. Transfer Port Select a method of connecting the computer and the V8 series.

USB
No special setting required

Ethernet
• IP address

Specify the local IP address of the V8i series (with built-in LAN 
port).

• Port No.
Specify the port number of the V8i series.
Set the same port number as set in [Ladder Transfer Port] 
under [PLC1] ([System Setting] → [Device Connection Setting] 
→ [PLC1]). 
Range: 1024 to 65533 (1024 as default) 

2.

1.

3.
4.
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PLC Programming Software Setting

Once you have specified a COM port in the [Ladder Transfer Setting] dialog in LadderComOp, set the 
COM port in the dialog shown below in the programming software for your PLC. 

MITSUBISHI ELECTRIC “GX Developer/Gx Works2”

OMRON CX-Programmer

Be sure to select “SYSMAC WAY” for [Network Type].
[Network Settings] dialog → [Driver] → [Port Name]
For [Baud Rate], specify the same value between the V8 unit and the PLC.

Panasonic “FPWIN GR”

[Communication Settings] dialog → [Port No.]
For [Baud Rate], specify the same value between the V8 unit and the PLC.

Notes on the use of LadderComOp version 1
• If your computer has no serial port, selecting a COM port may be disabled, 

depending on the PLC programming software.  Proceed to the LadderComOp 
settings beforehand.
For setting procedure, refer to [Ladder Transfer Setting] (page 27-18).

• In the case of ladder transfer via USB, turn on the V8 unit and establish its 
connection with the computer via a USB cable before proceeding to the COM port 
setting.  Otherwise, the COM port specified in LadderComOp cannot be identified.

Version 2 Version 1

Example: COM port No. 9 in the [Ladder Transfer Setting] dialog 

For [Transmission speed], 
specify the same value as 
the baud rate between the 
V8 unit and the PLC.
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Yokogawa Electric “Wide Field2”

[Environmental Settings] dialog → [Communication Settings] → [COM Port No.]

Fuji Electric “SX-Programmer Expert (D300win)”

Siemens “STEP 7-Micro/WIN”

[Set PG/PC Interface] dialog → [PC/PPI cable (PPI)] → [Properties].

Notes

Transferring Screen Data

• Observe the following when transferring ladder and screen data via a USB cable.
• Switch to the Main Menu screen on the V8 series.

(Ladder communication is enabled on the RUN screen only.)
• Place LadderComOp version 2 offline. 

(For more information on this setting, refer to [Ladder Transfer Setting] (page 27-18).)
• To use ladder transfer function via USB/Ethernet with Siemens S7-200 PPI, please make sure to 

switch to the Main Menu screen before transferring screen data. 
(Ladder communication is enabled on the RUN screen only.)

When Using LadderComOp Version 1

• Whenever you have made changes to the LadderComOp settings, restart the PLC programming 
software.  With a Fuji Electric PLC, terminate the message manager in the task manager before 
restarting the PLC programming software.

Others

• To use PC as users, the following configurations need to be done beforehand.
1) Log on as Administrator.
2) Start [LadderComOp] and make settings for [Used Port] (for version 1, [COM port]).

Specify the same value as the 
baud rate between the V8 unit 
and the PLC.

The baud rate between the V8 unit and the PC is fixed to 
115 Kbps.

* It may take time to close [LadderComOp] after initial settings.  Please also note that if you start 
the software without administrator authorization, the message, “Please start from the set of 
COM port with administrator.” will be displayed.
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• The following messages will be displayed in the top left of V series while accessing 
Siemens S7-200 PPI by using ladder transfer function via USB/Ethernet, especially for transferring 
large files such as programs.
V series will restore automatically after the access is completed.

• PLC1  Access denied by Loader
• PLC1  In Reset Service
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A1Appendix 1 System Memory
Addition to System Memory

The following system memory addresses ($s) have been added.
For description of the other system memory addresses ($s), refer to the V8 Series Reference Manual.

$s Description Memory Type

75 Overlap: Buzzer sound
This address is used to activate or deactivate the buzzer that is issued 
when an overlap display appears.
(For an overlap display with [  Superimpose] set, the buzzer does not 
sound regardless of the setting for $s75.)

0: Buzzer ON
1: Buzzer OFF

→ V

512 Two Ethernet ports selection
For more information, refer to “17.2 Two Ethernet Ports”.

→ V

519 Ethernet status (for Ethernet unit)
For more information, refer to “17.2 Two Ethernet Ports”.

← V

1006 E-mail transmission error information
For more information, refer to “17.1 E-mail”.

← V

1009 * Data sheet (STA_LIST): Consecutive print
0: Consecutive print prohibition
1: Consecutive print permission

→ V

1010 * Data sheet: Count in the printing queue
A value placed at this memory address is valid on the condition of 
$s1009 = 1.
The number of data sheets (8 maximum) waiting to be printed is stored.
If the macro command STA_LIST is executed while eight data sheets are 
already in the queue, a macro execution error arises.

← V

1011 * Data sheet: Cancel
A value placed at this memory address is valid on the condition of 
$s1009 = 1.
When canceling the data sheets in the printing queue, place “1” at 
$s1011.  The value is automatically reset to “0” upon cancellation.

→ V
← V

1025 USB-FDD (drive: A): FDD error status
For more information, refer to “26.6 USB FDD (Floppy Disk Drive)”.

← V

1026 USB-FDD (drive: A): FDD free capacity (low-order)
For more information, refer to “26.6 USB FDD (Floppy Disk Drive)”.

← V

1027 USB-FDD (drive: A): FDD free capacity (high-order)
For more information, refer to “26.6 USB FDD (Floppy Disk Drive)”.

← V

1028 USB-FDD (drive: A): [CF Card Removal] switch status
For more information, refer to “26.6 USB FDD (Floppy Disk Drive)”.

← V

1050 Operation log: CF card in processing flag
For more information, refer to “21 Operation Logs”.

← V

1051 Operation log: CF card completion flag
For more information, refer to “21 Operation Logs”.

← V

1052 Operation log: CF card processing error flag
For more information, refer to “21 Operation Logs”.

← V

1056 Macro execution result: Arithmetic operation
For more information, refer to “23 Macro”.

← V

1057 Macro execution result: Conversion, transfer
For more information, refer to “23 Macro”.

← V
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* Available with the macro command STA_LIST.
For more information on macro commands, refer to the Macro Reference Manual.

1059 Macro execution result: Macro operation control
For more information, refer to “23 Macro”.

← V

1062 Macro execution result: CF card
For more information, refer to “23 Macro”.

← V

1063 Macro execution result: Others
For more information, refer to “23 Macro”.

← V

1070 FTP server: FTP information storage
For more information, refer to “16 FTP Server”.

← V

1071 FTP server: Number of FTP clients that log in to the server (3 sets 
maximum)
For more information, refer to “16 FTP Server”.

← V

1072 FTP server: FTP line forced disconnection
For more information, refer to “16 FTP Server”.

→ V

1075 Storage of source voltage status at start-up
If the source voltage does not meet specifications at start-up, 1 is stored 
in $s1075 and  “Warning 207” is displayed on MONITOUCH.  For more 
information on “Warning”, refer to “Appendix 2 Error”.

0 : Normal
1 : Low

← V

1085 SRAM forced formatting
After the execution of a forced SRAM formatting, “1” is placed 
automatically.
The value at this address becomes “0” at the time of switching between 
the RUN and Main Menu screens
For more information on the SRAM forced formatting, refer to Chapter 1, 
“1.3 General Settings”.

← V

1349 Backlight information storage
The type of the backlight of the V8 unit is stored.

0: CCFL (cold cathode fluorescent lamp)
1: LED

← V

1360 Security: Security level of the current login
For more information, refer to “22 Security Function”.

← V

1361 to 
1364

Security: Current login user ID
For more information, refer to “22 Security Function”.

← V

1365 Operation log viewer: Log file number being displayed  
For more information, refer to “21.2 Operation Log Viewer”.

← V

1366 Operation log viewer: Log folder number being displayed  
For more information, refer to “21.2 Operation Log Viewer”.

← V

1380 Remote desktop window start-up status
For more information, refer to “19 Remote Desktop Window Display”.

← V

1381 Remote desktop window connection status
For more information, refer to “19 Remote Desktop Window Display”.

← V

1560 Global overlap: Registration/display status
For more information, refer to “2 Global Overlap”.

← V

1561 Global overlap: Display position (X coordinate)
For more information, refer to “2 Global Overlap”.

← V

1562 Global overlap: Display position (Y coordinate)
For more information, refer to “2 Global Overlap”.

← V

1563 Global overlap: Overlap library No.
For more information, refer to “2 Global Overlap”.

← V

$s Description Memory Type
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Appendix 2 Error

Additional Errors

The following errors are added.
For details on other error numbers, item numbers, and sub item numbers, refer to the V8 Series 
Reference Manual provided separately.

Error No.

Error No. Problem Solution

127 MONITOUCH does not support the remote 
desktop function.

Check whether MONITOUCH is a model on 
which the remote desktop function can be used.  
If not, remove the setting.

128 *1 A key code is not registered on MONITOUCH. Register the license key code for remote 
desktop on the Main Menu screen.

129 The remote desktop program is not registered in 
MONITOUCH.

Update the V-SFT version and resend the 
screen data to MONITOUCH.  For data transfer 
to a CF card, you need to write the data to the 
CF card via the CF card manager.

138 The remote desktop table is not registered. Register the remote desktop table with the 
specified number.

139 The setting value for the remote desktop table is 
incorrect.

Check the remote desktop setting again 
(whether an unregistered remote desktop table 
number is specified, etc.).

166 The function set for the serial port is duplicated.

The sub item number shows;
0: CN1
1: MJ1
2: MJ2

Specify a unique function (Simulator, etc.) for 
each port.

185 (V806 only)
No optional unit is installed.

Select [System Setting] → [Edit Model 
Selection] → [Option Unit], check the setting 
and then install option unit “DU-10”.

186 (V806 only)
No optional unit is installed.

Remove the option unit “DU-10” once and install 
it again.

196 The data stored on the CF card is not correct. This error may occur when the data (screen, 3D 
part, etc.) storing function is used for a CF card.
Insert a CF card on which data is correctly 
stored using the CF card manager.

199 The function set for the USB port is duplicated. Select one of the following setting for the USB B 
port and perform data transfer again.

• USB simulator
• PictBridge printer
• Ladder transfer via USB

214 *2 A key code for the remote desktop is not 
registered on MONITOUCH.

Register the license key code for remote 
desktop on the Main Menu screen.

216 A data sheet includes an item that cannot be 
printed.

Recheck the data sheet screen.  Remove the 
unusable item.

Error: xxx (xx: xx)

Error number
Item number

Sub item number

Error: 166 (0: x)
Sub item number
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*1 Version 5.4.13.0 (system program version 1.560 or earlier)
*2 Version 5.4.14.0 (system program version 1.570 or later)

Item number
The item number shows the editing screen or other place where the error is detected.

52:  Remote desktop table setting

Sub item number
The sub item number shows the number allocated for items regarding the detected error.
(If it is blank, it means that no sub item number is allocated.)

Hiding Warning Error

When an error check is performed on the editor, all errors (E) and warnings (W) are displayed at one 
time.
“Warning (W)” items can be hidden when you click the [Show/Hide Warning] icon on the [Error Check] 
window.

217 The source voltage of the touch panel does not 
conform to the specifications.

Check the source voltage.  For more 
information on the power source specifications, 
refer to the V8 Series Hardware Specifications.

Error No. Problem Solution

Click the [Show/Hide Warning] icon. “Warning (W)” errors are hidden.
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